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본 사용설명서 소개

정보

•	 본 사용설명서에 표시된 그림과 LCD 화면은 설명용으로만 제시된 것입니다.

•	 달리 표시되지 않는 한 본 사용설명서에 수록된 그림과 화면은 MODX M6(영문)를 기준으로 한 것입니다.

•	 Windows 는 미국 및 기타 국가에 등록된 Microsoft Corporation의 상표입니다.

•	 Lightning 및 Mac은 미국 및 기타 국가에 등록된 Apple Inc.의 상표입니다.

•	 MIDI는 Association of Musical Electronics Industry(AMEI)의 등록 상표입니다.

•	 MIDI 2.0 로고( )는 AMEI(Association of Musical Electronics Industry, 음악전자사업협회) 및 MMA(THE MIDI 

MANUFACTURERS ASSOCIATION INCORPORATED)의 상표 또는 등록 상표입니다.

•	 본 사용설명서에 기재된 회사명과 제품명은 각 회사의 상표 또는 등록 상표입니다. 

본 문서의 표기법

모델명
MODX M6, MODX M7 및 MODX M8은 총체적으로 "MODX M"으로 언급됩니다.

기타

표시 설명

주의사항 오작동, 고장 또는 데이터 손실이 발생할 수 있음을 표시합니다.

주 추가 정보를 표시합니다.

[  ] 제품에 인쇄된 버튼 또는 단자 이름
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1.	 MODX M 작동 방법

MODX M이란?

블록 다이어그램 및 데이터 흐름

본 악기는 컨트롤러, 모션 시퀀서, 톤 제너레이터, 이펙트, 시퀀서, 아르페지오, 엔벌로프 팔로워, A/D 입력의 8개 주요 기능 블록으로 

구성되어 있습니다.

(1) 컨트롤 메시지

(2) 오디오 신호

(3) 컨트롤러

(4) 모션 시퀀서

(5) 톤 제너레이터

(6) 이펙트

(7) 시퀀서

(8) 아르페지오

(9) 엔벌로프 팔로워

(10) A/D 입력

(11) 컨트롤 매트릭스

(12) 컴퓨터

(13) 외부 MIDI 장치

(14) 마이크, 오디오 장비 등

(15) 독립 전원 스피커 등

(1) Control message (2) Audio signal

MIDI IN AUDIO IN AUDIO OUTMIDI OUT

USB [TO HOST]
MIDI [OUT]

USB [TO HOST]
MIDI [IN]

USB [TO DEVICE]

USB [TO HOST]
A/D INPUT [L/MONO], [R]

USB [TO HOST]
OUTPUT [L/MONO], [R]

(12) Computer (12) Computer
(14) Microphone,
Audio equipment,

etc.
(12) Computer

(15) Powerd
speakers,

etc.
(13) Extermal MIDI equipment 

(3) Controller
Keyboard, Knobs, Pedals, etc.

(4) Motion Sequencer

(11) Controll Matrix

(9) Envelope Follower

(8) Arpeggio(7) Sequencer (10) A/D Input

(6) Effects(5) Tone Generator
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톤 제너레이터 블록

톤 제너레이터 블록에는 3개의 합성 시스템이 결합된 하이브리드 사운드 엔진이 장착되어 있습니다.

AWM2 사운드 엔진

AWM2 사운드 엔진은 각 요소에 지정한 후 필터 및 EG(엔벌로프 제너레이터)를 사용하여 음향을 변경할 수 있는 샘플링된 음파 

데이터가 포함된 파형을 특징으로 합니다.

일반 파트
일반 파트는 최대 128개의 요소를 사용하여 폭넓은 범위의 풍부한 음향을 생성하므로 표현력 넘치는 음향을 창출할 수 있습니다. 

어쿠스틱 악기에서 샘플링한 "미가공" 파형은 다양한 유형의 곡과 호환되도록 처리되어 현실적인 피아노, 관악기 등의 재현이 가능합니다. 

이와 더불어 필터 및 EG 등의 기능을 사용하여 새로운 음향을 생성할 수 있습니다.

Filter EQAmplitude

Waveform 2-Band EQ

3-Band EQ

Insertion A

Insertion B

Master EQ

Master FX

Reverb

Variation

Element

Part

× 128

드럼 파트
드럼 파트의 경우 최대 73개의 드럼 키를 통해 건반 각각에 타악기 음향의 파형을 지정하여 원하는 드럼 키트를 생성할 수 있습니다. 

Key (C0-C6)

Part

× 73

Filter EQAmplitude

Waveform 2-Band EQ

3-Band EQ

Insertion A

Insertion B

Master EQ

Master FX

Reverb

Variation

개별 드럼 음량(건반별로 다름) (C0~C6)

C0 F1 C6
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FM-X 사운드 엔진

FM-X 사운드 엔진은 "오퍼레이터"라고 불리는 8개 파형 제너레이터의 주파수 변조(FM)를 통해 음향을 생성합니다.

8개 오퍼레이터의 배열은 "알고리즘"이라고 하며, 총 88개의 패턴이 있습니다. 오퍼레이터의 역할은 "캐리어"와 "모듈레이터"의 두 

가지입니다.  

모듈레이터는 연결된 오퍼레이터의 변조를 수행하고, 음향은 캐리어를 통해 출력됩니다. 또한 오퍼레이터가 음향을 직접 변조할 수 있는 

"피드백" 기능도 있습니다.

오퍼레이터 파형의 하모니 구조는 파라미터를 사용하여 제어할 수 있으며, 이를 통해 AWM2 사운드 엔진과 동일한 고품질 필터, 이펙트, 

EQ 등을 적용하여 기존의 FM 사운드 엔진으로 생성하기 어려운 높은 표현력의 음향을 생성할 수 있습니다.

2-Band EQ

3-Band EQ

Insertion A

Insertion B

Master EQ

Master FX

Reverb

Variation

Part

(6) Algorithm

(2) Modulators

(3) Carriers

3

4

5

Filter Amplitude

(1) Feedback(1) Feedback

(7)

(8)

(9)

7

1 82 6

(4) Operators

(5) Frequency
     modulation

(1) 피드백

(2) 모듈레이터

(3) 캐리어

(4) 오퍼레이터

(5) 주파수 변조

(6) 알고리즘

(7) 모듈레이터 음파

(8) 캐리어 음파

(9) 변조된 음파
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AN-X 사운드 엔진

AN-X 사운드 엔진은 아날로그 신디사이저의 거동 및 특성을 디지털 방식으로 완전히 재현하는 가상 아날로그 사운드 엔진입니다. 이는 

전통과 혁신의 요소들을 통합하는 차세대 AN 사운드 엔진으로, 현실적인 빈티지 사운드부터 에지를 살린 극단적인 사운드까지 폭넓은 

음향을 표현할 수 있습니다.

AN-X 사운드 엔진은 3개의 오실레이터와 1개의 노이즈 제너레이터로 구성되어 있습니다. 각 오실레이터는 Pulse Width, OSC Self 

Sync, Wave Shaper의 파형 제어 기능이 탑재되어 자유로운 음향 생성이 가능합니다.

이에 더해 Oscillator 3(OSC 3)는 FM 또는 링 변조를 통해 Oscillator 1(OSC 1) 및 Oscillator 2(OSC 2)의 변조를 수행할 수 있으며, 

각 오실레이터의 출력 대상은 Filter1 또는 Filter2의 전후로 설정할 수 있습니다.

2-Band EQ

3-Band EQ

Insertion A

Insertion B

Master EQ

Master FX

Reverb

Variation

Part

FM Ring
Mod

Ring
Mod

FM

Modifier Filter1 Filter2 AmpOSC 1

OSC 2

OSC 3

Noise
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내장 메모리

본 악기의 내장 메모리는 저장된 퍼포먼스, Live Set, 곡 및 기타 설정을 유지합니다.

이 차트에는 내장 메모리와 외부 장치 간 데이터 흐름이 표시되어 있습니다.

외부 장치와의 데이터 통신

내부 데이터 통신

임시 저장 영역(전원이 꺼지면 삭제)

• User waveform edit

• User motion sequence edit

• User curve edit

• User micro tuning edit

• User live set edit

• 퍼포먼스

• 아르페지오

• 모션 시퀀스

• 오디션 프레이즈

• User waveforms

• User motion sequences

• User curves

• User micro tuning

• User live sets

• User audition phrases

• 파형

• Live sets

• 곡선

• 미세 튜닝

MIDI 장치 또는 컴퓨터
DAW 소프트웨어

MONTAGE 및 기타 호환 
파일

(.X7A, .X7U, .X7L, etc.)

라이브러리 영역
*사용자 영역과 동일

(유틸리티 설정 및 빠른 설정 제외)

• User arpeggios

• Utility settings
• Quick setup

• User performance

오디오 파일
(.WAV)

오디오 녹음 재생

오디오 파일
(.WAV and .AIF)

사용자 파일
(.Y2U)

백업 파일
(.Y2A)

라이브러리 파일
(.Y2L)

MIDI 파일(.MID)패턴/곡 영역

사용자 영역

사용자 메모리

벌크 덤프

Save
Load

USB 플래시 드라이브

저장

내장 메모리

비교 버퍼
(퍼포먼스)

불러오기 버퍼
(퍼포먼스)

• Pattern / song record

• Utility settings

• Performance edit

편집 버퍼

MODX M 내장 메모리
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내장 메모리

내장 퍼포먼스, 내장 아르페지오, 내장 오디션 프레이즈 및 기타 설정을 포함합니다. 읽기 전용이므로 내장 메모리의 데이터를 덮어쓰기할 

수 없습니다.

편집 버퍼

편집 버퍼는 퍼포먼스, Live Set, 곡 및 기타 설정을 편집할 때 사용되는 작업 영역입니다.

이 작업 영역에서는 읽기와 쓰기가 모두 가능하며 이 작업 영역 안의 내용은 악기의 전원을 끄면 삭제됩니다.

편집된 데이터는 퍼포먼스를 변경하거나 악기를 끄기 전에 사용자 메모리에 저장해야 합니다. (단, 퍼포먼스 및 모션 시퀀스 이외의 

데이터는 자동으로 저장됨)

사용자 메모리

사용자 메모리에는 사용자와 라이브러리의 2개 영역이 있습니다.

사용자 영역
사용자 영역은 저장된 퍼포먼스 및 모션 시퀀스, 유틸리티 설정 및 편집 버퍼에서 편집된 기타 사용자 데이터와 같은 전체 악기의 기타 

설정을 유지합니다.

사용자 퍼포먼스를 편집한 경우 새 퍼포먼스나 기존 퍼포먼스로 저장할 수 있습니다.

라이브러리 영역
라이브러리 영역에서는 USB 플래시 드라이브에서 최대 24개의 라이브러리 파일(.Y2L)을 불러올 수 있습니다. 라이브러리 영역에 

저장된 설정은 편집할 수 없습니다. 라이브러리 영역의 설정을 편집하려면 라이브러리 영역에 저장된 퍼포먼스를 선택하거나 라이브러리 

영역에서 모션 시퀀스를 불러와 편집 버퍼로 데이터를 전송합니다. 편집 후에는 데이터가 사용자 영역에 저장됩니다.

사용자 메모리는 읽기 및 쓰기에 사용되며 이 영역 안의 데이터는 악기의 전원이 꺼져도 유지됩니다.

불러오기 버퍼 및 비교 버퍼

불러오기 버퍼 및 비교 버퍼는 편집 중인 설정을 임시로 저장할 때 사용됩니다.

불러오기 버퍼
불러오기 버퍼는 편집 버퍼의 백업으로 사용됩니다.

먼저 설정을 저장하지 않고 실수로 다른 퍼포먼스로 변경한 경우, 불러오기 기능을 사용하여 불러오기 버퍼에서 비교 버퍼로 임시 저장된 

설정을 복원할 수 있습니다.

비교 버퍼
비교 버퍼는 편집 전 설정을 유지할 때 사용되는 영역입니다. 비교 기능을 사용하면 비교 버퍼에 임시 저장된 설정을 불러와 편집음과 

비편집음을 비교할 수 있습니다.

이러한 버퍼는 데이터를 읽고 쓸 때 사용되지만, 악기의 전원을 끄면 설정이 사라집니다.
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2.	 라이브 연주에 맞게 설정

본 악기의 일반 작업 흐름 안내가 아래 표시되어 있습니다.

퍼포먼스 선택
Live Set 화면 또는 Performance 화면(Category Search 화면)에서 선택합니다.

	 

설정 편집
	 

편집된 설정 저장
	 

Live Set 생성
	 

Live Set 선택
	 

건반 연주
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퍼포먼스 선택

 Live Set 화면에서 선택

1.	 [LIVE SET] 버튼을 누릅니다.

Live Set 화면이 열립니다.

2.	 표시된 목록에서 원하는 퍼포먼스를 탭해 선택합니다.
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 Category Search 화면에서 선택

Category Search 기능을 사용하면 퍼포먼스, 파트, 리듬 패턴, 아르페지오 및 파형을 쭉 검색하여 사용하려는 항목을 찾을 수 

있습니다. 퍼포먼스를 검색하려면 Performance 화면이 열린 상태에서 [CATEGORY] 버튼을 눌러 Performance Category Search 

화면을 엽니다.

Category Search 화면이 표시된 상태에서도 상단 패널에 있는 버튼을 사용하여 파트를 변경하거나 음소거할 수 있습니다.

주
Home 화면의 퍼포먼스 이름에 커서를 놓은 후 데이터 다이얼, [INC/YES] 버튼 및 [DEC/NO] 버튼을 사용해도 퍼포먼스를 선택할 수 있습니다.

화면 설명

(1) (2) (3) (4) (6)(5) (7)

(1)	Filter

필터를 사용하여 퍼포먼스 목록을 쭉 검색할 수 있습니다.

•	 Category

Main과 Sub에서 1개씩 선택할 수 있습니다.

•	 Attribute

1개의 속성이나 조합된 속성을 선택합니다. 필터는 조합에 따라 달라집니다.

필터:

완전 일치 AWM2, FM-X, AN-X

AND 조건 MC, SSS, Smart Morph

OR 조건 Single, Multi
MOTIF XF, MONTAGE, MODX M OS Vx.x(x.x: OS 버전 번호)

주
“MONTAGE”는 MODX 및 MODX+를 포함합니다.

(2)	뱅크

(3)	카워드로 검색

(4)	Job
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(5)	퍼포먼스 목록

선택한 카테고리 및 속성에 해당하는 퍼포먼스가 표시됩니다.

텍스트 색상 설명

흰색 현재 선택된 퍼포먼스

녹색 단일 파트 퍼포먼스

파란색 다중 파트 퍼포먼스

(6)	분류 순서 변경

(7)	Audition

절차

1.	 [CATEGORY] 버튼을 누릅니다.

Performance Category Search 화면이 나타납니다.

퍼포먼스 이름의 컨텍스트 메뉴에서 Category Search를 선택하여 이 화면을 여는 것도 가능합니다.

2.	 필요에 따라 필터를 사용합니다.

필터, 뱅크 및 분류를 사용하여 퍼포먼스를 검색합니다.

3.	 목록에서 선택합니다.

화면 우측에 표시된 퍼포먼스 목록에서 선택합니다.

데이터 다이얼, [INC/YES] 버튼, [DEC/NO] 버튼 또는 위/아래 버튼을 사용하여 원하는 항목을 선택합니다.

디스플레이 노브를 사용하여 현재 선택한 퍼포먼스를 변경하지 않고 화면을 스크롤 하는 것도 가능합니다.

4.	 화면을 닫습니다.

상단 패널의 [ENTER] 버튼, [EXIT] 버튼 또는 [PERFORMANCE (HOME)] 버튼을 누르거나 화면의 [ ] (HOME) 아이콘 

또는 [ ] (EXIT) 아이콘을 탭합니다.

주
다중 파트 퍼포먼스(파트가 1개 이상인 퍼포먼스)의 파트 중 하나를 변경하려는 경우, Part Category Search 기능을 사용하면 됩니다. 변경하려는 

파트를 선택한 후 [SHIFT] 버튼을 누른 상태에서 [CATEGORY] 버튼을 눌러 Part Category Search 화면을 표시하십시오.
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초기화된 퍼포먼스 또는 단일 파트 퍼포먼스 선택

초기화된 퍼포먼스
Bank/Favorite을 All 또는 Preset으로 설정합니다.

필터를 Category로 설정한 후 Init를 선택합니다.

단일 파트 퍼포먼스
필터를 Attribute로 설정한 후 Single을 선택합니다.
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오디션 프레이즈 재생

오디션 프레이즈 재생을 통해 퍼포먼스를 확인할 수 있습니다. 재생 중에는 컨트롤러 조작을 통해 퍼포먼스의 음향이 어떻게 변하는지 

듣는 것도 가능합니다.

1.	 상단 패널의 [AUDITION] 버튼을 누르거나  Category Search 화면의 Audition을 탭합니다.

현재 퍼포먼스의 오디션 프레이즈가 재생됩니다.

재생 중 퍼포먼스를 변경할 경우, 새로운 퍼포먼스의 프레이즈가 재생됩니다.

주
[AUDITION] 버튼을 끄면 선택한 퍼포먼스에 오디션 기능을 이용할 수 없어 버튼을 눌러도 아무 반응이 없습니다.

2.	 오디션 프레이즈 재생을 멈추려면 상단 패널의 [AUDITION] 버튼을 한 번 더 누르거나  Category Search 화면의 

Audition 버튼을 탭합니다.
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전체 퍼포먼스의 전반적인 기능 사용

퍼포먼스의 파트 간 밸런스를 조정하거나 미리 버튼에 등록했던 다른 설정 그룹으로 신속하게 전환할 때 사용되는 다른 기능들이 

있습니다.

믹싱

믹싱 기능을 사용하면 파트 간 밸런스를 조정할 수 있습니다.

팬, 볼륨 및 EQ 등 각 파트의 설정을 확인하고 파라미터를 조정할 수 있습니다.

화면 설명

(1)(2)(3)

(4)(7) (5)(6)

(1)	각 파트에 대한 메인 카테고리

(2)	Solo, Mute의 보기 전환 및 Kbd Ctrl

(3)	3-band EQ와 2-band EQ의 전환

(4)	각 파트에 대한 EQ 설정

(5)	각 파트에 대한 파라미터

(6)	16파트 보기로 전환

(7)	오디오 파트 보기로 전환(파트 9~16 숨김)

오디오 파트에 대해 다음의 오디오 파라미터를 설정할 수 

있습니다.

•	AD 파트: A/D INPUT 잭의 오디오 입력

•	디지털 파트: USB [TO HOST] 단자의 오디오 입력

* 오디오 채널에서 디지털 L/R로 설정된 오디오를 참조하십시오.
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절차

1.	 [PERFORMANCE (HOME)] 버튼을 누르고 Mixing을 탭합니다.

Mixing 화면이 나타납니다.

2.	 파라미터를 선택합니다.

PART 버튼이나 커서 버튼을 사용하여 파라미터를 선택하거나 화면의 아이콘 및 버튼은 탭합니다.

3.	 데이터 다이얼이나 관련 화면 노브를 사용하여 값을 변경합니다.

주
값을 미세 조정해야 하는 경우, Mixing 화면이 표시된 상태에서 [EDIT/ ] 버튼을 눌러 편집 화면을 여십시오.
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Scene

Scene은 아르페지오 형식, 모션 시퀀스 형식 및 파트 파라미터와 같은 여러 설정의 “스냅샷”입니다. 8개의 SCENE 버튼마다 각 

Scene을 등록하면 SCENE 버튼을 사용하여 즉시 여러 다른 설정을 불러올 수 있습니다.

이는 퍼포먼스를 변경하지 않고 아르페지오 및 모션 시퀀스 형식만 변경하여 곡의 진행을 따라가거나 퍼포먼스의 다른 측면을 끌어내려고 

할 때 등의 경우에 편리합니다.

화면 설명

(1)

(2)

(3)

(1)	Scene 탭

(2)	저장 스위치

(3)	탭에 사용되는 설정

저장 스위치가 켜지면 해당 기능의 파라미터가 화면에 나타납니다.

절차

1.	 [PERFORMANCE (HOME)] 버튼을 누르고 Scene을 탭합니다.

Scene 화면이 나타납니다.

2.	 Scene 1–8을 설정합니다.

저장 스위치(Memory)가 켜짐으로 설정된 기능이 선택한 SCENE 버튼에 등록됩니다.

해당 SCENE 버튼을 누르면 새로 설정한 Scene이 활성화됩니다.

3.	 [STORE] 버튼을 눌러 퍼포먼스를 저장합니다.

주의사항

반드시 다른 퍼포먼스로 변경하거나 악기의 전원을 끄기 직전에 편집했던 Scene 설정을 저장하십시오. Store 작업을 실시하지 않으면 Scene 설정이 

사라집니다.

주
SCENE 버튼에 등록할 수 있는 파라미터가 이미 노브나 슬라이더에 지정된 경우, 해당 매체를 사용하십시오. 이후 [SHIFT] 버튼을 누른 상태로 SCENE 

버튼 중 하나를 누르면 해당 버튼에 설정을 저장할 수 있습니다.

그런 후에 [STORE] 버튼을 눌러 Scene 설정을 퍼포먼스에 저장하십시오.
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설정 편집

스플릿 및 레이어 사용

스플릿이란?
이 설정은 건반 전체를 여러 그룹으로 구분하고 각 그룹에 파트를 지정합니다. 본 악기의 경우, 분리점을 설정하고 각 그룹에 건반 범위를 

설정할 수 있습니다.

레이어란?
이 설정은 여러 파트를 서로 곂치게 합친 후 동시에 연주할 수 있는 기능입니다. 2개 이상의 파트를 같은 그룹에 지정하는 것으로 여러 톤의 

조합을 연주할 수 있습니다.

Split Job 화면

화면의 각 항목에 대한 설명은 Split Job을 참조하십시오.

스플릿 설정 절차

1.	 [SPLIT] 버튼을 누릅니다.

퍼포먼스에 대한 Split Job 화면이 나타납니다.

2.	 화면의 항목을 탭해 분리점의 수와 위치를 지정하면 각 그룹에 대한 건반 범위를 설정할 수 있습니다.

[SHIFT] 버튼을 누른 상태에서 Group 버튼을 탭해 단일 파트를 다수 그룹에 지정합니다.

3.	 설정을 확정하려면 [EXIT] 버튼을 누르거나 화면에서 Done을 탭합니다.

좌측 상단의 [×] (종료)를 탭하면 설정이 취소되고 화면이 닫힙니다.

음 범위 설정 절차

1.	 [SHIFT] 버튼을 누른 상태에서 [SPLIT] 버튼을 누릅니다.

Performance 화면에 Part - Note 보기가 표시됩니다.

2.	 건반 또는 데이터 다이얼을 사용하여 각 파트의 음 범위를 변경합니다.
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편집 절차

1.	 퍼포먼스를 선택합니다.

2.	 Performance 화면에서 커서를 편집하려는 퍼포먼스 이름 또는 부품으로 이동합니다.

3.	 [EDIT/ ] 버튼을 누르거나 콘텍스트 메뉴의 Edit을 탭합니다.

Common Edit 화면은 퍼포먼스 이름에 커서가 위치하면 나타납니다.

사운드 엔진의 Part Edit 화면은 파트에 커서가 위치하면 나타납니다.

주
Edit 화면에서 Common Edit 화면을 연 후 탐색 바에서 원하는 항목을 선택하여 파라미터를 변경할 수 있습니다.

4.	 첫 번째/두 번째 열의 탭을 선택하여 화면을 엽니다.

상단에서 하단으로 각 탭의 설정을 변경하는 것이 좋습니다.

예: 일반 파트(AWM2)

5.	 탭 우측에 표시된 파라미터를 변경하여 설정을 편집합니다.

6.	 필요한 경우 다른 탭의 파라미터를 계속 변경합니다.

편집 대상이 탐색 바에 표시됩니다.

전체 퍼포먼스 설정을 편집하려면 Common을 선택합니다.

전체 파트 설정을 편집하려면 Part Common을 선택합니다.

상세 설정을 하려면 Element 1–128, Operator 1–8, Oscillator 1–3, Noise 및 C0–C6 중 하나를 선택합니다.

7.	 편집을 완료하면 [STORE] 버튼을 눌러 퍼포먼스를 저장합니다.
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Navigation 화면 사용

1.	 [NAVIGATION] 버튼을 누릅니다.

NAVIGATION 화면이 나타납니다.

편집 중 [NAVIGATION] 버튼을 누르면 현재 위치 아이콘( )을 불러올 수 있습니다.

2.	 편집할 항목을 선택합니다.

전체 파트 설정을 편집하려면 Part Common을 선택합니다.

상세 설정을 하려면 Element 1–128, Operator 1–8, Oscillator 1–3, Noise 및 C0–C6 중 하나를 선택합니다.

3.	 변경하려는 파라미터의 아이콘을 선택합니다.

커서 버튼을 사용하여 커서를 옮긴 후 [ENTER] 버튼을 누릅니다. 또는 화면의 아이콘을 탭합니다.

4.	 변경하려는 설정의 아이콘을 선택합니다.

5.	 화면에 표시된 파라미터를 변경합니다.

6.	 파라미터를 저장합니다.
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톤 변화 생성

톤 변화 생성을 위해 오실레이터, 필터, EG(또는 엔벌로프 제너레이터), LFO(또는 저주파 오실레이터) 및 이펙트를 사용할 수 있습니다. 

이러한 파라미터를 변경하면 음향의 밝기, 공명 또는 다른 음색 품질을 변경할 수 있습니다.

상세 설정은 사운드 엔진에 따라 다르며, 공통 설정은 다음과 같습니다.

Oscillators (Osc) 파형을 생성합니다.

Pitch (Pitch) 피치를 제어합니다.

Filters (Filter) 차단 주파수를 제어합니다.

EG 시간 경과에 따라 음향이 변하는 방식을 

결정합니다.

LFO 음향의 주기적인 변화를 결정합니다.

Motion Sequencer 시간 경과에 따라 음향에 복잡한 변화를 

생성합니다.

Effects (Effects) 음향을 처리합니다.

LFO

EG
Motion Sequencer
Envelope Follower

Osc
(Oscillator)

Filter Amp Effects Output

이펙트 구성

시스템 이펙트
이 이펙트는 퍼포먼스의 모든 파트에 적용됩니다.

시스템 이펙트는 변주와 리버브의 2가지 형식을 포함합니다. 변주의 출력 음향에 리버브를 추가할 수 있습니다(Variation to Reverb).

인서트 이펙트
이 이펙트는 각 파트에 적용됩니다.

마스터 이펙트
이 이펙트는 오디오 출력의 최종 단계에서 전체 음향에 적용됩니다.

파트 EQ
각 파트에 적용되는 3대역 및 2대역 이퀄라이저입니다.

파트 EQ는 삽입 이펙트 전후에 적용할 수 있습니다.

마스터 EQ
출력의 최종 단계에서 전체 음향에 적용되는 5대역 이퀄라이저입니다.
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이펙트 연결 및 설정

아래 그림과 같이 연결한 후 (1)~(4)에 따라 설정합니다.

Part
Insertion A
Insertion B

Part EQ
3-Band EQ

Part EQ
2-Band EQ

Performance

(1)

(2)

(3)

(4)

System Effect

Master Effect

Master EQ

Reverb

Variation

Variation to Reverb

Send Level

Return Level

(1)	파트 EQ 및 인서트 이펙트 설정

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Effect → Routing

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Effect → Ins A

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Effect → Ins B

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Effect → 3-band EQ

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Effect → 2-band EQ

(2)	변주 및 리버브 설정

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Effect → Routing

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Effect → Variation

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Effect → Reverb

(3)	마스터 이펙트 설정

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Effect → Master FX

(4)	마스터 EQ 설정

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Effect → Master EQ

주
A/D INPUT 잭을 통해 오디오 신호 입력에 적용되는 이펙트는 [PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Audio In에서 

설정하십시오.

이펙트 카테고리 및 이펙트 형식에 관한 내용은 이펙트 형식을 참조하십시오. 이펙트 파라미터에 관한 내용은 이펙트 파라미터를 

참조하십시오.

각 이펙트 형식의 내장 프로그램에 관한 내용은 Data List를 참조하십시오.
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이펙트 설정 변경

[SHIFT] 버튼을 누른 상태에서 [NAVIGATION] 버튼을 누르면 FX Overview 화면이 나타나 이펙트 설정의 개요를 확인할 수 

있습니다. Ins A 및 Var과 같은 이펙트 이름의 버튼을 탭해 편집 화면을 엽니다.
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아르페지오 사용

아르페지오는 건반을 누르는 것만으로 자동으로 리듬 패턴과 코드 백킹을 연주하는 기능입니다.

이 기능을 통해 라이브 퍼포먼스에 영감을 불어넣고 완전한 리듬 악구를 제공할 뿐만 아니라 다양한 음악 장르의 악기 반주 파트도 

완전하게 구성할 수 있어 곡을 간편하게 제작할 수 있습니다.

본 악기에 내장된 아르페지오 기능의 특징
본 악기에서는 각 파트에 최대 8개의 아르페지오를 설정할 수 있고, 8개 파트의 아르페지오를 동시에 재생할 수 있습니다.

또한 아르페지오 재생에 사용되는 건반의 범위를 설정(Note Limit)하고 건반을 누르는 강도의 상한 및 하한을 설정(Velocity 

Limit)하는 것도 가능합니다.

아르페지오 기능을 통해 강세 프레이즈(지정값보다 강한 세기로 건반을 연주할 때에만 재생되는 시퀀스 프레이즈) 또는 랜덤 SFX 기능을 

사용한 이펙트 음향(예: 기타 프렛 노이즈)을 연주할 수 있습니다.

Arp Category Search 화면에서 이러한 음향이 포함된 내장 아르페지오를 검색할 수 있습니다. Attribute에 Accent(강세 프레이즈) 

또는 Random SFX를 지정하면 일치하는 아르페지오의 범위를 좁힐 수 있습니다.

아르페지오 켜기 및 끄기

아르페지오 기능을 켜거나 끄려면 상단 패널의 [ARP] 버튼을 누릅니다.

노브를 사용하여 아르페지오 변경

[QUICK EDIT] 버튼을 사용하여 ARP/MSEQ를 선택한 후 노브 1 및 2를 사용하여 아르페지오 음향을 변경합니다.

노브를 돌리고 아르페지오 재생을 들어보면서 음향을 변경합니다.

노브 1 및 2의 이펙트에 관한 자세한 내용은 Common Edit 화면의 Arp/MS → Arp Common을 참조하십시오.

아르페지오 재생 켜짐/꺼짐 방식 변경

건반을 누르고 있는 동안에만 재생하거나 건반에서 손을 떼도 재생이 계속되도록 아르페지오 재생 방법을 자유롭게 변경할 수 있으며, 

변경 방법은 다음과 같습니다.

Hold
[EDIT/ ] 버튼 → Part 선택 → Common → Arpeggio → Common

Trigger Mode
[EDIT/ ] 버튼 → Part 선택 → Common → Arpeggio → Advanced

설정 Hold Trigger Mode

건반을 누를 때에만 재생됩니다. Off Gate

건반에서 손가락을 뗀 후에도 계속 재생됩니다. On Gate

건반을 누를 때마다 재생이 켜지거나 꺼집니다. On/Off 설정과 무관 Toggle

주
Arp Master 및 Arp Part가 켜진 상태에서 상단 패널의 [KEYBOARD HOLD] 버튼을 켜면 Hold가 On인 상태와 동일한 이펙트를 실현할 수 있습니다.
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모션 컨트롤 사용

모션 컨트롤 기능을 사용하면 모션(리듬감 있고 역동적인 음향 변화)을 실시간으로 창출할 수 있어 완전히 새로운 표현 방식을 찾을 수 

있습니다.

이 기능을 통해 미리 설정을 실시할 수 있으므로 페달이나 휠을 실제로 조작하지 않아도 파라미터를 변경할 수 있습니다.

그러므로 음악 박자를 따르는 역동적이고 강력한 표현력 넘치는 변화를 창출할 수 있습니다.

(1) Continuous control of Motion changes
(2) Switch between Motions
(3) Trigger

Motion SequencerEnvelope Follower Super Knob

Beat Audio Beat Sync
External MIDI
Internal Tempo

Audio Part 1-16
A/D Input Part
Master

Tone Generator Effect Arpeggio Motion Sequencer

(5) Rhythmic change

(4) Control the Motion Sequencer in real time

(6) Automation

(7) Multi-dimensional sonic change(7) Multi-dimensional sonic change

(1)	지속적인 모션 변화 제어

(2)	모션 간 전환

(3)	트리거

(4)	실시간 모션 시퀀서 제어

(5)	리듬 변화

(6)	자동화

(7)	다차원적인 음향 변화
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모션 컨트롤 설정

컨트롤러에 Source를 설정하고 Control Assign 화면에서 Destination 및 Parameter를 설정하면 모션 컨트롤을 설정할 수 있습니다. 

Control Assign 화면 여는 방법
[PERFORMANCE (HOME)] → Common 탭 → [EDIT/ ] → Control → Control Assign

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Mod/Control → Control Assign

수퍼 노브로 설정
Display Filter를 SuperKnob로 설정하고 Source(AsgnKnob 1–8), Destination 등을 선택합니다.

모션 시퀀스로 설정
모션 시퀀스의 경우, 모션 시퀀스 레인 1~4에 Source를 설정합니다.

엔벌로프 팔로워로 설정
Source를 EnvFollow로 설정합니다.

수퍼 노브 설정 사용자 지정

수퍼 노브를 사용하면 모든 파트에 공통적인 노브 1~8에 지정된 Assign 1–8 값을 동시에 제어할 수 있습니다.

수퍼 노브와 모션 시퀀서를 조합하면 더욱 복잡한 음향 변화를 실현할 수 있습니다.

페달을 통해 수퍼 노브 제어
본 악기에 연결된 별매품인 풋 컨트롤러(FC7)를 통해 수퍼 노브를 제어할 수 있습니다.

1.	 풋 컨트롤러(FC7)를 FOOT CONTROLLER 잭([1] 또는 [2])에 연결합니다.

2.	 [PERFORMANCE  (HOME)] → [EDIT/ ] → Control → Control Number에서 화면을 엽니다.

3.	 풋 컨트롤러(FC7)가 연결된 잭에 따라 Foot Ctrl1 또는 Foot Ctrl2에 대한 SuperKnob를 선택합니다.

4.	 화면을 닫아 설정을 완료합니다.
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수퍼 노브 설정 예시

수퍼 노브 설정은 사용자 지정이 가능합니다.

음향 모핑에 수퍼 노브를 사용할 수 있도록  2개 또는 3개의 고정값을 설정할 수 있습니다. 3개의 고정값이 있으면 중간값을 설정할 수 

있습니다.

3개의 고정값을 사용한 모핑 예시
여기에서는 3개의 내장 퍼포먼스(어쿠스틱 피아노, 패드 음향 및 일렉트릭 피아노)에 사용하여 생성된 레이어 사운드에 모핑 이펙트를 

추가하는 방법을 설명합니다. 이에 더해 본래 설정을 유지하면서 모핑 이펙트를 추가하는 방법도 설명합니다.

MID

LEFT RIGHT

Acoustic Piano
(CFX PopStudioGrand)

Electric Piano
(TV Show FM EP)

Pad sound
(AN-X Sine Pad PAT)

1.	 파트 1~3의 음향을 선택합니다.

1-1.	 [CATEGORY] 버튼을 누르고 CFX PopStudioGrand를 선택합니다.

1-2.	 Home 화면에서 파트 2의 [+] 아이콘을 탭해 Part Category Search 화면을 열고 AN-X Sine Pad PAT를 선택합니다.

1-3.	 Home 화면에서 파트 3의 [+] 아이콘을 탭해 Part Category Search 화면을 열고 TV Show FM EP를 선택합니다.

2.	 파트 1에 대해 파라미터를 설정합니다.

2-1.	 파트 1을 선택합니다.

2-2.	 [SHIFT] 버튼을 누른 상태에서 [CONTROL ASSIGN] 버튼을 눌러 Control View 화면을 엽니다.

2-3.	 수퍼 노브를 돌려 Control Assign 화면을 엽니다.

2-4.	 Page 2로 이동한 후 [+] 아이콘을 탭해 Destination 10을 추가합니다.
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2-5.	 Destination 10 탭을 탭하고 Part Param에서 Volume을 선택합니다.

2-6.	 Polarity (Curve Polarity)를 Bi로 설정하고 Ratio (Curve Ratio)를 +127로 설정합니다.

3.	 파트 2에 대해 파라미터를 설정합니다.

3-1.	 파트 2를 선택합니다.

3-2.	 [SHIFT] 버튼을 누른 상태에서 [CONTROL ASSIGN] 버튼을 누른 후 수퍼 노브를 돌립니다. 파트 2의 Control Assign 화면이 

열립니다.

3-3.	 [+] 아이콘을 탭해 Destination 8을 추가합니다.

3-4.	 Destination 8 탭을 탭하고 Part Param에서 Volume을 선택합니다.

3-5.	 Polarity (Curve Polarity)를 Bi로 설정하고 Ratio (Curve Ratio)를 +127로 설정합니다.

4.	 파트 3에 대해 파라미터를 설정합니다.

4-1.	 파트 3을 선택합니다.

4-2.	 [SHIFT] 버튼을 누른 상태에서 [CONTROL ASSIGN] 버튼을 누른 후 수퍼 노브를 돌립니다. 파트 3의 Control Assign 화면이 

열립니다.

4-3.	 [+] 아이콘을 탭해 Destination 8을 추가합니다.

4-4.	 Destination 8 탭을 탭하고 Part Param에서 Volume을 선택합니다.

4-5.	 Polarity (Curve Polarity)를 Bi로 설정하고 Ratio (Curve Ratio)를 +127로 설정합니다.
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5.	 파트 1~3의 파라미터가 Common Assignable Knob로 설정되었는지 확인합니다.

5-1.	 [COMMON] 버튼을 누릅니다.

5-2.	 [SHIFT] 버튼을 누른 상태에서 [CONTROL ASSIGN] 버튼을 누른 후 수퍼 노브를 돌립니다. Common Control Assign 화면이 

열립니다.

5-3.	 Destination 6~8 탭을 각각 탭해 Source가 각각 AsgnKnob 6~8로 설정되었는지 확인하고, Destination Parameter가 Part 

1~3 Volume으로 설정되었는지 확인합니다.

6.	 수퍼 노브의 LEFT 위치를 설정합니다.

이에 따라 왼쪽 끝까지 돌리면 수퍼 노브가 설정됩니다.

6-1.	 KNOB POSITION [LEFT] 버튼을 누릅니다.

6-2.	 파트 선택에 대해 COMMON이 선택되었는지 확인한 후 [ASSIGN] 버튼을 누릅니다. 노브가 5~8로 설정되었는지 확인합니다.

6-3.	 파트 1의 CFX PopStudioGrand만 설정하려면 노브 6(Assign6)을 오른쪽 끝(최대값)까지 돌리고 노브 7(Assign7) 및 노브 

8(Assign8)을 왼쪽 끝(최소값)까지 돌립니다.

6-4.	 [SHIFT] 버튼을 누른 상태에서 동시에 KNOB POSITION [LEFT] 버튼을 눌러 설정을 저장합니다.

7.	 수퍼 노브의 RIGHT 위치를 설정합니다.

이에 따라 오른쪽 끝까지 돌리면 수퍼 노브가 설정됩니다.

7-1.	 KNOB POSITION [RIGHT] 버튼을 누릅니다.

7-2.	 파트 3의 TV Show FM EP만 설정하려면 노브 8(Assign8)을 오른쪽 끝(최대값)까지 돌리고 노브 6(Assign6) 및 노브 

7(Assign7)을 왼쪽 끝(최소값)까지 돌립니다.

7-3.	 [SHIFT] 버튼을 누른 상태에서 동시에 KNOB POSITION [RIGHT] 버튼을 눌러 설정을 저장합니다.
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8.	 수퍼 노브의 MID 위치를 설정합니다.

MID 위치를 활성화한 후 수퍼 노브를 돌려 중앙 위치에 대한 값을 설정합니다.

8-1.	 NAVIGATION 화면에서 [NAVIGATION] 버튼을 누릅니다.

8-2.	 Super Knob를 탭해 수퍼 노브 설정 화면을 엽니다.

8-3.	 Mid Position에 값 512를 설정합니다.

8-4.	 KNOB POSITION [MID] 버튼을 누릅니다.

8-5.	 파트 2의 Sine Pad PAT만 설정하려면 노브 7(Assign7)을 오른쪽 끝(최대값)까지 돌리고 노브 6(Assign6) 및 노브 

8(Assign8)을 왼쪽 끝(최소값)까지 돌립니다.

8-6.	 [SHIFT] 버튼을 누른 상태에서 동시에 KNOB POSITION [MID] 버튼을 눌러 설정을 저장합니다.

이제 메인 설정이 완료되었습니다.

9.	 미세 조정을 수행합니다.

각 파트의 Curve Type, Ratio 및 Param을 조정하고, 원할 경우 KNOB POSITION에 대한 LEFT, RIGHT 및 MID를 조정합니다.
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모션 시퀀서 사용

모션 시퀀서 기능을 사용하면 미리 생성한 시퀀스에 따라 파라미터 시간을 제어하여 음향 변화를 창출할 수 있습니다. 이 기능을 통해 

퍼포먼스 템포, 아르페지오 또는 연결 장치의 리듬 입력에 동기화되는 리듬 변화를 설정하고 곡의 진행에 따라 쌍방향 및 실시간으로 

이러한 리듬 변화를 제어할 수 있습니다.

한 파트에 최대 4개의 레인을 사용하거나 전체 퍼포먼스에 최대 8개의 레인을 사용할 수 있습니다. 레인당 최대 8개의 시퀀스 패턴을 

설정할 수 있습니다. 아르페지오와 마찬가지로, 시퀀스 재생에 대한 Velocity Limit 및 시퀀스 재생 방식, 단계 수 등을 설정할 수 

있습니다.

각 레인의 파라미터 설정 방법:

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Motion Seq → Lane

모션 시퀀서 켜기/끄기

모션 시퀀서 기능을 켜거나 끄려면 상단 패널의 [MSEQ] 버튼을 누릅니다.

노브를 사용하여 모션 시퀀서 변경

[QUICK EDIT] 버튼을 사용하여 ARP/MSEQ를 선택한 후 노브 3 및 4를 사용하여 모션 시퀀서를 변경합니다

노브를 돌리고 모션 시퀀서 재생을 들어보면서 모션 시퀀서를 변경합니다.

노브 3 및 4의 이펙트에 관한 자세한 내용은 Common Edit 화면의 Arp/MS → MS Common을 참조하십시오.

모션 시퀀스 트리거 방식 변경

모션 시퀀서 트리거 방식은 LaneSw 및 Trigger 파라미터를 통해 설정할 수 있습니다.

LaneSw, Trigger
[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Motion Seq → Lane 

설정 Lane Sw Trigger Sync

건반을 누를 때 모션 시퀀서 재생 On Off -

[MSEQ TRIGGER] 버튼을 누를 때 모션 시퀀서 재생 On On Other than 
Arp

모션 시퀀서 편집

모션 시퀀스는 최대 16단계로 이루어져 있습니다.

Edit Sequence를 탭해 Motion Sequence 설정 화면을 열고 각 단계를 편집합니다.
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엔벌로프 팔로워 사용

엔벌로프 팔로워는 오디오 입력에서 파형 엔벌로프를 추출하는 기능으로, 음향 변화 생성용 컨트롤러로 사용되며 파트 출력은 물론 A/D 

INPUT 잭에 연결된 외부 장치의 출력도 허용합니다.

예를 들어, 리듬 패턴이 지정된 파트의 엔벌로프 팔로워를 다른 파트에 변화를 추가하는 소스로 사용할 수 있습니다. 엔벌로프 팔로워는 

일부 파트가 연주 중일 때 다른 파트의 음량을 낮추려고 하는 경우(즉, 더킹(ducking)) 등에 유용합니다.

엔벌로프 팔로워마다 입력 소스가 존재하는 데, 파트 1의 경우, EnvFollow 1, 파트 2의 경우 EnvFollow 2, 오디오 파트의 경우 

EnvFollow AD를 예로 들 수 있습니다. Control Assign 화면에서 다른 소스를 선택하면 각 엔벌로프 팔로워의 출력을 변경할 수 

있습니다.

예를 들어, 파트 1의 엔벌로프 팔로워(EnvFollow 1)를 설정하여 파트 2의 변화를 생성할 수 있습니다. 각 엔벌로프팔로워의  

출력으로 인한 음향 변경 방식은 Control Assign 화면에서 설정할 수 있습니다.

Envelope Follower

Input Source

Env Follower
MST

Env Follower
AD

Part 1
Performance

(16 parts and Audio Part) A/D IN PartPart 2

Env Follower
2

EnvFollower
1

(1) Input signal to Envelope Follower (Fixed)

(2) Output signal from Envelope Follower
     (The Destination can be changed)

(1) 엔벌로프 팔로워로 입력되는 신호	 (2) 엔벌로프 팔로워에서 출력되는 신호

엔벌로프 팔로워 설정:

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Effect → Routing → Envelope Follower (EnvFollow MST)

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Audio In → Routing → Envelope Follower (EnvFollow AD)

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Effect → Routing → Envelope Follower (EnvFollow 1–16)
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Rhythm Pattern 화면에서 엔벌로프 팔로워 설정

Rhythm Pattern 화면에서 엔벌로프 팔로워를 설정할 수 있습니다. 이런 방법으로 리듬 패턴에 자주 사용되는 엔벌로프 팔로워 

파라미터로 신속하게 이동할 수 있습니다.

1.	 [SHIFT] 버튼을 누른 상태에서 [SONG/PATTERN] 버튼을 눌러 Rhythm Pattern 화면을 엽니다.

2.	 화면 우측에 표시된 목록에서 드럼 음향을 선택합니다.

3.	 Envelope Follower을 탭해 스위치를 켭니다.

건반을 연주하여 엔벌로프 팔로워 이펙트를 들어볼 수 있습니다.

4.	 설정을 조정합니다.

설정 예시

• Polarity (Curve Polarity): Bi

• Ratio (Curve Ratio): −63

• Gain (Envelop Follower Gain): −12.0 dB

5.	 미세 조정을 하려면 화면에서 Edit을 탭합니다.

Envelope Follower Edit 화면이 열립니다.

주
•	[SHIFT] 버튼을 누른 상태에서 동시에 [SONG/PATTERN] 버튼을 눌러 Rhythm Pattern 화면으로 돌아가면 리듬 패턴에 새 키트나 아르페지오 

형식을 선택할 수 있습니다.

•	엔벌로프 팔로워 설정은 리듬 패턴에 새 키트나 아르페지오를 선택한 후에도 그대로 유지됩니다.
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Smart Morph 사용

Smart Morph는 머신 러닝을 통해 FM-X 파트나 AN-X 파트를 모핑시키는 기능입니다. 이를 통해 다수의 FM-X 파트나 AN-X 파트에서 

새로운 파트 1 음향을 생성하여 건반을 연주할 수 있습니다.

Smart Morph 기능
Smart Morph 기능은 파트 9~16에 지정된 각 음향을 분석하고 파트당 1개의 점을 맵에 표시합니다. 맵의 각 점은 음향을 표시하며 점 

사이의 거리는 이러한 음향의 유사성을 보여줍니다.

새로운 파트 생성(Learn)
Learn 기능은 맵의 점 사이를 채우기 위한 음향을 자동으로 생성합니다. 맵의 점을 탭하면 해당 점의 음향이 파트 1에 선택됩니다. 

원하는 위치를 맵에서 찾아 설정을 저장하여 새로운 파트 생성에 사용할 수 있습니다.

건반을 연주하면서 맵의 점을 끌거나 미리 지정한 2~8개의 점을 옮기면서 수퍼 노브를 움직여도 완전히 새로운 음향을 창출할 수 

있습니다.
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편집된 설정 저장

편집 후, 생성한 퍼포먼스를 내장 메모리에 저장합니다. 내장 메모리에 설정을 저장하는 것은 “Store” 작업이라고 합니다.

주의사항

•	다른 퍼포먼스를 선택하거나 먼저 퍼포먼스를 저장하지 않고 악기의 전원을 끄면 편집 중인 설정이 사라집니다.

•	User Bank의 기존 퍼포먼스를 덮어쓰면 사라집니다. 편집한 퍼포먼스를 저장할 때 기존 퍼포먼스를 덮어쓰면 안 됩니다. 중요한 설정은 USB 플래시 

드라이브에 저장되어야 합니다(Save). 저장 작업은 “USB 플래시 드라이브에 백업 파일로 설정 저장(Save)”를 참조하십시오.

퍼포먼스 저장 방법

1.	 [STORE] 버튼을 누릅니다.

•	 새로운 퍼포먼스를 저장하는 경우, Store As New Performance가 표시됩니다.

•	 퍼포먼스를 이미 저장한 경우, Overwrite Current Perf. 및 Store As New Performance가 표시됩니다.

2.	 새 퍼포먼스를 저장하려면 Store As New Performance를 탭합니다.

이미 저장한 퍼포먼스를 덮어쓰려는 경우, Overwrite Current Perf.를 탭한 후 Store (YES)를 탭합니다.

3.	 Keyboard 화면에서 퍼포먼스 이름을 입력합니다.

메인 화면에 표시된 건반을 사용합니다. 최대 20자의 영숫자 문자를 사용할 수 있습니다.

4.	 이름 입력을 완료하면 Done을 탭합니다.

Store 작업이 완료되면 Performance 화면이 나타납니다.
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Live Set 생성

Live Set 기능은 예를 들어 설정 목록의 곡을 연주할 때 여러 퍼포먼스 사이에서 변경할 수 있는 편리한 방법입니다.

본 악기에서는 즐겨찾는 퍼포먼스를 각 슬롯에 등록하기만 하면 Live Set를 생성할 수 있습니다.

슬롯에 퍼포먼스 등록

아래 절차에 따라 Live Set에 퍼포먼스를 등록할 수 있습니다.

주의사항

•	Live Set에 퍼포먼스를 등록하기 직전에 편집했던 퍼포먼스를 저장하십시오. 그러나 Live Set에 등록한 후 Store As New Perf. and Register 또는 

Overwrite Current Perf. and Register를 선택할 때에는 미리 퍼포먼스를 저장할 필요가 없습니다.

•	다른 퍼포먼스를 선택하거나 먼저 퍼포먼스를 저장하지 않고 악기의 전원을 끄면 편집했던 설정이 사라집니다.

1.	 Performance 화면에서 퍼포먼스를 선택합니다.

[LIVE SET] 버튼이 켜져 있는지 확인합니다.

2.	 [SHIFT] 버튼을 누른 상태에서 동시에 [LIVE SET] 버튼을 누릅니다.

Live Set Register 화면이 나타납니다.

3.	 등록하려는 슬롯을 탭해 선택합니다.

4.	 이용 가능한 저장 작업 중 하나를 선택하고 [ENTER] 버튼을 누르거나 화면에서 선택한 항목을 탭하기만 하면 됩니다.

저장 방식 설명

Store As New Perf. and Register 새 퍼포먼스로 저장하고 등록합니다.

Overwrite Current Perf. and Register 현재 퍼포먼스를 덮어쓰기하고 등록합니다.

Register 등록합니다.

필요에 따라 퍼포먼스 이름을 변경합니다. 변경사항을 확정하여 슬롯에 퍼포먼스를 등록합니다.

주
퍼포먼스가 이미 등록된 슬롯에 새 퍼포먼스를 등록하려는 경우, 다음 절차를 수행하십시오.

1. [SHIFT] 버튼을 누른 상태에서 슬롯을 탭합니다. 슬롯 앞에 커서가 나타납니다.

2. [SHIFT] 버튼을 누른 상태에서 저장 방식을 선택한 후 [ENTER] 버튼을 누르거나 화면을 탭합니다.

이 때 퍼포먼스는 삭제될 Live Set 페이지의 마지막 슬롯(우측 하단)에 등록됩니다.
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슬롯에 등록된 퍼포먼스 교환

슬롯의 내용을 교환할 수 있습니다.

1.	 [LIVE SET](또는 Live Set 아이콘)  → User Bank 선택 → [EDIT/ ]에서 화면을 엽니다.

Live Set Edit 화면이 나타납니다.

내장 뱅크 또는 라이브러리 뱅크의 Live Set 페이지가 열린 경우, Live Set Edit 화면이 나타나지 않습니다.

2.	 화면의 Job을 탭합니다.

Job 화면이 화면 하단에 나타납니다.

3.	 이동하려는 퍼포먼스의 슬롯을 탭한 후 Exchange를 탭합니다.

Job 화면이 화면 하단에 나타납니다.

4.	 퍼포먼스를 이동하려는 슬롯을 탭합니다.

두 슬롯의 퍼포먼스가 교환됩니다.

5.	 교환이 완료되면 Done을 탭합니다.

주
전체 Bank 또는 전체 Page를 복사하거나 교환하려는 경우, Live Set 화면이 표시된 상태에서 [SHIFT] 버튼과 [EDIT/ ] 버튼을 동시에 누릅니다. 

그러면 대화 상자가 나타납니다.
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슬롯에 패턴, 곡 또는 오디오 파일 등록

Live Set 슬롯에 패턴, 곡 또는 오디오 파일도 추가할 수 있습니다. 이렇듯, 원하는 패턴, 곡 또는 오디오 파일 재생용 슬롯을 선택한 후 

이에 맞춰 건반으로 퍼포먼스를 연주할 수 있습니다. 

1.	 [LIVE SET](또는 Live Set 아이콘)  → User Bank 선택 → [EDIT/ ]에서 화면을 엽니다.

Live Set Edit 화면이 나타납니다.

내장 뱅크 또는 라이브러리 뱅크의 Live Set 페이지가 열린 경우, Live Set Edit 화면이 나타나지 않습니다.

2.	 슬롯을 선택하거나 화면에서 [+]를 탭합니다. 

3.	 Slot Type에서 등록하려는 슬롯을 선택합니다.

Slot Type 형식

Perform 퍼포먼스

Song 곡

Audio 오디오 파일

Pattern 패턴

4.	 Pattern Name, Audio Name 등을 탭해 Load 화면을 엽니다.

5.	 원하는 패턴이나 파일을 선택하여 슬롯에 등록합니다. 

6.	 설정이 완료되면 Done을 탭합니다. 

주
Pattern 화면 또는 Song 화면에서 [SHIFT] 및 [LIVE SET] 버튼을 눌러도 Live Set에 패턴 또는 곡을 등록할 수 있습니다.
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풋 스위치로 슬롯 교환

FC4A 또는 FC5와 같은 풋 스위치(별매품)를 사용하여 다른 Live Set 슬롯을 선택할 수 있습니다.

아래 절차를 준수하십시오.

1.	 풋 스위치(FC4A 또는 FC5)를 FOOT SWITCH [ASSIGNABLE] 잭에 연결합니다.

2.	 [UTILITY]  → Settings → MIDI I/O에서 화면을 엽니다.

MIDI I/O 화면이 나타납니다.

3.	 FS Assign을 Live Set+ 또는 Live Set−로 설정합니다.

Live Set+를 통해 순서상 다음 Live Set를 선택할 수 있습니다.

Live Set−를 통해 순서상 이전 Live Set를 선택할 수 있습니다.
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Live Set에서 퍼포먼스 선택

Live Set 화면의 세트 목록에서 퍼포먼스를 선택합니다.

1.	 [LIVE SET] 버튼을 눌러 화면을 엽니다.

Live Set 화면이 나타납니다.

2.	 필요에 따라 Bank와 Page를 전환합니다.

3.	 슬롯을 탭해 선택합니다.

세트 목록의 퍼포먼스가 선택됩니다.
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건반 연주

건반을 연주하기 전에 반드시 Live Set에서 퍼포먼스를 선택하십시오.

원할 경우 건반 연주에 맞춰 (Live Set 슬롯에 등록된) 특정 패턴, 곡 또는 오디오 파일도 재생할 수 있습니다.

Live Set 슬롯에 등록된 패턴, 곡 또는 오디오 파일 재생

슬롯에 등록된 패턴, 곡 또는 오디오 파일에 맞춰 건반을 연주할 수 있습니다.

주
곡 또는 패턴 재생 중에는 퍼포먼스를 변경하거나 다른 슬롯을 선택할 수 없습니다. 변경하려고 시도하면 오류 메시지가 나타납니다.

1.	 Live Set 화면에서 슬롯을 선택합니다.

2.	 [] (재생) 버튼을 누릅니다.

그러면 선택한 슬롯에 등록된 패턴, 곡 또는 오디오 파일이 재생됩니다.

주
패턴, 곡 또는 오디오 파일 재생 중[] (재생) 버튼을 누르면 패턴 화면, 곡 화면 또는 오디오 화면과 동일한 화면이 표시됩니다.

3.	 [] (정지) 버튼을 누르면 재생이 멈춥니다.
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3.	 녹음 및 재생

본 악기를 사용하여 패턴, 곡 및 오디오 파일을 녹음하고 재생할 수 있습니다.

패턴 및 곡은 악기의 저장 영역에 녹음되고 오디오 파일은 연결된 USB 플래시 드라이브에 녹음됩니다.

용어

패턴

패턴은 MIDI 이벤트로 녹음된 짧은 프레이즈가 포함된 MIDI 시퀀스 데이터로 구성되어 있으며, 순환 재생되거나 Scene 기능과 함께 

사용될 수 있습니다. 본 악기는 메모리 영역 안에 최대 128개의 패턴을 유지할 수 있습니다. 

곡

곡은 MIDI 이벤트로 녹음된 건반 및 기타 컨트롤러 작업 관련 정보가 포함된 MIDI 시퀀스 데이터로 구성되어 있습니다. 본 악기는 메모리 

영역 안에 최대 128개의 곡을 유지할 수 있습니다.

트랙

트랙은 건반 연주 녹음을 위한 별도의 저장 위치로, 한 파트에 관한 정보를 유지할 수 있습니다.

본 악기에는 최대 16개의 트랙이 있으므로 녹음 및 재생에 최대 16개의 파트를 사용할 수 있습니다.
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패턴 녹음 및 재생

트랙의 멜로디를 녹음합니다.

패턴 녹음

1.	 트랙 1에 녹음할 음향을 선택합니다.

2.	 [SONG/PATTERN] 버튼을 누르고 Pattern을 탭합니다.

Pattern 화면이 나타납니다.

주
[PERFORMANCE (HOME)] 버튼 → Play/Rec → Pattern으로도 같은 화면을 열 수 있습니다.

3.	 필요에 따라 Scene 길이(Length), 템포(Tempo) 및 기타 설정을 변경할 수 있습니다.

4.	 [SCENE] 버튼 중 하나를 눌러 녹음하려는 Scene을 선택합니다.

5.	 [] (녹음) 버튼을 누릅니다.

녹음이 대기 상태로 설정됩니다.

(1) (2)(3) (4)

(6)

(8) (9) (10) (11)

(5)

(7)

(1)	패턴 이름

(2)	현재 선택한 퍼포먼스의 이름

(3)	박자

(4)	재생 및 녹음 시작 위치

(5)	템포

(6)	퀀타이즈

(7)	녹음 유형 전환(새 패턴을 녹음할 때에는 표시되지 않음)

(8)	Scene

(9)	패턴 길이

(10) 건반을 누를 때 녹음 시작 기능 켜기/끄기

(11) 루프 설정 켜기/끄기
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6.	 [] (재생) 버튼을 눌러 녹음을 시작합니다.

7.	 건반을 연주합니다.

Loop가 켜져 있으면 녹음 중 프레이즈가 루프 재생되어 녹음을 계속 진행하면서 다른 트랙을 녹음할 수 있습니다.

주
녹음 중 [] (녹음) 버튼을 누르면 버튼이 깜박이고 리허설 모드가 활성화됩니다. 이 모드에서는 재생을 계속 진행하면서 일시적으로 트랙 녹음을 

비활성화할 수 있으므로, 이 기능은 특정 음향을 사용해보고 싶을 때 유용합니다.

리허설 모드에서 [] (녹음) 버튼을 다시 누르면 녹음 모드로 돌아갑니다.

8.	 트랙 2에 사용할 음향을 선택하고, 트랙 1에 녹음한 프레이즈를 따라 건반을 연주합니다.

9.	 필요에 따라 다른 트랙들도 녹음합니다.

곡 및 패턴은 녹음 시 자동으로 저장됩니다.

녹음 후 곡의 템포 또는 톤을 변경한 후 저장하려면 Store Pattern&Perf Settings(곡의 경우 Store Song&Perf Settings)를 

탭해 저장합니다.

주
퍼포먼스 파라미터를 편집한 경우 퍼포먼스도 저장해야 합니다.

마지막 녹음 작업 취소(Undo, Redo)

Undo는 마지막 녹음 작업을 취소하고 방금 실시한 녹음을 삭제합니다.

Redo는 Undo를 통해 취소된 녹음을 복원합니다.

Undo Media Record (녹음이 없을 때 나타나지 않음)

탭하면 마지막 녹음 작업을 취소하고 녹음을 본래 상태로 복원합니다.
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Redo Media Record (Undo를 실시할 때까지 나타나지 않음)

탭하면 녹음을 Undo 전 상태로 복원합니다.

패턴 재생

녹음한 패턴을 재생하려면 시퀀서 전송 버튼을 사용하십시오.

SCENE 버튼을 사용하여 재생에 사용할 Scene을 선택할 수 있습니다.
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곡 녹음 및 재생

곡 녹음

건반 연주뿐만 아니라 컨트롤러 및 노브 작업 또한 MIDI 데이터로 트랙에 녹음됩니다.

건반을 연주하거나 컨트롤러를 조작하면 Keyboard Control Switch가 켜짐 상태인 파트들이 녹음됩니다.

노브 작업의 경우, 컨트롤 변경 및 파라미터 변경 메시지도 녹음됩니다. 컨트롤 변경에 관한 자세한 내용은 Data List를 참조하십시오.

주
•	 Arp Rec가 켜짐 상태인 경우, 아르페지오 재생의 결과만 녹음됩니다.

•	 Arp Rec가 꺼짐 상태인 경우, 전체 건반 연주 데이터가 녹음되므로 나중에 아르페지오 패턴을 변경할 수 있습니다.

1.	 퍼포먼스를 선택합니다.

2.	 [SONG/PATTERN] 버튼을 눌러 Play/Rec 화면을 열고 Song 탭을 선택한 후 [] (녹음) 버튼을 누릅니다.

[] (녹음) 버튼이 깜박이고 녹음이 대기 상태로 설정됩니다.

주
[PERFORMANCE (HOME)]  → Play/Rec → Song에서 화면을 열고 [] (녹음) 버튼을 눌러도 녹음을 대기 상태로 설정할 수 있습니다.

3.	 필요에 따라 Time Signature 및 Rec Quantize를 변경합니다.

(1) (2)(3) (4)

(9)

(8)

(6)

(5)

(7)

(1)	곡 이름

(2)	현재 선택한 퍼포먼스의 이름

(3)	박자

(4)	재생 및 녹음 시작 위치

(5)	퀀타이즈

(6)	시퀀스 전체 길이 및 현재 재생 위치 표시

(7)	전체 시퀀스 시간

(8)	재생에 대한 트랙 켜기/끄기 설정

(9)	아르페지오 녹음 켜기/끄기 

(새로 녹음한 경우에만 해당)
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4.	 준비가 완료되면 [] (재생) 버튼을 눌러 녹음을 시작합니다.

Click Settings를 설정한 경우,  [] (재생) 버튼을 누르면 Precount가 시작됩니다.  프리카운트 후 건반 연주를 시작합니다.

5.	 건반 연주가 완료되면 [] (정지) 버튼을 눌러 녹음을 멈춥니다.

일부 파트 다시 녹음(펀치 인/펀치 아웃 녹음)

본 악기에서 제공되는 녹음 유형(Record Type)은 3가지(Replace, Overdub 및 Punch)입니다.

•	 Replace: 기존 데이터를 덮어씁니다.

•	 Overdub: 트랙의 기존 음향에 레이어를 추가합니다.

•	 Punch: 기존 데이터의 지정된 섹션을 덮어씁니다.

지정된 섹션을 다시 녹음하려는 경우 펀치 녹음에 펀치 인/펀치 아웃 파라미터를 설정할 수 있습니다.

펀치 녹음을 시작하면 녹음곡이 처음부터 재생됩니다. 펀치 인에 설정된 소절까지 재생되면 녹음이 자동으로 시작됩니다. 펀치 아웃에 

설정된 소절까지 재생되면 녹음이 자동으로 종료되며 녹음곡의 나머지 부분이 끝까지 재생됩니다. 예를 들어, 8소절곡의 3~5소절을 

다시 녹음하려는 경우 아래 표시된 지침을 준수하십시오.

1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8

Punch In Punch Out

펀치 인/펀치 아웃 녹음의 경우 Record Setup 화면에서 다음 파라미터를 설정합니다.

(1) (2) (3)

(1) 	Record Type = Punch

(2)	Punch In(재녹음을 시작할 소절 및 박자) = 003:01

여기에서 지정된 소절 및 박자부터 시작하면 해당 트랙의 음향이 꺼지고 건반 연주가 녹음됩니다.

(3)	Punch Out(재녹음을 종료할 소절 및 박자) = 006:01

여기에서 지정된 소절 및 박자부터 트랙이 재생됩니다.
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마지막 녹음 작업 취소(Undo, Redo)

Undo는 마지막 녹음 작업을 취소하고 방금 실시한 녹음을 삭제합니다.

Redo는 Undo를 통해 취소된 녹음을 복원합니다.

Undo Media Record (녹음이 없을 때 나타나지 않음)

탭해서 확인 화면을 살펴봅니다. Continue(YES)는 마지막 녹음 작업을 취소하고 녹음을 본래 상태로 복원합니다.

Redo Media Record (Undo를 실시할 때까지 나타나지 않음)

탭해서 확인 화면을 살펴봅니다. Continue(YES) 녹음을 Undo 전 상태로 복원합니다.

곡 재생

녹음곡을 확인하려면 시퀀서 전송 버튼을 사용하십시오.
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오디오 녹음 및 오디오 파일 재생

오디오 녹음

본 악기를 사용하여 스테레오로 오디오 파일을 녹음하고 재생할 수 있습니다(44.1kHz, 24비트 .wav). 녹음 레벨이 고정되면 최대 

74분까지 연속 녹음을 실시할 수 있습니다(USB 저장 장치에 이용 가능한 메모리가 충분한 경우).

1.	 본 악기의 USB [TO DEVICE] 단자에 USB 플래시 드라이브를 연결합니다.

2.	 [PERFORMANCE (HOME)]  → Play/Rec → Audio에서 화면을 엽니다.

오디오 녹음 화면이 나타납니다.

3.	 [] (녹음) 버튼을 누릅니다.

[] (녹음) 버튼이 깜박이고 녹음이 대기 상태로 설정됩니다.

(1)

(5)

(2)

(4)

(3)

(1)	녹음 위치

(2)	오디오 파일 전체 길이 및 현재 녹음 위치

(3)	사용 가능한 녹음 시간

(4)	레벨 미터

(5)	Trigger Level

4.	 Trigger Level을 설정합니다.

Trigger Level을 manual로 설정하면 [] (재생) 버튼을 눌렀을 때 녹음이 시작합니다.

또는 Trigger Level을 1~127의 값으로 설정하면 [] (재생) 버튼을 누른 후 재생 음량이 해당 레벨을 초과할 때마다 녹음이 

자동으로 시작됩니다.

설정된 Trigger Level은 레벨 미터(4)에 파란색 선으로 표시됩니다. 최고의 결과를 얻으려면 이 파라미터를 가능한 한 낮게, 

그러나 원하지 않는 소음이 녹음될 정도로 낮지는 않게 설정하여 전체 신호를 포착해야 합니다.

5.	 [] (재생) 버튼을 누릅니다.

Trigger Level을 manual로 설정한 경우, [] (재생) 버튼을 누르면 바로 녹음이 시작됩니다. 녹음 중 [] (녹음) 버튼은 

빨간색으로, [] (재생) 버튼은 녹색으로 켜집니다.

1~127의 값으로 Trigger Level을 설정한 경우, 재생 음량이 해당 레벨을 초과할 때마다 녹음이 자동으로 시작됩니다.

6.	 건반을 연주합니다.



51MODX M 사용설명서

7.	 연주를 마치면 [] (정지) 버튼을 누릅니다.

녹음된 오디오 파일이 USB 플래시 드라이브에 저장됩니다.

오디오 파일 재생

아래에 설명된 대로 본 악기에서는 USB 플래시 드라이브에서 오디오 파일(44.1kHz, 24비트 또는 16비트 .wav, 스테레오)을 재생할 수 

있습니다.

오디오 파일 재생 중에도 건반으로 퍼포먼스를 연주할 수 있습니다.

1.	 본 악기의 USB [TO DEVICE] 단자에 USB 플래시 드라이브를 연결합니다.

2.	 [PERFORMANCE (HOME)]  → Play/Rec → Audio에서 화면을 엽니다.

3.	 Audio Name (1)을 탭한 후 컨텍스트 메뉴의 Load를 탭합니다.

4.	 원하는 소스 USB 플래시 드라이브 및 설정이 포함된 폴더를 선택합니다.

5.	 USB 플래시 드라이브에서 불러오려는 .wav 파일을 선택합니다.

(1)

(3)

(2)

(1)	오디오 이름

(2)	재생 음량

(3)	오디오 길이

6.	 [] (재생) 버튼을 누릅니다.

오디오 파일이 재생됩니다.

7.	 커서를 Audio Volume (2)로 옮긴 후 데이터 다이얼을 사용하여 재생 음량을 조정합니다.

8.	 [] (정지) 버튼을 눌러 재생을 멈춥니다.
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4.	 백업 관리

악기에서 생성하여 USB 플래시 드라이브에 저장한 퍼포먼스, Live Set 및 유틸리티 설정의 백업을 저장하고 USB 플래시 드라이브에서 

악기로 설정을 불러올 수 있습니다.

이 부분에서는 사용자 메모리의 모든 설정을 USB 플래시 드라이브에 저장하고 악기에 다시 설정을 불러오는 방법을 다룹니다.

장치에서 생성한 퍼포먼스 설정은 또한 Soundmondo(음향 관리 및 공유 장치)를 사용하여 백업할 수 있습니다.

Soundmondo: https://www.yamaha.com/2/soundmondo

이용 가능한 파일 형식

USB 플래시 드라이브에 저장

MONTAGE M과 MODX M의 공통 포맷 
•	 백업 파일(.Y2A)

사용자 메모리에 담긴 모든 부분(사용자 영역, 라이브러리 영역, 곡 및 패턴 포함)

•	 사용자 파일(.Y2U)

사용자 메모리의 사용자 영역에 담긴 모든 부분(유틸리티 설정 및 빠른 설정 포함)

•	 라이브러리 파일(.Y2L)

사용자 메모리의 사용자 영역(유틸리티 설정 및 빠른 설정 제외). Life Set는 하나의 뱅크만 사용 가능

파일 크기가 약 2GB보다 큰 경우 해당 파일은 2개로 분할됩니다. 분리 파일은 다른 파일 확장자를 가집니다.

•	 백업 파일(.Y2B)

•	 사용자 파일(.Y2W)

•	 라이브러리 파일(.Y2M)

일반 파일 형식
•	 패턴 및 곡(.MID)

사용자 메모리에 저장된 패턴 및 곡

https://www.yamaha.com/2/soundmondo
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USB 플래시 드라이브에서 불러오기

MONTAGE M 및 MODX M에 저장된 파일(.Y2A, .Y2U, .Y2L, .MID)

일반 파일 형식
•	 오디오 파일(.WAV 및 .AIF)

사용자 파형으로 사용되는 파일

•	 MIDI 파일(.MID)

패턴 및 곡으로 사용되는 파일

기존 모델에 사용되는 파일 형식
•	 MONTAGE(.X7A, .X7U, .X7L)

•	 MODX, MODX+(.X8A, .X8U, .X8L)

•	 MOTIF XF(.X3A, .X3V, .X3G, .X3W)

•	 MOTIF XS(.X0A, .X0V, .X0G, .X0W)

•	 MOXF(.X6A, .X6V, .X6G, .X6W)

주
MONTAGE M에 저장된 백업 파일이 MODX M 사용자 파형 메모리의 용량을 초과할 경우, 해당 파일을 불러올 수 없습니다.
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USB 플래시 드라이브 포맷

악기에서 USB 플래시 드라이브 포맷을 실행하는 것이 권장됩니다. 다른 장치에서 포맷한 USB 플래시 드라이브는 본 악기에서 올바르게 

작동하지 않을 수 있습니다.

주의사항
USB 플래시 드라이브을 포맷하면 저장된 파일이 모두 삭제됩니다. 포맷을 실행하기 전에 필수 데이터가 없는지 확인십시오.

포맷 절차

1.	 본 악기의 USB [TO DEVICE] 단자에 USB 플래시 드라이브를 연결합니다.

2.	 [UTILITY] → Contents → Load에서 화면을 엽니다.

[SHIFT] 버튼을 누른 상태에서 동시에 [STORE] 버튼을 누르면 동일한 화면을 열 수 있습니다.

3.	 화면 우측 상단의 Job을 탭한 후 USB 플래시 드라이브가 연결된 USB를 탭합니다.

4.	 컨텍스트 메뉴의 Format을 탭합니다.

5.	 Format(YES)를 탭합니다.

포맷이 완료되었습니다.
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USB 플래시 드라이브에 설정 저장

1.	 본 악기의 USB [TO DEVICE] 단자에 USB 플래시 드라이브를 연결합니다.

2.	 [UTILITY] → Contents → Save에서 화면을 엽니다.

[SHIFT] 버튼을 누른 상태에서 동시에 [STORE] 버튼을 누른 후 Save 탭을 선택하면 동일한 화면을 열 수 있습니다.

3.	 Content Type에서 Backup File을 선택합니다.

4.	 USB 플래시 드라이브 및 파일이 저장될 폴더를 선택합니다.

(1) (2)

(3)

(4)

(1)	상위 폴더 이름

(2)	USB 플래시 드라이브에서 현재 선택한 대상 폴더의 이름

(3)	저장 대상

(4)	폴더에 이미 저장된 파일의 목록
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5.	 Save As New File의 [+]를 탭합니다.

그러면 이름 입력 화면이 나타납니다.

주
기존 파일을 덮어쓰기하려면 화면의 파일 이름을 탭해 절차를 확인하십시오. Save(YES)를 탭해 파일을 저장하십시오.

6.	 사용하려는 파일 이름을 입력합니다.

파일 이름 입력 방법에 관한 구체적인 내용은 간편 사용설명서를 참조하십시오.

7.	 Done을 탭해 이름 입력을 완료합니다.

그러면 백업 파일이 USB 플래시 드라이브에 저장됩니다.
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USB 플래시 드라이브에서 설정 불러오기

주의사항

설정을 불러오면 악기의 기존 설정이 덮어쓰기되어 사라집니다. 유지하려는 중요한 설정은 설정을 불러오기 전에 USB 플래시 드라이브에 저장해야 

합니다(Save).

1.	 본 악기의 USB [TO DEVICE] 단자에 USB 플래시 드라이브를 연결합니다.

2.	 [UTILITY] → Contents → Load에서 화면을 엽니다.

[SHIFT] 버튼을 누른 상태에서 동시에 [STORE] 버튼을 누르면 동일한 화면을 열 수 있습니다.

3.	 Content Type에서 Backup File을 선택합니다.

4.	 원하는 소스 USB 플래시 드라이브 및 설정이 포함된 폴더를 선택합니다.

5.	 USB 플래시 드라이브에서 불러오려는 파일을 선택합니다.

(1) (2)

(3)

(1)	상위 폴더 이름

(2)	USB 플래시 드라이브에서 현재 선택한 원하는 폴더의 이름

(3)	폴더에 이미 저장된 파일의 목록
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5.	 외부 MIDI 장치 연결

마이크 또는 오디오 장치 연결

이 장치는 마이크와 CD 플레이어 및 신디사이저 등의 전자 기기를 A/D INPUT 단자에 연결하여 입력 오디오를 오디오 입력 파트(A/D 

INPUT 파트)로 재생할 수 있습니다.

기타 파트의 경우, 볼륨, 팬, 이펙트 등을 설정할 수 있습니다. 오디오 입력 파트는 다른 파트와 믹스되어 본 악기의 음향으로서 

출력됩니다.

마이크 및 오디오 장치 연결

1.	 악기의 전원을 끄고 A/D INPUT [GAIN] 노브를 최소값으로 설정합니다.

2.	 외부 장치를 후면 패널의 A/D INPUT 잭에 연결합니다.

 마이크를 연결하는 경우

A/D INPUT [L/MONO]

Mic.

주
반드시 다이나믹 마이크를 사용하십시오. 콘덴서 마이크는 사용할 수 없습니다.

 오디오 장치, 전자 기기 등을 연결하는 경우

A/D INPUT [R ]A/D INPUT [L /MONO]

L

R

(1) Stereo audio equipment 
     (CD player, etc.)

(1)	스테레오 오디오 장치(CD 플레이어 등)

3.	 연결 장치를 켠 후 본 악기를 켭니다.

4.	 [UTILITY] → Settings → Audio I/O에서 화면을 엽니다.
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5.	 A/D INPUT 잭에 연결된 장치의 경우 A/D 입력 설정을 선택합니다.

출력 레벨이 낮은 마이크 또는 장치를 연결한 경우 Mic로 설정하십시오. 입력 레벨이 높은 오디오 장치, 전자 기기를 연결한 경우 

Line으로 설정하십시오.

6.	 [A/D INPUT] 버튼을 누릅니다.

버튼이 켜지고 본 악기에 연결된 오디오 장치의 입력이 활성화됩니다.

7.	 MODX M에 연결된 외부 장치의 음향을 들고 A/D INPUT [GAIN] 노브를 돌려 게인을 조정합니다.

8.	 [PERFORMANCE (HOME)] 버튼을 누르고 MODX M에 연결된 외부 장치와 함께 사용하려는 퍼포먼스를 

선택합니다.

9.	 마이크에 대고 노래를 하거나 오디오 장치로 오디오를 재생하면서 건반을 연주합니다.

컨트롤 슬라이더의 A/D INPUT 음량을 조정합니다.
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보코더 사용

본 악기에는 보코더가 장착되어 있습니다. 보코더는 마이크에 입력된 음색 특성을 사용하여 장치의 내장 사운드 엔진의 음향을 처리하는 

이펙트입니다. 마이크에 말을 하며 건반을 연주할 경우, 악기의 음향이 로봇과 같은 음색으로 변합니다.

이 메커니즘은 인간이 소리를 내는 원리를 기반으로 합니다. 성대에서 생성된 음색이 입과 코를 통해 공명합니다. 입과 코는 특정 

주파수를 강화하는 필터와 같은 역할을 하여 음색 내 포먼트(특정 주파수의 피크)를 생성합니다.

보코더 이펙트는 마이크의 음색 입력의 필터 특성을 추출하여 여러 밴드 패스 필터로 포먼트를 재현하는 방식으로 이 원리를 재현합니다. 

악기의 음향을 통과시키는 것으로 로봇 음색 이펙트가 생성됩니다.

Vocoder

(3)

(5)

(1)
Mic Input

Part Output

(2)
Part Output

(Keyboard Performance)
(4)

(1)	마이크 입력 또는 파트 출력

(2)	파트 출력(악기 출력)

(3)	음색 특성 추출

(4)	필터로 포먼트 재현

(5)	로봇과 비슷한 음색

보코더를 사용하려면 마이크를 연결하고 Utility 화면에서 A/D 입력 설정을 설정한 후 게인을 조정합니다. 마지막으로 아래와 같이 

보코더 이펙트를 사용하는 퍼포먼스를 선택합니다.

1.	 Performance 화면에서 [CATEGORY] 버튼을 누릅니다.

2.	 화면의 버튼을 탭해 Pad/Choir 카테고리를 선택합니다.
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3.	 Category Search 화면의 검색 상자를 탭하고 "Vocoder"를 입력합니다.

4.	 Filter를 Attribute로 설정하고 Single을 선택합니다.

보코더 이펙트의 퍼포먼스 목록이 표시됩니다.

5.	 원하는 퍼포먼스를 선택하고 [ENTER] 버튼을 눌러 확인합니다.
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컴퓨터 또는 외부 MIDI 장치에 연결

후면 패널의 USB 및 MIDI 단자는 컴퓨터와 MIDI 장치에 연결할 때 사용됩니다. 퍼포먼스를 변경할 때 이러한 단자를 사용하여 외부 

MIDI 장치에 프로그램 변경 메시지를 전송할 수 있습니다.

영역 기능은 외부 MIDI 장치를 설정할 때 유용합니다.

영역 기능 설정

영역 기능을 사용하면 본 악기의 건반을 통해 다수의 외부 장치를 제어할 수 있습니다.

퍼포먼스별로 최대 8개 영역을 설정할 수 있습니다.

예를 들어, 이 기능을 사용하여 세기 또는 음 범위에 따라 내부 사운드 엔진과 연결된 외부 사운드 엔진을 서로 전환할 수 있습니다.

1.	 [PERFORMANCE (HOME)] 버튼을 눌러 Performance 화면을 엽니다.

2.	 파트를 선택한 후 [EDIT/ ] → General/Pitch → Zone Settings를 선택하여 화면을 엽니다.

3.	 Part Mode 설정을 확인합니다.

Internal을 선택하여 사운드 엔진에서 음향을 연주하고, External을 선택하여 외부 사운드 엔진에서 음향을 연주합니다.

주
[PART SELECT] 버튼이 켜진 상태에서 PART 버튼을 두 번 누르면 Part Mode Internal과 External 사이를 빠르게 전환할 수 있습니다.

4.	 필요한 경우 Tx/Rx Ch(Transmit-Receive Channel) 및 Note Limit에 대한 파라미터를 설정합니다.

5.	 [STORE] 버튼을 눌러 퍼포먼스를 저장합니다.
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컴퓨터 연결 및 설정

컴퓨터를 본 악기에 연결하면 DAW 또는 컴퓨터의 시퀀스 소프트웨어를 사용하여 자신만의 독창적인 곡을 만들 수 있습니다.

DAW(digital audio workstation)는 오디오 및 MIDI를 녹음, 편집 및 믹싱하기 위한 뮤직 소프트웨어를 지칭합니다. 일반적인 DAW 

소프트웨어는 Cubase, Logic, Pro Tools 및 Live를 포함합니다.

컴퓨터 연결 및 설정

컴퓨터를 USB [TO HOST] 단자에 연결하면 오디오 신호 및 MIDI 메시지를 송수신할 수 있습니다.

오디오 및 MIDI 송수신용 AB형 USB 케이블과 드라이버가 연결할 때 필요합니다.

Windows의 경우, Yamaha Steinberg USB Driver를 설치해야 합니다. Mac의 경우, OS에 포함된 일반 드라이버로만 작동하기 

때문에 드라이버를 설치할 필요가 없습니다.

Yamaha Steinberg USB Driver 설치 방법

1.	 아래 표시된 URL에서 최신 드라이버를 다운로드합니다.

https://download.yamaha.com/

주
•	 시스템 요구사항에 관한 정보도 위의 URL에서 이용할 수 있습니다.

•	 Yamaha Steinberg USB Driver는 사전 예고 없이 없데이트될 수 있습니다. 자세한 정보 및 최신 정보는 상기 URL을 참조하십시오.

2.	 다운로드한 파일을 압축 해제한 후 컴퓨터에 Yamaha Steinberg USB Driver를 설치합니다.

드라이버 설치 방법에 관한 내용은 다운로드한 파일에 포함된 설치 안내서를 참조하십시오.

본 악기를 컴퓨터에 연결할 때, 아래 그림과 같이 USB 케이블을 사용하여 USB [TO HOST] 단자를 컴퓨터의 USB 단자에 

연결합니다.

(1) USB terminal (3) USB [TO HOST] terminal

(2) USB cable

(4) MODX M
     (Rear panel)

(1)	USB 단자

(2)	USB 케이블

(3)	USB [TO HOST] 단자

(4)	본 악기의 후면 패널

https://download.yamaha.com/
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오디오 및 MIDI 전송/수신을 위한 설정
USB 케이블로 컴퓨터를 연결한 후 USB 연결을 통해 오디오 및 MIDI를 처리하기 위한 파라미터를 설정합니다.

•	 오디오

USB 케이블을 연결하는 것으로 사용할 수 있습니다. 필요한 경우 샘플링 주파수 및 게인과 같은 설정을 변경하십시오.

•  MIDI
케이블을 연결한 후 송수신을 위한 파라미터를 설정합니다. 아래 단계에 따라 설정하십시오.

[UTILITY] → Settings → MIDI I/O → MIDI IN/OUT에서 화면을 열고 USB를 선택합니다.

USB [TO HOST] 단자를 통해 MIDI를 송수신할 수 있도록 악기를 설정합니다.

오디오 채널
오디오 신호 출력의 경우 USB [TO HOST] 단자 및 OUTPUT 잭을 사용할 수 있습니다. USB [TO HOST] 단자로의 오디오 신호 출력은 

샘플링 주파수 44.1kHz에서 최대 10개 채널(스테레오 채널 5개)입니다.

특정 채널로 어떤 신호를 출력할지 결정하려면 [PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → General/Pitch → 
Part Settings에서 화면을 열고 해당 Part Output을 선택합니다.

오디오 신호 입력의 경우 [USB TO HOST] 단자 및 A/D INPUT 잭을 사용할 수 있습니다.

USB [TO HOST] 단자를 통해 전달되는 오디오 신호에는 최대 4개 채널(스테레오 채널 2개)이 있을 수 있으며, Digital In L/R 및 Main 

L/R의 출력 레벨은 Mixing 화면 또는 Performance Edit 화면에서 설정할 수 있고 OUTPUT 단자를 통해 출력됩니다.

이에 더해 A/D INPUT 단자를 통해 전달되는 오디오 신호는 최대 2개 채널(스테레오 채널 1개)을 통해 본 악기의 A/D 입력 섹션에 

전송됩니다.

MIDI 채널 및 MIDI 포트
MIDI에는 16개 채널이 있으나, 대용량 곡 데이터의 경우, 16개 채널이 부족할 수 있습니다.

이에 따라 16개 채널 이상의 데이터는 MIDI 포트 컨셉을 통해 처리됩니다. 각 MIDI 포트는 16개 채널을 처리할 수 있습니다.

•	 1개 MIDI 케이블은 한 번에 1개 포트(16개 채널)의 데이터를 전송할 수 있습니다.

•	 그러나 1개의 USB 케이블은 동시에 최대 8개 포트(16×8=128 채널)의 MIDI 데이터를 처리할 수 있습니다.

본 악기의 경우 아래와 같이 확정된 포트가 USB 단자에 제공됩니다.

포트 1: 본 악기의 사운드 엔진 섹션을 처리하는 포트

외부 MIDI 장치나 컴퓨터에서 사운드 엔진을 재생하려면 반드시 외부 MIDI 장치나 컴퓨터에서 포트 1로 설정하십시오.

포트 2: DAW 리모콘에만 사용됩니다.

포트 3: MIDI 장치에서 MIDI 메시지를 수신하거나 MIDI Thru를 위해 다른 MIDI 장치로 전송할 때에만 사용됩니다.

•	 USB [TO HOST] 단자를 통해 수신한 MIDI 포트 3 데이터는 MIDI [OUT] 단자를 통과합니다.

•	 MIDI [IN] 단자를 통해 수신한 MIDI 데이터는 MIDI 포트 3 데이터로서 USB [TO HOST] 단자를 통과합니다.

USB 케이블을 통해 악기와 컴퓨터 사이에서 MIDI 메세지를 전송하려면 해당 MIDI 포트와 MIDI 채널을 선택해야 합니다. 상황에 적합한 

외부 장치의 포트 설정을 실시하십시오.
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MIDI 2.0 기능 사용
본 악기는 MIDI 2.0 기능을 지원합니다. MIDI 2.0 작동 요건을 충족하는 컴퓨터에 본 악기를 연결하면 MIDI 1.0 악기보다 해상도가 

뛰어난 데이터를 사용할 수 있습니다.

MIDI 2.0에 관한 자세한 내용은 MIDI 2.0 웹사이트(https://www.yamaha.com/2/midi-2-0/)를 참조하십시오.

지원되는 MIDI 2.0 메시지에 관한 자세한 내용은 Data List를 참조하십시오. 

https://download.yamaha.com/

MIDI 2.0 기능을 사용하려면 먼저 [UTILITY] → Settings → Advance → USB Driver Mode에서 설정에 접근하고 Legacy 

Mode를 꺼짐으로 설정한 후 MIDI 2.0 작동 요건을 충족하는 컴퓨터를 연결합니다.

컴퓨터를 사용한 음악 제작

본 악기와 컴퓨터를 연결하면 아래 예시와 같이 DAW 소프트웨어를 사용할 수 있습니다.

•	 컴퓨터의 DAW 소프트웨어를 사용하여 MIDI 또는 오디오로 건반 연주 녹음

•	 톤 제너레이터 블록을 사용하여 DAW 소프트웨어에서 녹음한 곡 재생

이러한 지침은 악기 및 컴퓨터가 이미 연결된 것으로 가정합니다. DAW 소프트웨어 및 본 악기를 사용하는 일부 예시가 아래에 제시되어 

있습니다.

DAW에서 건반 연주 MIDI 녹음
다음에는 DAW에서 MIDI 데이터로 건반 연주를 녹음하는 방법이 제시되어 있습니다.

본 악기에서 설정

1.	 [UTILITY] → Settings → Quick Setup에서 화면을 엽니다.

2.	 MIDI Rec on DAW를 선택합니다.

3.	 [EXIT] 버튼을 눌러 Quick Setup 화면을 닫거나 [PERFORMANCE (HOME)] 버튼을 눌러 Performance 화면을 

연 후 녹음하려는 퍼포먼스를 선택합니다.

https://www.yamaha.com/2/midi-2-0/
https://download.yamaha.com/
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DAW 소프트웨어에서 설정

1.	 MIDI Thru를 활성화합니다.

MIDI Thru는 녹음 트랙의 설정에 따라 내장 건반에서 컴퓨터로 MIDI 메시지를 전송한 후 다시 본 악기의 톤 제너레이터 블록으로 

전송할 때 사용되는 설정입니다.

아래 그림의 예시와 같이 본 악기에서 입력한 MIDI 데이터는 채널 1로 전송됩니다. 컴퓨터에서 MIDI Thru가 켜짐으로 설정된 

경우, MIDI 데이터는 컴퓨터에서 채널 3으로 전송되어 채널 3의 사운드 엔진을 연주합니다. 이 설정을 사용하는 것으로 최종 

출력과 동일한 음향을 들으며 건반 연주를 녹음할 수 있습니다.

MODX M

USB [TO HOST] terminal

(1) Tone Generator 
(recognizing data 
over MIDI Channel 3)

(2) Keyboard 
(output via 
MIDI Channel 1)

MIDI Thru = on

IN
Ch1

OUT
Ch3

(3) Local Control = off

(4) Computer 
(DAW software such as Cubase)

(1)	톤 제너레이터 블록(MIDI 채널 3을 통한 데이터 인식)

(2)	건반(Ch1)

(3)	로컬 컨트롤 = 꺼짐

(4)	컴퓨터(Cubase와 같은 DAW 소프트웨어)

2.	 DAW에서 악기 연주를 녹음합니다.

DAW에서 사운드 엔진을 사용하여 곡 재생
다음에는 다중 음색 음향 제너레이터로 DAW 소프트웨어를 사용하는 방법이 제시되어 있습니다.

이를 통해 컴퓨터 CPU에 너무 많은 부하를 가하지 않고 고품질의 MIDI 사운드 제너레이터를 사용할 수 있습니다.

본 악기에서 설정

1.	 퍼포먼스를 선택합니다.

퍼포먼스를 선택한 후, [PERFORMANCE (HOME)] → Mixing에서 믹싱 화면을 사용하여 파트 1~16을 믹스하는 것이 유용할 

수 있습니다.

[UTILITY] → Effect Switch 화면에서 Kbd Ctrl Lock을 켜짐으로 설정하고, 각 파트의 Tx/Rx Ch.을 설정하여 메시지 수신을 

활성합니다.

DAW 소프트웨어에서 설정

1.	 사운드 엔진을 재생할 때 사용하려는 트랙의 경우 본 악기에서 MIDI 출력을 포트 1로 설정합니다.

2.	 각 트랙마다 MIDI 데이터를 입력합니다.

각 트랙의 MIDI 채널에 해당하는 사운드 엔진은 본 악기의 Mixing 화면에 설정됩니다.
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Expanded Softsynth Plugin for MONTAGE M/MODX M 사용
Expanded Softsynth Plugin for MONTAGE M/MODX M은 MONTAGE M 및 MODX M 등의 하드웨어와 동일한 사운드 엔진이 

있는 소프트웨어 신디사이저입니다.

본 소프트웨어는 MONTAGE M 또는 MODX M 하드웨어와 연동되어 작동하기 때문에 (소프트웨어 작업이 편리한 DAW) 음악 창작, 

또는 (실제 악기가 사용되는 무대 위의) 라이브 퍼포먼스에 모두 동일한 MONTAGE M 또는 MODX M 사운드가 자연스럽게 통합됩니다. 

따라서, 개인 선호도 또는 특정 애플리케이션에 따라 MONTAGE M이나 MODX M 버전 중 하나를 사용할 수 있습니다.

ESP 설치 및 활성화에 관한 자세한 내용은 악기와 함께 제공되는 Expanded Softsynth Plugin for MONTAGE M/MODX M 

Download Information 리플렛의 MODX M 소개 페이지를 참조하십시오.

ESP 설명서는 아래 웹사이트에서 다운로드할 수 있습니다.

https://download.yamaha.com/

DAW Remote 기능 사용
DAW Remote 기능을 사용하면 DAW 소프트웨어를 본 악기의 상단 패널에 있는 컨트롤러를 통해 제어할 수 있습니다.

이 기능은 악기가 USB 케이블로 컴퓨터에 연결된 경우에만 사용할 수 있습니다. MIDI 케이블로 연결된 경우에는 사용할 수 없습니다.

본 악기에서 설정

1.	 AB형 USB 케이블을 사용하여 컴퓨터를 본 악기의 USB [TO HOST] 단자에 연결합니다.

2.	 [DAW REMOTE]  → Settings → DAW에서 DAW 소프트웨어를 선택합니다.

DAW 소프트웨어에서 설정

이 부분에서는 DAW 소프트웨어 설정 방법을 설명합니다.

DAW 소프트웨어의 버전에 따라 설정 절차가 다를 수 있으며 설정 자체가 불가능할 수도 있습니다. 자세한 내용은 사용 중인 DAW 

소프트웨어의 관련 사용설명서를 참조하십시오.

주
컴퓨터와 본 악기 사이에 연결이 끊어지면 다시 연결해도 DAW 소프트웨어가 본 악기를 인식하지 못할 수 있습니다. 이 경우, 다시 연결한 후에 DAW를 

재시작하십시오.

•	 Cubase

1.	 Device/Studio → Device Settings.../Studio Setup... 에서 대화 상자를 엽니다.

2.	 MIDI → MIDI 포트 설정을 선택하고 MODX M-2 또는 MODX M의 Port 2에서 All MIDI Input을 해제합니다.

3.	 대화 상자 좌측 상단의 [+] 버튼을 누른 후 목록에서 Mackie Control을 선택합니다.

4.	 Remote Devices → Mackie Control을 선택합니다.

5.	 MIDI 입력 및 MIDI 출력을 MODX M-2 또는 MODX M Port2로 설정합니다.

6.	 (옵션) 원하는 기능을 User Commands의 F1~F8에 지정합니다.

•	 Logic Pro

1.	 Logic Pro X → Preferences → Advanced를 선택하고 [Advanced Tools] 보기를 선택합니다.

2.	 Logic Pro X → Control Surfaces → Setup... 에서 대화 상자를 엽니다.

3.	 New → Install...에서 Mackie Control의 Mackie Designs를 선택합니다.

4.	 Mackie Control의 출력 포트와 입력 포트를 MODX M Port2로 설정합니다.

5.	 (옵션) Logic Pro X → Control Surface → Controller Assignments... 에서 Zone을 Control Surface: Mackie Control로 

설정한 후 Control F1~F8에 기능을 지정합니다.

https://download.yamaha.com/
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•	 Pro Tools

1.	 Setup → Peripherals... 에서 대화 상자를 엽니다.

2.	 MIDI Controllers 탭을 선택합니다.

3.	 Type to HUI 및 Receive From and Send To를 사전 설정값(Predefined), MODX M-2 또는 MODX M, Port2로 설정합니다.

•	 Live

1.	 Live → Preferences... 에서 대화 상자를 엽니다.

2.	 Link/MIDI 탭을 선택합니다.

3.	 Control Surface에 대한 MackieControl을 선택합니다.

4.	 MIDI 입력 및 MIDI 출력을 MODX M-2 또는 MODX M Port2로 설정합니다.

5.	 (옵션) MIDI Map Assign Mode에서 MIDI Note F#2–C#3 작동을 설정하여 원하는 기능을 F1~F8에 지정합니다.
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스마트 기기 연결

스마트폰이나 태블릿 등의 스마트 기기를 본 악기에 연결합니다.

본 악기와 호환되는 스마트 기기 앱은 악기를 더 편하고 즐겁게 사용할 수 있는 여러 방법을 제공합니다.

앱 및 지원 장치에 관한 자세한 내용은 Yamaha 웹사이트를 참조하십시오.

자세한 연결 방법은 Yamaha 웹사이트에서 "스마트 기기 연결 설명서"를 검색하십시오.

iOS 장치와 오디오 통신을 사용하려면 커넥터/단자 형식에 따라 다음의 어댑터를 준비하십시오.

•	 Lighting 단자: Lightning-USB 3 카메라 어댑터

•	 USB C형 포트: USB-C 디지털 AV 멀티포트 어댑터

스마트 기기 연결 시, 악기에서 [UTILITY] → Settings → USB Driver Mode로 이동한 후 Generic으로 설정합니다.

외부 MIDI 장치 연결

(시중에서 일반적으로 구매 가능한) USB 케이블 및 표준 MIDI 케이블을 사용하면 외부 MIDI 기기를 본 악기에 연결할 수 있습니다.

내장 건반에서 외부 MIDI 장치를 연주하거나 외부 MIDI 건반 또는 시퀀서에서 톤 제너레이터 블록을 연주할 수 있습니다.

주
USB [TO DEVICE] 단자 또는 MIDI 단자를 사용하여 외부 MIDI 장치를 연결할 수 있습니다.

MIDI 단자에 외부 MIDI 장치 연결

MIDI 단자를 사용할 경우, MIDI 케이블을 사용하여 외부 MIDI 장치를 연결한 후 [UTILITY] → Settings → MIDI I/O에서 MIDI를 

선택합니다.

본 악기에서 외부 MIDI 사운드 엔진 제어

본 악기의 건반 또는 곡 재생을 사용하여 외부 MIDI 사운드 엔진의 음향을 재생할 수 있습니다.

내부 사운드 엔진과 외부 MIDI 사운드 엔진의 음향을 따로 재생하려면 영역 기능을 사용합니다. 외부 MIDI 장치의 MIDI 전송 채널과 

악기의 MIDI 수신 채널이 일치되었는지 확인합니다.

악기의 MIDI 수신 채널 설정
Part Mode가 External로 설정된 파트가 있는지 여부에 따라 본 악기의 MIDI 출력 채널을 다른 값으로 설정해야 합니다.

•	 Part Mode에 External 파트가 없는 경우
Common 또는 Keyboard Control Switch가 켜짐으로 설정된 파트: MIDI I/O Ch.

Keyboard Control Switch가 꺼짐으로 설정된 파트: Tx/Rx Ch.

•	 Part Mode에 External 파트가 있는 경우
Common 또는 Keyboard Control Switch가 켜짐으로 설정된 파트: Tx Ch. Part Mode가 External로 및 Keyboard Control 

Switch가 켜짐으로 설정된 경우

Keyboard Control Switch가 꺼짐으로 설정된 파트: Part Mode가 External로 및 기타 파트가 Tx Ch.로 설정된 경우

*Internal로 설정된 Part Mode 파트는 MIDI 메시지를 전송하지 않습니다.

외부 MIDI 사운드 엔진 수신 채널 설정
외부 MIDI 사운드 엔진의 사용 설명서를 참조하십시오.

외부 사운드 엔진에서만 음향을 연주하려는 경우, 본 악기의 음량을 낮추거나 [UTILITY] → Settings → MIDI I/O에서 Local 

Control을 꺼짐으로 설정합니다.
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외부 MIDI 건반으로 본 악기의 음향 재생

외부 MIDI 건반의 건반을 사용하여 본 악기의 퍼포먼스를 연주하거나 퍼포먼스를 변경할 수 있습니다.

외부 MIDI 장치의 MIDI 전송 채널과 MODX M의 MIDI 수신 채널이 일치되었는지 확인합니다.

악기의 MIDI 수신 채널 설정
Keyboard Control Switch가 켜짐으로 설정된 파트: MIDI I/O Ch.

Keyboard Control Switch가 꺼짐으로 설정된 파트: Tx/Rx Ch.

* Part Mode가 External로 설정된 경우, 해당 파트는 외부 장치로부터 MIDI 메시지를 수신하지 않습니다.

외부 MIDI 건반 수신 채널 설정
외부 MIDI 건반의 사용설명서를 참조하십시오.

USB [TO DEVICE] 단자에 USB MIDI 건반 연결

USB MIDI 건반을 USB [TO DEVICE] 단자에 연결하면 연결된 USB MIDI 건반의 기능에 따라 연결된 건반을 내장 건반처럼 사용할 수 

있습니다.

주의사항

•	 USB [TO DEVICE] 단자의 최대 정격은 5V/500mA입니다. 정격이 이 값을 초과하는 USB 장치는 연결하지 마십시오. 악기 자체가 손상될 수 

있습니다.

•	 3m 미만의 AB형 USB 케이블을 사용하십시오.

호환되는 MIDI 장치
•	 USB 클래스 호환 MIDI 장치

USB MIDI 건반 등

•	 호환 테스트를 완료한 Yamaha MIDI 장치

CP88, CP73, MODX, MODX+, MONTAGE, MOTIF XF, MOXF, MX, reface, YC, MONTAGE M, SEQTRAK

MIDI 통신에 관한 특별 주의사항
USB [TO DEVICE] 단자를 통해 연결된 장치와의 MIDI 통신은 장치가 내장 건반처럼 작동할 수 있도록 하는 특수 규칙을 따릅니다.

•	 MIDI 통신은 한 방향으로만 가능합니다(외부 MIDI 장치에서 전송되고 본 악기에서 수신됨).

•	 모든 MIDI 데이터는 MIDI IN/OUT 및 MIDI I/O Ch. 설정에 상관없이 수신됩니다.

•	 Keyboard Control Switch가 켜짐으로 설정된 파트는 공유된 모든 채널에서 데이터를 수신합니다.  

(예를 들어, 파트 1~3의 Keyboard Control Switch가 켜짐으로 설정된 경우, 채널 1~3에서 수신한 데이터는 파트 1~3 모두에 

전달됩니다.)

•	 Keyboard Control Switch가 꺼짐으로 설정된 파트는 파트에 해당하는 채널에서만 데이터를 수신합니다.
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6.	 화면 및 파라미터

탐색 바

이 장은 화면에 항상 표시되는 탐색 바를 소개합니다.

(3)(1) (2) (4) (5) (7) (8) (9)(6)

(1)	HOME 아이콘

상단 패널의 [PERFORMANCE (HOME)] 버튼과 동일하게 작동합니다. 탭하면 Performance 화면(홈)이 나타납니다.

(2)	EXIT 아이콘

상단 패널의 [EXIT] 버튼과 동일하게 작동합니다. 탭하면 한 레벨 상위 화면으로 돌아갑니다.

(3)	INFORMATION 영역

현재 선택된 화면 이름, 파트, 요소, 오퍼레이터, 오실레이터 및 드럼 키와 같은 정보를 표시합니다.

를 탭해 파트, 요소, 오퍼레이터, 오실레이터 및 드럼 키를 전환합니다.

•	 일반 파트

일반 파트를 선택하는 경우 요소, 오퍼레이터 및 오실레이터의 상태가 이 영역의 우측에 표시됩니다.

음소거된 경우 해당 번호 아래 M 아이콘이 표시됩니다.

1 2 3 4 5 6 7 8
M S

요소(AWM2)
요소가 들릴 경우 해당 번호 아래의 가 로 켜집니다. 세기에 따라 요소를 나누면 어느 요소가 연주 중인지 
확인할 수 있습니다.

Elements: 18 설정된 요소의 총 수
표시등은 연주 중인 요소의 음량을 표시합니다.

1 2 3 4 5 6 7 8
M S 오퍼레이터(FM-X)

1 2 3 N
M S 오실레이터(AN-X)

•	 드럼 파트

드럼 파트를 선택하는 경우 드럼 키의 상태가 이 영역의 우측에 표시됩니다.

Drum Keys: 73 설정된 드럼 키의 총 수
표시등은 연주 중인 드럼 파트의 음량을 표시합니다.
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(4)	VIEW 아이콘

이 기능을 사용하면 Performance 화면의 보기를 선택할 수 있습니다. 탭하면 Performance 화면의 보기 목록이 표시됩니다.

(5)	EFFECT 아이콘

탭하면 Effect Switch 화면이 나타납니다. 인서트 이펙트, 시스템 이펙트 또는 마스터 이펙트를 끄면 표시등이 꺼집니다.

(6)	QUICK SETUP 아이콘

탭하면 MIDI I/O 화면이 나타납니다.

로컬 컨트롤의 켜짐 또는 꺼짐을 표시합니다.
아이콘이 켜지면 켜지고, 아이콘이 꺼지면 꺼집니다.

MIDI IN/OUT을 MIDI로 설정한 경우 표시됩니다.

MIDI IN/OUT을 USB로 설정한 경우 표시됩니다

(7)	TEMPO SETTINGS 아이콘

현재 선택한 퍼포먼스의 템포를 표시합니다. 탭하면 Tempo Settings 화면이 나타납니다.

(8)	LIVE SET 아이콘

탭하면 Live Set 화면이 나타납니다.

현재 선택한 슬롯이 파란색으로 표시됩니다.

(9)	UTILITY 아이콘

탭하면 가장 최근에 연 Utility 화면이 나타납니다.
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Performance 화면

Performance 화면에서 건반 연주 또는 퍼포먼스 설정 변경을 위한 퍼포먼스를 선택하여 퍼포먼스를 사용자 지정할 수 있습니다.

홈

작업

[PERFORMANCE (HOME)] 버튼 누르기

HOME 아이콘( ) 탭하기

(1) (2) (3)

(14)(13)

(4)

(11) (12)

(5)
(6)

(7)

(8)

(9)

(10)

(1)	Performance Name

선택한 퍼포먼스의 이름을 표시합니다. 탭하면 Category Search, Edit, Recall 등에 대한 콘텍스트 메뉴가 표시됩니다.

데이터 다이얼, [INC/YES] 버튼 및 [DEC/NO] 버튼으로 퍼포먼스를 전환할 수 있습니다. 전환 방법에는 2가지가 있습니다.

•	 Default ( )
Performance Category Search 화면의 퍼포먼스 목록의 순서를 전환합니다.

•	 Live Set ( )
Live Set 슬롯의 순서를 전환합니다.

[UTILITY] → Settings → System → Perf Inc/Dec에서 전환 방법을 설정할 수 있습니다.

플래그를 사용하여 퍼포먼스 상태를 확인할 수 있습니다.

•	 즐겨찾는 플래그( )

Favorite 스위치를 켜면 이 나타납니다. 이 모양은 Performance Category Search 화면에도 나타납니다.

•	 편집 플래그( )

퍼포먼스의 파라미터를 변경하면 파란색 플래그가 나타납니다. [STORE] 버튼을 사용하여 설정을 저장하면 편집 플래그가 

꺼집니다.
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(2)	Performance Flag

퍼포먼스 플래그가 표시됩니다.

속성 설명

AWM2 AWM2 사운드 엔진 파트로만 구성된 퍼포먼스

FM-X(1가지 색상) FM- X 사운드 엔진 파트로만 구성된 퍼포먼스

FM-X(2가지 색상) Smart Morph 정보가 포함된 FM-X 파트를 사용하는 퍼포먼스

AN-X(1가지 색상) AN-X 사운드 엔진을 사용하는 퍼포먼스

AN-X(2가지 색상) Smart Morph 정보가 포함된 AN-X 파트를 사용하는 퍼포먼스

MC 모션 컨트롤이 내장된 퍼포먼스

SSS Seamless Sound Switching을 지원하는 퍼포먼스

* 다중 사운드 엔진 형식이 조합된 퍼포먼스는 “+” 기호로 표시됩니다.

(3)	Oscilloscope

Main L&R 출력이 파형으로 표시됩니다.

(4)	Part Indicator

Performance Name 또는 파트 1~8에 커서가 놓여 있으면 파트 9~16의 상태가 표시됩니다.

파트 9~16에 커서가 놓여 있으면 파트 1~8의 상태가 표시됩니다.

파트 9~16을 사용하지 않으면 아무 것도 표시되지 않습니다.

(5)	다양한 파라미터를 확인할 수 있는 보기 영역

Display Mode에 따라 다양한 파라미터가 이 보기 영역에 표시됩니다.

(6)	Part Name

파트 형식 및 카테고리 또는 파트 이름이 표시됩니다.

탭하면 Category Search, Edit, Copy 및 Property에 대한 콘텍스트 메뉴가 표시됩니다.

파트 1 이외의 다른 파트를 선택할 때 음향이 이미 해당 파트에 설정된 상태이면 Category Search, Edit, Copy 및 Delete에 대한 

콘텍스트 메뉴가 표시됩니다.

(7)	Keyboard Control Switch

각 파트의 Keyboard Control Switch를 켜거나 꺼서 어떤 파트를 동시에 연주할지 설정할 수 있습니다.

파트가 Common으로 설정되거나 해당 파트의 Keyboard Control Switch가 켜짐으로 설정된 경우, Keyboard Control 

Switch가 켜짐으로 설정된 파트를 동시에 연주할 수 있습니다.

파트의 Keyboard Control Switch가 꺼짐으로 설정된 경우, 해당 파트를 선택한 상태로 건반을 연주하면 이 음향이 연주됩니다.

설정: Off, On

(8)	Part Mute

파트 음소거를 켜거나 끕니다.

설정: Off, On

(9)	Part Solo

파트 솔로를 켜거나 끕니다.

설정: Off, On

(10)	Part Volume

파트의 음량을 설정합니다.

설정: 0–127

(11)	 Part Level Meter

파트의 오디오 출력 레벨을 표시합니다.
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(12)	[+](추가)

탭하면 Part Category Search 화면 또는 Performance Merge 화면이 나타나 파트를 추가할 수 있습니다.

(13)	Display Mode 전환

(14)	View Mode 전환

Display Mode 전환

Display Mode를 전환하면 Home 화면의 보기 영역에 다양한 파라미터가 표시됩니다.

해당 화면 노브를 움직이면 다른 Display Mode를 선택할 수 있습니다.

	� Range

Navigation

Navigation 화면이 열립니다.

Fx Overview

FX Overview 화면이 열립니다.

Control View

Control View 화면이 열립니다.

Favorite

Favorite 스위치를 켜거나 끕니다.

설정: Off, On

Note Limit

파트의 음 범위(최저/최고음)를 설정합니다.

지정된 첫 번째 음이 두 번째 음보다 높은 경우(예: C5에서 C4로), C−2~C4 및 C5~G8 범위에서 음이 연주됩니다.

설정: C−2–G8

Velocity Limit

파트의 세기 범위를 설정합니다.

설정: 1–127
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	� FX/Pan

Var Return

변주 이펙트로 처리된 신호의 출력 레벨(리턴 레벨)을 설정합니다.

설정: 0–127

Rev Return

리버브 이펙트로 처리된 신호의 출력 레벨(리턴 레벨)을 설정합니다.

설정: 0–127

Pan

현재 선택한 퍼포먼스의 팬 위치(스테레오 위치)를 조정합니다.

설정: L63–C(중앙)–R63

Volume

현재 선택한 퍼포먼스의 음량을 조정합니다.

설정: 0–127

Var (Part Variation Send)

파트 변주 이펙트로 전송되는 신호의 레벨을 설정합니다.

설정: 0–127

Rev (Part Reverb Send)

파트 리버브 이펙트로 전송되는 신호의 레벨을 설정합니다.

설정: 0–127

Dry (Part Dry Level)

파트의 dry 레벨(또는 시스템 이펙트로 처리되지 않은 신호의 레벨)을 설정합니다.

설정: 0–127

Pan (Part Pan)

파트의 (스테레오 필드 내) 팬 위치를 조정합니다.

설정: L63–C(중앙)–R63
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	� Arp/MS/Porta

Arp Select

아르페지오를 선택합니다.

설정: 1–8

MS Select

모션 시퀀스 선택 사항을 변경합니다.

설정: 1–8

Portamento Switch

Portamento Part Sw가 켜짐으로 설정된 파트의 포르타멘토를 켜짐 또는 꺼짐으로 설정합니다.

이 스위치는 상단 패널의 [PORTAMENTO] 버튼과 연결되어 있습니다.

설정: Off, On

Portamento Time

파트에 포르타멘토의 피치 이동에 대한 시간 길이(또는 속도)를 설정합니다.

이 파라미터는 파트에 대한 포르타멘토 시간(기준에 따라 조정되는 값)의 오프셋 값입니다.

설정: −64–+0–+63

Arp On/Off (Arpeggio Part Switch)

파트의 아르페지오를 켜짐 또는 꺼짐으로 설정합니다.

아르페지오와 아르페지오 홀드가 모두 켜져 있을 경우, Arp Hold On이 표시됩니다.

아르페지오가 켜짐으로 설정된 경우, [SHIFT] 버튼을 누른 상태에서 화면의 Arp On/Off 버튼을 탭하면 Arp Hold를 켜거나 끌 수 

있습니다. 

설정: Off, On

MS On/Off (Motion Sequencer Part Switch)

파트의 모션 시퀀서를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Prt On/Off (Portamento Part Switch)

파트의 포르타멘토를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Time (Portamento Part Time)

파트의 포르타멘토에 대한 피치 이동의 시간 길이를 설정합니다.

설정: 0–127
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	� Mode/Transpose

MIDI I/O Ch.

Common 및 Keyboard Control Switch가 켜짐으로 설정될 파트의 입력 및 출력에 대한 MIDI 채널을 설정합니다.

설정: Ch1–Ch16

Octave Shift (Keyboard Octave Shift)

건반 피치를 옥타브 단위로 이동합니다.

이 파라미터는 상단 패널의 OCTAVE 버튼과 연결되어 있습니다.

설정: −3–+0–+3

Transpose (Keyboard Transpose)

건반 피치를 반음 단위로 이동합니다.

설정: –11semi–+0semi–+11semi

주
피치가 음원 섹션이 재생할 수 있는 범위(C-2/G8)를 초과할 경우 한 옥타브 높은 음이 출력됩니다.

Int/Ext (Part Mode)

악기의 내장 음원(Int)을 사용할지 외장 음원(Ext)을 사용할지를 설정합니다.

설정: Int, Ext

Ch (Tx/Rx Ch)

Part Mode를 Internal로 설정하고 Keyboard Control Switch를 꺼짐으로 설정한 경우, 영역의 MIDI 메시지를 전송/수신할 때 

사용되는 채널을 설정합니다.

설정: Ch1–Ch16, Off

Ch (Transmit Ch)

Part Mode를 External로 설정한 경우, 영역의 MIDI 메시지를 전송/수신할 때 사용되는 채널을 설정합니다.

설정: Ch1–Ch16

Oct (Zone Octave)

영역 피치를 옥타브 단위로 이동합니다.

설정: −3–+0(표준)–+3

Trans (Zone Transpose)

영역 피치를 반음 단위로 이동합니다.

설정: −11–+0(표준)–+11
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	� Filter

Cutoff (Cutoff Frequency)

필터의 차단 주파수를 설정하여 음향을 변경합니다.

로우 패스 필터를 선택한 경우 값이 커지면 음향이 밝아지고 값이 작아지면 음향이 어두워집니다.

이 파라미터는 파트에 대한 필터 차단 주파수의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

Resonance

차단 주파수 근처의 신호 레벨을 조정하여 음향에 특별한 특성을 더합니다.

이 파라미터는 파트에 대한 필터 공명의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

FEG Depth

FEG로 제어되는 차단 주파수 변화의 깊이 범위를 설정합니다.

이 파라미터는 파트에 대한 FEG Depth의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

Cut (Part Cutoff Frequency)

파트 필터의 차단 주파수를 설정하여 음향을 변경합니다.

로우 패스 필터를 선택한 경우 값이 커지면 음향이 밝아지고 값이 작아지면 음향이 어두워집니다.

이 파라미터는 Filter Type 화면에서 설정한 필터 차단 주파수의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

Res (Part Resonance)

파트의 차단 주파수 근처의 신호 레벨을 조정하여 음향에 특별한 특성을 더합니다.

이 파라미터는 Filter Type 화면에서 설정한 필터 공명의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

FEG (Part FEG Depth)

Filter Type 화면의 FEG 설정으로 제어되는 차단 주파수 변화 범위를 조정합니다.

0으로 설정된 경우 Filter Type 화면의 설정이 그대로 사용됩니다.

설정: −64–+0–+63
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View Mode 전환

View Mode를 사용하여 Home 화면에서 자세한 내용을 살펴볼 수 있습니다.

해당 화면 노브를 움직이면 다른 View Mode를 선택할 수 있습니다.

Performance Name에 커서가 놓여 있을 때 [PERFORMANCE (HOME)] 버튼을 누르면 보기 모드를 전환할 수 있습니다.

	� Part Info

•	 Element Sw/Level
현재 선택한 파트가 일반 파트(AWM2)일 경우 표시됩니다.

Element Sw (Element Switch)

요소를 켜거나 끕니다.
설정: Off, On

Element Level

요소의 출력 레벨을 설정합니다.
설정: 0–127

•	 Drum Key
현재 선택한 파트가 드럼 파트일 경우 표시됩니다.

Drum Key Level

드럼 키의 출력 레벨을 설정합니다.
설정: 0–127
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•	 Algorithm
현재 선택한 파트가 일반 파트(FM-X)일 경우 표시됩니다.

Algorithm (Algorithm Number)

알고리즘을 변경합니다.

알고리즘 이미지를 탭하면 Algorithm Search 화면이 표시됩니다.
설정: Data List 참조

Feedback (Feedback Level)

피드백(모듈레이터에 의해 모듈레이션되는 캐리어 파형을 이용하여 모듈레이터 자체를 모듈레이션)의 정도(레벨)를 설정합니다.
설정: 0–7

•	 Virtual Analog
현재 선택한 파트가 일반 파트(AN-X)일 경우 표시됩니다.

1–3 (Oscillator 1–3)

파트 편집(AN-X)에 사용되는 OSC/Tune 화면을 엽니다.

N (Noise)

파트 편집(AN-X)에 사용되는 Noise 화면을 엽니다.

Oscillator Level

오실레이터의 출력 레벨을 설정합니다.
설정: 0–511
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노이즈 레벨

노이즈 레벨을 설정합니다.

설정: 0–511

Filter 1, 2

파트 편집(AN-X)에 사용되는 Filter Type 화면을 엽니다.

Amplifier

파트 편집(AN-X)에 사용되는 Amp EG 화면을 엽니다.

	� Smart Morph
Smart Morph 맵이 표시됩니다.

그러나 Smart Morph 정보가 없을 때에는 맵이 표시되지 않습니다.

	� Motion Seq
현재 선택된 파트의 View Lane에 설정된 레인을 표시합니다.

그러나 설정된 레인이 꺼져 있으면 표시되지 않습니다.
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	� Velocity - Note
Velocity - Note 보기가 표시됩니다.

이 파라미터는 다수의 파트를 사용하는 경우 세기 분리를 설정할 때 편리합니다.

	� Part - Note
Part - Note 보기가 표시됩니다.

View Mode가 Part Info로 설정되고 선택된 파트가 Common일 경우 표시됩니다.
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	� Ribbon
View Mode가 Ribbon일 경우 표시됩니다.
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Motion Control

Motion Control 화면에서 전체 퍼포먼스에 적용되는 모션 컨트롤을 설정할 수 있습니다.

Super Knob

Super Knob 화면에서 슈퍼 노브를 제어하기 위한 값을 설정할 수 있습니다.

수퍼 노브와 각 지정 가능 노브를 서로 연결할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Motion Control → Super Knob

(1)

(2)

(3)

(4)

(5)

(1)	Super Knob Link

(2)	Assignable Knob 1–8 Value

(3)	Assignable Knob 1–8 Value Left

(4)	Assignable Knob 1–8 Value Mid

(5)	Assignable Knob 1–8 Value Right

MS Master (Motion Sequencer Master Switch)

전체 퍼포먼스의 모션 시퀀서를 켜짐 또는 꺼짐으로 설정합니다.

이 스위치는 상단 패널의 [MSEQ] 버튼과 연결되어 있습니다.

설정: Off, On

Super Knob MS (Super Knob Motion Sequencer Switch)

수퍼 노브의 모션 시퀀서를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Edit Super Knob

Common Edit Control Assign 화면이 열립니다. 수퍼 노브로 제어되도록 파라미터를 설정할 수 있습니다.
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LED Pattern

수퍼 노브의 점등 패턴을 설정합니다.

설정: 	 Off, Type 1, Type 2-1, Type 2-2, Type 3-1, Type 3-2, Type 4-1, Type 4-2, Type 5-1, Type 5-2, Type 6, Type 7-1, Type 7-2, 

Type 8-1, Type 8-2, Type 9, Type 10, Type 11, Type 1B, Type 2-1B, Type 2-2B, Type 3-1B, Type 3-2B, Type 4-1B, Type 

4-2B, Type 5-1B, Type 5-2B, Type 6B, Type 7-1B, Type 7-2B, Type 8-1B, Type 8-2B, Type 9B, Type 10B, Type 11B, Rotary 

1, Rotary 2, Rotary 3, Rotary 4, Rotary 5, Rotary 6, Rotary 7, Rotary 8, Rotary 9, Rotary 10

Super Knob (Super Knob Value)

수퍼 노브 값을 설정합니다.

설정: 0–1023

Mid Position (Super Knob Mid Position)

수퍼 노브의 Mid 값을 설정합니다.

설정: Off, 1–1022

Super Knob Link

해당 노브를 설정하여 수퍼 노브와 연결합니다.

이러한 스위치를 꺼짐으로 설정하면 수퍼 노브 작업을 실시해도 노브 파라미터에 영향을 미치지 않습니다.

설정: Off, On

Assignable Knob 1 – 8 Value

지정 가능 노브(노브 1~8)의 현재값을 설정합니다.

설정: 0–1023

Assignable Knob 1 – 8 Value Left

Super Knob Value가 0으로 설정된 경우(또는 수퍼 노브를 왼쪽 끝까지 돌린 경우) 지정 가능 노브(노브 1~8)의 값을 표시합니다.

설정: 0–1023

Assignable Knob 1 – 8 Value Mid

Super Knob Value가 Mid Position으로 설정된 경우 지정 가능 노브(노브 1~8)의 값을 표시합니다.

Mid Position이 Off인 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 0–1023

Assignable Knob 1 – 8 Value Right

Super Knob Value가 1023으로 설정된 경우(또는 수퍼 노브를 오른쪽 끝까지 돌린 경우) 지정 가능 노브(노브 1~8)의 값을 

표시합니다.

설정: 0–1023

주
•	Value Left는 작게, Value Right는 크게 설정하면 노브 1~8이 수퍼 노브와 동일한 방향으로 움직입니다.

•	Value Right는 작게, Value Left는 크게 설정하면 노브 1~8이 수퍼 노브와 반대 방향으로 움직입니다.
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Knob Auto

Knob Auto 화면에서 Super Knob(Super Knob Motion Sequencer)에 대한 모션 시퀀서를 설정할 수 있습니다. 모션 시퀀서를 

설정하여 수퍼 노브 값을 자동으로 제어합니다.

수퍼 노브에는 1개의 레인만 사용할 수 있습니다.

주
동시에 최대 8개의 레인을 해당 퍼포먼스 전체에 사용할 수 있습니다. Knob Auto 화면에 사용되는 레인은 여기 언급된 8개에 포함되지 않습니다.

작업

[PERFORMANCE (HOME)] → Motion Control → Knob Auto

Motion Seq Master Sw (Motion Sequencer Master Switch)

전체 퍼포먼스의 모션 시퀀서를 켜짐 또는 꺼짐으로 설정합니다.

이 스위치는 상단 패널의 [MSEQ] 버튼과 연결되어 있습니다.

설정: Off, On

Super Knob MS Sw (Super Knob Motion Sequencer Switch)

수퍼 노브 모션 시퀀서를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

MS FX (Super Knob Motion Sequencer FX Receive)

수퍼 노브 작업의 영향을 받을 노브를 설정합니다.

설정: Off, On

Trigger (Super Knob Motion Sequencer Trigger Receive)

[MSEQ TRIGGER] 버튼에서 신호를 수신하도록 설정합니다.

켜짐으로 설정된 경우 [MSEQ TRIGGER] 버튼을 누를 때까지 모션 시퀀스가 재생되지 않습니다.

설정: Off, On

Sequence Select (Motion Sequence Select)

모션 시퀀스 형식 선택 사항을 변경합니다.

설정: 1–8

SK MS Random (Super Knob Motion Sequencer Randomness)

시퀀스 단계값의 변화 무작위를 설정합니다.

설정: 0–127

Edit Sequence

Super Knob Motion Sequence Edit 화면이 열립니다.
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	� Sync/Speed 탭

Sync (Super Knob Motion Sequencer Sync)

수퍼 노브 모션 시퀀스 재생 속도 및 타이밍을 선택합니다.

설정: 	 Off, Tempo, Beat

Off: 수퍼 노브 모션 시퀀서만 재생합니다.

Tempo: 퍼포먼스 템포로 재생합니다.

Beat: 박자에 맞춰 재생합니다.

•	 Sync를 Off로 설정한 경우

Speed (Super Knob Motion Sequencer Speed)

모션 시퀀스의 재생 속도를 설정합니다.

설정: 0–127

Delay Time (Super Knob Motion Sequencer Lane Key On Delay Time Length)

모션 시퀀스 재생을 시작할 때 사용되는 딜레이 타임을 설정합니다.

설정: 0–127

Fade In Time (Super Knob Motion Sequencer Lane Fade In Time Length)

모션 시퀀스가 최대 진폭에 도달할 때까지 소요되는 시간을 설정합니다.

설정: 0–127

•	 Sync를 Off 이외의 다른 값으로 설정한 경우

Unit (Super Knob Motion Sequencer Unit Multiply)

수퍼 노브 모션 시퀀서 재생 시간을 늘리거나 줄일 때 사용되는 백분율을 설정합니다.

설정: 	 50%–6400%, Common

200%: 재생 시간이 2배가 되어 결과적으로 템포가 1/2로 줄어듭니다.

100%: 재생 시간이 변함없이 유지됩니다.

50%: 재생 시간이 1/2이 되어 결과적으로 템포가 2배로 늘어납니다.

Common: 모든 파트에 공통된 Unit에 설정된 값이 적용됩니다.

Delay Steps (Super Knob Motion Sequencer Lane Key On Delay Step Length)

모션 시퀀스 재생을 시작할 때 사용되는 딜레이 타임을 설정합니다.

설정: 0–32

Fade In Steps (Super Knob Motion Sequencer Lane Fade In Step Length)

모션 시퀀스의 최대 진폭에 도달할 시간을 설정합니다.

설정: 0–32

Vel Limit (Super Knob Motion Sequencer Velocity Limit)

모션 시퀀스 재생에 사용되는 세기 범위를 설정합니다.

설정: 1–127
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	� Loop/Length 탭

Key On Reset (Super Knob Motion Sequencer Key On Reset)

아무 건반이나 누르면 모션 시퀀스 재생을 재설정합니다.

Trigger가 On인 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 	 Off, Each-On, 1st-On

Each-On: 음을 연주할 때마다 처음부터 재생이 시작됩니다.

1st-On: 연주하는 첫 음에서 처음부터 재생이 시작됩니다. 첫 번째 음을 유지하면서 두 번째 음을 연주하면 재생이 재설정되지 않습니다.

Loop (Super Knob Motion Sequencer Loop)

모션 시퀀스를 루프 재생(반복) 또는 단일 재생으로 설정합니다.

설정: Off, On

Loop Start (Super Knob Motion Sequencer Loop Start)

모션 시퀀스 루프 재생 시작 지점을 지정합니다.

설정: 1–16(Length 설정 미만이어야 함)

Length (Super Knob Motion Sequence Length)

모션 시퀀스 길이를 설정합니다.

설정: 1~16(Loop Start 설정을 초과해야 함)

MS Grid (Super Knob Motion Sequence Grid)

모션 시퀀스의 단계 길이를 설정합니다.

설정: 60, 80, 120, 160, 240, 320, 480
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	� Super Knob Motion Sequence Edit
수퍼 노브 모션 시퀀서의 설정 화면입니다.

최대 16단계로 구성된 시퀀서를 생성할 수 있습니다.

Loop Start (Super Knob Motion Sequencer Loop Start)

모션 시퀀스 루프 재생 시작 지점을 지정합니다.

설정: 1–16(Length 설정 미만이어야 함)

Length (Super Knob Motion Sequence Length)

모션 시퀀스 길이를 설정합니다.

설정: 1–16(Loop Start 설정을 초과해야 함)

MS Grid (Super Knob Motion Sequence Grid)

모션 시퀀스의 단계 길이를 설정합니다.

설정: 60, 80, 120, 160, 240, 320, 480

Sequence Select (Motion Sequence Select)

모션 시퀀스 형식 선택 사항을 변경합니다.

설정: 1–8

Polarity (Super Knob Motion Sequence Polarity)

모션 시퀀스의 극성을 설정합니다.

설정: 	 Unipolar, Bipolar

Unipolar: 파라미터를 변경할 때 양의 값만 사용됩니다.

Bipolar: 파라미터를 변경할 때 양의 값과 음의 값 모두 사용됩니다.

Amplitude (Super Knob Motion Sequence Amplitude)

모션 시퀀스의 변화도를 설정합니다.

설정: 0–127

Smooth (Super Knob Motion Sequence Smoothness)

시간 경과에 따른 모션 시퀀스 변화의 부드러움을 설정합니다.

설정: 0–127
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Job

작업 메뉴를 불러옵니다.

•	 Store Sequence

편집된 모션 시퀀스를 저장합니다.

•	 Load Sequence

모션 시퀀스를 불러옵니다.

•	 Copy Sequence

모션 시퀀스를 복사합니다.

Super Knob Motion Sequence Step Value

모션 시퀀스의 각 단계에 대한 값을 설정합니다.

컨트롤 슬라이더 1~8을 사용하여 커서 위치에 따라 단계 1~8 및 단계 9~16의 값을 변경합니다.

설정: 0–127

Super Knob Motion Sequence Step Type

모션 시퀀스에 존재하는 각 단계의 형식 및 방향을 설정합니다.

설정: A, B, Reverse A, Reverse B

Pulse A (Super Knob Motion Sequence Step Curve Type A)

Pulse B (Super Knob Motion Sequence Step Curve Type B)

Pulse A 및 Pulse B에 대한 파라미터 변화 곡선을 선택합니다.

Super Knob Motion Sequence Step Type을 사용하여 각 단계에 어떤 곡선 유형을 사용할지 선택합니다.

수직축은 시간을 의미하며, 수평축은 단계값을 의미합니다.

설정:	� (프리세트 뱅크를 선택한 경우) Standard, Sigmoid, Threshold, Bell, Dogleg, FM, AM, M, Discrete Saw, Smooth Saw, Triangle, 

Square, Trapezoid, Tilt Sine, Bounce, Resonance, Sequence, Hold, Harmonic, Steps

(유저 뱅크를 선택한 경우) Init Curve 1–32

(라이브러리 파일을 불러온 경우) Curve within Library 1–24

Edit User Curve

Init Curve를 Pulse A 및 Pulse B에 대해 선택할 때 표시됩니다.

User Curve Edit 화면이 열립니다.

Prm 1 (Super Knob Motion Sequence Step Curve Parameter 1)

Prm 2 (Super Knob Motion Sequence Step Curve Parameter 2)

모션 시퀀스 단계 곡선의 형태를 조정합니다. 또한, 파라미터 값에 대한 범위도 Curve Type에 따라 달라집니다.

Curve Type에 따라서는 이 설정을 이용하지 못할 수 있습니다.

Control (Super Knob Motion Sequence Step Curve Shape Control Switch)

모션 시퀀스 단계 곡선 유형을 제어할 때 노브의 사용을 활성화하거나 비활성화합니다.

MS FX (Super Knob Motion Sequencer FX Receive)가 켜짐으로 설정된 경우에만 표시됩니다.

Curve Type에 따라서는 이 설정을 이용하지 못할 수 있습니다.

설정: Off, On
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	� User Curve Edit
User Curve 설정 화면입니다.

8점 Linear 곡선 또는 8단계 곡선을 생성할 수 있습니다.

Curve No. (Curve Number)

현재 곡선 번호를 나타냅니다.

설정: 1–32

Curve Name

새 이름으로 편집 중인 곡선을 저장할 수 있습니다. 최대 20자의 영숫자 문자를 사용할 수 있습니다.

Curve Type

곡선 유형을 설정합니다.

설정: Linear, Step

Input

곡선의 입력 레벨을 설정합니다.

Input 1 값은 0으로 고정되어 있습니다. Input 8 값은 Curve Type이 Linear로 설정될 때 1023으로 고정됩니다.

설정: 0–1023

Output

곡선의 출력 레벨을 설정합니다.

설정: 0–1023
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Mixing

Mixing화면에서 각 파트의 음량을 조정하여 믹스를 변경한 후 이펙트를 설정할 수 있습니다.

Mixing 화면의 설정은 퍼포먼스에 저장됩니다.

작업

[PERFORMANCE (HOME)] → Motion Control → Super Knob

Part 1–16 (Part 1–16 Switch)

Audio (Audio Switch)

보기를 변경합니다.
설정: Part 1–16, Audio (Part 1–8, Audio Part, Master)

	� Part 1–16 보기
파트 1~16의 믹스를 설정합니다.

(1)(2)

(4)(3)
(1)	Part Category

(2)	Keyboard Control

(3)	Volume

(4)	Part Level Meter
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Part Category

선택한 파트의 메인 카테고리가 표시됩니다.

탭하면 Category Search, Edit, Property 등에 대한 콘텍스트 메뉴가 표시됩니다.

파트 1 이외의 다른 파트를 선택할 때 음향이 이미 해당 파트에 설정된 상태이면 Category Search, Edit, Copy 및 Delete에 대한 

콘텍스트 메뉴가 표시됩니다. [+] 기호를 탭해 파트를 추가합니다.

설정: Data List 참조

Mute/Solo Switch

Kbd Ctrl Switch

Mute/Solo 보기와 Keyboard Control 보기를 서로 전환합니다.

Mute (Part Mute)

Solo (Part Solo)

파트의 음소거 및 솔로를 켜거나 끕니다.

설정: Off, On

Keyboard Control

건반 컨트롤을 켜거나 끕니다.

파트 9~16의 경우 건반 컨트롤이 켜짐으로 설정되지 않으므로 버튼이 표시되지 않습니다.

설정: Off, On

3-band (3-band EQ Switch)

2-band (2-band EQ Switch)

파트 1~16의 2대역 EQ 보기와 3대역 EQ 보기를 서로 전환합니다.

설정: 3-band, 2-band

EQ (Equalizer)

3-band 또는 2-band 보기에서 EQ 설정을 표시합니다.

영역을 탭하면 파트 EQ의 콘텍스트 메뉴가 표시됩니다.

Rev Send (Reverb Send)

파트 1~16에서 리버브 이펙트로 전송된 신호의 레벨을 설정합니다.

설정: 0–127

Var Send (Variation Send)

파트 1~16에서 변주 이펙트로 전송된 신호의 레벨을 설정합니다.

설정: 0–127

Dry Level

파트 1~16의 dry 레벨(또는 시스템 이펙트로 처리되지 않은 신호의 레벨)을 설정합니다.

설정: 0–127

Pan

파트 1~16의 (스테레오 필드 내) 팬 위치를 조정합니다.

설정: L63–C(중앙)–R63

Volume

파트 1~16의 음량을 설정합니다.

설정: 0–127

Part Level Meter

파트 1~16의 레벨을 표시합니다.
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	� Audio 보기
오디오 파트의 믹스를 설정합니다.

(1)

(9)(8) (12)(11)(10) (14)(13) (15)

(2) (3) (4) (5)

(6)

(7)

(1)	Part Category

(2)	Digi (Digital Part)

(3)	Main (USB Main Part)

(4)	AD (A/D Part)

(5)	Mst (Master)

(6)	A/D Part EQ

(7)	Master EQ

(8)	Digital Part Volume

(9)	Part Level Meter

(10)	Digi (Digital Part Level Meter)

(11)	 USB Main Monitor Volume

(12)	Main (USB Main Monitor Level 

Meter)

(13)	A/D Part Volume

(14)	AD (A/D Part Level Meter)

(15)	Performance Volume

Part Category

선택한 파트의 메인 카테고리가 표시됩니다.

탭하면 Category Search, Edit, Property 등에 대한 콘텍스트 메뉴가 표시됩니다.

파트 1 이외의 다른 파트를 선택할 때 음향이 이미 해당 파트에 설정된 상태이면 Category Search, Edit, Copy 및 Delete에 대한 

콘텍스트 메뉴가 표시됩니다. [+] 기호를 탭해 파트를 추가합니다.

설정: Data List 참조

Digi (Digital Part)

Main (USB Main Part)

AD (A/D Part)

Mst (Master)

탭하면 Edit 등에 대한 콘텍스트 메뉴가 표시됩니다.

Mute/Solo Switch

Kbd Ctrl Switch

Mute/Solo 보기와 Keyboard Control 보기를 서로 전환합니다.
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Mute (Part Mute)

Solo (Part Solo)

파트의 음소거 및 솔로를 켜거나 끕니다.

설정: Off, On

A/D Part EQ

영역을 탭하면 파트 EQ의 콘텍스트 메뉴가 표시됩니다.

Digital Part Reverb Send

A/D Part Reverb Send

A/D 파트 또는 디지털 파트에서 리버브 이펙트로 전송된 신호의 레벨을 설정합니다.

설정: 0–127

Digital Part Variation Send

A/D Part Variation Send

A/D 파트 또는 디지털 파트에서 변주 이펙트로 전송된 신호의 레벨을 설정합니다.

설정: 0–127

Digital Part Dry Level

A/D Part Dry Level

디지털 파트 또는 A/D 파트의 dry 레벨(또는 시스템 이펙트가 없는 신호의 레벨)을 설정합니다.

설정: 0–127

Digital Part Pan

A/D Part Pan

디지털 파트 또는 A/D 파트의 (스테레오 필드 내) 팬 위치를 조정합니다.

설정: L63–C(중앙)–R63

Digital Part Volume

A/D Part Volume

USB Main Monitor Volume

오디오 파트의 음량을 설정합니다.

설정: 0–127

Master EQ

5대역 파라메트릭 EQ를 표시합니다.

영역을 탭하면 Master EQ Edit에 대한 콘텍스트 메뉴가 표시됩니다.

Rev Return (Reverb Return)

Var Return (Variation Return)

리버브 또는 변주 이펙트로 처리된 신호의 출력 레벨(리턴 레벨)을 설정합니다.

설정: 0–127

Rev Send (Reverb Send)

리버브 이펙트로 전송되는 신호의 레벨을 설정합니다.

설정: 0–127

Var Send (Variation Send)

변주 이펙트로 전송되는 신호의 레벨을 설정합니다.

설정: 0–127
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Pan (Performance Pan)

퍼포먼스의 (스테레오 필드 내) 팬 위치를 설정합니다.

이 파라미터 값은 각 파트에 대해 Pan 설정을 오프셋합니다.

설정: L63–C(중앙)–R63

Performance Volume

퍼포먼스 음량을 설정합니다.

설정: 0–127

Part Level Meter

Digi (Digital Part Level Meter)

Main (USB Main Monitor Level Meter)

AD (A/D Part Level Meter)

파트 1~8 및 오디오 파트의 레벨을 표시합니다.
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Scene

Scene 화면에서 아르페지오 형식, 모션 시퀀스 형식 및 파트 파라미터의 설정을 각 SCENE 버튼으로 등록할 수 있습니다.

이 화면에서 해당 Memory (Memory Switch)를 켜짐으로 설정하고 원하는 파라미터 값을 편집하면 Scene에 설정을 저장할 수 

있습니다.

주
Scene 기능은 Scene 이외의 다른 화면에서 설정할 수 있습니다. 해당 노브 및 슬라이더를 움직인 후 [SHIFT] 버튼을 누른 상태에서 동시에 원하는 

SCENE 버튼을 눌러 설정을 등록하면 지정된 Scene 파라미터를 변경할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Scene

(1)

(1)	Scene Select

Scene Select

Scene 탭을 선택하여 설정을 등록합니다.

Scene1~Scene8 탭은 상단 패널의 SCENE 버튼과 연결되어 있습니다.
설정: 1–8

Memory (Memory Switch)

각 파라미터 값(예: 아르페지오, 모션 시퀀서, 수퍼 노브, 수퍼 노브 링크, 믹싱, 건반 컨트롤, 진폭 EG 및 Arp/MS FX)을 선택하여 

Scene에 등록합니다.

이러한 스위치가 꺼짐으로 설정된 경우 해당 탭을 선택해도 파라미터 값은 화면에 표시되지 않습니다.
설정: Off, On

Part 1–16 / Common

Part1-16 보기와 Common 보기를 서로 전환합니다.

Mixing 1, Mixing 2, Kbd Ctrl, AEG, Arp/MS FX1 및 Arp/MS FX2 탭에 표시됩니다.

Offset (Scene Mixing / AEG Value Mode Switch)

Offset을 꺼짐으로 설정하면 일부 Scene 파라미터를 미세 조정할 수 있습니다.

Mixing 1, Mixing 2 및 AEG 탭에 표시됩니다.
설정: 꺼짐(Absolute), 켜짐(Offset)
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Arp 및 Motion Seq의 Memory Switch를 켜짐으로 설정한 경우

Motion Seq Master (Motion Sequencer Master Switch)

전체 퍼포먼스의 모션 시퀀서를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Motion Seq Select (Motion Sequence Select)

모션 시퀀스 선택 사항을 변경합니다.

설정: 1–8

Arp Master (Arpeggio Master Switch)

전체 퍼포먼스의 아르페지오를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Arp Select (Arpeggio Select)

아르페지오 선택 사항을 변경합니다.

설정: 1–8

Super Knob 및 Link의 Memory Switch를 켜짐으로 설정한 경우

Super Knob (Super Knob Value)

수퍼 노브 값을 설정합니다.

설정: 0–1023

Super Knob Link

수퍼 노브와 Assignable Knob 1–8 간 연결을 설정합니다.

이 스위치를 꺼짐으로 설정하면 수퍼 노브 작업을 실시해도 Assignable Knob 파라미터에 영향을 미치지 않습니다.

설정: Off, On
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Mixing 1 및 Mixing 2의 Memory Switch를 켜짐으로 설정한 경우

	� Mixing 1
Part 1–16 보기: Scene Part 1–16의 파라미터가 표시됩니다.

Common 보기: Scene Part 1–8 및 Common의 파라미터가 표시됩니다.

Common 파라미터는 전체 퍼포먼스에 적용됩니다.

•	 Part 1–16 보기

Rev Send (Reverb Send)

각 파트에 대해 리버브 전송을 설정합니다.

설정: 0–127

Var Send (Variation Send)

각 파트에 대해 변주 전송을 설정합니다.

설정: 0–127

Dry Level

각 파트에 대해 dry 레벨을 설정합니다.

설정: 0–127

Pan

각 파트의 (스테레오 필드 내) 팬 위치를 조정합니다.

설정: L63–C(중앙)–R63

Volume (Part Volume)

각 파트에 대해 음량을 설정합니다.

설정: 0–127

•	 Common 보기

Rev Return (Reverb Return)

리버브 리턴을 설정합니다.

설정: 0–127

Var Return (Variation Return)

변주 리턴을 설정합니다.

설정: 0–127

Pan (Performance Pan)

퍼포먼스의 (스테레오 필드 내) 팬 위치를 조정합니다.

설정: L63–C(중앙)–R63
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	� Mixing 2

•	 Part 1-16 보기

Offset을 켜짐으로 설정한 경우

Cutoff (Filter Cutoff Frequency)

각 파트에 대해 차단 주파수를 설정합니다.

설정: −64–+0–+63

Res (Filter Resonance/Width)

각 파트에 대해 필터 공명 또는 필터 폭을 설정합니다.

설정: −64–+0–+63

FEG Depth

각 파트에 대해 FEG 깊이를 설정합니다.

설정: −64–+0–+63

Offset을 꺼짐으로 설정한 경우
Offset을 꺼짐으로 설정하면 일부 Scene 파라미터를 미세 

조정할 수 있습니다.

Cutoff 

설정: (AN-X, FM-X): 0–1023

Res

설정: (AN-X): 0–255

설정: (FM-X): 0–127

FEG Depth

설정: (AN-X): −9600–+0–+9600

설정: (FM-X): −64–+0–+63

주
Smart Morph와 Scene을 모두 사용하려는 경우 Offset을 켜짐으로 

설정하는 것이 좋습니다.

Mute (Part Mute)

파트의 음소거를 켜거나 끕니다.

설정: Off, On

Volume (Part Volume)

파트의 음량을 설정합니다.

설정: 0–127

•	 Common 보기

Cutoff (Cutoff Frequency)

파트에 대한 차단 주파수의 오프셋 값을 설정합니다.

설정: −64–+0–+63

Res (Filter Resonance/Width)

파트에 대한 필터 공명 또는 필터 폭의 오프셋 값을 설정합니다.

설정: −64–+0–+63

FEG Depth

이 파라미터는 Part FEG Depth의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63
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Kbd Ctrl Memory Switch를 켜짐으로 설정한 경우

Kbd Ctrl (Part Keyboard Control Switch)

파트의 건반 컨트롤을 켜거나 끕니다.

파트의 건반 컨트롤을 꺼짐으로 설정한 경우 건반을 연주해도 어떤 소리도 들리지 않습니다.

설정: 꺼짐(회색), 켜짐(녹색)
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AEG Memory Switch를 켜짐으로 설정한 경우

•	 Part 1-16 보기

Offset을 켜짐으로 설정한 경우

Attack (AEG Attack Time)

파트의 AEG 어택 타임을 설정합니다.

설정: −64–+0–+63

Decay (AEG Decay Time)

파트에 대해 AEG 감쇄 타임을 설정합니다.

설정: −64–+0–+63

Sustain (AEG Sustain Level)

파트에 대해 AEG 어택 타임을 설정합니다.

설정: −64–+0–+63

Release (AEG Release Time)

파트에 대해 AEG 어택 타임을 설정합니다.

설정: −64–+0–+63

Offset을 꺼짐으로 설정한 경우
Offset을 꺼짐으로 설정하면 일부 Scene 파라미터를 미세 

조정할 수 있습니다.

Attack

설정: (AN-X): 0–255

Decay

설정: (AN-X): 0–255

Sustain

설정: (AN-X): 0–511

Release

설정: (AN-X): 0–255

•	 Common 보기

Attack

파트에 대해 오프셋 값을 Attack (AEG Attack Time)으로 

설정합니다.

설정: −64–+0–+63

Decay

파트에 대해 오프셋 값을 Decay (AEG Decay Time)으로 

설정합니다.

설정: −64–+0–+63

Sustain

파트에 대해 오프셋 값을 Sustain (AEG Sustain Level)로 

설정합니다.

설정: −64–+0–+63

Release

파트에 대해 오프셋 값을 Release (AEG Release Time)으로 

설정합니다.

설정: −64–+0–+63
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Arp/MS FX 1 및 Arp/MS FX 2의 Memory Switch를 켜짐으로 설정한 경우

	� Arp/MS FX 1

•	 Part 1-16 보기

Swing

각 파트마다 아르페지오 또는 모션 시퀀스의 스윙값을 

설정합니다.

설정: −120–+0–+120

Unit (Part Unit Multiply)

각 파트의 아르페지오 및 모션 시퀀서 재생 시간을 늘리거나 줄일 

때 사용되는 백분율을 설정합니다.

설정: 	 50%–400%, Common

200%: 재생 시간이 2배가 되어 결과적으로 템포가 1/2로 

줄어듭니다.

100%: 재생 시간이 변함없이 유지됩니다.

50%: 재생 시간이 1/2이 되어 결과적으로 템포가 2배로 

늘어납니다.

Common: 모든 파트에 공통된 Unit (Common Unit 

Multiply)에 설정된 값이 적용됩니다.

Gate Time (Arp Gate Time Rate)

각 파트에 대해 아르페지오 게이트 시간 비율을 설정합니다.

설정: 0%–200%

Velocity (Arp Velocity Rate)

각 파트에 대해 아르페지오 세기 비율을 설정합니다.

설정: 0%–200%

•	 Common 보기

Swing

각 파트에 대해 오프셋 값을 Swing으로 설정합니다.

설정: −120–+0–+120

Unit (Common Unit Multiply)

모든 파트에 대해 Unit Multiply를 설정합니다.

설정: 	 50%–400%

200%: 재생 시간이 2배가 되어 결과적으로 템포가 1/2로 

줄어듭니다.

100%: 재생 시간이 변함없이 유지됩니다.

50%: 재생 시간이 1/2이 되어 결과적으로 템포가 2배로 

늘어납니다.

Gate Time (Arp Gate Time Rate)

각 파트에 대해 오프셋 값을 Arpeggio Gate Time Rate로 

설정합니다.

설정: −100–+0–+100

Velocity (Arp Velocity Rate)

각 파트에 대해 오프셋 값을 Arpeggio Velocity Rate로 

설정합니다.

설정: −100–+0–+100
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	� Arp/MS FX 2

•	 Part 1-16 보기

Amp (Motion Sequencer Amplitude Part Offset)

각 파트에 대해 오프셋 값을 Motion Sequencer Amplitude로 

설정합니다.

설정: −127–+0–+127

Shape (Motion Sequencer Pulse Shape Part Offset)

각 파트에 대해 오프셋 값을 Motion Sequencer Pulse 

Shape로 설정합니다.

설정: −100–+0–+100

Smooth (Motion Sequencer Smoothness Part Offset)

각 파트에 대해 오프셋 값을 Motion Sequencer 

Smoothness로 설정합니다.

설정: −127–+0–+127

Random (Motion Sequencer Randomness)

각 파트에 대해 오프셋 값을 Motion Sequencer 

Randomness로 설정합니다.

설정: 0–127

•	 Common 보기

Amp (Motion Sequencer Amplitude Performance 

Offset)

모든 파트에 대해 오프셋 값을 Motion Sequencer 

Amplitude로 설정합니다.

설정: −127–+0–+127

Shape (Motion Sequencer Pulse Shape Performance 

Offset)

모든 파트에 대해 오프셋 값을 Motion Sequencer Pulse 

Shape로 설정합니다.

설정: −100–+0–+100

Smooth (Motion Sequencer Smoothness Performance 

Offset)

모든 파트에 대해 오프셋 값을 Motion Sequencer 

Smoothness로 설정합니다.

설정: −127–+0–+127

Random (Motion Sequencer Randomness Performance 

Offset)

모든 파트에 대해 오프셋 값을 Motion Sequencer 

Randomness로 설정합니다.

설정: −127–+0–+127
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Play/Rec

Play/Rec 화면에서 본 악기의 내장 메모리에는 패턴 및 곡, USB 플래시 드라이브에는 오디오를 녹음한 후 해당 녹음을 재생할 수 

있습니다.

Pattern

	� 재생 및 재생 대기

작업 

[SONG/PATTERN] 버튼 → Pattern 

[PERFORMANCE (HOME)] → Play/Rec → Pattern

[] (재생) 버튼 → Pattern

(1)

(1)	Link Icon

Pattern Name

선택한 패턴의 이름을 표시합니다.

탭하면 Load, Rename 및 New Pattern에 대한 콘텍스트 메뉴가 표시됩니다.

Pattern Name에 커서가 놓여 있을 때 [INC/YES] 및 [DEC/NO] 버튼을 사용하면 패턴을 선택할 수 있습니다.

Link Icon

Link Icon은 패턴 녹음에 사용된 퍼포먼스와 선택한 퍼포먼스가 동일한 경우 표시됩니다. 그렇지 않은 경우 틀어진 Link Icon이 

표시됩니다.

Performance Name

선택한 퍼포먼스의 이름을 표시합니다.

주
퍼포먼스의 파라미터를 변경하면 Performance Name의 우측 상단에 파란색 플래그가 나타납니다.

Click Settings

Tempo Settings 화면을 엽니다.
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Time Signature

패턴의 미터를 표시합니다.

Position

재생 및 녹음 시작 위치와 현재 재생 위치를 설정합니다.

좌측에 표시된 숫자는 소절이며 우측에 표시된 숫자는 박자 및 틱입니다.

Tempo

패턴 재생 템포를 설정합니다.

설정: 5–300

Store Pattern & Perf Settings (Store Pattern and Performance Settings)

편집한 패턴과 사용한 퍼포먼스 간 연결을 저장합니다.

주
퍼포먼스 파라미터를 편집한 경우 퍼포먼스도 저장해야 합니다.

Edit/Job

패턴 편집 및 작업 화면을 엽니다. 패턴 기능을 사용하면 각 Scene의 시퀀스를 등록할 수 있습니다.

Scene

선택한 Scene 번호를 표시합니다.

이 스위치는 상단 패널의 SCENE 버튼과 연결되어 있습니다.

Length (Section Length)

선택한 Scene의 시퀀스 길이를 설정합니다.

설정: 1–256

Key On Start

건반을 누를 때 녹음 또는 재생을 시작할 패턴을 설정합니다.

설정: Off, On

Chain

체인 재생을 활성화합니다.

설정: Off, On

Undo ***

이전 작업을 취소하고 이전 상태로 돌아갑니다.

시퀀스가 녹음된 후 1개 이상의 작업이 사용된 경우 이 버튼을 이용할 수 있습니다.

Redo ***

Undo를 통해 취소된 작업을 복원합니다. 이 버튼은 Undo ***를 사용한 후에만 활성화됩니다.

Part 1–8

Part 9–16

파트 보기를 서로 전환합니다.
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	� 녹음 대기

작업

[SONG/PATTERN] 버튼 → Pattern → [] (녹음) 버튼

[PERFORMANCE (HOME)] → Play/Rec → Pattern → [] (녹음) 버튼

Time Signature

Scene의 미터를 설정합니다.

설정: 1/16–16/16, 1/8–16/8, 1/4–8/4

Rec Quantize (Record Quantize)

퀀타이즈는 녹음한 음이 (음 값에서) 박자의 정확한 부분이 되도록 교정하는 기능합니다.

설정: 	� Off, 60(32분 음표), 80(16분 음표의 셋잇단음표), 120(16분 음표), 160(8분 음표의 셋잇단음표), 240(8분 음표), 320(4분 음표의 

셋잇단음표), 480(4분 음표)

Loop

켜짐으로 설정된 경우, 패턴 녹음은 루프로 계속됩니다.

설정: Off, On

주
곡 녹음 중 [] (녹음) 버튼을 누르면 레코더가 리허설 모드로 설정되며 [] (녹음) 버튼이 깜박입니다.

리허설 모드에서는 패턴 재생이 계속되나 녹음은 잠시 일시정지되므로 연습하는 데 유용합니다.

[] 버튼을 다시 눌러 녹음 모드로 돌아갈 수 있습니다.
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	� 녹음

작업

[SONG/PATTERN] 버튼 → Pattern → [] (녹음) 버튼 → [] (재생) 버튼

[PERFORMANCE (HOME)] → Play/Rec → Pattern → [] (녹음) 버튼 → [] (재생) 버튼

Hold [SHIFT] + key to erase

Erase

[SHIFT] 버튼을 누른 상태에서 삭제하려는 음에 해당하는 건반을 누르면 특정 노트 이벤트를 삭제할 수 있습니다.

화면의 Erase 버튼을 탭해 기능을 켠 후 해당 건반을 눌러 노트 이벤트를 삭제해도 됩니다.
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	� 겹침 녹음
겹침 녹음 중 컨트롤러를 작동할 때 해당 컨트롤러의 기존 이벤트를 삭제하여 새 이벤트로 작업을 녹음할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Play/Rec → Pattern → (이미 녹음된 곡의 경우) → [] (녹음) 버튼 → Record Type 탭하기 → 
메뉴에서 Overdub 선택하기 → [] (재생) 버튼

Record Type

Replace 또는 Overdub 중에서 선택합니다.

설정: Replace, Overdub
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Pattern Edit Overview

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Overview

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Overview

Type
이 버튼을 탭해 파트의 메인 및 하위 카테고리를 확인합니다.
또한, Play/Rec 화면에 표시된 목록도 변경합니다.

Name
탭해서 파트 이름을 살펴봅니다.
또한, Play/Rec 화면에 표시된 목록도 변경합니다.

Part Mute Icon
Part Solo Icon
파트의 음소거 및 솔로 설정 상태를 표시합니다.

Undo ***
이전 작업을 취소하고 이전 상태로 돌아갑니다.
시퀀스가 녹음된 후 1개 이상의 작업이 사용된 경우 이 버튼을 이용할 수 있습니다. Pattern Edit 화면의 모든 탭에 대한 공통 
작업입니다.

Redo ***
Undo를 통해 취소된 녹음을 복원합니다. 이 버튼은 Undo ***를 사용한 후에만 활성화됩니다. Pattern Edit 화면의 모든 탭에 대한 
공통 작업입니다.

Scene
선택한 Scene 번호를 표시합니다.

Save As .mid File
Save 화면을 엽니다. 선택한 Scene의 시퀀스를 MIDI 파일로 저장할 수 있습니다.

Load .mid File
MIDI 파일을 불러오려면 Load 화면을 엽니다.
MIDI 파일을 선택한 후 불러오기 위치에서 패턴 및 Scene을 선택합니다.

Length
선택한 Scene의 시퀀스 길이를 설정합니다.

Position
Scene 재생 중 현재 위치를 표시하며, 재생 위치를 지정할 수 있습니다.
설정: 001–256
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Pattern Edit Note

	� Quantize
퀀타이제이션은 노트 이벤트를 가장 인접해 있는 정확한 비트로 보다 가깝게 이동시켜 노트 이벤트의 타이밍을 조정하는 과정입니다. 

예를 들어, 이 기능을 사용하여 실시간으로 녹음된 패턴의 타이밍을 개선할 수 있습니다.

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Note → Quantize

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Note → Quantize

Track

작업의 트랙을 지정합니다.

설정: All, 1–16

Scene

작업의 Scene을 지정합니다.

설정: 1–8

Start Measure

작업의 시작 소절 위치를 지정합니다.

설정: 001–257

Start Beat

 작업의 시작 박자 위치를 지정합니다.

설정: Time Signature 설정에 따라 다름

Start Clock

작업의 시작 클록 위치를 지정합니다.

설정: Time Signature 설정에 따라 다름
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End Measure

작업의 종료 소절 위치를 지정합니다.

설정: 001–257

End Beat

작업의 종료 박자 위치를 지정합니다.

설정: Time Signature 설정에 따라 다름

End Clock

작업의 종료 클록 위치를 지정합니다.

설정: Time Signature 설정에 따라 다름

Quantize

퀀타이제이션 분해능(또는 퀀타이제이션의 기반으로 사용될 음)을 설정합니다.

설정: 	 32분 음표, 16분 음표의 셋잇단음표, 16분 음표, 8분 음표의 셋잇단음표, 8분 음표, 4분 음표의 셋잇단음표, 4분 음표, 16분 음표 + 16분 

음표의 셋잇단음표, 8분 음표 + 8분 음표의 셋잇단음표

Strength

퀀타이제이션의 “자기 강도”를 설정합니다.

이 파라미터가 100%로 설정된 경우 모든 음이 Quantize에 지정된 위치로 이동합니다. 0% 설정이면 퀀타이제이션이 전혀 존재하지 

않습니다.

설정: 0%–100%

Swing Rate

Quantize에 지정된 값에서 매겨진 짝수 번호 박자(백비트)의 타이밍을 변경하여 리듬에 스윙의 느낌을 더합니다.

설정: 	 Quantize (퀀타이즈 분해능) 설정에 따라 다름

Quantize를 4분 음표, 8분 음표, 16분 음표 또는 16분 음표로 설정한 경우: 0–1/2 그리드

Quantize를 4분 음표의 셋잇단음표, 8분 음표의 셋잇단음표 또는 16분 음표의 셋잇단음표로 설정한 경우: 0–1/2 그리드

Quantize를 8분 음표 + 8분 음표의 셋잇단음표 또는 16분 음표 + 16분 음표의 셋잇단음표로 설정한 경우: 0–1/2 셋잇단음표 그리드

Gate Time

Quantize에 지정된 값에서 매겨진 짝수 번호 박자(백비트)의 게이트 시간(또는 연주할 음의 실제 시간)을 변경하여 리듬에 스윙의 

느낌을 더합니다.

설정: 0%–200%

Execute

MIDI 시퀀스에 선택한 작업을 실시합니다. Pattern Edit 화면의 모든 탭에 대한 공통 작업입니다.
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	� Velocity
지정 범위의 음의 음향 강도(세기)를 변화시킵니다.

주
세기는 다음 식을 사용해 변경됩니다.

조정된 세기 = (본래 세기 × 비율) + 오프셋

결과가 0 이하인 경우 값이 1로 설정됩니다. 결과가 128 이상인 경우 값이 127로 설정됩니다.

작업

[] (재생) 버튼 → Pattern → [EDIT/ ] → Note → Velocity

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Note → Velocity

Set All

선택한 섹션의 모든 음에 대한 세기를 설정합니다.

Off로 설정하면 Set All이 작동하지 않습니다.

Off 이외의 다른 값으로 설정하면 Rate 및 Offset이 비활성화됩니다.

설정: Off, 001–127

Rate

세기를 변경할 때 사용되는 백분율을 설정합니다.

99% 이하로 설정하면 세기가 느려집니다. 101% 이상으로 설정하면 세기가 빨라집니다. 100%에서는 세기가 변함없이 유지됩니다.

Set All을 Off 이외의 다른 값으로 설정하면 이 파라미터를 변경할 수 없습니다.

설정: 0%–200%

Offset

값을 설정하여 본래 세기 값에 더하거나 뺍니다.

−1 이하로 설정하면 세기가 느려집니다. +1 이상으로 설정하면 세기가 빨라집니다. 0으로 설정하면 세기가 변함없이 유지됩니다.

Set All을 Off 이외의 다른 값으로 설정하면 이 파라미터를 변경할 수 없습니다.

설정: −127–0–+127
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	� Gate Time
지정 범위의 음의 시간(게이트 시간)을 변화시킵니다.

주
게이트 시간은 다음 식을 사용해 변경됩니다.

조정된 게이트 시간 = (본래 게이트 시간 × 비율) + 오프셋

결과가 0 이하인 경우 값이 1로 설정됩니다.

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Note → Gate Time

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Note → Gate Time

Set All 설정값이 다르다는 점을 제외하고는 Pattern Edit Note → Velocity와 동일합니다.

Set All

설정: Off, 001–9999
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	� Cresc. (Crescendo)
지정 범위의 음 세기의 점진적 증가(크레센도) 또는 감소(디크레센도)를 적용합니다.

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Note → Cresc.

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Note → Cresc.

Velocity Range

크레센도 또는 디크레센도의 강도를 설정합니다.

최종 세기가 초기 세기 값에 근거하여 "초기 세기 값 + Velocity Range 값"이 되도록 지정 범위 내에서 중간 세기를 점진적으로 증가 또는 

감소시킵니다. 최종 세기가 0 이하인 경우 최종 세기는 1로 설정되고, 최종 세기가 128 이상인 경우 최종 세기는 127로 설정됩니다.

양의 값은 크레센도를 생성하고 음의 값은 디크레센도를 생성합니다.

0에서는 세기가 변하지 않습니다.

설정: −127–0–+127
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	� Transpose
지정된 범위에서 건반 또는 음의 피치를 변경합니다.

주
조옮김되면, C–2~G8을 초과한 범위에 설정된 음은 C–2~G8 내에 들어가도록 자동으로 이동합니다.

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Note → Transpose

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Note → Transpose

Note

조옮김할 때 사용되는 건반(음) 범위를 지정합니다.

탭해 콘텍스트 메뉴를 연 후 Keyboard를 켜짐으로 설정하면 건반을 사용할 수 있습니다.

설정: C−2–G8

Transpose

반음 단위로 이동할 음의 범위를 설정합니다.

+12로 설정하면 1옥타브 위로 조옮김되고 –12로 설정하면 1옥타브 아래로 조옮김됩니다. 값을 0으로 설정하면 변경되지 않습니다.

설정: −127–0–+127



118MODX M 사용설명서

	� Roll
지정된 범위에서 (드럼 롤과 같은) 일련의 반복된 음을 생성합니다.

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Note → Roll

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Note → Roll

Track

설정: 1–16

Start Step

롤의 각 음 사이에서 단계의 크기(즉, 클록 번호)를 설정합니다.

작은 값을 설정하면 더욱 빠른 롤을 연주할 수 있습니다. 여기에서 지정된 클록은 범위 시작 부분에 사용됩니다.

설정: 015–999

End Step

롤의 각 음 사이에서 단계의 크기(즉, 클록 번호)를 설정합니다.

작은 값을 설정하면 더욱 빠른 롤을 연주할 수 있습니다. 여기에서 지정된 클록은 범위 종료 부분에 사용됩니다.

설정: 015–999

Note

롤에 사용되는 음을 설정합니다.

이 부분을 탭해 콘텍스트 메뉴를 연 후 Keyboard를 켜짐으로 설정하면 건반을 사용해 음을 설정할 수 있습니다.

설정: C−2–G8

Start Velocity

롤의 강도에 사용되는 세기를 설정합니다. 여기에서 지정된 세기는 범위 시작 부분에 사용됩니다.

설정: 001–127

End Velocity

롤의 강도에 사용되는 세기를 설정합니다. 여기에서 지정된 세기는 범위 종료 부분에 사용됩니다.

설정: 001–127

주
Start Velocity와 End Velocity를 모두 설정하면 롤에 대한 크레센도 또는 디크레센도를 생성할 수 있습니다.
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Pattern Edit Track

	� Copy/Exchange
지정된 소스 트랙에서 지정된 대상 트랙으로 복사하거나 지정된 두 트랙 간 데이터를 교환합니다.

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Track → Copy/Exchange

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Track → Copy/Exchange

Copy

지정된 트랙에서 다른 트랙으로 데이터를 복사합니다.

주의사항

Copy Track을 실시한 경우 대상 트랙의 기존 데이터는 덮어쓰기되어 

사라집니다.

Exchange

두 트랙 간 데이터를 교환합니다.

Pattern Name *소스

패턴 복사 소스를 지정합니다.

Track *소스

트랙 복사 소스를 지정합니다.

설정: All, 1–16

Scene *소스

Scene 복사 소스를 지정합니다.

설정: All, 1–8

Pattern Name *대상

패턴 복사 대상을 지정합니다.

Track *대상

트랙 복사 대상을 지정합니다.

소스가 All로 설정된 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 1–16

Scene *대상

Scene 복사 대상을 지정합니다.

소스가 All로 설정된 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 1–8

Copy Track

복사 작업을 실시합니다.

주
Track 및 Scene을 All로 설정한 상태에서 Copy Track을 실시하면 체인 

데이터도 복사됩니다.

Exchange Track

교환을 실시합니다.

주
Track 및 Scene을 All로 설정한 상태에서 Exchange Track을 실시하면 

체인 데이터도 복사됩니다.
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	� Mix
지정된 트랙 A와 트랙 B의 데이터를 믹싱(병합)하고 트랙 B에 해당 결과를 배치합니다.

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Track → Mix

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Track → Mix

Pattern Name *소스 A

믹싱할 첫 번째 패턴을 지정합니다.

Track *소스 A

작업의 트랙을 지정합니다.

설정: 1–16

Scene *소스 A

작업의 Scene을 지정합니다.

설정: All, 1–8

Pattern Name *소스 B

믹싱할 첫 번째 패턴을 지정합니다.

Track *소스 B

작업의 트랙을 지정합니다.

설정: 1–16

Scene *소스 B

작업의 Scene을 지정합니다.

소스 A가 All로 설정된 경우에는 이 파라미터를 이용할 수 

없습니다.

설정: 1–8

Pattern Name *대상 B

믹싱할 패턴의 이름을 표시합니다.

Track *대상 B

 작업의 트랙 번호를 표시합니다.

Scene *대상 B

작업의 Scene 번호를 표시합니다.

소스 A가 All로 설정된 경우에는 이 파라미터를 이용할 수 

없습니다.

Mix Track

믹스 작업을 실시합니다.
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	� Append
지정된 트랙의 데이터를 다른 트랙의 끝부분에 추가합니다.

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Track → Append

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Track → Append

Pattern Name *소스

패턴 추가 소스를 지정합니다.

Track *소스

작업의 대상 트랙을 설정합니다.

설정: All, 1–16

Scene *소스

작업의 Scene을 지정합니다.

설정: 1–8

Pattern Name *대상

패턴 추가 대상을 지정합니다.

Track *대상

작업의 대상 트랙을 설정합니다.

소스가 All로 설정된 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 1–16

Scene *대상

작업의 Scene을 지정합니다.

설정: 1–8

Append Track

추가 작업을 실시합니다.



122MODX M 사용설명서

	� Split
지정된 소절에서 지정된 트랙의 데이터를 분리하고 다른 지정된 트랙으로 두 번째 절반 부분을 옮깁니다.

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Track → Append

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Track → Append

Pattern Name *소스

분리할 패턴을 지정합니다.

Track *소스

작업의 대상 트랙을 설정합니다.

설정: All, 1–16

Scene *소스

작업의 대상 Scene을 설정합니다.

설정: 1–8

Measure *소스

데이터가 분리될 소절을 지정합니다.

설정: 2–256

Pattern Name

분리할 패턴을 표시합니다.

Track

작업의 트랙을 표시합니다.

Scene

작업의 Scene을 표시합니다.

Pattern Name *대상

분리 데이터가 전송될 패턴을 지정합니다.

Track *대상

작업의 대상 트랙을 설정합니다.

소스가 All로 설정된 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 1–16

Scene *대상

작업의 대상 Scene을 설정합니다.

설정: 1–8

Spilt Track

분할 작업을 실시합니다.
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	� Clear
지정된 트랙의 데이터를 삭제합니다.

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Track → Clear

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Track → Clear

Pattern Name

삭제할 패턴을 지정합니다.

Track

작업의 트랙을 지정합니다.

설정: All, 1–16

Scene

작업의 Scene을 지정합니다.

설정: All, 1–8

Clear Track

삭제 작업을 실시합니다.

주
Track 및 Scene을 All로 설정한 상태에서 Clear Track을 실시하면 체인 데이터도 복사됩니다.
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	� Divide Drum Tr (Divide Drum Track)
지정된 트랙에서 녹음한 트랙을 취해 각 악기(드럼 세트의 개별 타악기)를 트랙 9~16으로 지정합니다.

주
트랙 9~16 및 파트 9~16에 기존 데이터가 존재할 때 Divide Drum Track 작업을 실시하면 기존 데이터가 덮어쓰기됩니다. Undo 및 Redo를 이 

작업에서는 사용할 수 없습니다.

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Track → Divide Drum Tr

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Track → Divide Drum Tr

Pattern Name

작업의 대상 패턴을 설정합니다.

Track

작업의 대상 트랙을 설정합니다.

설정: 1–16

Divide Drum Track

드럼 트랙 분할 작업을 실시합니다.
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Pattern Edit Song/Event

	� Get Phrase
곡의 특정 섹션을 지정된 트랙으로 복사합니다.

주의사항

복사 대상의 데이터가 덮어쓰기되어 사라집니다.

작업

[] (재생) 버튼 → Pattern → [EDIT/ ] → Song/Event → Get Phrase

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Song/Event → Get Phrase

Song Name

곡 복사 소스를 지정합니다.

Track *소스

작업의 대상 트랙을 설정합니다.

설정: All, 1–16

Start Measure

작업의 대상 시작 소절을 설정합니다.

설정: 001–998

End Measure

작업의 대상 종료 소절을 설정합니다.

설정: 002–999

Pattern Name

패턴 복사 대상을 지정합니다.

Track *대상

트랙 복사 대상을 지정합니다.

소스가 All로 설정된 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 1–16

Scene

Scene 복사 대상을 지정합니다.

설정: 1–8

Get Phrase from Song

프레이즈를 복사합니다.
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	� Put Phrase
지정된 패턴 트랙의 지정된 소절을 지정된 곡 트랙으로 복사합니다.

주
복사된 데이터는 대상 트랙의 기존 데이터에 병합됩니다.

작업

[] (재생) 버튼 → Pattern → [EDIT/ ] → Song/Event → Put Phrase

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Song/Event → Put Phrase

Pattern Name

패턴 복사 소스를 지정합니다.

Track *소스

작업의 대상 트랙을 설정합니다.

설정: 1–16

Scene

작업의 대상 Scene을 설정합니다.

설정: 1–8

Song Name

곡 복사 대상을 지정합니다.

Track *대상

작업의 대상 트랙을 설정합니다.

설정: 1–16

Measure

소절 복사 대상을 지정합니다.

설정: 001–999

Put Phrase to Song

프레이즈를 복사합니다.
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	� Erase Event
이벤트를 삭제합니다.

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Song/Event → Erase Event

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Song/Event → Erase Event

다수의 파라미터가 Pattern Edit Note → Quantize와 동일합니다.

Auto Select

Event Type의 자동 선택을 켜짐 또는 꺼짐으로 전환합니다.

켜짐으로 설정된 경우 데이터를 삭제하려는 컨트롤러만 움직이면 해당 컨트롤러의 이벤트가 Event Type에 대해 자동으로 설정됩니다.

설정: Off, On

Event Type

삭제하려는 이벤트의 형식을 지정합니다.

설정: Note, Poly, CC, NRPN, RPN, PC, AfterTouch, PitchBend, Superknob, SysEx, All

CC Number

Event Type을 CC로 설정한 경우 표시됩니다. 삭제할 이벤트의 컨트롤 변경 번호를 지정합니다.

설정: All, 1–127

Erase Event

이벤트 삭제를 실시합니다.
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	� User Arp (User Arpeggio)
Scene의 지정된 소절에 포함된 데이터를 사용자 아르페지오로 등록합니다.

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Song/Event → User Arp

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Song/Event → User Arp

Scene

작업의 Scene을 지정합니다.

설정: 1–8

Start Measure

작업의 시작 소절 위치를 지정합니다.

설정: 1–256

End Measure

작업의 종료 소절 위치를 지정합니다.

설정: 2–257

Arp (Arp Number)

변환할 사용자 아르페지오의 아르페지오 번호를 설정합니다.

처음에는 사용되지 않은 다음 번호가 설정됩니다.

이미 사용 중인 번호로 변경하는 경우 아르페지오가 덮어쓰기되어 해당 번호에 대한 기존 사용자 아르페지오가 사라지게 됩니다.

설정: 1–256

Category (Arpeggio Category)

Sub Category (Arpeggio Sub Category)

변환된 아르페지오의 메인 및 하위 카테고리를 설정합니다.

설정: Data List 참조

Name (Arpeggio Name)

사용자 아르페지오의 이름을 지정합니다. 최대 20자의 영숫자 문자를 사용할 수 있습니다.

Track

각 아르페지오 트랙에서 변환할 트랙 번호를 설정합니다.

설정: Off, 1–16
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Convert Type

MIDI 시퀀스 데이터를 아르페지오로 변환하는 방법을 선택합니다.

각 아르페지오 트랙별로 다른 Convert Type을 사용할 수 있습니다.

설정: 	 Normal, Fixed, Org Notes

Normal: 아르페지오는 녹음된 MIDI 시퀀스와 동일한 옥타브로 재생됩니다.

Fixed: 건반 연주 방식과는 상관없이 녹음된 MIDI 시퀀스가 재생됩니다.

Org Notes: 기본적으로, Fixed와 동일하나 건반에서 연주하는 코드에 따라 MIDI 시퀀스가 변경됩니다.

Org Notes Root

트랙의 Convert Type을 Org Notes로 설정한 경우 근음을 설정합니다.

Org Notes로 설정된 트랙이 없는 경우에는 이 파라미터를 이용할 수 없습니다.

설정: C−2–G8

Store As User Arp (Store As User Arpeggio)

화면의 설정을 사용하여 사용자 아르페지오로 패턴을 저장합니다.

모든 Track을 Off로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.
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Pattern Edit Play FX (Play Effects)

패턴 재생 중 MIDI 시퀀스에 이펙트를 적용합니다. 지정된 트랙의 각 파라미터에 이펙트의 범위 및 레벨을 설정합니다.

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Play FX

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Play FX

	� 공통

Track

표준화할 트랙을 지정합니다.

설정: All, 1–16

Scene

표준화할 Scene을 지정합니다.

설정: All, 1–8

Normalize Play FX

Play FX에 지정된 이펙트를 MIDI 데이터에 고정시킵니다.

Length

선택한 Scene의 시퀀스 길이를 설정합니다.

Position

Scene 재생 중 현재 위치를 표시하며, 재생 위치를 지정할 수 있습니다.

설정: 001–256
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	� Play FX1
Qntz Value, Qntz Str, Swing Vel, Swing Gate 및 Swing Rate를 제어합니다.

Qntz Value (Quantize Value)

퀀타이제이션 분해능(또는 퀀타이제이션의 기반으로 사용될 음)을 설정합니다.

설정: 	� Off, 60(32분 음표), 80(16분 음표의 셋잇단음표), 120(16분 음표), 160(8분 음표의 셋잇단음표), 240(8분 음표), 320(4분 음표의 

셋잇단음표), 480(4분 음표)

Qntz Str (Quantize Strength)

퀀타이제이션의 “자기 강도”를 설정합니다.

이 파라미터가 100%로 설정된 경우 모든 음이 Qntz Value (Quantize Value)에 지정된 위치로 이동합니다. 0% 설정이면 

퀀타이제이션이 전혀 존재하지 않습니다.

설정: 0%–100%

Swing Vel (Swing Velocity Rate)

Qntz Value (Quantize Value)에 지정된 값에서 매겨진 짝수 번호 박자(백비트)의 세기를 변경하여 리듬에 스윙의 느낌을 더합니다. 

Qntz Value (Quantize Value)를 꺼짐으로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 0%–200%

Swing Gate (Swing Gate Time Rate)

Qntz Value (Quantize Value)에 지정된 값에서 매겨진 짝수 번호 박자(백비트)의 게이트 시간(또는 연주할 음의 실제 시간)을 

변경하여 리듬에 스윙의 느낌을 더합니다. Qntz Value (Quantize Value)를 Off로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 0%–200%

Swing Rate (Swing Offset)

Qntz Value (Quantize Value)에 지정된 값에서 매겨진 짝수 번호 박자(백비트)의 타이밍을 변경하여 리듬에 스윙의 느낌을 더합니다. 

Qntz Value (Quantize Value)를 Off로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 0–1/2 Qntz Value (Quantize Value)
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	� Play FX2
Note Shift, Clock Shift, Gate Time, Velocity Rate 및 Velocity Offset을 제어합니다.

Note Shift

반음 단위로 피치를 조정합니다.

설정: −99–+0–+99

Clock Shift

클록 단위로 음의 타이밍을 앞뒤로 이동합니다.

설정: −120–+0–+120

Gate Time

노트 이벤트의 게이트 시간(생성할 음이 들리기 위한 실제 시간)을 변경합니다.

설정: 0%–200%

Velocity Rate

지정된 백분율만큼 세기를 변경합니다.

설정: 0%–200%

Velocity Offset

지정된 값만큼 세기를 증가 또는 감소시킵니다.

설정: −99–+0–+99
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Pattern Edit Chain

Scene을 체인 형태로 연결하여 재생합니다.

작업 

[] (재생) 버튼 → Pattern → [EDIT/ ] → Chain

[PERFORMANCE (HOME)] → Play/Rec → Pattern → Edit/Job → Chain

Chain

체인 재생을 활성화합니다.

설정: Off, On

Measure

Scene을 재생할 시작 소절 위치를 지정합니다.

설정: 001–999

Scene

지정된 Measure에서 재생할 Scene을 설정합니다.

설정: 1–8, End

Page

Measure 및 Scene 목록이 8열 이상인 경우 위/아래 화살표가 표시됩니다.

Convert to Song

체인을 곡으로 저장합니다.

Length

전체 시퀀스의 길이를 표시합니다.

Position

체인 재생의 현재 위치를 표시하며, 재생 위치를 지정할 수 있습니다.

설정: 001–999
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Song

Song 화면에서 MIDI 곡의 건반 연주를 녹음하고 해당 곡을 재생할 수 있습니다.

건반 연주와 컨트롤러 및 노브 작동에 대한 데이터 모두 MIDI 트랙으로 녹음됩니다.

곡에 녹음할 아르페지오 재생도 선택할 수 있습니다.

	� 재생 및 재생 대기

작업 

[SONG/PATTERN] 버튼 → Song

[PERFORMANCE (HOME)] → Play/Rec → Song

[] (재생) 버튼 → Song

(1)

(2)

(3)

(1)	Link Icon

(2)	Song Length 

(3)	Track Play Switch

Song Name

선택한 Scene의 이름을 표시합니다.

탭하면 Load, Rename, New Song 및 User Arp에 대한 콘텍스트 메뉴가 표시됩니다.

Song Name에 커서가 놓여 있을 때 [INC/YES] 및 [DEC/NO] 버튼을 사용하면 곡을 선택할 수 있습니다.

Performance Name

선택한 퍼포먼스의 이름을 표시합니다.

주
퍼포먼스의 파라미터를 변경하면 Performance Name의 우측 상단에 파란색 플래그가 나타납니다.

Link Icon

Link Icon은 곡 녹음에 사용된 퍼포먼스와 선택한 퍼포먼스가 동일한 경우 표시됩니다. 그렇지 않은 경우 Link Icon이 표시됩니다.

Click Settings

Tempo Settings 화면을 불러옵니다.

Time Signature

패턴의 미터를 표시합니다.
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Position

재생 및 녹음 시작 위치와 현재 재생 위치를 설정합니다.

좌측에 표시된 숫자는 소절이며 우측에 표시된 숫자는 박자 및 틱입니다.

Tempo

곡 재생 템포를 설정합니다.

설정: 5–300

Loop

루프 재생을 켜짐 또는 꺼짐으로 설정합니다.

켜짐으로 설정한 경우 Loop Start와 Loop End 지점 간 섹션의 재생이 반복됩니다.

설정: Off, On

Loop Start

Loop End

루프 재생에 대한 섹션을 설정합니다. 좌측에 표시된 숫자는 소절이며 우측에 표시된 숫자는 박자입니다. Loop가 꺼짐으로 설정된 

경우에는 이 파라미터를 이용할 수 없습니다.

Store Song & Perf Settings (Store Song and Performance Settings)

편집한 곡과 사용한 퍼포먼스 간의 연결을 저장합니다.

주
퍼포먼스 파라미터를 편집한 경우 퍼포먼스도 저장해야 합니다.

Save As .mid File

이 버튼을 누르면 Save 화면이 표시되어 곡을 파일로 저장할 수 있게 됩니다.

다음 상황에서는 이용할 수 없습니다.

•	 새로 녹음하는 경우(곡이 존재하지 않는 경우)

•	 재생 중

•	 녹음 대기 모드가 활성화될 때

•	 녹음 중

Song Length

전체 시퀀스의 길이를 표시합니다.

Track Play Switch

각 트랙의 재생을 켜거나 끕니다.

설정: Off, On
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	� 녹음 및 녹음 대기
작업

[SONG/PATTERN] 버튼 → Song → [] (녹음) 버튼

[PERFORMANCE (HOME)] → Play/Rec → Song → [] (녹음) 버튼

새 녹음

이미 녹음된 데이터가 있는 경우

Time Signature

곡의 미터를 표시합니다.

설정: 1/16–16/16, 1/8–16/8, 1/4–8/4

Rec Quantize

퀀타이즈는 녹음한 음이 (음 값에서) 박자의 정확한 부분이 되도록 교정하는 기능합니다.

설정: 	� Off, 60(32분 음표), 80(16분 음표의 셋잇단음표), 120(16분 음표), 160(8분 음표의 셋잇단음표), 240(8분 음표), 320(4분 음표의 

셋잇단음표), 480(4분 음표)



137MODX M 사용설명서

Record Type

이미 녹음된 트랙의 녹음 형식을 선택합니다.

새로 녹음하는 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 	 Replace, Overdub, Punch

Replace: 실시간으로 덮어쓰고 녹음합니다. 기존 데이터가 사라집니다.

Overdub: 실시간으로 겹쳐쓰고 녹음합니다. 기존 데이터가 사라지지 않습니다.

Punch: 섹션을 다시 녹음하고 실시간으로 녹음합니다. 그러면 지정된 섹션의 기존 데이터가 덮어쓰기 됩니다.

Punch In

Punch in 지점(재녹음을 시작할 특정 소절 및 박자)을 설정합니다.

Record Type을 Punch로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

Punch Out

Punch out 지점(재녹음을 종료할 특정 소절 및 박자)을 설정합니다.

Record Type을 Punch로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

Arp Rec

켜짐으로 설정하면 아르페지오 재생 결과가 녹음됩니다. 꺼짐으로 설정하면 건반 연주만 녹음됩니다.

새로운 곡을 녹음할 때 이 파라미터를 설정할 수 있습니다. 녹음 후에는 설정을 변경할 수 없습니다.

Arp Rec가 꺼짐으로 설정된 녹음곡에 추가할 사항이 있는 경우 Replace만 Record Type에 사용할 수 있습니다.

설정: Off, On

주
Arp Rec가 꺼짐으로 설정된 곡의 경우 퍼포먼스의 아르페지오 선택 사항을 변경하여 재생할 다른 아르페지오를 선택할 수 있습니다.

Undo Media Record

이전 작업을 취소하고 이전 상태로 돌아갑니다.

시퀀스가 녹음된 후 1개 이상의 작업이 사용된 경우 이 버튼을 이용할 수 있습니다.

Redo Media Record

Undo Media Record를 통해 취소된 녹음을 복원합니다. Undo Media Record가 사용될 때 활성화됩니다.
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Put Track to Arpeggio

사용자 아르페지오로 선택한 곡을 변환합니다.

최대 16개의 음을 변환할 수 있습니다. (음 번호가 동일한 모든 음은 하나로 산정됩니다.)

특히 다수의 트랙을 사용할 때 사용자 아르페지오로 변환하려는 경우에는 반드시 곡에 최대 16개의 음만 사용하십시오.

작업 

[SONG/PATTERN] 버튼 → Play/Rec → Song → Song Name을 탭해 콘텍스트 메뉴 열기 → User Arp

Arp (Arpeggio Number)

변환할 사용자 아르페지오의 아르페지오 번호를 설정합니다.

처음에는 사용되지 않은 다음 번호가 설정됩니다.

이미 사용 중인 번호로 변경하는 경우 아르페지오가 덮어쓰기되어 해당 번호에 대한 기존 사용자 아르페지오가 사라지게 됩니다.

설정: 1–256

Category (Arpeggio Category)

Sub Category (Arpeggio Sub Category)

변환된 아르페지오의 메인 및 하위 카테고리를 설정합니다.

설정: Data List 참조

Name (Arpeggio Name)

아르페지오 이름을 설정합니다. 최대 20자의 영숫자 문자를 사용할 수 있습니다.

Song Track

각 아르페지오 트랙마다 변환할 곡의 트랙 번호를 설정합니다.

설정: Off, 1–16
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Convert Type

3가지 설정을 통해 곡에 녹음된 MIDI 시퀀스를 아르페지오로 변환하는 방법을 설정합니다.

각 아르페지오 트랙별로 다른 Convert Type을 사용할 수 있습니다.

설정: 	 Normal, Fixed, Org Notes

Normal: 아르페지오는 녹음된 MIDI 시퀀스와 동일한 옥타브로 재생됩니다.

Fixed: 건반 연주 방식과는 상관없이 녹음된 MIDI 시퀀스가 재생됩니다.

Org Notes: 기본적으로, Fixed와 동일하나 건반에서 연주하는 코드에 따라 MIDI 시퀀스 재생이 변경됩니다.

Org Notes Root (Original Notes Root)

트랙의 Convert Type을 Org Notes로 설정한 경우 근음을 설정합니다.

Org Notes로 설정된 트랙이 없는 경우에는 이 파라미터를 이용할 수 없습니다.

설정: C−2–G8

Start Measure

변환 시작 소절을 설정합니다.

설정: 1–998

End Measure

변환 종료 소절을 설정합니다.

설정: 2–999

Store As User Arp

이 화면에 지정된 설정을 사용하여 사용자 아르페지오로 곡을 변환합니다.

이 버튼은 모든 트랙이 꺼짐으로 설정된 경우 비활성화됩니다.
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Audio

Audio 화면에서 .wav (44.1kHz, 24비트 스테레오) 형식의 오디오 파일로 건반 연주를 USB 플래시 드라이브에 녹음할 수 있습니다. 

최대 녹음 시간은 74분 또는 녹음기의 용량까지입니다.

	� 재생 및 재생 대기

작업

[SONG/PATTERN] 버튼 → Audio

[PERFORMANCE (HOME)] → Play/Rec → Audio

[] (재생) 버튼 → Audio

Audio Name

선택한 오디오 파일의 이름을 표시합니다.

탭하면 Load에 대한 콘텍스트 메뉴가 표시됩니다.

Position

재생 시작 위치와 현재 재생 위치를 설정합니다.

Audio Volume

재생 시작 위치를 설정합니다. 녹음 중에는 이 파라미터를 이용할 수 없습니다.

설정: 0–255

Audio Length

오디오 파일의 전체 길이를 표시합니다.

레벨 미터

오디오 입력 및 출력 레벨을 표시합니다.
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	� 녹음 및 녹음 대기

작업

[PERFORMANCE (HOME)] → Play/Rec → Audio → [] (녹음) 버튼

Recordable (Audio Recordable Time)

오디오 녹음 가능 시간을 표시합니다. 녹음 대기 모드가 활성화된 경우에만 이 파라미터가 표시됩니다.

Trigger Level

녹음 시작 방법을 선택합니다. 녹음 대기 모드가 활성화된 경우에만 이 파라미터가 표시됩니다.

설정: 	 manual, 1–127

manual: [] (재생) 버튼을 눌러 녹음을 시작합니다.

1–127: [] (재생) 버튼을 누른 후 설정된 값을 초과하는 신호가 입력되면 녹음이 시작됩니다. 여기에서 설정한 레벨은 레벨 미터에 파란색 

삼각형으로 표시됩니다.

주
최고의 결과를 얻으려면 Trigger Level을 가능한 한 낮게, 그러나 원하지 않는 소음이 녹음될 정도로 낮지는 않게 설정하여 전체 신호를 포착해야 합니다.
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Smart Morph

Play

Smart Morph 맵을 탭하고 파트 1의 FM-X 음향 또는 AN-X 음향을 변경합니다.

작업

[PERFORMANCE (HOME)] → Smart Morph → Play
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Edit

작업

[PERFORMANCE (HOME)] → Smart Morph → Edit

사용하지 않은 파트

탭하면 FM-X 음향 또는 AN-X 음향을 선택할 수 있는 Part Category Search 화면이 열립니다.

사용 중인 파트

탭하면 Category Search, Edit, Property 등에 대한 콘텍스트 메뉴가 표시됩니다.

Display

각 파트에 대해 Part Main Category 보기 또는 Part Name 보기를 선택합니다.

Mode

FM-X와 AN-X를 서로 전환합니다.

설정: FM-X, AN-X

Learn

버튼을 탭해 머신 러닝을 시작합니다(맵 생성).

이 버튼은 파트 9~16에 FM-X 음향이나 AN-X 음향이 없을 때 표시되지 않습니다.

Undo

Redo

Learn 작업을 실시한 후 Undo 버튼이 우측 상단에 표시됩니다.

Undo 버튼을 사용하여 머신 러닝을 사용하기 전에 본래 맵을 복원합니다.

Undo 작업을 실시한 후에는 Redo 버튼이 나타나 Undo 작업 전에 이 버튼을 통해 맵을 복원할 수 있게 됩니다.
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Analyze

작업

[PERFORMANCE (HOME)] → Smart Morph → Analyze

Red

맵의 각 점은 빨간색의 음영으로 정도나 레벨을 보여주는 파라미터 값을 의미합니다.

Green

맵의 각 점은 녹색의 음영으로 정도나 레벨을 보여주는 파라미터 값을 의미합니다.

Blue

맵의 각 점은 파란색의 음영으로 정도나 레벨을 보여주는 파라미터 값을 의미합니다.

주
이용 가능한 Red, Green 및 Blue 파라미터의 목록은 "Red, Green 및 Blue에 대해 설정할 수 있는 파라미터"를 참조합니다.

Coloring

Auto로 설정되면 Red, Green 및 Blue는 Learn 프로세스에 대해 자동으로 재설정됩니다.

Manual로 설정되면 Red, Green 및 Blue는 Learn 프로세스에 대해 자동으로 재설정되지 않습니다.

설정: Auto, Manual

Learn

버튼을 탭해 머신 러닝을 시작합니다(맵 생성).

Undo

Redo

Learn 작업을 실시한 후 Undo 버튼이 우측 상단에 표시됩니다.

Undo 버튼을 사용하여 머신 러닝을 사용하기 전에 본래 맵을 복원합니다.

Undo 작업을 실시한 후에는 Redo 버튼이 나타나 Undo 작업 전에 이 버튼을 통해 맵을 복원할 수 있게 됩니다.
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	� Red, Green 및 Blue에 대해 설정할 수 있는 파라미터

•	 FM Common

화면 이름 파라미터 이름

Random Pan Depth Random Pan Depth

Alternate Pan Alternate Pan Depth

Scaling Pan Depth Scaling Pan Depth

KeyOnDly Time Key On Delay Time Length

KeyOnDly Sync Key On Delay Tempo Sync Switch

KeyOnDly Note Key On Delay Note Length

Pitch/Vel Pitch Velocity Sensitivity

Random Pitch Depth Random Pitch Depth

Pitch/Key Pitch Key Follow Sensitivity

Pitch/Key Center Pitch Key Follow Sensitivity Center Note

PEG Initial Lvl PEG Initial Level

PEG Attack Lvl PEG Attack Level

PEG Decay 1 Lvl PEG Decay 1 Level

PEG Decay 2 Lvl PEG Decay 2 Level

PEG Release Lvl PEG Release Level

PEG Attack Tm PEG Attack Time

PEG Decay 1 Tm PEG Decay 1 Time

PEG Decay 2 Tm PEG Decay 2 Time

PEG Release Tm PEG Release Time

PEG Depth/Vel PEG Depth Velocity Sensitivity

PEG Depth PEG Depth

PEG Time/Key PEG Time Key Follow Sensitivity

2nd LFO Wave 2nd LFO Wave

LFO Speed 2nd LFO Speed

LFO Phase 2nd LFO Phase

LFO Delay 2nd LFO Delay Time

LFO Key On Reset 2nd LFO Key On Reset

LFO Pitch Mod 2nd LFO Pitch Modulation Depth

LFO Amp Mod 2nd LFO Amp Modulation Depth

LFO Filter Mod 2nd LFO Filter Modulation Depth

Algorithm Number Algorithm Number

Feedback Level Feedback Level

LFO Speed Range LFO Speed Range

LFO Ex Speed LFO Extended Speed

Filter Type Filter Type

Cutoff Filter Cutoff Frequency

Cutoff/Vel Filter Cutoff Velocity Sensitivity

Resonance / Width Filter Resonance/Width

Res/Vel Resonance Velocity Sensitivity

HPF Cutoff HPF Cutoff Frequency
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화면 이름 파라미터 이름

Distance Distance

Filter Gain Filter Gain

FEG Hold Tm FEG Hold Time

FEG Attack Tm FEG Attack Time

FEG Decay 1 Tm FEG Decay 1 Time

FEG Decay 2 Tm FEG Decay 2 Time

FEG Release Tm FEG Release Time

FEG Hold Lvl FEG Hold Level

FEG Attack Lvl FEG Attack Level

FEG Decay 1 Lvl FEG Decay 1 Level

FEG Decay 2 Lvl FEG Decay 2 Level

FEG Release Lvl FEG Release Level

FEG Depth FEG Depth

FEG Segment FEG Time Velocity Sensitivity Segment

FEG Time/Vel FEG Time Velocity Sensitivity

FEG Depth/Vel FEG Depth Velocity Sensitivity

FEG Curve FEG Depth Velocity Sensitivity Curve

FEG Time/Key FEG Time Key Follow Sensitivity

FEG Center FEG Time Key Follow Sensitivity Center Note

Flt Cutoff/Key Filter Cutoff Key Follow Sensitivity

Flt Break Point 1 Filter Cutoff Scaling Break Point 1

Flt Break Point 2 Filter Cutoff Scaling Break Point 2

Flt Break Point 3 Filter Cutoff Scaling Break Point 3

Flt Break Point 4 Filter Cutoff Scaling Break Point 4

Flt Cutoff Offset 1 Filter Cutoff Scaling Offset 1

Flt Cutoff Offset 2 Filter Cutoff Scaling Offset 2

Flt Cutoff Offset 3 Filter Cutoff Scaling Offset 3

Flt Cutoff Offset 4 Filter Cutoff Scaling Offset 4

HPF Cutoff/Key HPF Cutoff Key Follow Sensitivity

•	 오퍼레이터

화면 이름 파라미터 이름

Key On Reset Oscillator Key On Reset

Freq Mode Oscillator Frequency Mode

Coarse Tune Coarse

Fine Tune Fine

Detune Detune

Pitch/Key Pitch Key Follow Sensitivity

Pitch/Vel Pitch Velocity Sensitivity

Spectral Spectral Form

Skirt Spectral Skirt

Resonance Spectral Resonance
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화면 이름 파라미터 이름

PEG Initial Lvl PEG Initial Level

PEG Attack Lvl PEG Attack Level

PEG Attack Tm PEG Attack Time

PEG Decay Tm PEG Decay Time

AEG Attack Lvl AEG Attack Level

AEG Decay 1 Lvl AEG Decay 1 Level

AEG Decay 2 Lvl AEG Decay 2 Level

AEG Release Lvl AEG Release (Hold) Level

AEG Attack Tm AEG Attack Time

AEG Decay 1 Tm AEG Decay 1 Time

AEG Decay 2 Tm AEG Decay 2 Time

AEG Release Tm AEG Release Time

AEG Hold Tm AEG Hold Time

AEG Time/Key AEG Time Key Follow Sensitivity

Level Operator Level

Lvl Break Point Level Scaling Break Point

Lvl/Key Lo Level Scaling Low Depth

Lvl/Key Hi Level Scaling High Depth

Curve Lo Level Scaling Low Curve

Curve Hi Level Scaling High Curve

Level/Vel Level Velocity Sensitivity

LFO PM Depth 2nd LFO Pitch Modulation Depth Offset

LFO AM Depth 2nd LFO Amplitude Modulation Depth Offset

Pitch/Ctrl Pitch Controller Sensitivity

Level/Ctrl Level Controller Sensitivity

•	 AN-X 공통

화면 이름 파라미터 이름

Random Pan Random Pan Depth

Alternate Pan Alternate Pan Depth

Scaling Pan Scaling Pan Depth

Delay Length Key On Delay Time Length

KeyOnDly Sync Key On Delay Tempo Sync Switch

Delay Length Key On Delay Note Length

Unison Unison

Unison Detune Unison Detune

Unison Spread Unison Spread

OSC Reset OSC Reset

Voltage Drift Voltage Drift

Ageing Ageing

Attack Pitch EG Attack Time

Decay Pitch EG Decay Time
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화면 이름 파라미터 이름

Sustain Pitch EG Sustain Level

Release Pitch EG Release Time

Time/Vel Pitch EG Time Velocity Sensitivity

Wave Pitch LFO Wave

Speed Pitch LFO Speed

Key On Reset Pitch LFO Key On Reset

Phase Pitch LFO Phase

Delay Pitch LFO Delay Time

Fade In Pitch LFO Fade In Time

Noise Tone Noise Generator Tone

Connect Noise Generator Out Select

Out Level Noise Generator Out Level

Out Level/Vel Noise Generator Out Level Velocity Sensitivity

Attack Filter Cutoff EG Attack Time

Decay Filter Cutoff EG Decay Time

Sustain Filter Cutoff EG Sustain Level

Release Filter Cutoff EG Release Time

Time/Vel Filter Cutoff EG Time Velocity Sensitivity

Wave Filter Cutoff LFO Wave

Speed Filter Cutoff LFO Speed

Key On Reset Filter Cutoff LFO Key On Reset

Phase Filter Cutoff LFO Phase

Delay Filter Cutoff LFO Delay Time

Fade In Filter Cutoff LFO Fade In Time

Level Amplitude Level

Level/Vel Amplitude Level Velocity Sensitivity

LFO Depth Amplitude Level LFO Depth

Level/Key Amplitude Level Key Follow

Drive Amplitude Saturator Drive

Attack Amplitude EG Attack Time

Decay Amplitude EG Decay Time

Sustain Amplitude EG Sustain Level

Release Amplitude EG Release Time

Time/Vel Amplitude EG Time Velocity Sensitivity

Wave Amplitude LFO Wave

Speed Amplitude LFO Speed

Key On Reset Amplitude LFO Key On Reset

Phase Amplitude LFO Phase

Delay Amplitude LFO Delay Time

Fade In Amplitude LFO Fade In Time
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•	 오실레이터

화면 이름 파라미터 이름

Wave Oscillator Wave

Octave Oscillator Octave

Pitch Oscillator Pitch

Pitch EG Depth Oscillator Pitch EG Depth

Pitch EG Depth/Vel Oscillator Pitch EG Depth Velocity Sensitivity

Pitch LFO Depth Oscillator Pitch LFO Depth

Sync Pitch Oscillator Self Sync Pitch

Sync Pitch/Vel Oscillator Self Sync Pitch Velocity Sensitivity

Sync Oscillator Self Sync EG Depth

Sync Oscillator Self Sync LFO Depth

Pulse Width Oscillator Pulse Width

PulseWidth/Vel Oscillator Pulse Width Velocity Sensitivity

Pulse Width Oscillator Pulse Width EG Depth

Pulse Width Oscillator Pulse Width LFO Depth

Shaper Oscillator Wave Shaper

Shaper/Vel Oscillator Wave Shaper Velocity Sensitivity

Shaper Oscillator Wave Shaper EG Depth

Shaper Oscillator Wave Shaper LFO Depth

FM Level Oscillator FM Level

FM Level/Vel Oscillator FM Level Velocity Sensitivity

Ring Level Oscillator Ring Level

Ring Level/Vel Oscillator Ring Level Velocity Sensitivity

Connect Oscillator Out Select

Invert Oscillator Out Invert Enable

Out Level Oscillator Out Level

Out Level/Vel Oscillator Out Level Velocity Sensitivity

Attack Oscillator EG Attack Time

Decay Oscillator EG Decay Time

Sustain Oscillator EG Sustain Level

Release Oscillator EG Release Time

Wave Oscillator LFO Wave

Speed Oscillator LFO Speed

Key On Reset Oscillator LFO Key On Reset

Phase Oscillator LFO Phase

Delay Oscillator LFO Delay Time

Fade In Oscillator LFO Fade In Time
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•	 필터

화면 이름 파라미터 이름

Type Filter Type

Cutoff Filter Cutoff

Cutoff/Vel Filter Cutoff Velocity Sensitivity

Filter EG Depth Filter Cutoff EG Depth

Filter EG Depth/Vel Filter Cutoff EG Depth Velocity Sensitivity

Filter LFO Depth Filter Cutoff LFO Depth

Cutoff/Key Filter Cutoff Key Follow

Resonance Filter Resonance

Resonance/Vel Filter Resonance Velocity Sensitivity

Saturator Drive Filter Saturator Drive

Saturator Drive/... Filter Saturator Drive Velocity Sensitivity

Out Level Filter Out Level

•	 모디파이어

화면 이름 파라미터 이름

Wave Folder Modifier Wave Folder

Folder/Vel Modifier Wave Folder Velocity Sensitivity

EG Depth Modifier Wave Folder EG Depth

LFO Depth Modifier Wave Folder LFO Depth

Texture Modifier Wave Folder Texture

Type Modifier Wave Folder Type

Attack Modifier EG Attack Time

Decay Modifier EG Decay Time

Sustain Modifier EG Sustain Level

Release Modifier EG Release Time

Time/Vel Modifier EG Time Velocity Sensitivity

Wave Modifier LFO Wave

Speed Modifier LFO Speed

Key On Reset Modifier LFO Key On Reset

Phase Modifier LFO Phase

Delay Modifier LFO Delay Time

Fade In Modifier LFO Fade In Time
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Super Knob

작업

[PERFORMANCE (HOME)] → Smart Morph → Super Knob

Super Knob Link

켜짐으로 설정하면 손가락으로 터치스크린을 조작하지 않고 시작 지점부터 종료 지점까지 맵의 경로를 따라갈 수 있도록 수퍼 노브를 

사용할 수 있습니다.

설정: Off, On

Start

맵에 가장 작은 수퍼 노브 값의 위치를 설정합니다.

Start에 커서가 놓여 있으면 맵을 탭해 시작 지점에 대한 값을 설정합니다.

End

맵에 가장 큰 수퍼 노브 값의 위치를 설정합니다.

End에 커서가 놓여 있으면 맵을 탭해 종료 지점에 대한 값을 설정합니다.

Waypoints

시작 지점과 종료 지점 간 삽입 지점(중간 지점)의 수를 설정합니다.

설정: 0–6

Waypoint 1–Waypoint 6

맵에 위치를 설정합니다.
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Job

작업

[PERFORMANCE (HOME)] → Smart Morph → Job

Load Smart Morph

Load 화면을 엽니다.

Load 화면에서 다른 퍼포먼스를 선택한 후 이 퍼포먼스에서 현재 퍼포먼스로 Smart Morph 설정을 가져올 수 있습니다.

Delete Smart Morph

선택한 퍼포먼스에서 Smart Morph 설정을 삭제합니다.

Delete Part 9–16

모든 파트 9~16을 한 번에 삭제하여 이러한 파트를 미사용 상태로 설정합니다.

파트 9~16은 Smart Morph 맵을 생성할 때 사용됩니다.

파라미터 조정을 완료하여 맵을 더 이상 사용할 필요가 없다면 파트 9~16을 삭제해도 됩니다.
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Common Edit 화면

Common Edit 화면에서 전체 퍼포먼스의 파라미터와 오디오 파트의 파라미터를 편집할 수 있습니다.

General/Pitch

Perf Settings

Perf Settings 화면에서 퍼포먼스의 일반 파라미터를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → General/Pitch → Perf Settings

Main Category
Sub Category
선택한 퍼포먼스의 메인 카테고리와 하위 카테고리를 설정합니다.

설정: Data List 참조

Performance Name
현재 선택한 퍼포먼스의 이름입니다. 최대 20자의 영숫자 문자를 사용할 수 있습니다.

Volume (Performance Volume)
선택한 퍼포먼스의 음량을 설정합니다.

설정: 0–127

Pan (Performance Pan)
현재 선택되어 있는 퍼포먼스의 팬 위치(스테레오 위치)를 조정합니다.

설정: L63–C(중앙)–R63
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Var Return (Variation Return)
변주 이펙트로 처리된 신호의 출력 레벨(리턴 레벨)을 설정합니다.

설정: 0–127

Rev Return (Reverb Return)
리버브 이펙트로 처리된 신호의 출력 레벨(리턴 레벨)을 설정합니다.

설정: 0–127

MC Flag (Motion Control Flag)
현재 선택한 퍼포먼스에 MC(Motion Control) 플래그를 설정합니다.

켜짐으로 설정한 경우 MC가 Performance 화면(HOME)에 나타나고 Performance Category Search 화면의 MC 속성에 의해 

필터링이 실시됩니다.

설정: Off, On

Portamento Master Sw (Portamento Master Switch)
Portamento Part Sw가 켜짐으로 설정된 파트의 포르타멘토를 켜짐 또는 꺼짐으로 설정합니다.

이 스위치는 상단 패널의 [PORTAMENTO] 버튼과 연결되어 있습니다.

설정: Off, On

Portamento Time
파트에 포르타멘토의 피치 이동에 대한 시간 길이(또는 속도)를 설정합니다.

이 파라미터는 파트 포르타멘토 시간의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63
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USB Monitor

USB Monitor 화면의 USB [TO HOST] 단자에서 전송되는 오디오 신호 입력의 음량을 조정합니다.

Audio Signal Flow의 USB Volume을 탭하면 커서가 Audio I/O 화면에서 USB Volume으로 움직입니다.

주
USB Main Monitor Volume은 퍼포먼스에 저장됩니다.

작업

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → General/Pitch → USB Monitor

Monitor Volume Main
USB [TO HOST] 단자에서 입력되고 OUTPUT 잭으로 출력되는 오디오 신호의 음량을 조정합니다.

설정: 0–127

Audio Settings
탭해서 Utility Audio I/O 화면을 엽니다.

[UTILITY] → Settings → Audio I/O에서도 동일한 화면을 열 수 있습니다.
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Pitch

Pitch 화면에서 피치 설정을 실시할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → General/Pitch → Pitch

[SHIFT] + [PORTAMENTO]

	� Note Shift / Detune

Part
Part 1~8과 Part 9~16의 보기를 서로 전환합니다.

Detune
파트의 피치를 0.1Hz 단위로 조정합니다.

피치를 약간 이동하면 음향을 디튠 처리할 수 있습니다.

설정: −12.8Hz–+0.0Hz–+12.7Hz

Shift (Note Shift)
파트의 피치를 반음 단위로 조정합니다.

설정: −24–+0–+24

Perf Note Shift (Performance Note Shift)
모든 파트의 피치를 반음 단위로 조정합니다.

설정: −24–+0–+24
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	� Pitch Bend / Mono

드럼 파트에는 Mono / Poly가 표시되지 않습니다.

Edit Control Assign
Common Edit Control Assign 화면이 열립니다.

Group (Pitch Control Group)
동일한 그룹에 지정된 파트에는 동일한 피치가 설정됩니다.

따라서 레이어 음향에 포르타멘토를 적용하거나 다중 파트를 한꺼번에 동일하게 미세 튜닝하려는 경우 편리합니다.

Lower (Pitch Bend Lower)
Upper (Pitch Bend Upper)
피치 벤드 휠로 생성한 변경 범위를 반음 단위로 설정합니다.

설정: −48–+0–+24

Mono / Poly
건반의 톤 생성 모드를 설정합니다.

Mono는 하나의 음만 연주할 때 사용되고 Poly는 동시에 여러 음을 연주할 때 사용됩니다.

설정: Mono, Poly
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	� Portamento

Sw, Mode, Time 및 Time Mode는 드럼 파트에 표시되지 않습니다.

Master Sw (Portamento Master Switch)
Sw (Portamento Part Switch)가 켜짐으로 설정된 파트의 포르타멘토를 켜짐 또는 꺼짐으로 설정합니다.

이 스위치는 상단 패널의 [PORTAMENTO] 버튼과 연결되어 있습니다.

설정: Off, On

Time (Portamento Time)
파트에 포르타멘토의 피치 이동에 대한 시간 길이(또는 속도)를 설정합니다.

이 파라미터는 파트 포르타멘토 시간의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

Sw (Portamento Part Switch)
파트의 포르타멘트를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Portamento Mode
건반 연주에 따른 포르타멘토 적용 방식을 설정합니다.

설정: 	 Fingered, Full-time

Fingered: 레가토(이전의 건반에서 손을 떼기 전에 다음 음을 연주하는 것)를 연주할 때에만 포르타멘토가 적용됩니다.

Full-time: 포르타멘토가 항상 적용됩니다.

Time (Portamento Part Time)
파트에 포르타멘토의 피치 이동에 대한 시간 길이(또는 속도)를 설정합니다.

설정: 0–127

Time Mode (Portamento Time Mode)
시간 경과에 따라 피치가 변하는 방식을 설정합니다.

설정: 	 Rate 1, Time 1, Rate 2, Time 2

Rate 1: 피치가 지정된 속도로 변경됩니다.

Time 1: 피치가 지정된 시간에 변경됩니다.

Rate 2: 피치가 한 옥타브 안에서 지정된 속도로 변경됩니다.

Time 2: 피치가 한 옥타브 안에서 지정된 시간에 변경됩니다.
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	� Micro Tuning

드럼 파트에는 Micro Tuning Name 및 Root가 표시되지 않습니다.

Edit Global Tuning
Utility 화면의 Settings → Sound를 엽니다.

Edit User Tuning
User Micro Tuning 설정 창을 엽니다.

•	 Tuning No. (Micro Tuning Number)

선택한 사용자 미세 튜닝 번호를 표시합니다.

설정: 1–8

•	 Tuning Name (Micro Tuning Name)

새 이름으로 User Micro Tuning을 저장할 수 있습니다. 최대 20자의 영숫자 문자를 사용할 수 있습니다.

•	 C, C#, D, D#, E, F, F#, G, G#, A, A#, B

각 음의 피치를 cent 단위로 조정하여 미세 튜닝을 설정할 수 있습니다.

설정: −99–+0–+99

•	 Initialize

선택한 사용자 미세 튜닝을 초기화합니다.
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Micro Tuning Name
파트의 미세 튜닝(평균율)을 설정합니다. 각 설정에 대한 설명은 아래 표를 참조합니다.

설정: 	 Equal Temperament, Pure Major, Pure Minor, Werckmeister, Kirnberger, Vallotti & Young, 1/4 shift, 1/4 tone, 1/8 tone, 

Indian, Arabic 1, Arabic 2, Arabic 3

Init Tuning 1–8 (유저 뱅크를 선택한 경우)

Library 1–1 – 24–8 (라이브러리 파일을 불러오는 경우) 

Equal Temperament 크기가 동일한 12개의 간격으로 각 옥타브가 나누어집니다. 이 음계는 현대 음악에서 가장 많이 사용되는 
방법입니다.

Pure Major

Pure Minor

이 음계는 특히 3화음(근음, 3도, 5도)에서 각 음계의 순수한 수치 간격을 유지합니다.
합창 및 a cappella 합창 등 실제 음성 하모니에서 가장 잘 들을 수 있습니다.

Werckmeister

Kirnberger

Vallotti & Young

각 음계는 중전음률과 피타고라스식 음계를 결합한 것입니다. 이 음계의 주요 특징은 각 건반마다 고유한 
특성을 갖추고 있다는 점입니다.
이 음계는 바흐 및 베토벤 시대에 사용되었으며, 현재는 하프시코드 등의 그 시대의 악기로 음악을 연주할 때 
사용됩니다.

1/4 shift 50센트 위로 이동시킨 동음 평균 음계입니다.
동음 평균율로 이 설정을 믹싱하면 음악에 긴장감을 생성할 수 있습니다.

1/4 tone 옥타브당 균등한 공간을 두고 떨어져 있는 24개의 음입니다.
한 옥타브가 24개의 건반으로 구성되어 있습니다.

1/8 tone 옥타브당 균등한 공간을 두고 떨어져 있는 48개의 음입니다.
한 옥타브가 48개의 건반으로 구성되어 있습니다.

Indian 일반적으로 인도 음악에서 볼 수 있습니다.
흰 건반만 연주합니다.

Arabic 일반적으로 아라비아 음악에서 볼 수 있습니다.

Root (Micro Tuning Root)
미세 튜닝의 근음을 설정합니다.

Micro Tuning Name에서 선택한 형식에 근음이 필요하지 않는 경우에는 이 파라미터가 표시되지 않습니다.

설정: C–B
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Audition

Audition 화면에서 오디션 프레이즈를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → General/Pitch → Audition

Audition Bank
오디션 프레이즈의 뱅크를 선택합니다.

Audition Phrase Number
오디션 프레이즈를 선택합니다.

내장 퍼포먼스에 이미 적합한 오디션 프레이즈가 지정되어 있습니다.

오디션 프레이즈를 재생하면 해당 음악 콘텍스트로 선택한 퍼포먼스를 들을 수 있습니다.

설정: Data List 참조

Note Shift (Audition Note Shift)
오디션 프레이즈의 음 피치를 반음 단위로 조정합니다.

설정: −24 semi –+0 semi– +24 semi

Velocity Shift (Audition Velocity Shift)
오디션 프레이즈의 음 세기를 조정합니다.

설정: −64–+0–+63

Update User Auditions
내장 메모리에 저장된 모든 곡을 사용자 오디션으로 변환합니다.

사용자 오디션이 이미 존재하는 경우 이전 사용자 오디션 모두 덮어쓰기됩니다.
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Filter/Amp

Filter EG

Filter EG 화면에서 필터 엔벌로프 제너레이터(FEG)를 설정할 수 있습니다.

그러면 차단 주파수의 변화도(또는 레벨)와 건반을 누른 순간부터 음향이 감쇄될 때까지 시간 경과에 따라 어떻게 변하는지 설정할 수 

있습니다.

작업

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Filter/Amp → Filter EG

FEG Atk (FEG Attack Time)
건반을 누른 순간부터 차단 주파수가 어택 레벨에 설정된 값이 될 때까지 음향이 변하는 데 소요되는 시간을 설정합니다.

이 파라미터는 파트 FEG의 오프셋 값으로 지정됩니다.
설정: −64–+0–+63

FEG Decay (FEG Decay Time)
차단 주파수가 어택 레벨에서 변할 때까지 소요되는 시간을 설정합니다. 음향의 산뜻한 정도나 감쇄 속도를 제어할 수 있습니다.

이 파라미터는 파트 FEG의 오프셋 값으로 지정됩니다.
설정: −64–+0–+63

FEG Rel (FEG Release Time)
건반에서 손가락을 뗀 순간부터 릴리스 레벨에 이를 때까지 차단 주파수가 변하는 데 소요되는 시간을 설정합니다. 건반에서 손을 뗀 

후의 음향 감쇄를 느리거나 빠르게 할 수 있습니다.

이 파라미터는 파트 FEG의 오프셋 값으로 지정됩니다.
설정: −64–+0–+63

Cutoff (Cutoff Frequency)
필터의 차단 주파수를 설정하여 음향을 변경합니다.

로우 패스 필터를 선택한 경우 값이 커지면 음향이 밝아지고 값이 작아지면 음향이 어두워집니다.

이 파라미터는 파트에 대한 필터 차단 주파수의 오프셋 값으로 지정됩니다.
설정: −64–+0–+63
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Resonance
차단 주파수 근처의 신호 레벨을 조정하여 음향에 특별한 특성을 더합니다.

이 파라미터는 파트의 필터 공명의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

FEG Depth
FEG로 제어되는 차단 주파수 변화의 깊이 범위를 설정합니다.

이 파라미터는 파트 FEG Depth의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

Amp EG

Amp EG 화면에서 AEG(진폭 엔벌로프 제너레이터)를 설정할 수 있습니다. Amp EG를 설정하면 건반을 누른 순간부터 음향이 감쇄될 

때까지 음량이 어떻게 변하는지 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Filter/Amp → Amp EG

Amp EG 화면의 설정은 모든 파트의 AEG에 대한 오프셋값입니다.

Attack (AEG Attack Time)
건반을 누른 순간부터 최대값에 이를 때까지 음량이 변하는 데 소요되는 시간을 설정합니다.

설정: −64–+0–+63

Decay (AEG Decay Time)
최대값에 이른 후 음량이 변할 때까지 소요되는 시간을 설정합니다.

설정: −64–+0–+63

Sustain (AEG Sustain Level)
건반을 누르고 있는 동안 유지되는 음량을 설정합니다.

설정: −64–+0–+63

Release (AEG Release Time)
건반에서 손을 뗀 후 음향이 감쇄될 때까지 소요되는 시간을 설정합니다.

설정: −64–+0–+63
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Effect

Routing

이 화면에서 모든 파트에 적용되는 시스템 이펙트를 설정하고 마스터 이펙트의 신호 흐름을 확인할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Effect → Routing

Var (Variation Switch)
Rev (Reverb Switch)
MFX (Master Effect Switch)
변주 이펙트, 리버브 및 마스터 이펙트를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Var Type (Variation Type)
Rev Type (Reverb Type)
MFX Type (Master Effect Type)
변주 이펙트, 리버브 및 마스터 이펙트의 형식을 설정합니다.

설정: 이펙트 형식 참조

Var Preset (Variation Preset Number)
Rev Preset (Reverb Preset Number)
MFX Preset (Master Effect Preset Number)
변주 이펙트, 리버브 및 마스터 이펙트 파라미터에서 내장 번호를 선택합니다.

설정: Data List 참조

Side Chain (Variation Side Chain Part)
Side Chain (Master Effect Side Chain Part)
Modulator (Variation Modulator Part)
Modulator (Master Effect Modulator Part)
변주 이펙트 및 마스터 이펙트의 사이드 체인 파트(또는 이펙트 형식에 따라 모듈레이터)를 설정합니다.

Master가 모듈레이터 파트로 설정된 경우에는 이 파라미터를 이용할 수 없습니다. 이 경우, 파라미터 값이 "(Master)"와 같이 괄호로 

표시됩니다.

설정: Part 1–16, A/D, Master, Off
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Var Return (Variation Return)
Rev Return (Reverb Return)
변주 이펙트 또는 리버브 이펙트로 처리된 신호의 출력 레벨(리턴 레벨)을 설정합니다.
설정: 0–127

Var to Rev (Variation To Reverb)
변주 이펙트로 처리된 신호의 전송 레벨을 설정합니다.
설정: 0–127

Master EQ (Master EQ Switch)
Master EQ를 켜짐 또는 꺼짐으로 설정합니다.
설정: Off, On

Var Pan (Variation Pan)
Rev Pan (Reverb Pan)
변주 이펙트 또는 리버브 이펙트로 처리된 신호의 스테레오 위치를 설정합니다.
설정: L63–C(중앙)–R63

Envelope Follower
Envelope Follower 설정 화면을 엽니다.

•	 Part (Input Source)

선택한 엔벌로프 팔로워의 입력 소스로 표시합니다.
설정: Master, AD, Part 1–16

•	 Gain (Envelope Follower Gain)

Part에 설정된 입력 소스의 입력 게인을 설정합니다.
설정: −24.0dB–0.0dB–+24.0dB

•	 Attack (Envelope Follower Attack)

엔벌로프 팔로워의 어택 타임을 설정합니다.
설정: 1ms–40ms

•	 Release (Envelope Follower Release)

엔벌로프 팔로워의 릴리스 타임을 설정합니다.
설정: 10ms–680ms

•	 Input Level

선택한 Part의 입력 소스에서 입력된 신호의 입력 레벨을 표시합니다.

•	 Envelope Follower Output

엔벌로프 팔로워의 출력 레벨을 표시합니다.

•	 Edit

선택한 파트의 Control Assign 화면을 엽니다.
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Variation

변주 이펙트를 설정합니다.

작업

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Effect → Variation

Variation Switch
변주 이펙트를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Category (Variation Category)
Type (Variation Type)
변주 이펙트의 카테고리와 형식을 설정합니다.

설정: 이펙트 형식 참조

Preset (Variation Preset Number)
이펙트 형식마다 내장 이펙트 파라미터 중 하나를 선택합니다.

설정: Data List 참조

Side Chain (Variation Side Chain Part)
Modulator (Variation Modulator Part)
변주 이펙트의 사이드 체인(또는 이펙트 형식에 따라 모듈레이터) 파트를 설정합니다.

Master가 모듈레이터 파트로 설정된 경우에는 이 파라미터를 이용할 수 없습니다. 이 경우, 파라미터 값이 "(Master)"와 같이 괄호로 

표시됩니다.

설정: 파트 1–16, A/D, Master, Off

Effect Parameter
이펙트 파라미터는 이펙트 형식에 따라 다릅니다.

설정: 이펙트 파라미터 참조
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Reverb

리버브 이펙트를 설정합니다.

작업

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Effect → Reverb

Reverb Switch
리버브 이펙트를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Category (Reverb Category)
Type (Reverb Type)
리버브 이펙트의 카테고리와 형식을 설정합니다.

설정: 이펙트 형식 참조

Preset (Reverb Preset Number)
이펙트 형식마다 내장 이펙트 파라미터 중 하나를 선택합니다.

설정: Data List 참조

Effect Parameter
이펙트 파라미터는 이펙트 형식에 따라 다릅니다.

설정: 이펙트 파라미터 참조
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Master FX

마스터 이펙트를 설정합니다.

작업 

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Effect → Master FX

Master Effect Switch
마스터 이펙트를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Category (Master Effect Category)
Type (Master Effect Type)
마스터 이펙트의 카테고리와 형식을 설정합니다.

설정: 이펙트 파라미터 참조

Preset (Master Effect Preset Number)
이펙트 형식마다 내장 이펙트 파라미터 중 하나를 선택합니다.

설정: Data List 참조

Side Chain (Master Effect Side Chain Part)
Modulator (Master Effect Modulator Part)
마스터 이펙트의 사이드 체인(또는 이펙트 형식에 따라 모듈레이터)을 설정합니다.

Master가 모듈레이터 파트로 설정된 경우에는 이 파라미터를 이용할 수 없습니다. 이 경우, 파라미터 값이 "(Master)"와 같이 괄호로 

표시됩니다.

설정: Part 1–16, A/D, Master, Off

Effect Parameter
이펙트 파라미터는 이펙트 형식에 따라 다릅니다.

설정: 이펙트 파라미터 참조
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Master EQ

Master EQ를 설정합니다.

작업 

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Effect → Master EQ

Master EQ (Master EQ Switch)
Master EQ를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Low Gain (Master EQ Low Gain)
Low 대역의 신호 레벨을 설정합니다.

설정: −12dB – +0dB – +12dB

Lo Mid Gain (Master EQ Low Mid Gain)
Lo Mid 대역의 신호 레벨을 설정합니다.

설정: −12dB – +0dB – +12dB

Mid Gain (Master EQ Mid Gain)
Mid 대역의 신호 레벨을 설정합니다.

설정: −12dB – +0dB – +12dB

Hi Mid Gain (Master EQ High Mid Gain)
Hi Mid 대역의 신호 레벨을 설정합니다.

설정: −12dB – +0dB – +12dB

High Gain (Master EQ High Gain)
High 대역의 신호 레벨을 설정합니다.

설정: −12dB – +0dB – +12dB

Low Freq (Master EQ Low Frequency)
Low 대역의 주파수를 설정합니다.

설정: 32Hz – 2.0kHz
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Lo Mid Freq (Master EQ Low Mid Frequency)
Lo Mid 대역의 주파수를 설정합니다.

설정: 100Hz – 10kHz

Mid Freq (Master EQ Mid Frequency)
Mid 대역의 주파수를 설정합니다.

설정: 100Hz – 10kHz

Hi Mid Freq (Master EQ High Mid Frequency)
Hi Mid 대역의 주파수를 설정합니다.

설정: 100Hz – 10kHz

High Freq (Master EQ High Frequency)
High 대역의 주파수를 설정합니다.

설정: 500Hz – 16kHz

Low Q (Master EQ Low Q)
Low 대역의 대역폭을 설정합니다.

Low Shape (Master EQ Low Shape)을 Peak로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0.1–12.0

Lo Mid Q (Master EQ Low Mid Q)
Lo Mid 대역의 대역폭을 설정합니다.

설정: 0.1–12.0

Mid Q (Master EQ Mid Q)
Mid 대역의 대역폭을 설정합니다.

설정: 0.1–12.0

Hi Mid Q (Master EQ High Mid Q)
Hi Mid 대역의 대역폭을 설정합니다.

설정: 0.1–12.0

High Q (Master EQ High Q)
High 대역의 대역폭을 설정합니다.

High Shape (Master EQ High Shape)을 Peak로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0.1–12.0

Low Shape (Master EQ Low Shape)
High Shape (Master EQ High Shape)
Low 및 High를 쉘빙 형식(특정 주파수 설정 아래의 신호를 차단하거나 증폭하는 형식)으로 사용할지 또는 피킹 형식(특정 주파수 

대역의 신호를 차단하거나 증폭하는 형식)으로 사용할지 여부를 설정합니다.

설정: Shelf, Peak
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Audio In

Mixing

Mixing 화면에서 A/D 파트(A/D INPUT 잭에서 전송된 신호) 및 디지털 파트(USB [TO HOST] 단자에서 전송된 신호)를 믹싱할 수 

있습니다.

*USB [TO HOST] 단자에서 전송되는 신호는 장치 포트에서 Digital L/R로 설정되는 오디오입니다.

작업 

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Audio In → Mixing

[SHIFT] + [A/D INPUT ON/OFF]

Input Mode (A/D Part Input Mode)
Input Mode (Digital Part Input Mode)
좌측 및 우측 채널에서 입력 신호의 처리 방식을 결정합니다.

설정: 	 L Mono, R Mono, L+R Mono, Stereo

L Mono: 좌측 채널만 사용합니다.

R Mono: 우측 채널만 사용합니다.

L+R Mono: 좌측 및 우측 채널을 믹싱하고 모노로 처리합니다.

Stereo: 스테레오 입력을 스테레오로 처리합니다.

주
음향이 [L/MONO] 잭에서만 입력되는 경우 모노로 처리됩니다.

Volume (A/D Part Volume)
Volume (Digital Part Volume)
A/D 파트 또는 디지털 파트의 음량을 설정합니다.

설정: 0–127

Pan (A/D Part Pan)
Pan (Digital Part Pan)
A/D 파트 또는 디지털 파트의 (스테레오 필드 내) 팬 위치를 설정합니다.

설정: L63–C(중앙)–R63
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Dry Level (A/D Part Dry Level)
Dry Level (Digital Part Dry Level)
A/D 파트 또는 디지털 파트의 dry 레벨(또는 시스템 이펙트로 처리되지 않은 신호의 레벨)을 설정합니다.

Output Select를 MainL&R로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Var Send (A/D Part Variation Send)
Var Send (Digital Part Variation Send)
A/D 파트 또는 디지털 파트에서 변주 이펙트로 전송된 신호의 레벨을 설정합니다.

Output Select를 MainL&R로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Rev Send (A/D Part Reverb Send)
Rev Send (Digital Part Reverb Send)
A/D 파트 또는 디지털 파트에서 리버브 이펙트로 전송된 신호의 레벨을 설정합니다.

Output Select를 MainL&R로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Output Select (A/D Part Output Select)
Output Select (Digital Part Output Select)
A/D 파트 또는 디지털 파트에서 전송된 오디오 신호의 팬 대상을 설정합니다.

설정: 	 MainL&R, (AsgnL&R), USB Stereo, (AsgnL), (AsgnR), USB mono, Off

MainL&R: OUTPUT [L/MONO] 및 OUTPUT [R] 잭으로 스테레오(2개의 채널)로 출력됩니다.

USB Stereo: USB [TO HOST] 단자로 스테레오(채널 1 및 2~채널 7 및 8)로 출력됩니다.

USB mono: USB [TO HOST] 단자로 모노(채널 1~8)로 출력됩니다.

Off: 파트의 오디오 신호 출력이 없습니다.

주
MONTAGE M과의 데이터 호환 설정은 아래 표시되어 있습니다. 설정 시에는 Off로 간주됩니다.

•	AsgnL&R

•	USB Stereo: USB9&10 – USB29&30

•	USB mono: USB9 – USB30

•	AsgnL

•	AsgnR
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Routing

Routing 화면에서 A/D 파트의 이펙트 경로를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Audio In → Routing

(1)

(2)

(1) A/D Part Insertion FX A Switch

(2) A/D Part Insertion FX B Switch

A/D In
Digital In
A/D In 보기와 Digital In 보기를 서로 전환합니다.

Digital In을 선택한 경우에는 Digital Part Reverb Send, Digital Part Variation Send 및 Digital Part Output Select만 이용할 수 

있습니다.

A/D Part Insertion FX A Switch
A/D Part Insertion FX B Switch
인서트 이펙트 A 및 인서트 이펙트 B를 켜거나 끕니다.

설정: Off, On

Type (A/D Part Insertion Effect A Type)
Type (A/D Part Insertion Effect B Type)
이펙트 형식을 설정합니다.

설정: 이펙트 형식 참조

Preset (A/D Part Insertion Effect A Preset)
Preset (A/D Part Insertion Effect B Preset)
이펙트 형식마다 내장 이펙트 파라미터 중 하나를 선택합니다.

내장을 선택하면 이펙트 적용 방식을 변경할 수 있습니다.

설정: Data List 참조
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Side Chain (A/D Part Insertion Effect A Side Chain)
Side Chain (A/D Part Insertion Effect B Side Chain)
Modulator (A/D Part Insertion Effect A Modulator)
Modulator (A/D Part Insertion Effect B Modulator)
인서트 이펙트 A 또는 인서트 이펙트 B의 사이드 체인 파트(또는 이펙트 형식에 따라 모듈레이터)를 설정합니다.

파트 자체 또는 Master가 모듈레이터 파트로 설정된 경우에는 이 파라미터를 이용할 수 없습니다. 이 경우, 파라미터 값이 "(Master)"와 

같이 괄호로 표시됩니다.

설정: Part 1–16, A/D, Master, Off

Ins Connect (A/D Part Insertion Effect Connect Type)
인서트 이펙트 A 및 인서트 이펙트 B의 이펙트 경로를 설정합니다. 설정이 변경되면 이에 따라 그림이 변합니다.

설정: Ins A→B, Ins B→A

Dry Level (A/D Part Dry Level)
AD 파트의 dry 레벨(또는 시스템 이펙트로 처리되지 않은 신호의 레벨)을 설정합니다.

Output Select를 MainL&R로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

2-band EQ
A/D 파트의 2대역 EQ 2-band EQ 화면을 엽니다.

Rev Send (A/D Part Reverb Send)
Rev Send (Digital Part Reverb Send)
인서트 이펙트 A 또는 인서트 이펙트 B에서 리버브 이펙트로 전송된 신호(또는 바이패스 신호)의 레벨을 설정합니다.

Output Select를 MainL&R로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Var Send (A/D Part Variation Send)
Var Send (Digital Part Variation Send)
인서트 이펙트 A 또는 인서트 이펙트 B에서 변주 이펙트로 전송된 신호(또는 바이패스 신호)의 레벨을 설정합니다.

Output Select를 MainL&R로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Envelope Follower
Envelope Follower 설정 화면을 엽니다.

Output Select (A/D Part Output Select)
Output Select (Digital Part Output Select)
오디오 신호의 출력 대상을 설정합니다.

설정: 	 MainL&R, (AsgnL&R), USB Stereo, (AsgnL), (AsgnR), USB mono, Off

MainL&R: OUTPUT [L/MONO] 및 OUTPUT [R] 잭으로 스테레오(2개의 채널)로 출력됩니다.

USB Stereo: USB [TO HOST] 단자로 스테레오(채널 1 및 2~채널 7 및 8)로 출력됩니다.

USB mono: USB [TO HOST] 단자로 모노(채널 1~8)로 출력됩니다.

Off: 파트의 오디오 신호 출력이 없습니다.

주
MONTAGE M과의 데이터 호환 설정은 아래 표시되어 있습니다. 설정 시에는 Off로 간주됩니다.

•	AsgnL&R

•	USB Stereo: USB9&10 – USB29&30

•	USB mono: USB9 – USB30

•	AsgnL

•	AsgnR
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Ins A, Ins B

Ins A 및 Ins B 화면에서 인서트 이펙트를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Audio In → Ins A

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Audio In → Ins B

Insertion FX Switch
인서트 이펙트를 활성화합니다.

설정: Off, On

Category (Insertion Effect A Category)
Category (Insertion Effect B Category)
Type (Insertion Effect A Type)
Type (Insertion Effect B Type)
인서트 이펙트의 카테고리와 형식을 설정합니다.

설정: 이펙트 형식 참조

Preset (Insertion Effect A Preset)
Preset (Insertion Effect B Preset)
이펙트 형식마다 내장 이펙트 파라미터 중 하나를 선택합니다. 내장을 선택하면 이펙트 적용 방식을 변경할 수 있습니다.

설정: Data List 참조

Side Chain (Insertion Effect A Side Chain Part)
Side Chain (Insertion Effect B Side Chain Part)
Modulator (Insertion Effect A Modulator Part)
Modulator (Insertion Effect B Modulator Part)
인서트 이펙트 A 또는 인서트 이펙트 B의 사이드 체인 파트(또는 이펙트 형식에 따라 모듈레이터)를 설정합니다.

파트 자체 또는 Master가 모듈레이터 파트로 설정된 경우에는 이 파라미터를 이용할 수 없습니다. 이 경우, 파라미터 값이 "(Master)"와 

같이 괄호로 표시됩니다.

설정: Part 1–16, A/D, Master, Off

Effect Parameter
이펙트 파라미터는 이펙트 형식에 따라 다릅니다.

설정: 이펙트 파라미터 참조
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2-band EQ

2-band EQ 화면에서 파트 EQ를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Audio In → 2-band EQ

EQ1 Type (A/D Part 2-band EQ 1 Type)
EQ2 Type (A/D Part 2-band EQ 2 Type)
원하는 EQ 형식을 선택합니다.

설정: 	 Thru, LPF, HPF, Low Shelf, Hi Shelf, Peak/Dip

Thru: 적용되는 이펙트 없이 신호를 통과시킵니다.

LPF: 차단 주파수 위의 신호를 차단합니다.

HPF: 차단 주파수 아래의 신호를 차단합니다.

Low Shelf: 지정된 주파수 설정 아래의 신호를 차단하거나 증폭시킵니다.

Hi Shelf: 지정된 주파수 설정 위의 신호를 차단하거나 증폭시킵니다.

Peak/Dip: 지정된 주파수 설정에서 신호를 차단하거나 증폭시킵니다.

EQ 1 Freq (A/D Part 2-band EQ 1 Frequency)
EQ 2 Freq (A/D Part 2-band EQ 2 Frequency)
차단하거나 증폭시킬 주파수를 설정합니다.

EQ Type을 Thru로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 63.0Hz–18.0kHz

EQ 1 Gain (A/D Part 2-band EQ 1 Gain)
EQ 2 Gain (A/D Part 2-band EQ 2 Gain)
EQ1 Freq 또는 EQ2 Freq에 설정된 주파수 대역의 신호 레벨을 설정합니다.

EQ Type을 Thru, LPF 또는 HPF로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.

설정: −12.0dB – +0.0dB – +12.0dB

EQ 1 Q (A/D Part 2-band EQ 1 Q)
EQ 2 Q (A/D Part 2-band EQ 2 Q)
EQ1 Freq 또는 EQ2 Freq로 설정된 주파수의 음량을 차단하거나 증폭시킬 때 사용되는 대역폭을 설정합니다.

EQ Type을 Peak/Dip으로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0.1–12.0

Output Level (A/D Part 2-band EQ Output Level)
2대역 EQ의 출력 게인을 설정합니다.

설정: −12.0dB – +0.0dB – +12.0dB
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Arp/MS

Arp Common

Arp Common 화면에서 전체 퍼포먼스의 아르페지오 파라미터를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Arp/MS → Arp Common

Arp Master (Arpeggio Master Switch)
퍼포먼스의 아르페지오를 켜짐 또는 꺼짐으로 설정합니다. 이 스위치는 상단 패널의 ARP 버튼과 연결되어 있습니다.

설정: Off, On

Sync Quantize (Arpeggio Sync Quantize Value)
다중 파트에서 아르페지오 프레이즈를 재생할 때 첫 아르페지오 재생 중 다음 아르페지오 프레이즈 시작 타이밍을 조정합니다. Off로 

설정된 경우 건반에서 파트를 연주할 때 아르페지오가 재생됩니다.

설정: 	 Off, 60(32분 음표), 80(16분 음표의 셋잇단음표), 120(16분 음표), 160(8분 음표의 셋잇단음표), 240(8분 음표), 320(4분 음표의 

셋잇단음표), 480(4분 음표) (여기 표시된 숫자는 클록값임)

Swing (Swing Offset)
퍼포먼스의 아르페지오 및 모션 시퀀스의 스윙값을 설정합니다.

이 파라미터는 Part Swing의 오프셋 값으로 지정됩니다.

설정: −120–+ 0–+120

Unit (Common Unit Multiply)
전체 퍼포먼스의 아르페지오 재생 시간을 늘리거나 줄일 때 사용되는 백분율을 설정합니다.

이 파라미터는 Part Unit (Arpeggio Unit Multiply)가 Common으로 설정된 파트에 영향을 미칩니다.

재생 시간을 늘리거나 줄일 때 세분화된 박자 및 템포가 변경되므로 본래 선택한 아르페지오에 완전히 새로운 느낌을 창출할 수 있습니다.

설정: 	 50%, 66%, 75%, 100%, 133%, 150%, 200%, 266%, 300%, 400%

200%: 재생 시간이 2배가 되어 결과적으로 템포가 1/2로 줄어듭니다.

100%: 재생 시간이 변함없이 유지됩니다.

50%: 재생 시간이 1/2이 되어 결과적으로 템포가 2배로 늘어납니다.
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Qntz Strength (Arpeggio Quantize Strength Offset)
퍼포먼스의 아르페지오에 적용된 퀀타이즈 설정의 강도를 설정합니다.

이 파라미터는 각 파트에 대한 Qntz Strength (Arpeggio Quantize Strength)의 오프셋 값으로 지정됩니다.

설정: −100–+0–+100

Gate Time (Arpeggio Gate Time Rate Offset)
퍼포먼스의 아르페지오 게이트 시간 비율을 설정합니다.

이 파라미터는 각 파트에 대한 Gate Time (Arpeggio Gate Time Rate)의 오프셋 값으로 지정됩니다.

설정: −100–+0–+100

Velocity (Arpeggio Velocity Rate Offset)
퍼포먼스의 아르페지오 세기 비율을 설정합니다.

이 파라미터는 각 파트에 대한 Velocity (Arpeggio Velocity Rate)의 오프셋 값으로 지정됩니다.

설정: −100–+0–+100

Octave Shift (Arpeggio Octave Shift Offset)
퍼포먼스의 아르페지오 피치를 옥타브 단위로 이동합니다.

이 파라미터는 각 파트에 대한 Octave Shift (Arpeggio Octave Shift)의 오프셋 값으로 지정됩니다.

설정: −20–+0–+20

Octave Range (Arpeggio Octave Range Offset)
퍼포먼스의 아르페지오 범위를 옥타브 단위로 이동합니다.

이 파라미터는 각 파트에 대한 Octave Range (Arpeggio Octave Range)의 오프셋 값으로 지정됩니다.

설정: −6–+0–+6

Arp Select (Arpeggio Select)
아르페지오를 선택합니다.

설정: 1–8
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Arp Overview (Arpeggio Overview)

Arp Overview 화면에서 전체 파트의 목록에서 아르페지오 형식을 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Arp/MS → Arp Overview

(선택한 파트가 Common일 때) [SHIFT] + [ARP]

Part 1–8
Part 9–16
파트 보기를 전환합니다.

설정: Part 1–8, Part 9–16

Arp Master (Arpeggio Master Switch)
퍼포먼스의 아르페지오를 켜짐 또는 꺼짐으로 설정합니다.

이 스위치는 상단 패널의 ARP 버튼과 연결되어 있습니다.

설정: Off, On

Group (Arpeggio Group)
다중 파트와 함께 동일한 아르페지오를 사용하여 Arpeggio Group을 설정합니다. 동일한 Group에 지정된 파트의 경우 아르페지오 

설정이 동일합니다.

Arp Select (Arpeggio Select)
아르페지오를 선택합니다.

설정: 1–8

Sw (Part Arpeggio Switch)
각 파트의 아르페지오를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On
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	� View를 Category로 설정한 경우

Category (Arpeggio Category)
Sub (Arpeggio Sub Category)
Name (Arpeggio Name)
설정: Data List 참조

	� View를 Number로 설정한 경우

Bank (Arpeggio Bank)
Number (Arpeggio Number)
Name (Arpeggio Name)
설정: Data List 참조

	� View를 Range로 설정한 경우 

Name (Arpeggio Name)
설정: Data List 참조

Velocity Limit (Arpeggio Velocity Limit)
아르페지오 재생의 세기 범위(최저/최고값)를 설정합니다.

높은 값이 첫 번째, 낮은 값이 두 번째(예: 93에서 34로)가 되도록 설정된 경우, 1~34 및 93~127의 세기에서만 아르페지오가 

연주됩니다.

설정: 1–127

Note Limit (Arpeggio Note Limit)
아르페지오 파트의 음 범위(최저/최고음)를 설정합니다.

지정된 첫 번째 음이 두 번째 음보다 높은 경우(예: C5에서 C4로), C−2~C4 및 C5~G8 범위에서 음이 연주됩니다.

설정: C−2–G8
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MS Common (Motion Sequencer Common)

MS Common 화면에서 전체 퍼포먼스에 사용되는 모션 시퀀서 파라미터를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Arp/MS → MS Common

(선택한 파트가 Common일 때) [SHIFT] + [MSEQ]

Common Swing (Swing Offset)
퍼포먼스의 아르페지오 및 모션 시퀀스의 스윙값을 설정합니다.

이 파라미터는 Part Swing의 오프셋 값으로 지정됩니다.

설정: −120–+0–+120

Common Unit (Common Unit Multiply)
전체 퍼포먼스의 모션 시퀀서 재생 시간을 늘리거나 줄일 때 사용되는 백분율을 설정합니다.

이 파라미터는 Unit이 Common으로 설정된 레인에 영향을 미칩니다.

재생 시간을 늘리거나 줄일 때 세분화된 박자 및 템포가 변경되므로 본래 선택한 모션 시퀀서에 완전히 새로운 느낌을 창출할 수 

있습니다.

설정: 	 50%, 66%, 75%, 100%, 133%, 150%, 200%, 266%, 300%, 400%

200%: 재생 시간이 2배가 되어 결과적으로 템포가 1/2로 줄어듭니다.

100%: 재생 시간이 변함없이 유지됩니다.

50%: 재생 시간이 1/2이 되어 결과적으로 템포가 2배로 늘어납니다.

Common Amplitude (Motion Sequencer Amplitude Performance Offset)
전체 퍼포먼스에 모션 시퀀서 진폭(또는 시퀀스가 변하는 정도)을 설정합니다.

이 파라미터는 MS FX (Lane FX Receive)가 켜짐으로 설정된 경우 파트 안에 존재하는 레인의 진폭을 오프셋합니다.

이 파라미터는 각 파트에 대한 Part Amplitude (Part Motion Sequencer Amplitude)의 오프셋 값으로 지정됩니다.

설정: −127–+0–+127

Common Shape (Motion Sequencer Pulse Shape Performance Offset)
퍼포먼스의 모션 시퀀서 펄스 형태(또는 단계 곡선 형태)를 설정합니다.

이 파라미터는 MS FX (Lane FX Receive)가 레인에 켜짐으로 설정되고 Control이 켜짐으로 설정된 경우 파트 안에 존재하는 레인의 

파라미터를 오프셋합니다.

이 파라미터는 각 파트에 대한 Part Shape (Part Motion Sequencer Pulse Shape)의 오프셋 값으로 지정됩니다.

설정: −100–+0–+100
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Common Smooth (Motion Sequencer Smoothness Performance Offset)
전체 퍼포먼스의 모션 시퀀서 부드러움(또는 시간 경과에 따라 시퀀스 변화 부드러움)을 설정합니다.

이 파라미터는 MS FX (Lane FX Receive)가 레인에 켜짐으로 설정된 경우 파트 안에 존재하는 레인의 부드러움을 오프셋합니다.

이 파라미터는 각 파트에 대한 Part Motion Seq Smooth (Part Motion Sequencer Smoothness)의 오프셋 값으로 지정됩니다.

설정: −127–+0–+127

Common Random (Motion Sequencer Randomness Performance Offset)
전체 퍼포먼스의 모션 시퀀서 무작위(또는 시간 경과에 따라 시퀀스 변화 무작위)를 설정합니다.

이 파라미터는 MS FX (Lane FX Receive)가 레인에 켜짐으로 설정된 경우 퍼포먼스 안에 존재하는 레인의 무작위를 오프셋합니다.

이 파라미터는 각 파트에 대한 Part Motion Seq Random (Part Motion Sequencer Randomness)의 오프셋 값으로 지정됩니다.

설정: −127–+0–+127

View Lane (Motion Seq View Lane)
Home 화면의 View Mode가 Motion Seq로 설정된 경우 표시되는 Motion Seq Lane을 설정합니다.

설정: Super Knob, 1–4

AD MS Random (A/D Part Motion Sequencer Randomness)
A/D Part Motion Sequencer Step Value의 변화 무작위를 설정합니다.

설정: 0–127

MS Select (Motion Sequence Select)
모션 시퀀스 선택 사항을 변경합니다.

설정: 1–8
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MS Overview (Motion Sequencer Overview)

MS Overview 화면에서 전체 파트의 목록에서 모션 시퀀서를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Arp/MS → MS Overview

MS Master (Motion Seq Master Switch)
전체 퍼포먼스의 모션 시퀀서를 켜짐 또는 꺼짐으로 설정합니다.

이 스위치는 상단 패널의 MSEQ 버튼과 연결되어 있습니다.

설정: Off, On

Active (Active Motion Sequencer)
켜짐으로 설정된 레인 스위치 번호를 표시합니다.

슬래시(/) 우측에 표시된 번호는 동시에 켜짐으로 설정할 수 있는 최대 레인 수를 의미합니다.

MS Select (Motion Sequence Select)
모션 시퀀스 선택 사항을 변경합니다.

설정: 1–8

PartSw (Motion Sequencer Part Switch)
각 파트의 모션 시퀀서를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Lane Switch
각 레인을 켜짐 또는 꺼짐으로 설정합니다.

한 파트에 최대 4개의 모션 시퀀서 레인을 사용하거나 전체 퍼포먼스에 최대 8개의 레인을 사용할 수 있습니다.

설정: Off, On
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Lane

Lane 화면에서 각 모션 시퀀서 레인의 파라미터를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Arp/MS → Lane

Motion Seq Master Sw (Motion Sequencer Master Switch)
전체 퍼포먼스의 모션 시퀀서를 켜짐 또는 꺼짐으로 설정합니다.
설정: Off, On

Motion Seq Part Sw (Motion Sequencer Part Switch)
파트의 모션 시퀀서를 켜짐 또는 꺼짐으로 설정합니다.
설정: Off, On

Lane (Lane Select)
선택한 레인의 이름을 표시합니다.
설정: 1–4

LaneSw (Lane Switch)
각 레인을 켜짐 또는 꺼짐으로 설정합니다.

한 파트에 최대 4개의 모션 시퀀서 레인을 사용하거나 전체 퍼포먼스에 최대 8개의 레인을 사용할 수 있습니다.

꺼짐으로 설정한 경우 해당 레인의 파라미터가 표시되지 않습니다.
설정: Off, On

MS FX (Lane FX Receive)
모션 시퀀서 파라미터를 변경할 때 사용되는 노브에서 신호를 수신하도록 선택한 레인을 설정합니다.
설정: Off, On

Trigger (Lane Trigger Receive)
[MSEQ TRIGGER] 버튼에서 신호를 수신하도록 선택한 레인을 설정합니다.

켜짐으로 설정된 경우 [MSEQ TRIGGER] 버튼을 누를 때까지 모션 시퀀스가 재생되지 않습니다.
설정: Off, On

Sequence Select (Motion Sequence Select)
모션 시퀀스 선택 사항을 변경합니다.
설정: 1–8

Target Sequence
선택한 레인 및 시퀀스를 표시합니다.
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	� Sync/Speed 탭

Sync (Lane Sync)
 Control Assign 화면의 Destination으로 설정된 모션 시퀀스의 재생을 설정하여 퍼포먼스 템포 또는 박자에 맞게 동기화합니다.
설정: 	 Off, Tempo, Beat, Lane1(Lane2–4를 선택한 경우)

Off: 레인 모션 시퀀서만 재생합니다.
Tempo: 퍼포먼스 템포로 레인 모션 시퀀서를 재생합니다.
Beat: 퍼포먼스 템포에 맞춰 레인 모션 시퀀서를 재생합니다.
Lane1: Lane 1에 맞춰 레인 모션 시퀀서를 재생합니다.

•	 Sync를 Off로 설정한 경우

Speed (Lane Speed)
모션 시퀀스의 재생 속도를 설정합니다.

Sync를 Off로 설정한 경우 이 파라미터를 이용할 수 있습니다.
설정: 0–127

Delay Time (A/D Part Motion Seq Lane Key On Delay Time Length)
모션 시퀀스 재생을 시작할 때 사용되는 딜레이 타임을 설정합니다.
설정: 0–127

Fade In Time (A/D Part Motion Seq Lane Fade In Time Length)
모션 시퀀스가 최대 진폭에 도달할 때까지 소요되는 시간을 설정합니다.
설정: 0–127

•	 Sync를 Off 이외의 다른 값으로 설정한 경우

Unit (A/D Part Motion Seq Lane Unit Multiply)
선택한 레인의 모션 시퀀서 재생 시간을 늘리거나 줄일 때 사용되는 백분율을 설정합니다.

Sync를 Tempo 또는 Beat로 설정한 경우 이 파라미터를 이용할 수 있습니다.
설정: 	 50%, 66%, 75%, 100%, 133%, 150%, 200%, 266%, 300%, 400%, 600%, 800%, 1200%, 1600%, 2400%, 3200%, 6400%, 

Common

200%: 재생 시간이 2배가 되어 결과적으로 템포가 1/2로 줄어듭니다.
100%: 재생 시간이 변함없이 유지됩니다.
50%: 재생 시간이 1/2이 되어 결과적으로 템포가 2배로 늘어납니다.
Common: 모든 파트에 공통된 Unit Multiply에 설정된 값이 적용됩니다.

Delay Steps (A/D Part Motion Seq Lane Key On Delay Step Length)
Sync를 Tempo 또는 Beat로 설정한 경우 Motion Sequence 재생을 시작할 때 사용되는 딜레이 타임을 설정합니다.
설정: 0–32

Fade In Steps (A/D Part Motion Seq Lane Fade In Step Length)
Sync를 Tempo, Beat 또는 Lane1로 설정한 경우 Motion Sequence의 최대 진폭에 도달할 시간을 설정합니다.
설정: 0–32

Lane Vel Limit (Lane Velocity Limit)
선택한 레인의 모션 시퀀스를 재생할 때 사용되는 세기 범위(최저/최고값)를 설정합니다

Sync를 Off, Tempo 또는 Beat로 설정한 경우 이 파라미터를 이용할 수 있습니다.

Velocity Limit를 최고값에서 최저값의 범위로 설정하면 Motion Sequence는 최대값에서 최고값 및 최소값에서 최저값의 2가지 세기 

범위로 재생됩니다.
설정: 1–127

Edit Sequence
Motion Sequence Edit 화면이 열립니다.

Motion Seq Step n Value
선택한 시퀀스의 단계 곡선을 표시합니다.



186MODX M 사용설명서

	� Loop/Length 탭

Key On Reset (Lane Key On Reset)
아무 건반이나 누르면 모션 시퀀스 재생을 재설정합니다.

Sync를 Off, Tempo 또는 Beat로 설정한 경우 이 파라미터를 이용할 수 있습니다. Trigger를 On으로 설정한 경우에는 이 파라미터를 

이용할 수 없습니다.
설정: 	 Off, Each-On, 1st-On

Each-On: 음을 연주할 때마다 시퀀스가 재설정되며 처음부터 재생이 시작됩니다.
1st-On: 연주하는 첫 음에서 처음부터 재생이 시작됩니다. 첫 번째 음이 연주되는 동안 두 번째 음이 연주되면 시퀀스가 재설정되지 

않습니다.

Loop (Lane Loop)
모션 시퀀스를 루프 재생(반복) 또는 단일 재생으로 설정합니다.

Sync를 Off, Tempo 또는 Beat로 설정한 경우 이 파라미터를 이용할 수 있습니다.
설정: Off, On

Loop Start (Lane Loop Start)
모션 시퀀스 루프 재생 시작 지점을 지정합니다.
설정: 1–16(Length 설정 미만이어야 함)

Length (Motion Seq Length)
모션 시퀀스의 단계 수를 설정합니다.
설정: 1–16(Loop Start 설정을 초과해야 함)

MS Grid (Motion Sequencer Grid)
모션 시퀀스의 단계 길이를 설정합니다.
설정: 60, 80, 120, 160, 240, 320, 480

	� Motion Sequence Edit
Motion Sequence 설정 화면을 엽니다.

최대 16단계로 구성된 시퀀서를 생성할 수 있습니다.

Loop Start (Lane Loop Start)
모션 시퀀스 루프 재생 시작 지점을 지정합니다.
설정: 1–16(Length 설정 미만이어야 함)

Length (Motion Sequence Length)
모션 시퀀스 길이를 설정합니다.

설정: 1–16(Loop Start 설정을 초과해야 함)
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MS Grid (Motion Sequencer Grid)
모션 시퀀스의 단계 길이를 설정합니다.

설정: 60, 80, 120, 160, 240, 320, 480

Sequence Select (Motion Sequence Select)
모션 시퀀스 형식 선택 사항을 변경합니다.

설정: 1–8

Lane Select
레인 선택 사항을 변경합니다.

설정: 1–4

Polarity (Motion Sequence Polarity)
모션 시퀀스의 극성을 설정합니다.

설정: 	 Unipolar, Bipolar

Unipolar: 파라미터를 변경할 때 양의 값만 사용됩니다.

Bipolar: 파라미터를 변경할 때 양의 값과 음의 값 모두 사용됩니다.

Amplitude (Motion Sequence Amplitude)
모션 시퀀스의 변화도를 설정합니다.

설정: 0–127

Smooth (Motion Sequence Smoothness)
시간 경과에 따른 모션 시퀀스 변화의 부드러움을 설정합니다.

설정: 0–127

Job
작업 메뉴를 불러옵니다.

•	 Store Sequence

편집된 모션 시퀀스를 저장합니다.

•	 Load Sequence

모션 시퀀스를 불러옵니다.

•	 Copy Sequence

모션 시퀀스를 복사합니다.

Motion Sequence Step Value
모션 시퀀스의 각 단계에 대한 값을 설정합니다.

컨트롤 슬라이더 1~8을 사용하여 커서 위치에 따라 단계 1~8 및 단계 9~16의 값을 변경합니다.

설정: 0–127

Motion Sequence Step Type
모션 시퀀스에 존재하는 각 단계의 형식 및 방향을 설정합니다.

설정: A, B, Reverse A, Reverse B

Pulse A (Motion Sequence Step Curve Type A)
Pulse B (Motion Sequence Step Curve Type B)
Pulse A 및 Pulse B에 대한 파라미터 변화 곡선을 선택합니다.

Motion Sequence Step Type을 사용하여 각 단계에 어떤 곡선 형식을 사용할지 선택합니다.

수직축은 시간을 의미하며, 수평축은 단계값을 의미합니다.

설정: 	 Standard, Sigmoid, Threshold, Bell, Dogleg, FM, AM, M, Discrete Saw, Smooth Saw, Triangle, Square, Trapezoid, Tilt Sine, 

Bounce, Resonance, Sequence, Hold, Harmonic, Steps(프리세트 뱅크를 선택한 경우)

Init Curve 1–32 (유저 뱅크를 선택한 경우)

 Library 1–24 내 Curve(라이브러리 파일을 불러오는 경우)
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Prm 1 (Motion Sequence Step Curve Parameter 1)
Prm 2 (Motion Sequence Step Curve Parameter 2)
모션 시퀀스 단계 곡선의 형태를 조정합니다. 또한, 파라미터 값에 대한 범위도 Curve Type에 따라 달라집니다.

Curve Type에 따라서는 이 설정을 이용하지 못할 수 있습니다.

Control (Motion Sequence Step Curve Shape Control Switch)
모션 시퀀스 단계 곡선 형태를 제어할 때 노브의 사용을 활성화하거나 비활성화합니다.

MS FX (Lane FX Receive)가 켜짐으로 설정된 경우에만 표시됩니다. Curve Type에 따라서는 이 설정을 이용하지 못할 수 있습니다.

설정: Off, On
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Control

Control Assign

Control Assign 화면에서 파트의 컨트롤러를 설정할 수 있습니다.

컨트롤러(Source에 파라미터(Destination)를 지정하면 여러 다양한 방법으로 음향을 제어할 수 있습니다. 피치 벤드 휠 및 노브와 모션 

시퀀서 및 엔벌로프 팔로워와 같은 물리적인 컨트롤러를 사용해도 됩니다.

파트에 최대 32개의 컨트롤러를 함께 지정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Control → Control Assign

Motion Control의 Edit Super Knob 탭하기 → Super Knob

Auto Select
Display Filter의 자동 선택을 켜짐 또는 꺼짐으로 전환합니다.

켜짐으로 설정한 경우 Source로 설정하려는 컨트롤러를 움직이면 Display Filter에 컨트롤러가 자동으로 설정됩니다.
설정: Off, On

Display Filter
화면에 설정을 표시할 때 사용되는 컨트롤러를 선택합니다.

Super Knob를 선택하면 Super Knob Link가 켜짐으로 설정된 노브 1~8의 모든 설정이 표시됩니다.
설정: 	 PitchBend, ModWheel, Ch. AT, FootCtrl 1, FootCtrl 2, FootSwitch, Ribbon, Breath, AsgnKnob 1–8, Super Knob, AsgnSw 1, 

AsgnSw 2, MS Lane 1–4, EnvFollow 1–16, EnvFollowAD, EnvFollowMst, All

Display Name (Assignable Knob Name)
노브 1~8에 새 이름을 입력할 수 있습니다. Source를 AsgnKnob 1–8 이외의 다른 값으로 설정한 경우에는 이 파라미터가 표시되지 

않습니다.

Edit Pitch Bend
General/Pitch → Pitch가 열립니다. Source를 PitchBend 이외의 다른 값으로 설정한 경우에는 이 파라미터가 표시되지 않습니다.

Edit Motion Sequencer
Arp/MS → Lane을 엽니다. Source를 MS Lane 1–4 이외의 다른 값으로 설정한 경우에는 이 파라미터가 표시되지 않습니다.

Edit Envelope Follower
Envelope Follower 설정 화면을 엽니다. Source를 EnvFollow 1–16, EnvFollowAD 또는 EnvFollowMst 이외의 다른 값으로 

설정한 경우에는 이 파라미터가 표시되지 않습니다.



190MODX M 사용설명서

Destination
대상에 파라미터를 설정합니다. [+] 기호를 탭해 Destination을 추가합니다.

Source를 AsgnKnob 1–8로 설정한 경우 Part1–16 Assign1–8이 설정에 추가됩니다. 이 경우, Curve Type 및 Curve Ratio는 

이용할 수 없습니다.

Source
Destination으로 설정된 파라미터를 제어할 때 사용되는 컨트롤러를 설정합니다.

Destination을 Part1–16 Assign1–8로 설정한 경우 AsgnKnob 1–8만 이용할 수 있습니다. 다른 컨트롤러는 사용할 수 없습니다.

설정: 	 PitchBend, ModWheel, AfterTouch, FootCtrl 1, FootCtrl 2, FootSwitch, Ribbon, Breath, AsgnKnob 1–8,  

AsgnSw 1, AsgnSw 2, MS Lane 1–4, EnvFollow 1–16, EnvFollowAD, EnvFollowMst

Destination to Name
Destination에 설정된 파라미터를 Display Name으로 복사합니다.

Source를 AsgnKnob 1–8 이외의 다른 값으로 설정한 경우에는 이 파라미터가 표시되지 않습니다.

Delete
선택한 Destination을 삭제합니다.

Destination (Part Assignable Knob Destination)
다수의 대상이 이미 Part Assign에 지정된 상태에서 Part1–16 Assign1–8을 Destination에 설정하려고 할 때 표시할 파라미터를 

설정합니다.

Parameter (Part Assignable Knob Parameter)
Destination에 파트 파라미터를 설정합니다.

설정: Data List 참조

아래 표시된 파라미터는 Destination 1–32를 Part1–16 Assign1–8로 설정한 경우에만 나타납니다. 또한 파트 노브 1~8을 

Destination에서 확인할 수 없는 경우 단축키 버튼만 이용할 수 있습니다.

Edit (Part No.) Control Assign
선택한 파트의 Control Assign 화면을 엽니다.

Curve Type
Destination으로 설정된 파라미터의 변화 곡선을 설정합니다.

수평축은 Source에서 설정된 컨트롤러 값을 의미하고, 수직축은 파라미터 값을 나타냅니다.

설정: 	 Standard, Sigmoid, Threshold, Bell, Dogleg, FM, AM, M, Discrete Saw, Smooth Saw, Triangle, Square, Trapezoid, Tilt Sine, 

Bounce, Resonance, Sequence, Hold, Harmonic, Steps (프리세트 뱅크를 선택한 경우)

Init Curve 1–32 (유저 뱅크를 선택한 경우)

Library 1–24 내 Curve(라이브러리 파일을 불러오는 경우)

Polarity (Curve Polarity)
Curve Type에서 설정된 곡선의 극성을 설정합니다.

설정: 	 Uni, Bi

Uni: 곡선 형태에 따라 양의 범위 또는 음의 범위 안에서만 파라미터가 변합니다.

Bi: 곡선 형태에 따라 양의 범위와 음의 범위 안 모두에서 파라미터가 변합니다.

Ratio (Curve Ratio)
파라미터 값의 비율을 설정합니다.

설정: −128–+0–+127

Param 1 (Curve Parameter 1)
Param 2 (Curve Parameter 2)
곡선 형태를 조정합니다. Curve Type에 따라서는 이 설정을 이용하지 못할 수 있습니다.

Edit User Curve
User Curve 설정 화면을 엽니다.
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Ribbon Settings

리본 컨트롤러를 설정합니다.

작업

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Control → Ribbon Settings

Ribbon Grid Mode
리본 컨트롤러에 그리드 모드를 설정합니다.

설정: Continuous, 5 step, 3 step 

주
Control Assign 화면에서 설정한 Ribbon Controller 설정을 사용하려면 Continuous로 설정합니다.

	� Continuous 모드

Ribbon Mode (Ribbon Controller Mode)
리본 컨트롤러 작동 방식을 설정합니다.

설정: 	 Hold, Reset

Hold: 리본 컨트롤러에서 손가락을 떼는 위치의 값을 유지합니다.

Reset: 리본 컨트롤러에서 손가락을 뗄 때 중간 위치로 값을 자동 재설정합니다.

	� 5 step 모드, 3 step 모드

Control Part
리본 컨트롤러로 제어할 파트를 선택합니다.

설정: Common, Part 1–16

Control Destination
설정: Data List의 Control Box Destination 참조

Step Value 1–5
설정: Destination에 따라 달라짐
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Control Number

전체 퍼포먼스에 대해 컨트롤 변경 번호를 설정합니다.

상단 패널의 노브와 외부 장치의 컨트롤러에 MIDI 컨트롤 변경 번호를 지정할 수 있습니다.

주
본 악기에 포함되지 않은 컨트롤러의 경우 외부 시퀀서 또는 외부 MIDI 컨트롤러를 사용할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Control → Control Number

Ribbon Ctrl (Ribbon Controller Control Number)
리본 컨트롤러를 작동하여 생성되는 컨트롤 변경 번호를 설정합니다.

본 악기가 외부 장치에서 이 파라미터를 통해 설정되는 번호의 MIDI 컨트롤 변경 메시지를 수신할 때 이 메시지는 내장 리본 컨트롤러 

작동과 동일하게 처리됩니다.

설정: Off, 1–95

Breath Ctrl (Breath Controller Control Number)
브레스 컨트롤러가 외부 장치에서 수신할 컨트롤 변경 번호를 설정합니다.

본 악기가 외부 장치에서 이 파라미터를 통해 설정되는 번호의 MIDI 컨트롤 변경 메시지를 수신할 때 이 메시지는 브레스 컨트롤러 

작동과 동일하게 처리됩니다.

설정: Off, 1–95

Foot Ctrl 1 (Foot Controller 1 Control Number)
Foot Ctrl 2 (Foot Controller 2 Control Number)
FOOT CONTROLLER 잭에 연결된 풋 컨트롤러를 작동하여 생성되는 컨트롤 변경 번호를 설정합니다.

본 악기가 외부 장치에서 이 파라미터를 통해 설정되는 번호의 MIDI 컨트롤 변경 메시지를 수신할 때 이 메시지는 풋 컨트롤러 작동과 

동일하게 처리됩니다.

설정: Off, 1–95, Super Knob

Assign Sw 1 (Assignable Switch 1 Control Number)
Assign Sw 2 (Assignable Switch 2 Control Number)
[ASSIGN 1] 및 [ASSIGN 2] 버튼을 작동하여 생성되는 컨트롤 변경 번호를 설정합니다.

본 악기가 외부 장치에서 이 파라미터를 통해 설정되는 번호의 MIDI 컨트롤 변경 메시지를 수신할 때 이 메시지는 [ASSIGN 1] 및 

[ASSIGN 2] 버튼 작동과 동일하게 처리됩니다.

설정: Off, 1–95
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MS Trigger (Motion Sequencer Trigger Switch Control Number)
[MSEQ TRIGGER] 버튼을 작동하여 생성되는 컨트롤 변경 번호를 설정합니다.

본 악기가 외부 장치에서 이 파라미터를 통해 설정되는 번호의 MIDI 컨트롤 변경 메시지를 수신할 때 이 메시지는 [MSEQ TRIGGER] 

버튼 작동과 동일하게 처리됩니다.

설정: Off, 1–95

MIDI Settings
MIDI 설정 화면을 엽니다. [UTILITY] → Settings → MIDI I/O에서도 동일한 화면을 열 수 있습니다.

Assign Knob (Assignable Knob Control Number)
노브 1~8을 작동하여 생성되는 컨트롤 변경 번호를 설정합니다.

본 악기가 외부 장치에서 이 파라미터를 통해 설정되는 번호의 MIDI 컨트롤 변경 메시지를 수신할 때 이 메시지는 노브 1~8 작동과 

동일하게 처리됩니다.

설정: Off, 1–95

FS Assign (Foot Switch Assign Control Number)
FOOT SWITCH [ASSIGNABLE] 잭에 연결된 풋 스위치를 작동하여 생성되는 컨트롤 변경 번호를 표시합니다. 본 악기가 외부 장치에서 

이 파라미터를 통해 설정되는 번호의 MIDI 컨트롤 변경 메시지를 수신할 때 이 메시지는 풋스위치 작동과 동일하게 처리됩니다.

Scene CC (Scene Control Change Number)
SCENE 버튼을 작동하여 생성되는 컨트롤 변경 번호를 설정합니다. 본 악기가 외부 장치에서 이 파라미터를 통해 설정되는 번호의 MIDI 

컨트롤 변경 메시지를 수신할 때 이 메시지는 SCENE 버튼 작동과 동일하게 처리됩니다.

Super Knob CC (Super Knob Control Change Number)
수퍼 노브를 작동하여 생성되는 컨트롤 변경 번호를 설정합니다. 본 악기가 외부 장치에서 이 파라미터를 통해 설정되는 번호의 MIDI 

컨트롤 변경 메시지를 수신할 때 이 메시지는 수퍼 노브 작동과 동일하게 처리됩니다.

주
•	Scene CC 및 Super Knob CC를 꺼짐으로 설정한 경우 MIDI 메시지를 처리할 때 시스템 전용(SysEx)이 사용됩니다.

•	FS Assign, Scene CC 및 Super Knob CC는 전체 악기에 사용됩니다. 원하는 경우 Utility MIDI I/O 화면에서 이러한 설정을 변경하십시오.
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Control Settings

컨트롤러 모드를 설정합니다.

작업 

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Control → Control Settings

[SHIFT] + [ASSIGN 1]

[SHIFT] + [ASSIGN 2]

Slider Direction Part 1–8
슬라이더 Mode를 PART로 설정한 경우 컨트롤 슬라이더 1~8의 방향을 설정합니다.

설정: Normal(하단에서 상단으로), Reverse(상단에서 하단으로)

Assignable Switch 1 Mode
Assignable Switch 2 Mode
Latch 또는 Momentary 설정에 [ASSIGN 1] 및 [ASSIGN 2] 버튼을 설정합니다.

설정: 	 Latch, Momentary

Latch: 버튼을 누르면 켜짐으로 설정하고 버튼을 다시 누르면 꺼짐으로 설정합니다.

Momentary: 버튼을 길게 누르면 켜짐으로 설정하고 버튼에서 손을 떼면 꺼짐으로 설정합니다.
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Part Edit (AWM2) Part Common Edit 화면

일반 파트(AWM2)는 최대 128개의 요소로 구성됩니다.

Part Edit (AWM2)에는 전체 파트에 파라미터를 설정할 때 사용되는 Part Common Edit과 파트의 각 요소에 대한 파라미터를 설정할 

때 사용되는 Element Edit이 포함됩니다.

General/Pitch

Part Settings

Part Settings 화면에서 파트의 일반 파라미터(예: 파트 이름 및 톤 생성 시스템)를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → General/Pitch → Part Settings

Main Category (Part Main Category)
Sub Category (Part Sub Category)
선택한 파트의 메인 카테고리와 하위 카테고리를 설정합니다.

설정: Data List 참조

Part Name
새 이름으로 편집 중인 파트를 저장합니다. 최대 20자의 영숫자 문자를 사용할 수 있습니다.

Volume
선택한 파트의 음량을 설정합니다.

설정: 0–127

Pan
선택한 파트의 (스테레오 필드 내) 팬 위치를 설정합니다.

설정: L63–C(중앙)–R63
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Dry Level
선택한 파트의 dry 레벨을 설정합니다. Part Output을 MainL&R로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Var Send (Variation Send)
선택한 파트의 변주 전송을 설정합니다. Part Output을 MainL&R로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Rev Send (Reverb Send)
선택한 파트의 리버브 전송을 설정합니다. Part Output을 MainL&R로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Part Output (Part Output Select)
선택한 파트에서 오디오 신호의 출력 대상을 설정합니다.

설정: 	 MainL&R, (AsgnL&R), USB Stereo, (AsgnL), (AsgnR), USB mono, Off

MainL&R: OUTPUT [L/MONO] 및 OUTPUT [R] 잭으로 스테레오(2개의 채널)로 출력됩니다.

USB Stereo: USB [TO HOST] 단자로 스테레오(채널 1 및 2~채널 7 및 8)로 출력됩니다.

USB mono: USB [TO HOST] 단자로 모노(채널 1~8)로 출력됩니다.

Off: 파트의 오디오 신호 출력이 없습니다.

주
MONTAGE M과의 데이터 호환 설정은 아래 표시되어 있습니다. 설정 시에는 Off로 간주됩니다.

•	AsgnL&R

•	USB Stereo: USB9&10 – USB29&30

•	USB mono: USB9 – USB30

•	AsgnL

•	AsgnR

Mono/Poly
현재 파트의 톤 생성 모드를 설정합니다. Mono는 하나의 음만 연주할 때 사용되고 Poly는 동시에 여러 음을 연주할 때 사용됩니다.

레가토에서 건반을 연주할 때 Mono 설정을 사용하면 한 음에서 다른 음으로 음향을 매끄럽게 전환할 수 있습니다.

설정: Mono, Poly

Key Assign (Key Assign Mode)
내부 톤 제너레이터가 동일한 음향의 노트 온 메시지를 두 번 (이상) 연속으로 수신할 때 음향 생성 방법을 설정합니다.

대부분의 경우 Multi 설정이 권장됩니다. 그러나 Multi 설정은 최대 동시발음수로 수많은 음을 사용하므로 다른 파트의 음향이 

끊어지거나 올바르게 연주되지 않으면 Single로 변경하는 것이 좋습니다.

설정: 	 Single, Multi

Single: 먼저 음을 멈춘 후에 다시 동일한 음을 연주합니다. 이 경우, 동일한 채널에서 동일한 음을 반복할 때 편리합니다.

Multi: 첫 번째 음에 겹쳐 두 번째 음을 연주합니다. 이 Multi설정을 실시하면 특히 크래시 심벌 및 다른 타악기의 감쇄가 긴 상태로 롤이 

자연스럽게 들립니다.

Arp Play Only (Arpeggio Play Only)
아르페지오에 따라서만 연주할 파트를 설정합니다.

켜짐으로 설정된 파트는 아르페지오에서 전송된 노트 온 메시지에 의해 연주됩니다.

설정: Off, On

Element Pan (Element Pan Switch)
Element Edit에서 팬을 켜짐 또는 꺼짐으로 설정합니다.

꺼짐으로 설정한 경우 Element Edit의 Pan이 C(중앙)로 설정됩니다.

설정: Off, On
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TG Note Limit (Note Limit)
파트의 음 범위(최저/최고음)를 설정합니다.

Note Limit의 첫 번째 음이 두 번째 음보다 높은 경우(예: C5에서 C4로), C−2~C4 및 C5~G8 범위의 음이 연주됩니다.

설정: C−2–G8

TG Vel Limit (Velocity Limit)
파트의 세기 범위(최저/최고값)를 설정합니다.

높은 값이 첫 번째, 낮은 값이 두 번째(예: 93에서 34로)가 되도록 설정된 경우, 1~34 및 93~127의 세기에서만 음이 연주됩니다.

설정: 1–127

Velocity Offset (Velocity Sensitivity Offset)
내부 톤 제너레이터로 전송된 세기 값을 증가 또는 감소시킵니다.

설정: 0–127

Velocity Depth = 64이고
Velocity Offset = 32인 경우

Velocity Depth = 64이고
Velocity Offset = 64인 경우

Velocity Depth = 64이고
Velocity Offset = 96인 경우

127

0 12764 12764

127

012764

127

0

(1)

(2)

(1)

(2)

(1)

(2)

127

0 12764 12764

127

012764

127

0

(1)

(2)

(1)

(2)

(1)

(2)

127

0 12764 12764

127

012764

127

0

(1)

(2)

(1)

(2)

(1)

(2)

(1) 실제 결과적으로 만들어지는 세기(톤 제너레이터에 영향)
(2) 음을 연주하는 세기

Velocity Depth (Velocity Sensitivity Depth)
내부 톤 제너레이터에 전송된 세기 값 레벨이 건반을 누르는 세기나 강도에 어떻게 반응하는지 설정합니다.

설정: 0–127

Velocity Depth = 64인 경우

 

127

0 12764

(1)
Depth = 127

Depth = 64

Depth = 32

Depth = 0
(2)

(1) 실제 결과적으로 만들어지는 세기(톤 제너레이터에 영향)
(2) 음을 연주하는 세기
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Zone Settings

Zone Settings 화면에서 영역 기능의 파라미터를 설정할 수 있습니다.

이 기능을 사용하면 전체 건반을 최대 8개의 부분(영역)으로 분할하고 각 영역에 별도의 채널을 개별적으로 지정할 수 있습니다.  

이렇듯, 1개의 건반만으로도 여러 건반의 음향을 연주할 수 있습니다. 외부 다중 음색 사운드 모듈에서 다수의 파트를 연주하거나 내부 톤 

제너레이터 및 연결된 모든 외부 사운드 모듈을 연주할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → General/Pitch → Zone Settings

Keyboard Sw (Keyboard Control Switch)
각 파트의 Keyboard Sw (Keyboard Control Switch)를 켜거나 꺼서 어떤 파트를 동시에 연주할지 설정할 수 있습니다.

Common 또는 Keyboard Sw가 켜짐으로 설정된 파트를 선택하고 건반을 연주하면 Keyboard Sw가 켜짐으로 설정된 파트가 동시에 

연주됩니다.

파트의 Keyboard Sw를 꺼짐으로 설정한 경우, 이 파트를 선택한 상태로 건반을 연주하면 이 음향이 연주됩니다.

설정: Off, On

Zone Vel Limit (Zone Velocity Limit)
영역의 세기 범위(최저/최고값)를 설정합니다.

높은 값이 첫 번째, 낮은 값이 두 번째(예: 93에서 34로)가 되도록 설정된 경우, 1~34 및 93~127의 세기에서만 음이 연주됩니다.

설정: 1–127

Zone Note Limit
영역의 음 범위(최저/최고음)를 설정합니다.

Note Limit의 첫 번째 음이 두 번째 음보다 높은 경우(예: C5에서 C4로), C−2~C4 및 C5~G8 범위의 음이 연주됩니다.

설정: C−2–G8

Octave Shift
영역 피치를 옥타브 단위로 이동합니다.

설정: −3–+0(표준)–+3
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Transpose
영역 피치를 반음 단위로 이동합니다.

설정: -11–+0(표준)–+11

Part Mode
파트 모드를 전환합니다.

설정: 	 Internal, External

Internal: 악기의 내장 음원을 사용하는 모드

External: 외부 사운드 제너레이터를 사용합니다. External로 설정된 파트는 외부 장치에서 MIDI 메시지를 수신하지 않습니다.

Tx/Rx Ch (Transmit/Receive Channel)
Part Mode를 Internal로 설정한 경우 MIDI 메시지를 전송/수신할 때 사용되는 채널을 설정합니다.

설정: Ch1–Ch16, Off

Transmit Ch
Part Mode를 External로 설정한 경우, 영역의 MIDI 메시지를 전송/수신할 때 사용되는 채널을 설정합니다.

설정: Ch1–Ch16

MIDI I/O Ch (MIDI Input/Output Channel)
Common으로 설정된 파트 및 Keyboard Sw가 켜짐으로 설정된 파트를 제어할 때 사용되는 채널을 표시합니다.

이 설정은 전체 악기에 공통입니다. Utility MIDI Settings 화면에서 설정을 변경할 수 있습니다.

Tx/Rx Ch 및 Transmit Ch을 사용할 경우 MIDI I/O Ch에 지정된 동일한 채널을 사용하지 마십시오. 동일한 채널이 지정되었다면 MIDI 

I/O Ch이 우선합니다.

설정: Ch1–Ch16

MIDI Settings
Utility 화면의 Settings → MIDI I/O를 엽니다.

MIDI Send
이 파라미터가 켜짐으로 설정된 경우 변경할 때마다 MIDI Bank MSB/LSB, MIDI Pgm Num, MIDI Volume 및 MIDI Pan 설정이 외부 

장치로 전송됩니다. 그러나 해당 전송 스위치가 꺼짐으로 설정된 경우에는 설정이 전송되지 않습니다.

이 설정은 모든 파트에 공통적으로 적용되며 각 퍼포먼스에 대해 개별적으로 설정할 수 없습니다.

Part Mode를 External로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: Off, On

Bank Select (Transmit Bank Select)
MIDI Bank MSB 및 MIDI Bank LSB를 외부 장치로 전송할 때 사용되는 전송 스위치입니다.

Part Mode를 External로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: Off, On

MIDI Bank MSB
MIDI Bank LSB
퍼포먼스 선택 사항을 전송할 때 사용되는 뱅크를 선택합니다. Bank Select (Transmit Bank Select)가 꺼짐으로 설정된 경우에는 이 

파라미터를 이용할 수 없습니다.

Part Mode를 External로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 000–127

Pgm Change (Transmit Program Change)
프로그램 변경 메시지를 외부 장치에 전송할 때 사용되는 전송 스위치입니다.

Part Mode를 External로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: Off, On
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MIDI Pgm Num (MIDI Program Number)
퍼포먼스 선택 사항을 전송할 때 사용되는 프로그램 변경 번호를 선택합니다.

Pgm Change (Transmit Program Change)가 꺼짐으로 설정된 경우에는 이 파라미터를 이용할 수 없습니다.

Part Mode를 External로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 001–128

Vol/Exp (Transmit Volume/Expression)
음량 설정을 외부 장치에 전송할 때 사용되는 전송 스위치입니다.

Part Mode를 External로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: Off, On

MIDI Volume
퍼포먼스 선택 사항을 전송할 때 사용되는 음량을 선택합니다.

Part Mode를 External로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Pan (Transmit Pan)
팬 설정을 외부 장치에 전송할 때 사용되는 전송 스위치입니다.

Part Mode를 External로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: Off, On

MIDI Pan
퍼포먼스 선택 사항을 전송할 때 사용되는 팬을 선택합니다.

Pan (Transmit Pan)가 꺼짐으로 설정된 경우에는 이 파라미터를 이용할 수 없습니다.

설정: L64–C(중앙)–R63

Edit Tx/Rx Switch
Mod/Control → Tx/Rx Switch가 표시됩니다.



201MODX M 사용설명서

Element Settings

사용할 최대 요소 수를 설정합니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → General/Pitch → Element Settings

Ex Elem Sw (Extended Element Switch)
요소 확장 성능을 활성화합니다.

꺼짐으로 설정한 경우 최대 8개의 요소만 이용할 수 있습니다.

설정: Off, On

Element Count
사용할 최대 요소 수를 설정합니다.

설정: 8–128
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Pitch

Pitch 화면에서 파트의 피치를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → General/Pitch → Pitch

Master Sw (Portamento Master Switch)
포르타멘토는 두 음을 서로 매끄럽게 전환할 때 사용되는 기능입니다.

Portamento Part Switch가 켜짐으로 설정된 파트의 포르타멘토를 켜짐 또는 꺼짐으로 설정합니다.

이 스위치는 상단 패널의 [PORTAMENTO] 버튼과 연결되어 있습니다.

설정: Off, On

Note Shift
반음 단위로 피치를 조정합니다.

설정: −48–+0–+48

Detune
선택한 파트의 피치를 0.1Hz 단위로 조정합니다.

피치를 약간 이동하면 음향을 디튠 처리할 수 있습니다.

설정: −12.8Hz–+0.0Hz–+12.7Hz

Pitch Control Group
동일한 그룹에 지정된 파트에는 동일한 피치가 설정됩니다.

Mono/Poly
현재 파트의 톤 생성 모드를 설정합니다. Mono는 하나의 음만 연주할 때 사용되고 Poly는 동시에 여러 음을 연주할 때 사용됩니다.

레가토에서 건반을 연주할 때 Mono 설정을 사용하면 한 음에서 다른 음으로 음향을 매끄럽게 전환할 수 있습니다.

설정: Mono, Poly

Pitch Bend (Pitch Bend Range Lower)
Pitch Bend (Pitch Bend Range Upper)
피치 벤드 휠로 생성한 변경 범위를 반음 단위로 설정합니다.

설정: −48–+0–+24
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Edit Control Assign
Display Filter 가 PitchBend로 설정된 Control Assign 화면을 엽니다.

Portamento (Portamento Part Switch)
파트의 포르타멘트를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Mode (Portamento Mode)
건반 연주에 따른 포르타멘토 적용 방식을 설정합니다.

설정: 	 Fingered, Full-time

Fingered: 레가토(이전의 건반에서 손을 떼기 전에 다음 음을 연주하는 것)를 연주할 때에만 포르타멘토가 적용됩니다.

Full-time: 포르타멘토가 항상 적용됩니다.

Time (Portamento Time)
파트에 포르타멘토의 피치 이동에 대한 시간 길이(또는 속도)를 설정합니다.

설정: 0–127

Time Mode (Portamento Time Mode)
시간 경과에 따라 피치가 변하는 방식을 설정합니다.

설정: 	 Rate 1, Time 1, Rate 2, Time 2

Rate 1: 피치가 지정된 속도로 변경됩니다.

Time 1: 피치가 지정된 시간에 변경됩니다.

Rate 2: 피치가 한 옥타브 안에서 지정된 속도로 변경됩니다.

Time 2: 피치가 한 옥타브 안에서 지정된 시간에 변경됩니다.

Legato Slope (Portamento Legato Slope)
Mono/Poly를 Mono로 설정한 경우 레가토(이전의 건반에서 손을 떼기 전에 다음 음을 연주하는 것)의 어택을 조정합니다.

Mono로 설정한 경우 음의 어택은 파트에 지정된 파형의 어택 속도에 따라 부자연스럽게 들릴 수 있습니다. 이 파라미터를 어택이 짧은 

음향에 대해서는 낮게, 어택이 긴 음향에 대해서는 높게 설정하면 음향의 어택이 자연스럽게 들리도록 조정할 수 있습니다.

설정: 0–7

Micro Tuning Name
파트의 미세 튜닝(평균율)을 설정합니다.

각 평균율에 대한 설명은 Common Edit 화면의 General/Pitch → Pitch를 참조하십시오.

설정: 	 Equal Temperament, Pure Major, Pure Minor, Werckmeister, Kirnberger, Vallotti & Young, 1/4 shift, 1/4 tone, 1/8 tone, 

Indian, Arabic 1, Arabic 2, Arabic 3

Init Tuning 1–8 (유저 뱅크를 선택한 경우)

Library 1–1 – 24–8 (라이브러리 파일을 불러오는 경우)

Root (Micro Tuning Root)
미세 튜닝의 근음을 설정합니다.

이 파라미터는 근음이 필요한 Micro Tuning Name을 선택한 경우에만 표시됩니다.

설정: C–B

Edit User Tuning
User Micro Tuning 설정 창을 엽니다.
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Filter/Amp

Filter

Filter 화면에서 파트에 필터 엔벌로프 제너레이터(FEG)를 설정할 수 있습니다.

FEG를 사용하면 차단 주파수의 변화도(또는 레벨)와 건반을 누른 순간부터 음향이 감쇄될 때까지 시간 경과에 따라 어떻게 변하는지 

설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Filter/Amp → Filter

FEG Atk (FEG Attack Time)
건반을 누른 순간부터 차단 주파수가 Attack Level (FEG Attack Level)에 설정된 값이 될 때까지 음향이 변하는 데 소요되는 시간을 

설정합니다.

이 파라미터는 Element FEG의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

FEG Decay (FEG Decay Time)
차단 주파수가 Attack Level (FEG Attack Level)에서 변할 때까지 소요되는 시간을 설정합니다. 음향의 산뜻한 정도나 감쇄 속도를 

제어할 수 있습니다.

이 파라미터는 Element FEG의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

FEG Sus (FEG Sustain Level)
FEG Decay (FEG Decay Time)의 끝부분을 따르는 차단 주파수 레벨을 설정합니다.

이 파라미터는 Element FEG의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

FEG Rel (FEG Release Time)
건반에서 손을 뗄 때 차단 주파수가 Release Level (FEG Release Level)로 감소할 때까지 소요되는 시간을 설정합니다.

이 파라미터는 Element FEG의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63
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Cutoff (Filter Cutoff Frequency)
필터의 차단 주파수를 설정하여 음향을 변경합니다. 로우 패스 필터를 선택한 경우 값이 커지면 음향이 밝아지고 값이 작아지면 음향이 

어두워집니다.

이 파라미터는 요소에 대한 차단 주파수의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

Resonance (Filter Resonance)
차단 주파수 근처의 신호 레벨을 조정하여 음향에 특별한 특성을 더합니다.

이 파라미터는 Resonance (Filter Resonance) 또는 Width (Filter Width)의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

FEG Depth
FEG로 제어되는 차단 주파수 변화의 깊이 범위를 요소에 대해 설정합니다.

0으로 설정한 경우 요소의 설정이 그대로 사용됩니다.

설정: −64–+0–+63
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Amp EG

Amp EG 화면에서 파트에 AEG(진폭 엔벌로프 제너레이터)를 설정할 수 있습니다. Amp EG를 설정하면 건반을 누른 순간부터 음향이 

감쇄될 때까지 음량이 어떻게 변하는지 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Filter/Amp → Amp EG

AEG Attack (AEG Attack Time)
건반을 누른 순간부터 최대값에 이를 때까지 음량이 변하는 데 소요되는 시간을 설정합니다.

이 파라미터는 Element AEG의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

AEG Decay (AEG Decay Time)
최대값에 이른 후 음량이 변할 때까지 소요되는 시간을 설정합니다.

이 파라미터는 Element AEG의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

AEG Sustain (AEG Sustain Level)
AEG Decay (AEG Decay Time) 후 유지되는 음량을 조정합니다.

설정: −64–+0–+63

AEG Release (AEG Release Time)
건반에서 손을 뗀 후 음향이 감쇄될 때까지 소요되는 시간을 설정합니다.

이 파라미터는 Element AEG의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63
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Effect

Routing

Routing 화면에서 파트의 이펙트 경로를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Effect → Routing

(1)

(1) VCM Rotary Speaker Switch

Element (Element Select)
선택한 요소의 이름을 표시합니다.

Ex Elem Sw (General/Pitch → Element Settings)를 꺼짐으로 선택하거나 요소가 8개 미만인 경우 번호 1~8이 표시됩니다.

설정: 1–128(최대 Element Count 설정)

Connect (Element Connection Switch)
인서트 이펙트 A 또는 인서트 이펙트 B로 출력할 요소를 설정합니다.

Thru로 설정하면 인서트 이펙트가 우회됩니다.

설정: Thru, InsA, InsB

3-band EQ
3-band EQ 설정 화면을 엽니다.
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Expression (Expression Type)
Expression 페달을 사용할 때 신호 흐름의 위치를 설정합니다.

설정: 	 Normal, Pre FX

Normal: 2-band EQ 후에 적용됩니다.

Pre FX: 인서트 이펙트 전에 적용됩니다. 이 설정은 Distortion 등의 비선형(입력 레벨에 따라 음향이 크게 변화) 이펙트와 함께 사용하면 

효과적입니다.

Exp. Curve (Expression Curve)
 Exp. Curve Expression Type을 Pre FX로 설정한 경우 표현 이펙트를 Exp. Curve로 적용하는 방식을 설정합니다.

설정: 	 Normal, Organ

Normal: 일반 특성의 음량 곡선

Organ: 빈티지 오르간을 재현하는 특성의 음량 곡선

VCM Rotary Speaker Switch
VCM 기술을 활용하여 로터리 스피커의 특성을 재현하는 VCM Rotary Speaker 이펙트를 설정합니다.

VCM Rotary Speaker Switch를 Part 1로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: Off, On

Ins Connect (Insertion Connection Type)
인서트 이펙트 A 및 인서트 이펙트 B의 이펙트 경로를 설정합니다. 설정이 변경되면 이에 따라 그림이 변합니다.

설정: 	 Parallel, Ins A→B, Ins B→A

Parallel: (일반 파트(AWM2) 및 드럼 파트의 경우): 인서트 이펙트 A 및 인서트 이펙트 B에서 전송되는 출력은 마스터 이펙트, 마스터 EQ, 

리버브, 변주 및 엔벌로프 팔로워로 각각 전송됩니다.

Ins A→B: 인서트 이펙트 A에서 전송되는 신호는 인서트 이펙트 B로 전송되고, 인서트 이펙트 B에서 전송되는 신호는 마스터 이펙트, 마스터 

EQ, 리버브, 변주 및 엔벌로프 팔로워로 전송됩니다.

Ins B→A: 인서트 이펙트 B에서 전송되는 신호는 인서트 이펙트 A로 전송되고, 인서트 이펙트 A에서 전송되는 신호는 마스터 이펙트, 마스터 

EQ, 리버브, 변주 및 엔벌로프 팔로워로 전송됩니다.

Parallel Ins A→B Ins B→A

A

B

A

B

A

B

A (Insertion Effect A Switch)
B (Insertion Effect B Switch)
모든 인서트 이펙트 A 또는 B를 켜거나 끕니다.

설정: Off, On

Type (Insertion Effect Type)
이펙트 형식을 설정합니다.

설정: 이펙트 형식 참조

Preset (Insertion Effect Preset)
이펙트 형식마다 내장 이펙트 파라미터 중 하나를 선택합니다.

내장을 선택하면 이펙트 적용 방식을 변경할 수 있습니다.

설정: Data List 참조
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Side Chain (Insertion Side Chain Part)
Modulator (Insertion Modulator Part)
인서트 이펙트 A 또는 인서트 이펙트 B의 사이드 체인 파트(또는 이펙트 형식에 따라 모듈레이터)를 설정합니다.

파트 자체 또는 Master가 모듈레이터 파트로 설정된 경우에는 이 파라미터를 이용할 수 없습니다. 이 경우, 파라미터 값이 "(Master)"와 

같이 괄호로 표시됩니다.

설정: Part 1–16, A/D, Master, Off

Dry Level
선택한 파트의 dry 레벨(또는 시스템 이펙트로 처리되지 않은 신호의 레벨)을 설정합니다.

Part Output (Part Output Select)를 MainL&R로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

2-band EQ
2-band EQ 설정 화면을 엽니다.

Rev Send (Reverb Send)
인서트 이펙트 A 또는 인서트 이펙트 B에서 리버브 이펙트로 전송된 신호(또는 바이패스 신호)의 레벨을 설정합니다. Part Output (Part 

Output Select)를 MainL&R로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Var Send (Variation Send)
인서트 이펙트 A 또는 인서트 이펙트 B에서 변주 이펙트로 전송된 신호(또는 바이패스 신호)의 레벨을 설정합니다. Part Output (Part 

Output Select)를 MainL&R로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Envelope Follower
Envelope Follower 설정 화면을 엽니다.

Part Output (Part Output Select)
오디오 신호의 출력 대상을 설정합니다.

설정: 	 MainL&R, (AsgnL&R), USB Stereo, (AsgnL), (AsgnR), USB mono, Off

MainL&R: OUTPUT [L/MONO] 및 OUTPUT [R] 잭으로 스테레오(2개의 채널)로 출력됩니다.

USB Stereo: USB [TO HOST] 단자로 스테레오(채널 1 및 2~채널 7 및 8)로 출력됩니다.

USB mono: USB [TO HOST] 단자로 모노(채널 1~8)로 출력됩니다.

Off: 파트의 오디오 신호 출력이 없습니다.

주
MONTAGE M과의 데이터 호환 설정은 아래 표시되어 있습니다. 설정 시에는 꺼짐으로 간주됩니다.

•	AsgnL&R

•	USB Stereo: USB9&10 – USB29&30

•	USB mono: USB9 – USB30

•	AsgnL

•	AsgnR
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Ins A, Ins B

Ins A 및 Ins B 화면에서 인서트 이펙트를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Effect → Ins A

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Effect → Ins B

Common Edit 화면의 Audio In → Ins A 및 Ins B와 동일합니다.
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3-band EQ

3-band EQ 화면에서 파트 EQ를 설정할 수 있습니다. EQ는 인서트 이펙트 전에 설정할 수 있습니다.

Part EQ Part EQ
3-band EQ

Insertion A

Insertion B 2-band EQ

Part

작업 

PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Effect → 3-band EQ

EQ Low Gain (3band EQ Low Gain)
Low 대역의 신호 레벨을 설정합니다.
설정: −12.00dB – +0.00dB – +12.00dB

EQ Low Freq (3band EQ Low Frequency)
Low 대역의 주파수를 설정합니다.
설정: 50.1Hz–2.00kHz

EQ Mid Gain (3band EQ Mid Gain)
Mid 대역의 신호 레벨을 설정합니다.
설정: −12.00dB – +0.00dB – +12.00dB

EQ Mid Freq (3band EQ Mid Frequency)
Mid 대역의 주파수를 설정합니다.
설정: 139.7Hz–10.1kHz

EQ Mid Q (3band EQ Mid Q)
Mid 대역의 대역폭을 설정합니다.
설정: 0.7–10.3

EQ Hi Gain (3band EQ High Gain)
High 대역의 신호 레벨을 설정합니다.
설정: −12.00dB – +0.00dB – +12.00dB

EQ Hi Freq (3band EQ High Frequency)
High 대역의 주파수를 설정합니다.
설정: 503.8Hz–14.0kHz
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2-band EQ

2-band EQ 화면에서 파트 EQ를 설정할 수 있습니다. EQ는 인서트 이펙트 후에 설정할 수 있습니다.

Part EQ Part EQ
3-band EQ

Insertion A

Insertion B 2-band EQ

Part

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Effect → 2-band EQ

EQ1 Type (2band EQ 1 Type)
EQ2 Type (2band EQ 2 Type)
원하는 EQ 형식을 선택합니다.

설정: 	 Thru, LPF, HPF, Low Shelf, Hi Shelf, Peak/Dip

Thru: 적용되는 이펙트 없이 신호를 통과시킵니다.

LPF: 차단 주파수 위의 신호를 차단합니다.

HPF: 차단 주파수 아래의 신호를 차단합니다.

Low Shelf: 지정된 주파수 설정 아래의 신호를 차단하거나 증폭시킵니다.

Hi Shelf: 지정된 주파수 설정 위의 신호를 차단하거나 증폭시킵니다.

Peak/Dip: 지정된 주파수 설정에서 신호를 차단하거나 증폭시킵니다.

EQ 1 Gain (2band EQ 1 Gain)
EQ 2 Gain (2band EQ 2 Gain)
EQ1 Type (2band EQ 1 Type) 또는 EQ2 Type (2band EQ 2 Type)에 설정된 주파수 대역의 신호 레벨을 설정합니다. EQ Type을 

Thru, LPF 또는 HPF로 설정한 경우에는 이 파라미터를 이용할 수 없습니다

설정: −12.0dB – +0.0dB – +12.0dB

EQ 1 Freq (2band EQ 1 Frequency)
EQ 2 Freq (2band EQ 2 Frequency)
차단하거나 증폭시킬 주파수를 설정합니다. EQ Type을 Thru로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 63.0Hz–18.0Hz
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EQ 1 Q (2band EQ 1 Q)
EQ 2 Q (2band EQ 2 Q)
EQ1 Type (2band EQ 1 Type) 또는 EQ2 Type (2band EQ 2 Type)으로 설정된 주파수의 음량을 차단하거나 증폭시킬 때 사용되는 

대역폭을 설정합니다. EQ Type을 Peak/Dip으로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0.1–12.0

Output Level (2band EQ Output Level)
2대역 EQ의 출력 게인을 설정합니다.

설정: −12.0dB – +0.0dB – +12.0dB

Ins Assign

Ins Assign 화면에서 Part 9~16 Insertion Effect를 활성화할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Effect → Ins Assign

Active (Active Part)
스위치가 켜짐으로 설정된 파트의 수를 표시합니다. 사선(/) 우측의 수는 동시에 켤 수 있는 인서트 이펙트의 최대 수입니다.

Part 9–16
파트 9~16의 인서트 이펙트를 활성화합니다.

설정: Off, On

주
파트 1~8의 인서트 이펙트는 항상 활성화됩니다.
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Arpeggio

Common

Common 화면에서 전체 파트의 아르페지오를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Arpeggio → Common

Arp Part (Part Arpeggio Switch)
파트의 아르페지오를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Arp Master (Arpeggio Master Switch)
퍼포먼스의 아르페지오를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Sync Quantize (Arpeggio Sync Quantize Value)
다중 파트에서 아르페지오 프레이즈를 재생할 때 첫 아르페지오 재생 중 다음 아르페지오 프레이즈 시작 타이밍을 조정합니다.

꺼짐으로 설정된 경우 건반에서 파트를 연주할 때 아르페지오가 재생됩니다.

여기에 표시된 값은 클록으로 표시됩니다.

설정: 	 Off, 60(32분 음표), 80(16분 음표의 셋잇단음표), 120(16분 음표), 160(8분 음표의 셋잇단음표), 240(8분 음표), 320(4분 음표의 

셋잇단음표), 480(4분 음표)

Arpeggio Group
다중 파트와 함께 동일한 아르페지오를 사용하여 Arpeggio Group을 설정합니다.

Indicator
이 표시등은 선택한 파트와 동일한 Arpeggio Group에 파트가 존재하는 경우 켜짐으로 설정됩니다.
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Hold (Arpeggio Hold)
손을 뗀 후에도 아르페지오가 반복해서 계속 재생되는 홀드 기능을 활성화하거나 비활성화합니다.

설정: 	 Sync-Off, Off, On

Sync-Off: 건반에서 손을 뗀 상태일 때 배경에서 아르페지오 재생을 반복하고 건반을 누를 때 재생을 재개합니다.

Off: 건반을 누른 상태에서만 아르페지오를 재생합니다.

On: 건반을 누르면 손을 뗀 후에도 아르페지오가 반복해서 계속 재생됩니다.

Change Timing (Arpeggio Change Timing)
다른 아르페지오 프레이즈가 여전히 재생 중일 때 아르페지오 변경 타이밍을 설정합니다. 즉시 새 아르페지오로 전환할 때 Real-time을 

선택하거나 다음 소절 맨 앞에서 새 아르페지오 프레이즈로 전환할 때 Measure를 선택할 수 있습니다.

설정: Real-time, Measure

Key Mode (Arpeggio Key Mode)
아르페지오 재생 방식을 설정합니다.

설정: 	 Sort, Thru, Direct, Sort+Drct, Thru+Drct

Sort: 연주한 건반 순서와는 상관없이 동일한 아르페지오를 재생합니다.

Thru: 연주한 건반 순서에 따라 다른 방식으로 아르페지오를 재생합니다.

Direct: 아르페지오를 재생하지 않습니다. 건반 연주만 재생됩니다. 그러나 아르페지오 데이터가 팬 또는 선명도 등의 컨트롤 변경(CC) 

데이터를 포함할 경우 이 이펙트가 반영됩니다. 이 파라미터는 아르페지오 데이터가 컨트롤 변경 데이터를 포함하거나 Control 카테고리의 

아르페지오를 선택할 경우 효과적입니다.

Sort+Drct: Sort 설정과 건반 연주음에 따라 아르페지오를 재생합니다.

Thru+Drct: Thru 설정과 건반 연주음에 따라 아르페지오를 재생합니다.

Loop (Arpeggio Loop)
건반을 누른 상태에서 루프(반복) 재생을 선택하거나 건반을 누를 때마다 아르페지오의 단일 재생을 선택합니다.

설정: Off, On

Arp Play Only (Arpeggio Play Only)
아르페지오에 따라서만 연주할 파트를 설정합니다.

켜짐으로 설정된 파트는 아르페지오에 대해 전송된 노트 온 메시지에 의해 연주됩니다.

설정: Off, On

Swing
Quantize Value에 지정된 값에서 매겨진 짝수 번호 박자(백비트)의 타이밍을 변경하여 아르페지오 재생에 스윙의 느낌을 더합니다. 이 

설정은 스윙, 셔플, 바운스 느낌 연주를 위한 원하는 리듬 생성에 유용합니다.

설정: 	 −120–+0–+120

+1 이상: 박자보다 나중에 이동

-1 이하 박자보다 먼저 이동

0: 짝수 번호 박자를 변경하거나 스윙의 느낌을 더하지 않음.

Unit (Arpeggio Unit Multiply)
아르페지오 재생 시간을 늘리거나 줄일 때 사용되는 백분율을 설정합니다.

재생 시간을 늘리거나 줄일 때 세분화된 박자 및 템포가 변경되므로 본래 선택한 아르페지오에 완전히 새로운 느낌을 창출할 수 있습니다.

설정: 	 50%, 66%, 75%, 100%, 133%, 150%, 200%, 266%, 300%, 400%, Common

200%: 재생 시간이 2배가 되어 결과적으로 템포가 1/2로 줄어듭니다.

100%: 재생 시간이 변함없이 유지됩니다.

50%: 재생 시간이 1/2이 되어 결과적으로 템포가 2배로 늘어납니다.

Common: 모든 파트에 공통된 에 설정된 값이 적용됩니다.
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Quantize Value (Arpeggio Quantize Value)
퀀타이즈 및 스윙에 대한 기준음을 설정합니다. 여기에 표시된 값은 클록으로 표시됩니다.

설정: 	 Off, 60(32분 음표), 80(16분 음표의 셋잇단음표), 120(16분 음표), 160(8분 음표의 셋잇단음표), 240(8분 음표), 320(4분 음표의 

셋잇단음표), 480(4분 음표)

Qntz Strength (Arpeggio Quantize Strength)
Quantize Value (Arpeggio Quantize Value) 퀀타이즈 설정 강도(또는 Quantize Value에 설정된 기준음에 가까운 정도)를 

설정합니다. 100% 설정이면 Quantize Value에 설정된 타이밍으로 완전히 이동하며, 0% 설정이면 퀀타이제이션이 전혀 존재하지 

않습니다.

설정: 0%–100%

Gate Time Rate (Arpeggio Gate Time Rate)
아르페지오 재생의 게이트 시간(또는 음 연주 시간)을 설정합니다. 이에 따라 게이트 시간 값이 0으로 설정되면 설정값이 1로 변경됩니다.

설정: 0%–200%

Velocity Rate (Arpeggio Velocity Rate)
아르페지오 재생의 세기 비율을 설정합니다. 이에 따라 게이트 시간 값이 0으로 설정되면 설정값이 1로 변경됩니다. 128보다 큰 값으로 

설정되면 설정값이 127로 변경됩니다.

설정: 0%–200%

Arp Vel Limit (Arpeggio Velocity Limit)
아르페지오 재생의 세기 범위(최저/최고값)를 설정합니다.

높은 값이 첫 번째, 낮은 값이 두 번째(예: 93~34)가 되도록 설정된 경우, 1~34 및 93~127의 세기에서만 아르페지오가 연주됩니다.

설정: 1–127

Arp Note Limit (Arpeggio Note Limit)
아르페지오 파트의 음 범위(최저/최고음)를 설정합니다.

지정된 첫 번째 음이 두 번째 음보다 높은 경우(예: C5에서 C4로), C−2~C4 및 C5~G8 범위에서 음이 연주됩니다.

설정: C−2–G8

Octave Shift (Arpeggio Output Octave Shift)
아르페지오 피치를 옥타브 단위로 이동합니다.

설정: −10–+0–+10

Octave Range (Arpeggio Octave Range)
아르페지오 범위를 옥타브 단위로 이동합니다.

설정: −3–+0–+3

Arp Select (Arpeggio Select)
아르페지오를 선택합니다.

설정: 1–8
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Individual

Individual 화면에서 Arp Select (Arpeggio Select) 1–8의 아르페지오 형식 파라미터를 설정할 수 있습니다.

아르페지오 형식 설정을 탭하면 콘텍스트 메뉴가 표시됩니다. Category Search를 선택하면 Arpeggio Category Search 화면이 

열립니다. Number를 선택하면 번호별로 아르페지오 형식을 지정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Arpeggio → Individual

(선택한 파트가 Common 이외의 다른 값일 때) [SHIFT] + [ARP]

Arp Part (Part Arpeggio Switch)
Arp Master (Arpeggio Master Switch)
Sync Quantize (Arpeggio Sync Quantize Value)
Arpeggio Group
Indicator
Common 화면과 동일합니다.

Arp (Arpeggio Select)
Arpeggio Select를 전환합니다.

설정: 1–8

Category (Arpeggio Category)
선택한 아르페지오의 이름을 표시합니다.

설정: Data List 참조

Sub (Arpeggio Sub Category)
선택한 아르페지오의 하위 카테고리를 표시합니다.

설정: Data List 참조

Name (Arpeggio Name)
선택한 아르페지오의 이름을 표시합니다.

설정: Data List 참조
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Velocity (Arpeggio Velocity Rate)
아르페지오 재생의 세기 비율을 설정합니다.

이에 따라 게이트 시간 값이 0으로 설정되면 설정값이 1로 변경됩니다. 128보다 큰 값으로 설정되면 설정값이 127로 변경됩니다.

설정: −100%–+0%–+100%

Gate Time (Arpeggio Gate Time Rate)
아르페지오 재생의 게이트 시간(또는 음 연주 시간)을 설정합니다.

이에 따라 게이트 시간 값이 0으로 설정되면 설정값이 1로 변경됩니다.

설정: −100%–+0%–+100%

Advanced

Advanced 화면에서 아르페지오 파라미터를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Arpeggio → Advanced

Arp Part (Part Arpeggio Switch)
Arp Master (Arpeggio Master Switch)
Sync Quantize (Arpeggio Sync Quantize Value)
Arpeggio Group
Indicator
Common 화면과 동일합니다.

Accent Vel Threshold (Arpeggio Accent Velocity Threshold)
강세 프레이즈를 작동할 때 사용되는 세기 레벨을 설정합니다. 강세 프레이즈는 빠른 세기로 건반을 연주할 때에만 재생될 특정 유형의 

아르페지오 패턴에 프로그램된 시퀀스 프레이즈입니다.

설정값보다 큰 세기로 건반을 누르면 강세 프레이즈가 재생됩니다. 건반을 눌렀지만 강세 프레이즈가 재생되지 않을 경우 약간 낮게 

설정을 한 후 건반을 다시 눌러보십시오.

설정: Off, 1–127

주
강세 프레이즈를 지원하는 아르페지오 형식에 관한 자세한 내용은 Data List를 참조하십시오.
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Accent Start Quantize (Arpeggio Accent Start Quantize)
Accent Vel Threshold (Arpeggio Accent Velocity Threshold)(켜짐으로 설정)보다 큰 세기 값에서 건반을 누를 때 작동되거나 

선택한 아르페지오 형식(꺼짐으로 설정)에 설정된 타이밍에서 작동되도록 강세 프레이즈를 선택합니다.

설정: Off, On

Random SFX (Arpeggio Random SFX)
무작위 SFX 기능을 활성화합니다.

무작위 SFX 기능은 일부 아르페지오 형식에 포함된 특수 음향을 작동합니다. 아르페지오 형식에 따라 사용할 수 있는 다양한 형식의 특수 

음향이 있습니다. 예를 들어, 건반에서 손을 뗄 때 이 기능을 사용하여 기타 프렛 노이즈를 추가할 수 있습니다.

설정: Off, On

주
이 기능을 지원하는 아르페지오 형식에 관한 자세한 내용은 Data List를 참조하십시오.

Random SFX Velocity Offset (Arpeggio Random SFX Velocity Offset)
무작위 SFX 기능의 특수 음향을 작동할 때 사용되는 세기 값을 설정합니다.

설정: −64–+0–+63

Random SFX Key On Ctrl (Arpeggio Random SFX Key On Control)
건반을 누르기 위한 세기 레벨이나 자동으로 설정된 세기 레벨에 따라 작동되도록 특수 음향을 설정합니다.

설정: Off, On

Velocity Mode (Arpeggio Velocity Mode)
아르페지오 재생 세기를 설정합니다.

설정: 	 Original, Thru

Original: 아르페지오 형식에 설정된 세기 레벨을 따릅니다.

Thru: 건반을 누르는 세기 레벨을 따릅니다.

Trigger Mode (Arpeggio Trigger Mode)
아르페지오 재생 방법을 전환합니다.

설정: 	 Gate, Toggle

Gate: 건반을 눌러 아르페지오 재생을 시작하고 건반에서 손을 떼어 재생을 정지합니다.

Toggle: 건반을 눌러 아르페지오 재생 시작 및 정지 간을 전환시킵니다.

Arp Select (Arpeggio Select)
Arpeggio Select를 전환합니다.

설정: 1–8
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Motion Seq

Common

Common 화면에서 전체 파트에 사용되는 모션 시퀀서 파라미터를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Motion Seq → Common

(선택한 파트가 Common 이외의 다른 값일 때) [SHIFT] + [MSEQ]

Common Swing (Common Swing Offset)
퍼포먼스의 아르페지오 및 모션 시퀀스의 스윙값을 설정합니다.

이 파라미터는 Part Swing의 오프셋 값으로 지정됩니다.

설정: −120–+0–+120

Common Unit (Common Unit Multiply)
전체 퍼포먼스의 아르페지오 및 모션 시퀀서 재생 시간을 늘리거나 줄일 때 사용되는 백분율을 설정합니다.

이 파라미터는 Unit (Lane Unit Multiply)가 Common으로 설정된 레인에 영향을 미칩니다.

재생 시간을 늘리거나 줄일 때 세분화된 박자 및 템포가 변경되므로 본래 선택한 모션 시퀀서에 완전히 새로운 느낌을 창출할 수 

있습니다.

설정: 	 50%–400%

200%: 재생 시간이 2배가 되어 결과적으로 템포가 1/2로 줄어듭니다.

100%: 재생 시간이 변함없이 유지됩니다.

50%: 재생 시간이 1/2이 되어 결과적으로 템포가 2배로 늘어납니다.

Common Amplitude (Common Motion Sequencer Amplitude Performance Offset)
전체 퍼포먼스에 모션 시퀀서 진폭(또는 시퀀스가 변하는 정도)을 설정합니다.

이 파라미터는 MS FX (Lane FX Receive)가 켜짐으로 설정된 경우 파트 안에 존재하는 레인의 진폭을 오프셋합니다.

이 파라미터는 각 파트에 대한 Part Amplitude (Part Motion Sequencer Amplitude)의 오프셋 값으로 지정됩니다.

설정: −127–+0–+127
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Common Shape (Common Motion Sequencer Pulse Shape Performance Offset)
퍼포먼스의 모션 시퀀서 펄스 형태(또는 단계 곡선 형태)를 설정합니다.

이 파라미터는 MS FX (Lane FX Receive)가 레인에 켜짐으로 설정되고 Control (Motion Sequence Step Curve Shape Control 

Switch)가 켜짐으로 설정된 경우 파트 안에 존재하는 레인의 파라미터를 오프셋합니다.

이 파라미터는 각 파트에 대한 Part Shape (Part Motion Sequencer Pulse Shape)의 오프셋 값으로 지정됩니다.

설정: −100–+0–+100

Common Smooth (Common Motion Sequencer Smoothness Performance Offset)
전체 퍼포먼스의 모션 시퀀서 부드러움(또는 시간 경과에 따라 시퀀스 변화 부드러움)을 설정합니다.

이 파라미터는 MS FX (Lane FX Receive)가 레인에 켜짐으로 설정된 경우 파트 안에 존재하는 레인의 부드러움을 오프셋합니다.

이 파라미터는 각 파트에 대한 Part Motion Seq Smooth (Part Motion Sequencer Smoothness)의 오프셋 값으로 지정됩니다.

설정: −127–+0–+127

Common Random (Common Motion Sequencer Randomness Performance Offset)
전체 퍼포먼스의 모션 시퀀서 무작위(또는 시간 경과에 따라 시퀀스 변화 무작위)를 설정합니다.

이 파라미터는 MS FX (Lane FX Receive)가 레인에 켜짐으로 설정된 경우 퍼포먼스 안에 존재하는 레인의 무작위를 오프셋합니다.

이 파라미터는 각 파트에 대한 Part Motion Seq Random (Part Motion Sequencer Randomness)의 오프셋 값으로 지정됩니다.

설정: −127–+0–+127

Part Swing (Part Swing)
MS Grid에 지정된 값에서 매겨진 짝수 번호 박자(백비트)의 타이밍을 변경하여 모션 시퀀서에 스윙의 느낌을 더합니다. 이 설정은 스윙, 

셔플, 바운스 느낌 연주를 위한 원하는 리듬 생성에 유용합니다.

설정: 	 −120–+0–+120

+1 이상: 박자보다 나중에 이동

0: 짝수 번호 박자를 변경하거나 스윙의 느낌을 더하지 않음.

-1 이하: 박자보다 먼저 이동

Part Unit (Arpeggio Unit Multiply)
파트의 아르페지오 재생 시간을 늘리거나 줄일 때 사용되는 백분율을 설정합니다.

이 파라미터 설정은 각 레인의 Unit (Lane Unit Multiply)를 Arp로 설정한 경우 효과적입니다.

설정: 	 50%–400%, Common

200%: 재생 시간이 2배가 되어 결과적으로 템포가 1/2로 줄어듭니다.

100%: 재생 시간이 변함없이 유지됩니다.

50%: 재생 시간이 1/2이 되어 결과적으로 템포가 2배로 늘어납니다.

Common: 모든 파트에 공통된 에 설정된 값이 적용됩니다.

Part Amplitude (Part Motion Sequencer Amplitude)
파트에 모션 시퀀서 진폭(또는 시퀀스가 변하는 정도)을 설정합니다. 이 파라미터는 MS FX (Lane FX Receive)가 레인에 켜짐으로 

설정된 경우 파트 안에 존재하는 레인의 진폭을 오프셋합니다.

이 파라미터는 각 레인에 대한 Amplitude (Motion Sequence Amplitude)의 오프셋 값으로 지정됩니다.

설정: −127–+0–+127

Part Shape (Part Motion Sequencer Pulse Shape)
파트의 모션 시퀀서 펄스 형태(또는 단계 곡선 형태)를 설정합니다. 이 파라미터는 MS FX (Lane FX Receive)가 레인에 켜짐으로 

설정되고 Control (Motion Sequence Step Curve Shape Control Switch)가 켜짐으로 설정된 경우 파트 안에 존재하는 레인의 

파라미터를 오프셋합니다.

이 파라미터는 각 레인에 대한 Prm (Motion Sequence Step Curve Parameter)의 오프셋 값으로 지정됩니다.

설정: −100–+0–+100
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Part Smooth (Part Motion Sequencer Smoothness)
파트의 모션 시퀀서 부드러움을 설정합니다. 이 파라미터는 MS FX (Lane FX Receive)가 레인에 켜짐으로 설정된 경우 파트 안에 

존재하는 레인의 부드러움을 오프셋합니다.

이 파라미터는 각 레인에 대한 Smooth (Motion Sequence Smoothness)의 오프셋 값으로 지정됩니다.

설정: −127–+0–+127

Part Random (Part Motion Sequencer Randomness)
파트의 모션 시퀀서 무작위를 설정합니다.

시퀀스 단계값의 변화 무작위를 설정합니다.

설정: 0–127

View Lane
Lane을 설정하여 Home 화면의 View Mode가 Motion Seq View로 설정될 때 표시합니다.

MS Select (Motion Sequence Select)
재생할 모션 시퀀스를 선택합니다.

설정: 1–8
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Lane

Lane 화면에서 각 모션 시퀀서 레인의 파라미터를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Motion Seq → Lane

Motion Seq Master Sw (Motion Sequencer Master Switch)
전체 퍼포먼스의 모션 시퀀서를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Motion Seq Part Sw (Motion Sequencer Part Switch)
파트의 모션 시퀀서를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Lane Select
레인을 선택합니다.

설정: 1–4

LaneSw (Lane Switch)
각 레인을 켜짐 또는 꺼짐으로 설정합니다.

한 파트에 최대 4개의 모션 시퀀서 레인을 사용하거나 전체 퍼포먼스에 최대 8개의 레인을 사용할 수 있습니다.

꺼짐으로 설정한 경우 해당 레인의 파라미터가 표시되지 않습니다.

설정: Off, On

MS FX (Lane FX Receive)
모션 시퀀서 파라미터를 변경할 때 사용되는 노브에서 신호를 수신하도록 선택한 레인을 설정합니다.

설정: Off, On

Trigger (Lane Trigger Receive)
[MSEQ TRIGGER] 버튼에서 신호를 수신하도록 선택한 레인을 설정합니다.

켜짐으로 설정된 경우 [MSEQ TRIGGER] 버튼을 누를 때까지 모션 시퀀스가 재생되지 않습니다.

설정: Off, On
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Sequence Select (Motion Sequence Select)
모션 시퀀스 선택 사항을 변경합니다.

설정: 1–8

Target Sequence
레인 및 시퀀스를 표시합니다.

Edit Sequence
Motion Sequence Edit 화면이 열립니다.

최대 16단계로 구성된 시퀀서를 생성할 수 있습니다.

Motion Seq Step Value
모션 시퀀스의 각 단계에 대한 값을 설정합니다.

컨트롤 슬라이더 1~8을 사용하여 커서 위치에 따라 단계 1~8 및 단계 9~16의 값을 변경합니다.

설정: 0–127

	� Sync/Speed 탭

Sync (Lane Sync)
Control Assign 화면의 Destination으로 설정된 모션 시퀀스의 재생을 설정하여 퍼포먼스 템포, 박자 또는 아르페지오에 맞게 

동기화합니다.

설정: 	 Off, Tempo, Beat, Arp, Lane1 (Lane2–4를 선택한 경우)

Off: 레인 모션 시퀀서만 재생합니다.

Tempo: 퍼포먼스 템포로 레인 모션 시퀀서를 재생합니다.

Beat: 박자에 맞춰 재생합니다.

Arp: 아르페지오 재생 맨 앞부분에 맞춰 레인 모션 시퀀서를 재생합니다.

Lane1: Lane 1에 맞춰 레인 모션 시퀀서를 재생합니다.

•	 Sync를 Off로 설정한 경우

Speed (Lane Speed)
모션 시퀀스의 재생 속도를 설정합니다.

Sync (Lane Sync)를 Off로 설정한 경우 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Delay Time (Lane Key On Delay Time Length)
모션 시퀀스 재생을 시작할 때 사용되는 딜레이 타임을 설정합니다.

설정: 0–127

Fade In Time (Lane Fade In Time Length)
모션 시퀀스가 최대 진폭에 도달할 때까지 소요되는 시간을 설정합니다.

설정: 0–127
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•	 Sync를 Off 이외의 다른 값으로 설정한 경우

Unit (Lane Unit Multiply)
선택한 레인의 모션 시퀀서 재생 시간을 늘리거나 줄일 때 사용되는 백분율을 설정합니다.

Sync (Lane Sync)를 Tempo, Beat 또는 Arp로 설정한 경우 이 파라미터를 이용할 수 있습니다.

설정: 	 50%–6400%, Common, Arp

200%: 재생 시간이 2배가 되어 결과적으로 템포가 1/2로 줄어듭니다.

100%: 재생 시간이 변함없이 유지됩니다.

50%: 재생 시간이 1/2이 되어 결과적으로 템포가 2배로 늘어납니다.

Common: 모든 파트에 공통된 에 설정된 값이 적용됩니다.

Arp: 파트 아르페지오의 Unit에 설정된 값이 적용됩니다.

Delay Steps (Lane Key On Delay Step)
Sync (Lane Sync)를 Tempo, Beat 또는 Arp로 설정한 경우 모션 시퀀스 재생을 시작할 때 사용되는 딜레이 타임을 설정합니다.

설정: 0–32

Fade In Steps (Lane Fade In Step Length)
Sync (Lane Sync)를 Tempo, Beat, Arp 또는 Lane1로 설정한 경우 모션 시퀀스의 최대 진폭에 도달할 시간을 설정합니다.

설정: 0–32

Lane Vel Limit (Lane Velocity Limit)
선택한 레인의 모션 시퀀스를 재생할 때 사용되는 세기 범위(최저/최고값)를 설정합니다

Sync (Lane Sync)를 Off, Tempo, Beat 또는 Arp로 설정한 경우 이 파라미터를 이용할 수 있습니다.

Velocity Limit를 최고값에서 최저값의 범위로 설정하면 Motion Sequence는 최대값에서 최고값 및 최소값에서 최저값의 2가지 세기 

범위로 재생됩니다.

설정: 1–127

	� Loop/Length 탭

Key On Reset (Lane Key On Reset)
아무 건반이나 누르면 모션 시퀀스 재생을 재설정합니다.

Sync (Lane Sync)를 Off, Tempo 또는 Beat로 설정한 경우 이 파라미터를 이용할 수 있습니다. Trigger를 On으로 설정한 경우에는 

이 파라미터를 이용할 수 없습니다.

설정: 	 Off, Each-On, 1st-On

Each-On: 음을 연주할 때마다 시퀀스가 재설정되며 처음부터 재생이 시작됩니다.

1st-On: 연주하는 첫 음에서 처음부터 재생이 시작됩니다. 첫 번째 음을 유지하면서 두 번째 음을 연주하면 재생이 재설정되지 않습니다.

Loop (Lane Loop)
모션 시퀀스를 루프 재생(반복) 또는 단일 재생으로 설정합니다.

Sync (Lane Sync)를 Off, Tempo, Beat 또는 Arp로 설정한 경우 이 파라미터를 이용할 수 있습니다.

설정: Off, On

Loop Start (Motion Sequence Loop Start)
모션 시퀀스 재생을 반복할 때 두 번째나 그 이후에 재생을 시작하기 위한 단계를 설정합니다.

설정: 1–Length (Motion Sequence Length)

Length (Motion Sequence Length)
모션 시퀀스의 단계 수를 설정합니다.

설정: Loop Start (Motion Sequence Loop Start)–16

MS Grid (Motion Sequencer Grid)
모션 시퀀스의 단계 길이를 설정합니다.

설정: 60, 80, 120, 160, 240, 320, 480
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Mod/Control

Control Assign

Control Assign 화면에서 파트의 컨트롤러를 설정할 수 있습니다.

컨트롤러(Source에 파라미터(Destination)를 지정하면 여러 다양한 방법으로 음향을 제어할 수 있습니다. 피치 벤드 휠 및 노브와 모션 

시퀀서 및 엔벌로프 팔로워와 같은 물리적인 컨트롤러를 사용해도 됩니다.

파트에 최대 32개의 컨트롤러를 함께 지정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Mod/Control → Control Assign

Display Filter를 Super Knob로 설정한 경우 [+]를 누르면 화면 상단 영역에 메시지가 표시되며 Common EditControl Assign 

설정이 자동으로 추가됩니다.

주
지정 가능 노브를 전혀 이용할 수 없으면 [+]가 나타나지 않습니다.

Auto Select
Display Filter의 자동 선택을 켜짐 또는 꺼짐으로 전환합니다.

켜짐으로 설정한 경우 Source로 설정하려는 컨트롤러를 움직이면 Display Filter에 컨트롤러가 자동으로 설정됩니다.

설정: Off, On

Display Filter
화면에 설정을 표시할 때 사용되는 컨트롤러를 선택합니다.

Super Knob를 선택하면 Super Knob Link가 켜짐으로 설정된 모든 설정이 표시됩니다.

설정: 	 PitchBend, ModWheel, Ch. AT, FootCtrl 1, FootCtrl 2, FootSwitch, Ribbon, Breath, AsgnKnob 1–8, Super Knob, AsgnSw 1, 

AsgnSw 2, MS Lane 1–4, EnvFollow 1–16, EnvFollowAD, EnvFollowMst, All

주
다른 파트에서 Display Filter로 설정된 컨트롤러가 사용되면 해당 PART 버튼이 깜박입니다.
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Edit Pitch Bend
Pitch 설정 화면을 불러옵니다. General/Pitch → Pitch가 열립니다.

Source를 PitchBend 이외의 다른 값으로 설정한 경우에는 이 파라미터가 표시되지 않습니다.

Display Name (Assignable Knob Name)
노브 1~8에 새 이름을 입력할 수 있습니다.

Source를 AsgnKnob 1–8 이외의 다른 값으로 설정한 경우에는 이 파라미터가 표시되지 않습니다.

Edit Motion Sequencer
선택한 파트의 Motion Seq → Lane을 엽니다.

최대 16단계로 구성된 시퀀서를 생성할 수 있습니다.

Source를 MS Lane 1–4 이외의 다른 값으로 설정한 경우에는 이 파라미터가 표시되지 않습니다.

Edit Envelope Follower
Envelope Follower 설정 화면을 엽니다.

Source를 EnvFollow 1–16, EnvFollowAD 또는 EnvFollowMst 이외의 다른 값으로 설정한 경우에는 이 파라미터가 표시되지 

않습니다.

Page
Destination이 4개 이상일 경우 다음 페이지를 선택합니다. Destination이 4개 이하일 경우 다음 페이지는 나타나지 않습니다.

설정: 1–8

Destination
대상에 파라미터를 설정합니다. [+] 기호를 탭해 Destination을 추가합니다.

Source
Destination으로 설정된 파라미터를 제어할 때 사용되는 컨트롤러를 설정합니다.

설정: 	 PitchBend, ModWheel, Ch. AT, FootCtrl 1, FootCtrl 2, FootSwitch, Ribbon, Breath, AsgnKnob 1–8, AsgnSw 1, AsgnSw 2, 

MS Lane 1–4, EnvFollow 1–16, EnvFollowAD, EnvFollowMst

Element Sw (Element Switch) 1–128
선택한 Destination이 요소와 관련된 경우에만 이 파라미터가 표시됩니다.

각 요소에 대한 컨트롤러 설정을 켜짐 또는 꺼짐으로 설정할 수 있습니다.

General/Pitch → Element Settings Ex Elem Sw가 켜짐으로 설정된 경우 8개의 표시된 스위치 번호로 구성된 다른 그룹을 
선택할 수 있습니다.  
그러나 스위치에서 사용할 수 있는 번호의 실제 범위는 General/Pitch → Element Settings 화면의  

Element Count에서 설정된 값에 따라 다릅니다.(예: Element Count가 30으로 설정된 경우 선택할 수 있는 그룹은 25~32임)

설정: (각 스위치) Off, On, (표시된 스위치 번호 변경됨) 1–8, 9–16, ..., 121–128
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Curve Type
Destination으로 설정된 파라미터의 변화 곡선을 설정합니다.

수평축은 Source에서 설정된 컨트롤러 값을 의미하며, 수직축은 Destination에서 설정된 파라미터 값을 나타냅니다.
설정: 	 Standard, Sigmoid, Threshold, Bell, Dogleg, FM, AM, M, Discrete Saw, Smooth Saw, Triangle, Square, Trapezoid, Tilt Sine, 

Bounce, Resonance, Sequence, Hold, Harmonic, Steps(프리세트 뱅크를 선택한 경우)

Init Curve 1–32 (유저 뱅크를 선택한 경우)

 Library 1–24 내 Curve(라이브러리 파일을 불러오는 경우)

Standard

Sigmoid

Threshold

Bell

Dogleg

FM

AM

M

Discrete Saw

Smooth Saw

Triangle

Square

Trapezoid

Tilt Sine

Bounce

Harmonic

Steps

Resonance

Sequence

Hold

Polarity (Curve Polarity)
Curve Type에서 설정된 곡선의 극성을 설정합니다.
설정: 	 Uni, Bi

Uni: 곡선 형태에 따라 양의 범위 또는 음의 범위 안에서만 파라미터가 변합니다.
Bi: 곡선 형태에 따라 양의 범위와 음의 범위 안 모두에서 파라미터가 변합니다.

Ratio (Curve Ratio)
파라미터 값의 비율을 설정합니다.
설정: −128–+0–+127

Param 1 (Curve Parameter 1)
Param 2 (Curve Parameter 2)
곡선 형태를 조정합니다.

곡선 형식에 따라서는 이 설정을 이용하지 못할 수 있습니다.

Destination to Name
Destination에 설정된 파라미터를 Display Name으로 복사합니다.

Source를 AsgnKnob 1–8 이외의 다른 값으로 설정한 경우에는 이 파라미터가 표시되지 않습니다.

Edit User Curve
User Curve Edit 화면이 열립니다.

Edit Common Control Assign
Common Edit 화면의 Control → Control Assign를 엽니다.

Delete
선택한 Destination을 삭제합니다.
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After Touch

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Mod/Control → After Touch

Destination
대상에 파라미터를 설정합니다. [+] 기호를 탭해 Destination을 추가합니다.

Source
이 화면에서서는 변경할 수 없습니다. 이 파라미터는 Poly AT로 고정되어 있습니다.

Element Sw (Element Switch) 1–128
Curve Type
Polarity (Curve Polarity)
Ratio (Curve Ratio)
Edit User Curve
Delete
Mod/Control → Control Assign과 동일합니다.
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Tx/Rx Switch

Tx/Rx Switch 화면에서 MIDI 메시지(예: 컨트롤 변경) 전송 또는 수신 스위치를 켜짐 또는 꺼짐으로 설정할 수 있습니다.

주
CC (Control Change)를 꺼짐으로 설정한 경우 컨트롤 변경 메시지 관련 파라미터는 설정되지 않습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Mod/Control → Tx/Rx Switch

Transmit Sw (Transmit Switch)
전송 스위치를 표시합니다.

Part Mode를 External로 설정하거나 Keyboard Sw를 꺼짐으로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

Receive Sw (Receive Switch)
수신 스위치를 표시합니다.

Keyboard Sw (Keyboard Control Switch)
동시에 연주할 파트를 설정합니다.

Common 또는 Keyboard Sw가 켜짐으로 설정된 파트를 선택하고 건반을 연주하면 Keyboard Sw가 켜짐으로 설정된 파트가 동시에 

연주됩니다.

파트의 Keyboard Sw를 꺼짐으로 설정한 경우, 이 파트를 선택한 상태로 건반을 연주하면 이 음향이 연주됩니다.

설정: Off, On

Tx/Rx Ch (Transmit/Receive Channel)
Part Mode를 Internal로 설정한 경우 MIDI 메시지를 전송/수신할 때 사용되는 채널을 설정합니다.

설정: Ch1–Ch16, Off

Transmit Ch.
Part Mode를 External로 설정한 경우 MIDI 메시지를 수신할 때 사용되는 채널을 설정합니다.

설정: Ch1–Ch16

MIDI I/O Ch. (MIDI In-Out Channel)
MIDI 메시지를 전송/수신할 때 사용되는 채널을 표시합니다.
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Zone Settings
Zone 설정 화면을 불러옵니다.

General/Pitch → Zone Settings와 동일합니다.

PC (Program Change)
프로그램 변경 메시지 전송/수신을 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

BankSelect (Bank Select)
뱅크 선택 MSB 및 LSB 메시지 전송/수신을 켜짐 또는 꺼짐으로 설정합니다. CC (Control Change)가 꺼짐으로 설정된 경우에는 이 

파라미터를 이용할 수 없습니다.

설정: Off, On

Pitch Bend
MIDI 피치 벤드 메시지 전송/수신을 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

CAT (Channel After Touch)
채널 애프터터치 전송/수신을 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

PAT (Polyphonic After Touch)
다성 음색 애프터터치 전송/수신을 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

CC (Control Change)
컨트롤 변경 메시지 전송/수신을 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Vol/Exp (Volume/Expression)
음량 설정 전송/수신을 켜짐 또는 꺼짐으로 설정합니다. CC (Control Change)가 꺼짐으로 설정된 경우에는 이 파라미터를 이용할 수 

없습니다.

설정: Off, On

Pan
팬 설정 전송/수신을 켜짐 또는 꺼짐으로 설정합니다. CC (Control Change)가 꺼짐으로 설정된 경우에는 이 파라미터를 이용할 수 

없습니다.

설정: Off, On

MW (Modulation Wheel)
MIDI 모듈레이션 휠 메시지 전송/수신을 켜짐 또는 꺼짐으로 설정합니다. CC (Control Change)가 꺼짐으로 설정된 경우에는 이 

파라미터를 이용할 수 없습니다.

설정: Off, On

Sustain
MIDI 서스테인 및 소스테누토 메시지 전송/수신을 켜짐 또는 꺼짐으로 설정합니다. CC (Control Change)가 꺼짐으로 설정된 경우에는 

이 파라미터를 이용할 수 없습니다.

설정: Off, On

FC1 (Foot Controller 1)
FC2 (Foot Controller 2)
별매품인 풋 컨트롤러의 MIDI 메시지 전송/수신을 켜짐 또는 꺼짐으로 설정합니다. CC (Control Change)가 꺼짐으로 설정된 경우에는 

이 파라미터를 이용할 수 없습니다.

설정: Off, On
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FS (Foot Switch)
별매품인 풋 스위치의 MIDI 메시지 전송/수신을 켜짐 또는 꺼짐으로 설정합니다. CC (Control Change)가 꺼짐으로 설정된 경우에는 

이 파라미터를 이용할 수 없습니다.

설정: Off, On

A. Sw 1 (Assignable Function Switch 1)
A. Sw 2 (Assignable Function Switch 2)
[ASSIGN 1] 및 [ASSIGN 2] 버튼의 MIDI 메시지 전송/수신을 켜짐 또는 꺼짐으로 설정합니다. CC (Control Change)가 꺼짐으로 

설정된 경우에는 이 파라미터를 이용할 수 없습니다.

설정: Off, On

MS Trigger (Motion Sequencer Trigger)
[MSEQ TRIGGER] 버튼의 MIDI 메시지 전송/수신을 켜짐 또는 꺼짐으로 설정합니다. CC (Control Change)가 꺼짐으로 설정된 

경우에는 이 파라미터를 이용할 수 없습니다.

설정: Off, On

RB (Ribbon Controller)
MIDI 리본 컨트롤러 메시지 전송/수신을 켜짐 또는 꺼짐으로 설정합니다. CC (Control Change)가 꺼짐으로 설정된 경우에는 이 

파라미터를 이용할 수 없습니다.

설정: Off, On

BC (Breath Controller)
MIDI 브레스 컨트롤러 메시지 전송/수신을 켜짐 또는 꺼짐으로 설정합니다. CC (Control Change)가 꺼짐으로 설정된 경우에는 이 

파라미터를 이용할 수 없습니다.

설정: Off, On

Porta Sw (Portamento Switch)
[PORTAMENTO] 버튼의 MIDI 메시지 전송/수신을 켜짐 또는 꺼짐으로 설정합니다. CC (Control Change)가 꺼짐으로 설정된 

경우에는 이 파라미터를 이용할 수 없습니다.

설정: Off, On

Porta Time (Portamento Time)
PORTAMENTO [TIME] 노브의 MIDI 메시지 전송/수신을 켜짐 또는 꺼짐으로 설정합니다. CC (Control Change)가 꺼짐으로 설정된 

경우에는 이 파라미터를 이용할 수 없습니다.

설정: Off, On

A. Knob 1–8 (Assignable Knob)
노브 1~8의 MIDI 메시지 전송/수신을 켜짐 또는 꺼짐으로 설정합니다. CC (Control Change)가 꺼짐으로 설정된 경우에는 이 

파라미터를 이용할 수 없습니다.

설정: Off, On
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Control Settings

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Mod/Control → Control Settings

Slider Direction
슬라이더 Mode를 ELEM/OP/OSC로 설정한 경우 컨트롤 슬라이더 1~8의 방향을 설정합니다.

Reverse로 설정한 경우 화면의 음량 컨트롤이 오르간 슬라이더로 변경됩니다. 오르간 슬라이더는 파트를 선택한 후 View Mode를 Part 

Info로 설정할 때 표시됩니다.

설정: Normal(하단에서 상단으로), Reverse(상단에서 하단으로)
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Part LFO

Part LFO 화면에서 파트 LFO를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Mod/Control → Part LFO

LFO Wave
LFO Wave를 선택하고 LFO에 주기적인 변화 유형을 설정합니다.

설정: Triangle, Triangle+, Saw Up, Saw Down, Squ1/4, Squ1/3, Square, Squ2/3, Squ3/4, Trapezoid, S/H1, S/H2, User

Edit User LFO
User LFO Edit 화면이 열립니다.

최대 16단계로 구성된 LFO 파형을 생성할 수 있습니다.

•	 Cycle

LFO 단계 수를 설정합니다.

설정: 2 steps, 3 steps, 4 steps, 6 steps, 8 steps, 12 steps, 16 steps

•	 Slope

화면에 현재 표시된 파형의 기울기에 대한 변경 사항을 설정합니다.

설정: Off(기울기 없음), Up, Down, Up&Down
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•	 User LFO Step Value

각 단계의 값을 설정합니다.

설정: −64–+0–+63

•	 Template

LFO 파형의 템플릿을 선택합니다.

Tempo Sync (LFO Tempo Sync)
LFO Wave 변화 속도를 설정하여 아르페지오 또는 곡 재생에 맞춥니다.

설정: 꺼짐(동기화되지 않음), 켜짐(동기화됨)

•	 꺼짐으로 설정한 경우

Speed (LFO Speed)
LFO Wave 변화 속도를 설정합니다.

Tempo Sync (LFO Tempo Sync)가 켜짐으로 설정된 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 0–63

Random Speed (Part LFO Random Speed Depth)
LFO Speed를 무작위로 변경합니다.

Tempo Sync (LFO Tempo Sync)가 켜짐으로 설정된 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 0–127

•	 켜짐으로 설정한 경우

Tempo Speed (LFO Tempo Speed)
악보값을 사용하여 LFO Wave 변화 속도를 설정합니다.

설정: 	 1/16(16분 음표), 1/8 Tri. (8분 음표의 셋잇단음표), 1/16 Dot. (점16분 음표), 1/8(8분 음표), 1/4 Tri. (4분 음표의 셋잇단음표), 1/8 

Dot. (점8분 음표), 1/4(8분 음표), 1/2 Tri. (2분 음표의 셋잇단음표), 1/4 Dot. (점4분 음표), 1/2(2분 음표), Whole Tri. (온음표의 

셋잇단음표), 1/2 Dot. (점2분 음표), 1/4 × 4(4분 음표의 넷잇단음표, 해당 박자에 맞춰 4개의 4분 음표 연주), 1/4 × 5(4분 음표의 

다섯잇단음표, 해당 박자에 맞춰 5개의 4분 음표 연주), 1/4 × 6(4분 음표의 여섯잇단음표, 해당 박자에 맞춰 6개의 4분 음표 연주), 1/4 × 

7(4분 음표의 일곱잇단음표, 해당 박자에 맞춰 7개의 4분 음표 연주), 1/4 × 8(4분 음표의 여덟잇단음표, 해당 박자에 맞춰 8개의 4분 음표 

연주), 1/4 × 16(해당 박자에 맞춰 16개의 4분 음표 연주), 1/4 × 32(해당 박자에 맞춰 32개의 4분 음표 연주), 1/4 × 64(해당 박자에 맞춰 

64개의 4분 음표 연주)

Delay (LFO Delay Time)
건반을 누르는 순간부터 LFO가 적용될 때까지 딜레이 타임을 설정합니다.

값이 커질수록 LFO가 적용될 때까지 소요되는 딜레이가 길어집니다.

설정: 0–127
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Fade In (LFO Fade In Time)
건반에서 손을 떼고 Delay (LFO Delay Time)에서 설정된 딜레이 타임이 경과된 후 LFO 이펙트가 페이드 인될 때까지 소요되는 시간을 

설정합니다. 값이 커질수록 이펙트가 최대 레벨에 이를 때까지 소요되는 시간이 길어집니다.

설정: 0–127

0: LFO가 페이드 인 없이 최대값으로 변경됩니다.

값이 작을 경우

Fade In
Maximum

Delay

Key On

Time

값이 클 경우

Fade In
Maximum

Delay

Key On

Time

Hold (LFO Hold Time)
최대 레벨에 도달한 후 LFO 이펙트를 유지하기 위한 시간을 설정합니다.

설정: 0–126, Hold

Hold: 페이드 아웃하지 않음

Hold
Maximum

Key On

Time
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Fade Out (LFO Fade Out time)
Hold (LFO Hold Time)에 설정된 홀드 타임이 경과한 후 LFO 이펙트가 페이드 아웃하는 데 소요되는 시간을 설정합니다. 값이 

커질수록 LFO 이펙트가 페이드 아웃할 때까지 소요되는 시간이 길어집니다.
설정: 0–127

값이 작을 경우

Fade-Out
Maximum

Hold

Key On

Time

값이 클 경우

Fade-Out
Maximum

Hold

Key On

Time

Key On Reset (LFO Key On Reset)
건반을 누를 때 LFO의 진동을 재설정합니다.
설정: 	 Off, Each-on, 1st-on

Off로 설정한 경우

LFO의 진동을 재설정하지 않습니다. 해당 시점에서 LFO가 어떤 상태에 있든지 건반을 누르면 LFO 음파가 시작됩니다.

Key On

Time

Each-on으로 설정한 경우

건반을 누를 때마다 LFO 진동을 재설정하고 위상 파라미터로 지정된 위상에서 파형을 시작합니다.

Key On
(first note)

Key On
(second note)

Time

1st-on으로 설정한 경우

건반을 누를 때마다 LFO 진동을 재설정하고 위상 파라미터로 지정된 위상에서 파형을 시작합니다.

첫 번째 음을 유지하면서 두 번째 음을 연주하면 재생이 재설정되지 않습니다.

Key On
(first note)

Key On
(second note)

Time
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Loop (LFO Loop Switch)
순환(반복) 재생 또는 단일 재생으로 LFO Wave를 설정합니다.

설정: Off, On

Phase (LFO Phase)
LFO Wave가 재설정되는 시간에 대한 초기 위상을 설정할 수 있습니다.

설정: 0°, 90°, 120°, 180°, 240°, 270°

Phase

Time

Level

0° 90°
120° 240°

180° 270°

Element Phase Offset (LFO Element Phrase Offset)
각 요소에 대해 오프셋 값을 Phase (LFO Phase)로 설정합니다.

설정: 0°, 90°, 120°, 180°, 240°, 270°

Element (Display Element)
General/Pitch → Element Settings Ex Elem Sw가 켜짐일 경우 Element Phase Offset 및 Element Depth Ratio에 해당하는 

4개 요소로 구성된 그룹에 대해 다른 숫자를 선택할 수 있습니다. 그러나 스위치에서 사용할 수 있는 번호의 실제 범위는 General/Pitch 

→ Element Settings 화면의 Element Count에서 설정된 값에 따라 다릅니다. (예: Element Count가 30으로 설정된 경우 선택할 수 

있는 그룹은 29~32임)

설정: 1–4, 5–8, ..., 125–128

Element Phase Offset (LFO Element Phase Offset)
각 요소에 대해 오프셋 값을 Phase (LFO Phase)로 설정합니다.

LFO Wave가 재설정될 때 각 요소의 초기 위상을 설정할 수 있습니다.

General/Pitch → Element Settings 화면의 Ex Elem Sw가 켜짐으로 설정된 경우, Element (Display Element)를 변경하여 요소 

번호를 변경할 수 있습니다. General/Pitch → Element Settings Element Count에 설정된 값까지 표시됩니다.

Element Depth Ratio (LFO Element Depth Ratio)
각 요소의 Depth를 조정합니다. LFO를 끄도록 이 파라미터를 꺼짐으로 설정합니다.

선택한 Destination이 요소와 관련된 경우에만 이 파라미터가 표시됩니다.

General/Pitch → Element Settings Ex Elem Sw가 켜짐으로 설정된 경우 조정된 Depth 요소 번호는 Element (Display 

Element)로 변경할 수 있습니다.

General/Pitch → Element Settings Element Count에 설정된 값까지 표시됩니다.

설정: Off, 0–127

Destination (LFO Destination)
LFO Wave로 제어되도록 기능을 설정합니다.

설정: 	 Insertion Effect A Parameter 1–24, Insertion Effect B Parameter 1–24, Level, Pitch, Cutoff, Resonance, Pan,  

E.LFO Speed

Depth (LFO Depth)
각 Destination에 대한 LFO Wave 컨트롤의 깊이를 설정합니다.

설정: 0–127
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Part Edit (AWM2) Element Edit 화면

일반 파트(AWM2)는 최대 128개의 요소로 구성됩니다.

Part Edit (AWM2)에는 전체 파트에 파라미터를 설정할 때 사용되는 Part Common Edit과 파트의 각 요소에 대한 파라미터를 설정할 

때 사용되는 Element Edit이 포함됩니다.

Osc/Tune

Osc/Tune 화면에서 요소의 오실레이터를 설정할 수 있습니다.

여기에서 음향의 기준으로 사용되는 파형을 선택하고 요소의 건반 범위 및 세기 범위를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Element 선택 → Osc/Tune

Element Switch
선택한 요소를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Bank (Waveform Bank)
Number (Waveform Number)
Category (Waveform Category)
Sub Category (Waveform Sub Category)
Waveform Name
요소에 대해 선택된 파형의 이름을 표시합니다.

Bank 요소에 지정된 파형의 형식(프리세트, 유저 및 라이브러리)을 나타냅니다.

설정: Data List 참조
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XA Control
XA(Expanded Articulation)는 어쿠스틱 악기에서와 같은 실감나는 음향이나 새로운 신디 음향을 생성할 때 사용되는 기능입니다.

XA Control을 설정하여 요소 연주 방식을 지정하면 이러한 음향을 생성할 수 있습니다.

설정: 	 Normal, Legato, Key Off, Cycle, Random, A.Sw Off, A.Sw1 On, A.Sw2 On

Normal: 일반 요소로 연주됩니다.

Legato: Mono/Poly를 Mono로 설정한 경우 연주됩니다. 레가토로 연주할 때 Legato가 설정된 요소가 Normal로 설정된 요소 대신 

연주됩니다.

Key Off: 건반에서 손을 떼면 연주됩니다.

Cycle: 일련의 요소가 Cycle로 설정된 경우 연주됩니다.

Random: 다수의 요소가 Random으로 설정된 경우 무작위로 요소를 연주합니다.

A.Sw Off: [ASSIGN 1] 및 [ASSIGN 2] 버튼이 꺼짐으로 설정된 경우 연주됩니다.

A.Sw1 On: [ASSIGN 1] 버튼이 켜짐으로 설정된 경우 연주됩니다.

A.Sw2 On: [ASSIGN 2] 버튼이 켜짐으로 설정된 경우 연주됩니다.

XA Control 설정 예시

•	 부드러운 레가토 생성

XA Control이 Normal로 설정된 한 요소와 XA Control이 Legato로 설정된 다른 요소 간을 전환시킵니다.

•	 건반에서 손을 뗄 때 생성되는 음향 생성

XA Control이 Key Off로 설정된 요소를 생성합니다.

•	 동일한 음에 대한 무작위 생성

XA Control이 Cycle로 설정된 한 요소와 XA Control이 Random으로 설정된 다른 요소를 만듭니다.

•	 기타의 하모닉 및 팜 뮤트, 플루트의 플러터 텅잉, 색소폰의 그로울 등의 어쿠스틱 악기에 고유한 음향 생성

XA Control이 A.Sw Off, A.Sw1 On 또는 A.Sw2 On으로 설정된 한 요소를 설정하고, 상단 패널의 [ASSIGN 1] 및 [ASSIGN 2] 

버튼에서 제어합니다.

주
외부 장치에서 Common Edit 화면의 Control → Control Number에서 설정된 컨트롤 변경 번호를 전송하면 [ASSIGN 1] 및 [ASSIGN 2] 버튼을 

켜짐 또는 꺼짐으로 설정할 수 있습니다.

Elem Group (Element Group Number)
XA Control 설정이 동일한 요소를 그룹별로 분류할 때 이 파라미터를 이용합니다.

모든 요소의 XA Control이 Normal로 설정된 경우 이 설정은 유효하지 않습니다.

설정: 1–8

Elem Connect (Element Connection Switch)
인서트 이펙트 A 또는 인서트 이펙트 B로 요소 출력을 설정합니다.

Thru로 설정하면 인서트 이펙트가 우회됩니다.

설정: Thru, InsA, InsB

New Waveform
USB 플래시 드라이브에 저장된 오디오 파일을 파형으로 불러옵니다.

파형을 불러오면 Edit Waveform이 나타납니다.

Edit Waveform
Waveform Edit 화면이 열립니다.
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Coarse (Coarse Tune)
요소 피치를 반음 단위로 이동합니다.

설정: −48–+0–+48

Fine (Fine Tune)
요소의 피치를 미세하게 조정합니다.

설정: −64–+0–+63

Pitch/Vel (Pitch Velocity Sensitivity)
피치 변화가 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

설정: 	 −64–+0–63

양의 값: 세기가 빨라질수록 피치가 높아집니다.

0: 변함없이 유지됩니다.

음의 값: 세기가 빨라질수록 피치가 낮아집니다.

Fine/Key (Fine Tune Key Follow Sensitivity)
미세 튜닝의 피치 변화가 건반 위치에 어떻게 반응하는지 설정합니다.

설정: 	 −64–+0–63

양의 값: 양의 값: 저음부에서 건반을 누르면 피치가 내려가고 고음부에서 건반을 누르면 피치가 올라갑니다.

음의 값: 음의 값: 저음부에서 건반을 누르면 피치가 올라가고 고음부에서 건반을 누르면 피치가 내려갑니다.

Random (Random Pitch Depth)
건반을 누를 때마다 무작위로 요소의 피치를 변경합니다.

파라미터를 큰 값으로 설정하여 피치를 더 많이 변경하십시오. 값을 0으로 설정한 경우 피치가 변함없이 유지됩니다.

설정: 0–127

Vel Cross Fade (Velocity Cross Fade)
Velocity Limit을 벗어난 건반을 누르는 세기 값이 Velocity Limit으로 설정된 값과 더욱 벌어질 때 낮아지도록 오실레이터의 출력 

레벨을 설정합니다.

값이 커질수록 오실레이터 출력 레벨이 더욱 서서히 감소합니다. 0으로 설정한 경우 세기가 Velocity Limit을 벗어나면 어떤 음향도 

생성되지 않습니다.

설정: 	 0–127

Level/Vel을 +0으로 설정한 경우

Output

Velocity
Velocity Limit Low

(1)

(2)

Output

Velocity
Velocity Limit Low

Vel Cross Fade = 0

(1)큰 값이 사용되면 기울기가 왼쪽으로 이동함

(2) 0으로 설정한 경우 세기가 Velocity Limit을 벗어나면 어떤 음향도 생성되지 않음



242MODX M 사용설명서

Key On Delay Tempo Sync (Key On Delay Tempo Sync Switch)
템포에 맞춰지도록 Key On Delay의 타이밍을 설정합니다.

설정: Off, On

Key On Delay Length (Key On Delay Time Length)
건반을 누른 후 음향이 생성될 때까지 딜레이 타임을 설정합니다.

Key On Delay Tempo Sync (Key On Delay Tempo Sync Switch)를 켜짐으로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 0–127

Length (Key On Delay Note Length)
악보값을 사용하면 Key On Delay에 타이밍을 설정할 수 있습니다.

Key On Delay Tempo Sync (Key On Delay Tempo Sync Switch)를 켜짐으로 설정한 경우 이 파라미터를 이용할 수 있습니다.

설정: 	� 1/16(16분 음표), 1/8 Tri. (8분 음표의 셋잇단음표), 1/16 Dot. (점16분 음표), 1/8(8분 음표), 1/4 Tri. (4분 음표의 셋잇단음표), 1/8 Dot. 

(점8분 음표), 1/4(8분 음표), 1/2 Tri. (2분 음표의 셋잇단음표), 1/4 Dot. (점4분 음표), 1/2(2분 음표), Whole Tri. (온음표의 셋잇단음표), 

1/2 Dot. (점2분 음표), 1/4 × 4(4분 음표의 넷잇단음표, 해당 박자에 맞춰 4개의 4분 음표 연주), 1/4 × 5(4분 음표의 다섯잇단음표, 

해당 박자에 맞춰 5개의 4분 음표 연주), 1/4 × 6(4분 음표의 여섯잇단음표, 해당 박자에 맞춰 6개의 4분 음표 연주), 1/4 × 7(4분 음표의 

일곱잇단음표, 해당 박자에 맞춰 7개의 4분 음표 연주), 1/4 × 8(4분 음표의 여덟잇단음표, 해당 박자에 맞춰 8개의 4분 음표 연주)

Velocity Limit
요소 음파 재생에 사용되는 세기 범위(최저/최고값)를 설정합니다.

높은 값이 첫 번째, 낮은 값이 두 번째(예: 93에서 34로)가 되도록 설정된 경우, 1~34 및 93~127의 세기에서만 요소가 들립니다.

설정: 1–127

Note Limit
요소의 음 범위(최저/최고음)를 설정합니다.

지정된 첫 번째 음이 두 번째 음보다 높은 경우(예: C5에서 C4로), C2~C4 및 C5~G8 범위에서 요소가 연주됩니다.

설정: C−2–G8

Center Key (Pitch Key Follow Sensitivity Center Key)
Pitch/Key (Pitch Key Follow Sensitivity)의 기준음을 설정합니다.

여기에 표시된 음 번호로 설정된 건반은 Pitch/Key 설정과는 상관없이 일반 피치로 연주됩니다.

설정: C−2–G8
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Pitch/Key (Pitch Key Follow Sensitivity)
인접한 두 건반 사이의 피치 차이를 설정합니다. 기준음은 Center Key (Pitch Key Follow Sensitivity Center Key)로 지정됩니다.

이 파라미터는 특수 이펙트와 같이 피치 처리되지 않은 음향을 연주하거나 일반 파트로 타악기를 연주할 때, 또는 피치 차이가 반음 

단위일 필요가 없는 경우에 유용합니다.

설정: 	 −200%–+0%–+200%

+100%(일반 설정): 서로 옆에 위치한 두 건반 사이의 피치 차이가 반음으로 설정됩니다.

0%: 두 건반 사이의 피치 차이가 없으며 모든 건반이 Center Key로 설정된 피치로 연주됩니다.

음의 값: 음이 낮아지면 피치가 높아지고 음이 높아지면 피치가 낮아지도록 반대 피치 응답을 설정합니다.

Pitch/Key 및 Center Key

(2)

(1)

(3)

(4)

(5)

+

–

High

+100%

+150%

+50%

Low

(1) 키

(2) 피치 변화량

(3) Center Key

(4) 인접한 두 건반 사이의 피치 차이가 커집니다.

(5) 인접한 두 건반 사이의 피치 차이가 작아집니다.
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Waveform Edit

Waveform Edit 화면을 엽니다.

여기에서 파형을 구성하는 여러 다양한 키 뱅크를 설정할 수 있습니다.

	� 키 뱅크
키 뱅크는 악기로 불러온 디지털 데이터(음성 또는 다른 음향과 같이 짧은 오디오 세그먼트로 구성)로, .wav 파일과 특성이 동일합니다. 

그러나 혼동되지 않도록 다른 이름이 사용되므로 파형과 구별할 수 있습니다.

	� 키 뱅크 및 파형
키 뱅크는 항상 파형의 일부로 저장됩니다.

파형은 다수의 키 뱅크를 포함할 수 있어 단일 파형에 수십 개의 키 뱅크를 저장할 수 있습니다.

그러나 모든 키 뱅크가 동시에 연주되면 다룰 수 없으므로 각 키 뱅크에 대해 연주될 키의 범위(Note Limit) 및 세기 범위(Velocity 

Limit)를 설정할 수 있습니다. 다수의 키 뱅크를 설정하면 사용하는 건반 부분과 건반을 누르는 강도에 따라 다양한 키 뱅크 음향을 

연주할 수 있습니다.

키 뱅크 및 파형 설정 예시

Velocity

Waveform
Key

Bank 1

Key Number
(Note Number)

40

127

D♯2 A♯2 G♯3 F4

Key Bank 2 Key Bank 4

Key Bank 3 Key Bank 5

	� 파트 및 파형
파형은 파트에 포함되어 건반에서 연주될 수 있습니다.

Part Edit (AWM2), Element Edit, Drum Part Edit (AWM2) 및 Key Edit을 사용하여 요소당 1개의 파형을 지정할 수 있습니다.
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Waveform
선택한 파형의 이름을 표시합니다.

Category (Waveform Category)
Sub Category (Waveform Sub Category)
선택한 파형의 메인 카테고리와 하위 카테고리를 설정합니다.

설정: Data List 참조

Name (Waveform Name)
최대 20자의 영숫자 문자를 사용하여 새 이름으로 편집 중인 파형을 저장할 수 있습니다.

Total
파형 및 데이터 용량의 총 크기로 키 뱅크 수를 표시합니다.

Keybank (Keybank Number)
키 뱅크 번호를 표시합니다.

Size (Keybank Size)
데이터 용량의 총 크기를 표시합니다.

Channel (Keybank Channel)
키 뱅크가 스테레오인지 모노인지 여부를 표시합니다.

Velocity Limit
키 뱅크 연주에 사용되는 세기 범위(최저/최고값)를 설정합니다.

설정: 1–127

Note Limit
키 뱅크 연주에 사용되는 음 범위(최저/최고값)를 설정합니다.

설정: 1–127

Center Note
본래 파형 데이터의 건반(피치)을 설정합니다.

설정: C−2–G8

Volume
키 뱅크의 음량을 설정합니다.

설정: 0–255

Pan
키 뱅크의 (스테레오 필드 내) 팬 위치를 설정합니다.

설정: L63–C(중앙)–R63

Tune Coarse (Coarse Tune)
키 뱅크의 피치를 반음 단위로 이동합니다.

설정: −64–+63

Tune Fine (Fine Tune)
키 뱅크의 피치를 조정할 때 사용됩니다.

설정: −64–+63

Delete Keybank
키 뱅크를 삭제합니다.

Add Keybank
키 뱅크를 파형에 추가합니다.
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Pitch EG

Pitch EG 화면에서 오실레이터의 엔벌로프 제너레이터를 설정할 수 있습니다.

PEG(피치 엔벌로프 제너레이터) 시간 및 레벨(피치 변화량)을 설정하면 건반을 누른 순간부터 음향이 감쇄되어 음소거될 때까지 음향이 

어떻게 변하는지 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Element 선택 → Pitch EG

Hold Time (PEG Hold Time)
건반을 누른 순간부터 Hold Level (PEG Hold Level)로 피치를 유지하는 데 소요되는 시간을 설정합니다.

설정: 0–127

Attack Time (PEG Attack Time)
Hold Time (PEG Hold Time) 끝부분에서 Attack Level (PEG Attack Level)로 피치가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–127

Decay1 Time (PEG Decay 1 Time)
Attack Level (PEG Attack Level)에서 Decay1 Level (PEG Decay 1 Level)로 피치가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–127

Decay2 Time (PEG Decay 2 Time)
Decay1 Level (PEG Decay 1 Level)에서 Decay2 Level (PEG Decay 2 Level)로 피치가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–127

Release Time (PEG Release Time)
건반에서 손을 뗀 순간부터 Release Level (PEG Release Level)에 이를 때까지 피치가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–127
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Hold Level (PEG Hold Level)
건반을 누를 때 피치를 설정합니다.

설정: −128–+0–+127

Attack Level (PEG Attack Level)
Hold Level 또는 건반을 누른 순간부터 피치 변화를 설정합니다.

설정: −128–+0–+127

Decay1 Level (PEG Decay 1 Level)
Attack Level (PEG Attack Level)부터 변경할 다음 피치 값을 설정합니다.

설정: −128–+0–+127

Decay2 Level (PEG Decay 2 Level)
Decay1 Level (PEG Decay 1 Level)부터 변경할 다음 피치 값을 설정합니다.

설정: −128–+0–+127

Release Level (PEG Release Level)
건반에서 손을 뗀 후 도달할 최종 피치를 설정합니다.

설정: −128–+0–+127

Center Key (PEG Time Key Follow Sensitivity Center Key)
Time/Key (PEG Time Key Follow Sensitivity)의 기준음을 설정합니다.

여기에서 음(건반)을 설정한 경우 PEG에서 설정된 피치 변화의 결과음이 연주됩니다.

설정: C−2–G8

Time/Key (PEG Time Key Follow Sensitivity)
PEG의 피치 변화 속도가 건반 위치에 어떻게 반응하는지 설정합니다.

PEG의 변화 속도는 Center Key (PEG Time Key Follow Sensitivity Center Key)의 지정 건반에 사용됩니다.

설정: 	 −64–+0–+63

양의 값: 연주음이 낮을수록 PEG 변화가 느려지고 연주음이 높을수록 PEG 변화가 빨라집니다.

0: 건반 위치와는 상관없이 PEG가 변하지 않습니다

음의 값: 누른 건반음이 높을수록 PEG의 피치 변화 속도가 느려집니다.

Center Key 및 Time/key

(2)

(1)

(3)

High

Fast

Slow

+63

+30

−40

Low

Time

(6)

Time

(6)

Time

(6)

Time

(6)

(4)

(5)

Low key High key

(1) 키

(2) PEG의 피치 변화 속도

(3) Center Key

(4) Time/Key 가 양수일 경우

(5) Time/Key 가 음수일 경우

(6) 피치
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Time/Vel (PEG Time Velocity Sensitivity)
Segment (PEG Time Velocity Sensitivity Segment)
PEG의 피치 변화가 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.
먼저, Segment에 시간 값을 설정한 후 Time/Vel에 세기 감도 값을 설정합니다.
설정: 	 Time/Vel: −64–+0–+63

양의 값: 세기가 빨라질수록 PEG의 피치 변화가 빨라집니다.
0: 세기 설정과는 상관없이 PEG가 변하지 않습니다.
음의 값: 세기가 빨라질수록 PEG의 피치 변화가 빨라집니다.

값이 양수일 경우
빠른 세기(피치 변화가 빠름)		  느린 세기(피치 변화가 느림)

Time

(1)

Time

(1)

(1) 피치

설정: 	 Segment: Attack, Atk+Dcy, Decay, Atk+Rls, All
Attack: Time/Vel 값이 Attack Time에 영향을 미칩니다.
Atk+Dcy: Time/Vel 값이 Attack Time 및 Decay1Time에 영향을 미칩니다.
Decay: Time/Vel 값이 Decay Time에 영향을 미칩니다.
Atk+Rls: Time/Vel 값이 Attack Time 및 Release Time에 영향을 미칩니다.
All: Time/Vel 값이 PEG의 시간 관련 설정에 영향을 미칩니다.

PEG Depth
PEG로 제어되는 피치 변화의 양을 설정합니다. 깊이 값이 0에서 멀어지면 피치 변화가 넓어집니다.
설정: 	 −64–+0–+63

0: 변함없이 유지됨
음의 값: 피치 변화가 반대가 됨

Depth/Vel (PEG Depth Velocity Sensitivity)
Curve (PEG Depth Velocity Sensitivity Curve)
PEG로 제어되는 피치 변화의 깊이 범위가 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.
또한 Curve 설정을 사용해도 PEG Depth가 세기에 어떻게 반응하는지 설정할 수 있습니다. 수직축은 세기를 나타내는 반면 수평축은 
피치 변화의 깊이 범위를 의미합니다.
설정: 	 Depth/Vel: −64–+0–+63

양의 값: 세기 값이 빠를수록 차단 주파수의 깊이 범위가 넓어지고 값이 느릴수록 차단 주파수의 깊이 범위가 좁아집니다.
0: 세기 설정과는 상관없이 PEG가 변하지 않습니다.
음의 값: 세기 값이 빠를수록 차단 주파수의 깊이 범위가 좁아지고 값이 느릴수록 차단 주파수의 깊이 범위가 넓어집니다.

값이 양수일 경우
빠른 세기(피치 변화의 깊이 범위가 넓어짐)	 느린 세기(피치 변화의 깊이 범위가 좁아짐)

Time

(1)

Time

(1)

(1) 피치 깊이

설정: 	 Curve: 0–4

0 31 42
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Filter

Type

Type 화면에서 요소에 필터 형식을 선택할 수 있습니다. 사용 가능한 파라미터는 여기에서 선택한 필터 형식에 따라 다릅니다.

작업

[PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Element 선택 → Filter → Type

Filter Type
요소의 필터를 설정합니다. 본 악기에서 이용할 수 있는 필터는 LPF, HPF, BPF 및 BEF의 4개 형식으로 분류됩니다.

설정: 	� LPF24D, LPF24A, LPF18, LPF18s, LPF12+HPF12, LPF6+HPF12, HPF24D, HPF12, BPF12D, BPFw, BPF6, BEF12, BEF6, DualLPF, 

DualHPF, DualBPF, DualBEF, LPF12+BPF6, Thru

•	 LPF(로우 패스 필터)

차단 주파수에서 설정된 값 위의 신호를 차단합니다. 이 필터 형식은 고전적인 신디사이저 음향을 만드는 데 많이 사용됩니다. 

차단 주파수를 높이면 음향이 밝아지는데, 필터가 더 많은 신호를 통과시키기 때문입니다. 차단 주파수를 낮추면 음향이 

어두워지는데, 필터가 신호를 차단하거나 막기 때문입니다.

공명을 높이거나 차단 주파수 근처의 신호 레벨을 증폭시키면 독특한 “피크” 음향을 생성할 수 있습니다.

Frequencies that are
“passed” by the filter

Cutoff Frequency

Resonance

FrequencyCutoff FrequencyFrequency

Gain
Gain

LPF24D: 특징적인 디지털 음향을 갖춘 다이나믹 4폴(−24dB/oct) LPF입니다. LPF24A 형식에 비해 더욱 뚜렷한 공명 이펙트를 생성할 수 

있습니다.

LPF24A: 4폴(−24dB/oct) 아날로그 신디사이저 필터와 특성이 비슷한 디지털 다이나믹 로우 패스 필터

LPF18: 3폴(−18dB/oct) LPF

LPF18s: 3폴(−18dB/oct) LPF. 주파수 곡선이 LPF18보다 완만합니다.
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•	 HPF(하이 패스 필터)

차단 주파수 위의 신호만 통과시키는 필터 형식입니다.

공명을 높이거나 차단 주파수 근처의 신호 레벨을 증폭시키면 독특한 “피크” 음향을 생성할 수 있습니다.

Resonance

Frequencies that are
“passed” by the filter

Frequency
Cutoff Frequency

Gain

LPF12+HPF12: 직렬로 연결된 2폴(−12dB/oct) LPF와 HPF의 조합. 이 필터 형식을 선택하면 HPF Cutoff (HPF Cutoff Frequency) 및 

HPF Cutoff /Key (HPF Cutoff Key Follow Sensitivity)를 설정할 수 있습니다.

LPF6+HPF12: 직렬로 연결된 −6dB/oct LPF와 −12dB/oct의 조합입니다. 이 필터 형식을 선택하면 H PF Cutoff (HPF Cutoff Frequency) 

및 HPF Cutoff /Key (HPF Cutoff Key Follow Sensitivity)를 설정할 수 있습니다.

HPF24D: 특징적인 디지털 음향을 갖춘 다이나믹 −24dB/oct HPF입니다. 뚜렷한 공명 이펙트를 생성할 수 있습니다.

HPF12: 다이나믹 −12dB/oct HPF

•	 BPF(밴드 패스 필터)

특정 차단 주파수 대역에 대한 신호만 통과시키고 다른 모든 신호를 차단하는 필터 형식입니다.

Frequencies that are “passed” by the filter

FrequencyCenter Frequency

Gain

BPF12D: 특징적인 디지털 음향을 갖춘 −12dB/oct HPF와 LPF의 조합

BPFw: −12dB/oct HPF와 LPF의 조합. 넓은 대역폭 설정을 할 수 있습니다.

BPF6: −6dB/oct HPF와 LPF의 조합

BPF12D	 BPFw

Width

Frequencies that are 
“passed” by the filter

Frequencies that are 
“passed” by the filter

Frequencies that are 
“passed” by the filter

Frequency Frequency

Frequency

Resonance

Resonance

Gain

Gain

Gain

BPF6
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•	 BEF(밴드 소거 필터)

BPF(밴드 패스 필터)와 비교할 때 밴드 소거 필터는 사운드에 반대되는 영향을 줍니다. 차단 주파수 근처의 신호를 차단하고 

다른 주파수 대역의 신호만 통과시키는 필터 형식입니다.

Frequencies that are 
“passed” by the filter

Frequency
Center Frequency

Gain

BEF12: −12dB/oct BEF

BEF6: −6dB/oct BEF

DualLPF: 병렬로 연결된 2개의 −12dB/oct LPF입니다. Distance로 2개 필터의 차단 주파수 간의 거리를 설정합니다. 하한 주파수는 

화면에서 설정하고 상한 주파수는 이와 연계하여 자동으로 결정합니다.

DualHPF: 병렬로 연결된 2개의 −12dB/oct HPF

DualBPF: 병렬로 연결된 2개의 −6dB/oct BPF

DualBEF: 직렬로 연결된 2개의−6dB/oct BEF

LPF12+BPF6: 병렬로 연결된 −12dB/oct LPF와 −6dB/oct BPF의 조합입니다. Distance로 2개 필터의 차단 주파수 간의 거리를 설정합니다. 

하한 주파수는 화면에서 설정하고 상한 주파수는 이와 연계하여 자동으로 결정합니다.

DualLPF	 DualBEF

Frequency Frequency

Frequency

Distance

Distance

Distance
Gain

Gain

Gain

Cutoff (Filter Cutoff Frequency)
차단 주파수를 설정합니다.

여기에서 설정된 주파수는 Type에서 설정된 필터를 통해 사용됩니다.

설정: 0–1023

Cutoff/Vel (Filter Cutoff Velocity Sensitivity)
차단 주파수가 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

설정: 	 −64–+0–+63

양의 값: 세기가 빨라질수록 차단 주파수 값이 커집니다.

0: 차단 주파수가 세기에 반응하지 않습니다.

음의 값: 세기가 느려질수록 차단 주파수 값이 커집니다

LPF12+BPF6
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Resonance (Filter Resonance)
Width (Filter Width)
여기에 표시된 파라미터는 Filter Type 설정에 따라 다릅니다. Resonance는 LPF, HPF, BPF(BPFw 제외) 또는 BEF에 표시되고 

Width는 BPFw에 표시됩니다.

Resonance의 경우 이 파라미터는 공명 강도를 표시합니다. 또한 Cutoff 파라미터와 함께 사용하여 음향에 추가로 특징을 더할 수 

있습니다.

BPFw의 경우 Width는 필터에 의해 통과되는 신호 주파수 폭을 조정할 때 사용됩니다.

설정: 0–127

Res/Vel (Filter Resonance Velocity Sensitivity)
공명 레벨이 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

Filter Type에 따라서는 이 파라미터를 이용하지 못할 수 있습니다.

설정: 	 −64–+0–+63

양의 값: 세기가 커질수록 공명이 커집니다.

0: 공명 값이 세기에 따라 변하지 않습니다.

음의 값: 세기가 작아질수록 공명이 커집니다.

Cutoff/Key (Filter Cutoff Key Follow Sensitivity)
필터의 차단 주파수 레벨이 건반 위치에 어떻게 반응하는지 설정합니다.

기준 지점은 Center Key (FEG Time Key Follow Sensitivity Center Key)에서 설정된 건반의 차단 주파수입니다.

설정: 	 −200%–0%–+200%

양의 값: 연주음이 낮을수록 차단 주파수가 낮아지고 연주음이 높을수록 차단 주파수가 높아집니다.

음의 값: 연주음이 낮을수록 차단 주파수가 높아지고 연주음이 높을수록 차단 주파수가 낮아집니다.

Distance
Dual Filter 형식 및 LPF12+BPF6 필터의 차단 주파수 간 거리를 설정합니다.

Filter Type에 따라서는 이 파라미터를 이용하지 못할 수 있습니다.

설정: −128–+0–+127

HPF Cutoff (HPF Cutoff Frequency)
필터를 제어하는 기능의 중심 주파수 및 HPF의 건반 수반 설정에 따른 FEG 변화 속도를 설정합니다.

값이 증가하면 차단 주파수가 높아지며 저주파수 신호가 차단되거나 막혀 음향이 밝아집니다. 값이 감소하면 차단 주파수가 낮아지며 

베이스파가 통과하여 음향이 풍부하고 깊어집니다.

Filter Type을 LPF12+HPF12 또는 LPF6+HPF12로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 0–1023

HPF Cutoff/Key (HPF Cutoff Key Follow Sensitivity)
건반 위치에 따라 HPF의 차단 주파수 레벨을 설정합니다.

Filter Type을 LPF12+HPF12 또는 LPF6+HPF12로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 	 −200%–+0–+200%

양의 값: 연주음이 낮을수록 차단 주파수가 낮아지고 연주음이 높을수록 차단 주파수가 높아집니다.

음의 값: 연주음이 낮을수록 차단 주파수가 높아지고 연주음이 높을수록 차단 주파수가 낮아집니다.

Gain (Filter Gain)
게인(필터 유닛으로 전송되는 신호)을 설정합니다.

값이 낮아지면 요소의 음량이 감소합니다.

설정: 0–255
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Filter EG

Filter EG 화면에서 요소에 필터 엔벌로프 제너레이터(FEG)를 설정할 수 있습니다.

FEG를 사용하면 차단 주파수의 변화도(또는 레벨)와 건반을 누른 순간부터 음향이 감쇄될 때까지 시간 경과에 따라 어떻게 변하는지 

설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Element 선택 → Filter → Filter EG

Hold Time (FEG Hold Time)
건반을 누른 순간부터 Hold Level (FEG Hold Level)로 차단 주파수를 유지하는 데 소요되는 시간을 설정합니다.

설정: 0–127

Attack Time (FEG Attack Time)
Hold Time (FEG Hold Time) 끝부분에서 Attack Level (FEG Attack Level)로 차단 주파수가 변하는 데 소요되는 시간을 

설정합니다.

설정: 0–127

Decay 1 Time (FEG Decay 1 Time)
Attack Level (FEG Attack Level)에서 Decay1 Level (FEG Decay 1 Level)로 차단 주파수가 변하는 데 소요되는 시간을 

설정합니다.

설정: 0–127

Decay 2 Time (FEG Decay 2 Time)
Decay 1 Level (FEG Decay 1 Level)에서 Decay 2 Level (FEG Decay 2 Level)로 차단 주파수가 변하는 데 소요되는 시간을 

설정합니다.

설정: 0–127

Release Time (FEG Release Time)
건반에서 손을 뗀 순간부터 Release Level (FEG Release Level)에 이를 때까지 차단 주파수가 변하는 데 소요되는 시간을 

설정합니다.

설정: 0–127
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Hold Level (FEG Hold Level)
건반을 누를 때 차단 주파수 레벨을 설정합니다.
설정: −128–+0–+127

Attack Level (FEG Attack Level)
건반을 누른 후 차단 주파수 값을 설정합니다.
설정: −128–+0–+127

Decay 1 Level (FEG Decay 1 Level)
Attack Level (FEG Attack Level)부터 변경할 다음 차단 주파수 값을 설정합니다.
설정: −128–+0–+127

Decay 2 Level (FEG Decay 2 Level)
건반을 누르고 있는 동안 유지되는 차단 주파수를 설정합니다.
설정: −128–+0–+127

Release Level (FEG Release Level)
건반에서 손을 뗀 후 다음 차단 주파수 값을 설정합니다.
설정: −128–+0–+127

Center Key (FEG Time Key Follow Sensitivity Center Key)
Time/Key의 기준음을 설정합니다.

여기에서 건반(음)을 설정한 경우 FEG에서 설정된 차단 주파수의 변화 속도가 그대로 사용됩니다.
설정: C−2–G8

Time/Key (FEG Time Key Follow Sensitivity)
건반의 피치에 따라 증가 또는 감소하는 FEG가 유발하는 변화 속도의 정도를 설정합니다.

FEG의 변화 속도는 Center Key의 지정 건반에 사용됩니다.
설정: 	 −64–+63

양의 값: 연주음이 낮을수록 FEG로 제어되는 차단 주파수 변화가 느려지며 연주음이 높을수록 변화가 빨라집니다.
0: 건반 위치와는 상관없이 FEG가 변하지 않습니다.
음의 값: 연주음이 낮을수록 FEG로 제어되는 차단 주파수 변화가 빨라지며 연주음이 높을수록 변화가 느려집니다.

Center Key 및 Time/key

(2)

(1)

(3)

High

Fast

Slow

+63

+30

−40

Low

Time

(6)

Time

(6)

Time

(6)

Time

(6)

(4)

(5)

Low key High key

(1) 키

(2) FEG에 의한 차단 주파수 속도

(3) Center Key

(4) Time/Key가 양수일 경우

(5) Time/Key가 음수일 경우

(6) 차단 주파수
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Time/Vel (FEG Time Velocity Sensitivity)
Segment (FEG Time Velocity Sensitivity Segment)
차단 주파수가 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.
먼저, Segment에 시간 값을 설정한 후 Time/Vel에 세기 감도 값을 설정합니다.
설정: 	 Time/Vel: −64–+0–+63

양의 값: 세기가 빨라질수록 차단 주파수 변화가 빨라집니다. 세기가 느려질수록 차단 주파수 변화가 느려집니다.
0: 세기 설정과는 상관없이 변하지 않습니다.
음의 값: 세기가 빨라질수록 차단 주파수 변화가 느려집니다. 세기가 느려질수록 차단 주파수 변화가 빨라집니다.

값이 양수일 경우
빠른 세기(빠른 차단 주파수 변화)	 느린 세기(느린 차단 주파수 변화)

Time

(1)

Time

(1)

(1) 차단 주파수

설정: 	 Segment: Attack, Atk+Dcy, Decay, Atk+Rls, All
Attack: Time/Vel 값이 Attack Time에 영향을 미칩니다.
Atk+Dcy: Time/Vel 값이 Attack Time 및 Decay1Time에 영향을 미칩니다.
Decay: Time/Vel 값이 Decay Time에 영향을 미칩니다.
Atk+Rls: Time/Vel 값이 Attack Time 및 Release Time에 영향을 미칩니다.
All: Time/Vel 값이 FEG의 시간 관련 설정에 영향을 미칩니다.

FEG Depth
FEG로 제어되는 차단 주파수 변화의 깊이 범위를 설정합니다. 설정값이 0에서 멀어질수록 차단 주파수의 깊이 범위가 넓어집니다.
설정: 	 −64–+0–+63

0: FEG에 따라 차단 주파수가 변화되지 않습니다.
음의 값: 차단 주파수 변화가 반전됩니다.

Depth/Vel (FEG Depth Velocity Sensitivity)
Curve (FEG Depth Velocity Sensitivity Curve)
Depth/Vel (FEG Depth Velocity Sensitivity) FEG로 제어되는 차단 주파수 변화의 깊이 범위가 건반을 누르는 세기 또는 강도에 
어떻게 반응하는지 설정합니다.
Curve (FEG Depth Velocity Sensitivity Curve) 설정을 사용하여 FEG Depth가 세기에 어떻게 반응하는지 설정할 수 있습니다. 
수직축은 세기를 나타내고 수평축은 차단 주파수 변화의 깊이 범위를 의미합니다.
설정: 	 Depth/Vel: −64–+0–+63

양의 값: 세기가 빨라질수록 차단 주파수의 깊이 범위가 넓어집니다. 세기가 느려질수록 차단 주파수의 깊이 범위가 좁아집니다.
0: 차단 주파수가 세기에 반응하지 않습니다.
음의 값: 세기가 빨라질수록 차단 주파수의 깊이 범위가 좁아집니다. 세기가 느려질수록 차단 주파수의 깊이 범위가 넓어집니다.

값이 양수일 경우
빠른 세기(차단 주파수 변화의 깊이 범위가 넓어짐)	 느린 세기(차단 주파수 변화의 깊이 범위가 좁아짐)

Time

(1)

Time

(1)

(1) 차단 주파수 변화의 깊이 범위

설정: 	 Curve: 0–4

0 31 42
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Scale

Scale 화면에서 요소에 필터 스케일을 설정할 수 있습니다.

필터 스케일 기능을 사용하면 피치에 따라 필터의 차단 주파수를 변경할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Element 선택 → Filter → Scale

Break Point (Filter Cutoff Scaling Break Point) 1–4
Cutoff Offset으로 설정되도록 네 지점의 음 번호를 설정합니다.

설정: C−2–G8

주
Break Point 1이 4로 설정된 음 번호는 오름차순으로 자동 정렬됩니다.

Cutoff Offset (Filter Cutoff Scaling Offset) 1–4
Break Point (Filter Cutoff Scaling Break Point) 1–4의 Cutoff를 증가 또는 감소시키는 값을 설정합니다.

설정: −128–+0–+127

주
•	오프셋 값이 Cutoff 값 위 또는 아래에서 설정되면 차단 주파수가 해당 설정을 절대 벗어나지 않습니다.

•	Break Point 1 아래에서 설정된 음의 경우 값은 1의 차단 주파수로 설정됩니다. Break Point 4 위에서 설정된 음의 경우 값은 4의 차단 주파수로 

설정됩니다.



257MODX M 사용설명서

Amplitude

Level/Pan

Level/Pan 화면에서 각 요소의 (스테레오 필드 내) 레벨 및 팬을 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Element 선택 → Amplitude → Level/Pan

Level/Key (Level Key Follow Sensitivity)
각 요소의 음량이 건반 위치에 어떻게 반응하는지 설정합니다.

기준 지점은 Center Key (AEG Time Key Follow Center Key)에 지정된 음량입니다.

설정: 	 −64–+0–+63

양의 값: 연주음이 낮을수록 음량이 약해지며 연주음이 높을수록 음량이 커집니다.

음의 값: 연주음이 낮을수록 음량이 커지며 연주음이 높을수록 음량이 약해집니다.

Level (Element Level)
각 요소의 출력 레벨(음량)을 설정합니다.

설정: 0–127
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Level/Vel (Level Velocity Sensitivity)
Offset (Level Velocity Offset)
Curve (Level Sensitivity Key Curve)
Level/Vel (Level Velocity Sensitivity)가 요소의 음량이 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

Offset (Level Velocity Offset) Level/Vel에서 지정된 모든 설정을 조정합니다. 값이 127을 초과하면 세기는 127로 설정됩니다.

Curve (Level Sensitivity Key Curve) 설정을 사용하여 음량이 세기에 어떻게 반응하는지 설정할 수 있습니다. 수직축은 세기를 

나타내고 수평축은 음량 변화의 깊이 범위를 의미합니다.

설정: 	 Level/Vel: −64–+0–+63

양의 값: 세기가 빨라질수록 음량이 커집니다.

음의 값: 음의 값 세기가 느려질수록 음량이 커집니다.

0: 세기 설정과는 상관없이 변하지 않습니다.

설정: 	 Offset: 0–127

Offset = 0 Offset = 64 Offset = 96

0 64 127

127 A

B

X

Y

C

0 64 127

127 A

B

X

Y

C

0 64 127

127 A
B

X

Y

C

A: Level/Vel = 0

B: Level/Vel = 32

C: Level/Vel = 64

X: 음을 연주하는 세기

Y: 내부 톤 제너레이터에 전송되는 세기

설정: 	 Curve: 0–4

0 31 42

Pan (Element Pan)
요소의 (스테레오 필드 내) 팬 위치를 설정합니다.

파트 안에 존재하는 요소의 우측 및 좌측 팬 설정이 존재하면 팬 설정 결과를 듣기가 어려울 수 있습니다.

설정: L63–C(중앙)–R63
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Alternate Pan (Alternate Pan Depth)
누르는 각 건반의 음향이 어떻게 좌우 교대로 패닝되는지 설정합니다.

Pan (Element Pan)에서 설정된 값은 팬의 좌우 이동에 대한 중앙 위치입니다.

설정: L63–C(중앙)–R63

Random Pan (Random Pan Depth)
누르는 각 건반의 음향이 어떻게 무작위로 좌우 패닝되는지 설정합니다.

Pan (Element Pan)에서 설정된 값은 팬의 좌우 이동에 대한 중앙 위치입니다.

설정: 0–127

Scaling Pan (Scaling Pan Depth)
누르는 건반의 위치가 팬 설정 위치에 어떻게 영향을 미치는지 설정합니다.

Pan (Element Pan)에서 설정된 값은 C3의 위치입니다.

설정: 	 −64–+0–+63

양의 값: 음이 낮으면 팬 위치가 왼쪽으로, 음이 높으면 오른쪽으로 스케일링됩니다.

음의 값: 음이 낮으면 팬 위치가 오른쪽으로, 음이 높으면 왼쪽으로 스케일링됩니다.
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Amp EG

Amp EG 화면에서 요소의 AEG(진폭 엔벌로프 제너레이터) 시간을 설정할 수 있습니다. Amp EG를 설정하면 건반을 누른 순간부터 

음향이 감쇄될 때까지 음량이 어떻게 변하는지 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Element 선택 → Amplitude → Amp EG

Attack Time (AEG Attack Time)
건반을 누른 순간부터 Attack Level (AEG Attack Level)에 설정된 값에 이를 때까지 음량이 변하는 데 소요되는 시간을 설정합니다.

설정: 0–127

Decay 1 Time (AEG Decay 1 Time)
Attack Level (AEG Attack Level)에서 Decay 1 Level (AEG Decay 1 Level)로 음량이 변하는 데 소요되는 시간을 설정합니다.

설정: 0–127

Decay 2 Time (AEG Decay 2 Time)
Decay 1 Level (AEG Decay 1 Level)에서 Decay 2 Level (AEG Decay 2 Level)로 음량이 변하는 데 소요되는 시간을 설정합니다.

설정: 0–127

Release Time (AEG Release Time)
건반에서 손을 뗀 후 음향이 감쇄될 때까지 소요되는 시간을 설정합니다.

설정: 0–127

Initial Level (AEG Initial Level)
건반을 누를 때 음량을 설정합니다.

설정: 0–127

Attack Level (AEG Attack Level)
건반을 누른 후 변경할 음량을 설정합니다.

설정: 0–127
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Decay 1 Level (AEG Decay 1 Level)
Attack Level (AEG Attack Level)에서 변경할 다음 음량 값을 설정합니다.

설정: 0–127

Decay 2 Level (AEG Decay 2 Level)
건반을 누르고 있는 동안 유지되는 음량을 설정합니다.

설정: 0–127

Center Key (AEG Time Key Follow Center Key)
Time/Key (AEG Time Key Follow Sensitivity)의 기준음을 설정합니다.

여기에서 음(건반)을 설정한 경우 Time/Key (AEG Time Key Follow Sensitivity)에서 설정된 피치 변화의 결과음이 연주됩니다.

설정: C−2–G8

Time/Key (AEG Time Key Follow Sensitivity)
AEG의 음량 변화 속도가 건반 위치에 어떻게 반응하는지 설정합니다.

AEG의 변화 속도는 Center Key (AEG Time Key Follow Center Key)의 지정 건반에 사용됩니다.

설정: 	 −64–+0–+63

양의 값: 연주음이 낮을수록 AEG 음량 변화가 느려지며 연주음이 높을수록 AEG 음량 변화가 빨라집니다.

0: 건반 위치와는 상관없이 AEG 음량이 변하지 않습니다.

음의 값: 연주음이 낮을수록 AEG 음량 변화가 빨라지며 연주음이 높을수록 AEG 음량 변화가 느려집니다.

Center Key 및 Time/key

(2)

(1)

(3)

High

Fast

Slow

+63

+30

−40

Low

Time

(6)

Time

(6)

Time

(6)

Time

(6)

(4)

(5)

Low key High key

(1) 키

(2) AEG의 음량 변화 속도

(3) Center Key

(4) Time/Key가 양수일 경우

(5) Time/Key가 음수일 경우

(6) AEG 음량

Release Adj (AEG Time Key Follow Sensitivity Release Adjustment)
AEG Release에 대한 Time/Key (AEG Time Key Follow Sensitivity)의 감도를 조정합니다.

값이 낮을수록 감도가 적어집니다.

설정: 	 0–127

127: Decay 1 및 Time/Key Decay 2와 동일함

0: Time/Key가 AEG Release에 영향을 미치지 않음.



262MODX M 사용설명서

Time/Vel (AEG Time Velocity Sensitivity)
Segment (AEG Time Velocity Segment)
AEG의 음량 변화가 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

먼저, Segment에 시간 값을 설정한 후 Time/Vel에 세기 감도 값을 설정합니다.

설정: 	 Time/Vel: −64–+0–+63

양의 값: 세기가 빨라질수록 AEG 음량 변화가 빨라집니다.

0: 세기 설정과는 상관없이 변하지 않습니다.

음의 값: 세기 값이 빠르면 AEG 음량 변화가 느려지고 세기 값이 느리면 AEG 음량 변화가 빨라집니다.

값이 양수일 경우

빠른 세기(빠른 음량 변화)		  느린 세기(느린 음량 변화)

Time

(1)

Time

(1)

(1) 음량

설정: 	 Segment: Attack, Atk+Dcy, Decay, Atk+Rls, All

Attack: Time/Vel 값이 Attack Time에 영향을 미칩니다.

Atk+Dcy: Time/Vel 값이 Attack Time 및 Decay1Time에 영향을 미칩니다.

Decay: Time/Vel 값이 Decay Time에 영향을 미칩니다.

Atk+Rls: Time/Vel 값이 Attack Time 및 Release Time에 영향을 미칩니다.

All: Time/Vel 값이 AEG의 시간 관련 설정에 영향을 미칩니다.

Half Damper (Half Damper Switch)
이 스위치를 켜짐으로 설정하면 별매품인 풋 컨트롤러 FC3A를 후면 패널의 [SUSTAIN] 잭에 연결하여 건반 연주에 하프 댐퍼 기능을 

사용할 수 있습니다.

하프 댐퍼 기능을 사용하면 더욱 표현력 있게 음향 감쇄를 제어할 수 있어 켜짐/꺼짐 스위치에 그치지 않고 지속적으로 마치 어쿠스틱 

피아노처럼 댐퍼 페달을 조작할 수 있습니다.

설정: Off, On

Time (Half Damper Time)
Half Damper (Half Damper Switch)를 켜짐으로 설정한 경우 풋 컨트롤러 FC3A를 끝까지 밟은 상태에서 건반에서 손을 뗀 순간부터 

음향이 감쇄될 때까지의 시간을 설정합니다. 꺼짐으로 설정한 경우에는 이 파라미터가 표시되지 않습니다.

페달을 밟는 정도를 변경하면 Half Damper Time에서 Release Time (AEG Release Time)까지의 감쇄 타임을 조정할 수 있습니다.

페달에서 발을 떼면 Release Time (AEG Release Time)이 음향을 감쇄시킬 때 사용됩니다. Release Time을 작은 값으로 설정하고 

Half Damper Time을 큰 값으로 설정하면 어쿠스틱 피아노와 같이 자연스러운 감쇄 음향을 연주할 수 있습니다.

설정: 0–127
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Scale

Scale 화면에서 요소에 진폭 스케일을 설정할 수 있습니다.

이 파라미터는 건반 위치에 따라 음량을 변화시킵니다.

작업

[PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Element 선택 → Amplitude → Scale

Break Point (Level Scaling Break Point) 1–4
Level Offset (Level Scaling Offset) 1–4의 음 번호를 설정합니다.

설정: C−2–G8

주
Break Point 1이 4로 설정된 음 번호는 오름차순으로 자동 정렬됩니다.

Level Offset (Level Scaling Offset) 1–4
Break Point (Level Scaling Break Point) 1–4의 Level을 증가 또는 감소시키는 값을 설정합니다.

설정: −128–+0–+127
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Element EQ

Element EQ 화면에서 요소의 이퀄라이저를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Element 선택 → Element EQ

EQ Type (Element EQ Type)
원하는 EQ 형식을 선택합니다.

설정: 	 2-band, P.EQ, Boost6, Boost12, Boost18, Thru

2-band: 특정 주파수(Low Freq 또는 High Freq) 위나 아래의 신호 대역을 증폭시키거나 차단하는 쉘빙 EQ

P.EQ: 중심 주파수(Freq) 근처의 신호 레벨(Gain))을 증폭시키거나 차단하는 파라메트릭 EQ

Boost6: 레벨을 6dB만큼 증폭시킵니다.

Boost12: 레벨을 12dB만큼 증폭시킵니다.

Boost18: 레벨을 18dB만큼 증폭시킵니다.

Thru: 적용되는 이펙트 없이 신호를 통과시킵니다.

	� EQ Type을 2-band로 설정한 경우

–

+

0

Gain

Low Gain High Gain

Low Freq High Freq

Frequency

EQ Low Gain (Element EQ Low Gain)
Low 대역의 신호 레벨을 설정합니다.

설정: −12.00dB – +0.00dB – +12.00dB

EQ Low Freq (Element EQ Low Frequency)
Low 대역의 주파수를 설정합니다.

설정: 50.1Hz–2.00kHz
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EQ Hi Gain (Element EQ High Gain)
High 대역의 신호 레벨을 설정합니다.

설정: −12.00dB – +0.00dB – +12.00dB

EQ Hi Freq (Element EQ High Frequency)
High 대역의 주파수를 설정합니다.

설정: 503.8Hz–10.1kHz

	� EQ Type을 P.EQ로 설정한 경우

–

+

0

Gain

Gain
Freq

Q

Frequency

EQ Gain (Element EQ Gain)
EQ Freq (Element EQ Frequency)에서 설정된 주파수 범위의 신호 레벨을 설정합니다.

설정: −12.00dB – +0.00dB – +12.00dB

EQ Freq (Element EQ Frequency)
차단하거나 증폭시킬 주파수를 설정합니다.

설정: 139.7Hz–12.9kHz

EQ Q (Element EQ Q)
EQ Freq (Element EQ Frequency)에서 설정된 주파수의 신호 레벨을 증폭시키거나 차단하면 다양한 주파수 응답 곡선을 생성할 수 

있습니다.

설정: 0.7–10.3
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Element LFO

Element LFO 화면에서 요소의 LFO(저주파수 오실레이터)를 설정할 수 있습니다.

요소의 LFO(저주파수 오실레이터)는 낮은 대역에서 신호를 생성하므로 피치, 필터 및 진폭 모듈레이션(주기적인 변화)에 사용할 수 

있습니다.

작업

[PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Element 선택 → Element LFO

LFO Wave
선택한 음파를 사용해 LFO 음파를 선택하면 다양한 형식의 모듈레이션을 생성할 수 있습니다.

설정: Saw, Triangle, Square

Saw (톱니파) Triangle (삼각파) Square (사각파)

Extended LFO
속도(LFO 속도)의 기존 Speed (LFO Speed) 설정 세트(Off: 0~63)와 높은 해상도의 신규 설정 세트(On: 0~415)를 서로 

전환합니다.

기존 설정으로 생성한 데이터의 호환성을 유지하려면 이 파라미터를 꺼짐으로 설정합니다.

설정: Off, On

Speed (LFO Speed)
LFO Wave 변화 속도를 설정합니다. 이 파라미터의 값이 클수록 속도가 빨라집니다.

설정: 0~63(Extended LFO를 꺼짐으로 설정한 경우), 0~415(Extended LFO를 켜짐으로 설정한 경우)

Delay (LFO Delay Time)
건반을 누르는 순간부터 LFO가 적용될 때까지 딜레이 타임을 설정합니다.

설정: 0–127
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Fade In (LFO Fade In Time)
건반에서 손을 떼고 Delay (LFO Delay Time)에서 설정된 딜레이 타임이 경과된 후 LFO 이펙트가 페이드 인될 때까지 소요되는 시간을 

설정합니다. 값이 커질수록 이펙트가 최대 레벨에 이를 때까지 소요되는 시간이 길어집니다.

설정: 	 0–127

0: LFO가 페이드 인 없이 최대값으로 변경됩니다.

값이 작을 경우

Fade In
Maximum

Delay

Key On

Time

값이 클 경우

Fade In
Maximum

Delay

Key On

Time

Key On Reset (LFO Key On Reset)
건반을 누를 때 LFO의 진동을 재설정합니다.

설정: Off, On

Pitch Mod (LFO Pitch Modulation Depth)
이 파라미터는 LFO 음파를 사용하여 비브라토 이펙트(주기적인 피치 변화)를 생성합니다.

파라미터를 큰 값으로 설정하면 음량 변화가 커집니다.

설정: 0–127

Filter Mod (LFO Filter Modulation Depth)
이 파라미터는 LFO 음파를 사용하여 와와 이펙트(주기적인 필터 차단 주파수 변화)를 생성합니다.

값이 커지면 차단 주파수 변화 범위가 넓어집니다.

설정: 0–127

Amp Mod (LFO Amplitude Modulation Depth)
이 파라미터는 LFO 음파를 사용하여 트레몰로 이펙트(주기적인 음량 변화)를 생성합니다.

파라미터를 큰 값으로 설정하면 음량 변화가 커집니다.

설정: 0–127
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Drum Part Edit (AWM2) Part Common Edit 화면

드럼 파트(AWM2)는 73개의 드럼 키로 구성되어 있습니다.

Drum Part Edit (AWM2)에는 전체 파트에 파라미터를 설정할 때 사용되는 Part Common Edit와 각 드럼 키에 대한 파라미터를 

설정할 때 사용되는 Key Edit이 포함됩니다.

General/Pitch

Part Settings

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → General/Pitch → Part Settings

Main Category (Part Main Category)
Sub Category (Part Sub Category)
선택한 파트의 메인 카테고리와 하위 카테고리를 설정합니다.

설정: Data List 참조

Part Name
새 이름으로 편집 중인 파트를 저장합니다. 최대 20자의 영숫자 문자를 사용할 수 있습니다.

Volume
선택한 파트의 음량을 설정합니다.

설정: 0–127

Pan
파트의 (스테레오 필드 내) 선택한 팬 위치를 설정합니다.

설정: L63–C(중앙)–R63
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Dry Level
선택한 파트의 dry 레벨을 설정합니다.

Part Output (Part Output Select)를 MainL&R 또는 Drum으로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Var Send (Variation Send)
선택한 파트의 변주 전송을 설정합니다.

Part Output (Part Output Select)를 MainL&R 또는 Drum으로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Rev Send (Reverb Send)
선택한 파트의 리버브 전송을 설정합니다.

Part Output (Part Output Select)를 MainL&R 또는 Drum으로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Part Output (Part Output Select)
선택한 파트에서 오디오 신호의 출력 대상을 설정합니다.

설정: 	 MainL&R, (AsgnL&R), USB Stereo, (AsgnL), (AsgnR), USB mono, Off, Drum

MainL&R: OUTPUT [L/MONO] 및 OUTPUT [R] 잭으로 스테레오(2개의 채널)로 출력됩니다.

USB Stereo: [USB TO HOST] 단자로 스테레오(채널 1 및 2~채널 7 및 8)로 출력됩니다.

USB mono: USB [TO HOST] 단자로 모노(채널 1~8)로 출력됩니다.

Off: 파트의 오디오 신호 출력이 없습니다.

Drum: 각 드럼 키에 대한 출력을 설정할 수 있습니다.

주
MONTAGE M과의 데이터 호환 설정은 아래 표시되어 있습니다. 설정 시에는 꺼짐으로 간주됩니다.

•	AsgnL&R

•	USB Stereo: USB9&10 – USB29&30

•	USB mono: USB9 – USB30

•	AsgnL

•	AsgnR

Arp Play Only (Arpeggio Play Only)
아르페지오에 따라서만 연주할 파트를 설정합니다.

켜짐으로 설정된 파트는 아르페지오에서 전송된 노트 온 메시지에 의해 연주됩니다.

설정: Off, On

Element Pan (Element Pan Switch)
Key Edit에서 Pan을 켜짐 또는 꺼짐으로 설정합니다.

꺼짐으로 설정한 경우 Key Edit의 팬이 C(중앙)로 설정됩니다.

설정: Off, On

Velocity Limit
파트의 세기 범위(최저/최고값)를 설정합니다.

설정: 1–127

Note Limit
파트의 음 범위(최저/최고음)를 설정합니다.

설정: C−2–G8
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Velocity Offset (Velocity Sensitivity Offset)
내부 톤 제너레이터로 전송된 세기 값을 증가 또는 감소시킵니다.

설정: 0–127

Velocity Depth = 64이고
Velocity Offset = 32인 경우

Velocity Depth = 64이고
Velocity Offset = 64인 경우

Velocity Depth = 64이고
Velocity Offset = 96인 경우

127

0 12764 12764

127

012764

127

0

(1)

(2)

(1)

(2)

(1)

(2)

127

0 12764 12764

127

012764

127

0

(1)

(2)

(1)

(2)

(1)

(2)

127

0 12764 12764

127

012764

127

0

(1)

(2)

(1)

(2)

(1)

(2)

(1) 실제 결과적으로 만들어지는 세기(톤 제너레이터에 영향)
(2) 음을 연주하는 세기

Velocity Depth (Velocity Sensitivity Depth)
내부 톤 제너레이터에 전송된 세기 값 레벨이 건반을 누르는 세기나 강도에 어떻게 반응하는지 설정합니다.

설정: 0–127

Velocity Depth = 64인 경우

 

127

0 12764

(1)
Depth = 127

Depth = 64

Depth = 32

Depth = 0
(2)

(1) 실제 결과적으로 만들어지는 세기(톤 제너레이터에 영향)
(2) 음을 연주하는 세기
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Zone Settings

Part Edit (AWM2) Part Common Edit 화면의 General/Pitch → Zone Settings와 동일합니다.

Pitch

Pitch 화면에서 파트의 피치를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → General/Pitch → Pitch

Note Shift
반음 단위로 피치를 조정합니다.

설정: −48–+0–+48

Detune
선택한 파트의 피치를 0.1Hz 단위로 조정합니다.

피치를 약간 이동하면 음향을 디튠 처리할 수 있습니다.

설정: −12.8Hz–+0.0Hz–+12.7Hz

Pitch Control Group
동일한 그룹에 지정된 파트에는 동일한 피치가 설정됩니다.

그러나 Portamento, Mono/Poly 및 Micro Tuning은 드럼 파트에 이용할 수 없습니다.

Pitch Bend (Pitch Bend Range Lower)
Pitch Bend (Pitch Bend Range Upper)
피치 벤드 휠로 변경한 범위를 반음 단위로 설정합니다.

설정: −48–+0–+24
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Filter/Amp

Filter

Part Edit (AWM2) Part Common Edit 화면의 Filter/Amp → Filter와 동일합니다.

Amp EG

Part Edit (AWM2) Part Common Edit 화면의 Filter/Amp → Amp EG와 동일합니다.
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Effect

Routing

Routing 화면에서 파트의 이펙트 경로를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Effect → Routing

여기에 표시된 화면은 기본적으로 Part Edit (AWM2) Part Common Edit 화면의 Effect → Routing에서 연 화면과 동일하지만 아래 

표시된 파라미터가 Drum Part Edit (AWM2)에 추가되었습니다.

Drum Key (Drum Key Select)
선택한 드럼 키의 이름을 표시합니다.

설정: C0–C6

Keyboard Select
건반 선택 설정을 켜짐 또는 꺼짐으로 설정합니다.

이 파라미터를 켜짐으로 설정하면 원하는 드럼 키를 선택할 수 있으므로 건반을 눌러 편집할 수 있습니다.

설정: Off, On

Connect (Drum Key Connection Switch)
인서트 이펙트 A(InsA) 또는 인서트 이펙트 B(InsB)로 출력할 키를 설정하거나 인서트 이펙트(Thru)를 건너뜁니다.

설정: Thru, InsA, InsB
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InsRev (Insertion to Reverb Send Level)
InsVar (Insertion to Variation Send Level)
인서트 이펙트 A 또는 인서트 이펙트 B에 전송된 드럼 키 신호의 레벨을 리버브 또는 변주 이펙트에 설정합니다.

이 설정은 전체 드럼 파트(모든 드럼 키)에 적용됩니다.

Connect (Drum Key Connection Switch)를 InsA 또는 InsB로 설정하고 Part Output (Part Output Select)를 MainL&R 또는 

Drum으로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

KeyRev (Drum Key Reverb Send Level)
KeyVar (Drum Key Variation Send Level)
인서트 이펙트 A 또는 인서트 이펙트 B를 통해 전송된 드럼 키 신호의 레벨을 리버브 또는 변주 이펙트로 설정합니다.

이 파라미터를 각 드럼 키로 설정할 수 있습니다.

Connect (Drum Key Connection Switch)를 Thru로 설정하고, Part Output (Part Output Select)를 MainL&R로 설정하거나, 

Part Output을 Drum으로 설정하고 Drum Key Out을 MainL&R로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–127

Drum Key Out (Drum Key Output Select)
각 드럼 키의 출력 대상을 설정합니다.

Part Output (Part Output Select)를 Drum으로 설정한 경우에만 이 파라미터가 표시됩니다.

설정: 	 MainL&R, (AsgnL&R), USB Stereo, (AsgnL), (AsgnR), USB mono

MainL&R: OUTPUT [L/MONO] 및 OUTPUT [R] 잭으로 스테레오(2개의 채널)로 출력됩니다.

USB Stereo: [USB TO HOST] 단자로 스테레오(채널 1 및 2~채널 7 및 8)로 출력됩니다.

USB mono: USB [TO HOST] 단자로 모노(채널 1~8)로 출력됩니다.

주
•	MONTAGE M과의 데이터 호환 설정은 아래 표시되어 있습니다. 설정 시에는 꺼짐으로 간주됩니다.

•	AsgnL&R

•	USB Stereo: USB9&10 – USB29&30

•	USB mono: USB9 – USB30

•	AsgnL

•	AsgnR

•	Connect (Drum Key Connection Switch)는 InsA/InsB로 설정되고, 이 파라미터는 MainL&R로 고정되어 있습니다.
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Ins A, Ins B

Ins A 및 Ins B 화면에서 인서트 이펙트를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Effect → Ins A

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Effect → Ins B

Common Edit 화면의 Audio In → Ins A 및 Ins B와 동일합니다.

3-band EQ

Part Edit (AWM2) Part Common Edit 화면의 Effect → 3-band EQ와 동일합니다.

2-band EQ

Part Edit (AWM2) Part Common Edit 화면의 Effect → 2-band EQ와 동일합니다.

Ins Assign

Part Edit (AWM2) Part Common Edit 화면의 Effect → Ins Assign과 동일합니다.
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Arpeggio

Common

Part Edit (AWM2) Part Common Edit 화면의 Arpeggio → Common과 동일합니다.

Individual

Part Edit (AWM2) Part Common Edit 화면의 Arpeggio → Individual과 동일합니다.

Advanced

여기에 표시된 화면은 기본적으로 Part Edit (AWM2) Part Common Edit 화면의 Arpeggio → Advanced에서 연 화면과 동일하지만 

아래 표시된 파라미터가 추가되었습니다.

Fixed SD/BD (Arpeggio Fixed SD/BD)
이 파라미터를 켜짐으로 설정하면 아르페지오가 재생될 때 베이스 드럼과 스네어 드럼에 C1과 D1이 각각 사용됩니다.

대부분의 드럼 키트는 베이스 드럼과 스네어 드럼에 C1과 D1을 각각 지정하지만, 일부 드럼 키트는 다른 음을 지정할 수 있습니다. 

그러므로, 선택한 드럼 키트와 아르페지오 형식에 따라 부자연스럽게 들릴 수 있습니다. 이 파라미터를 켜면 이 부자연스러운 음향을 

해결할 수 있습니다.

설정: Off, On
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Motion Seq

Common

Part Edit (AWM2) Part Common Edit 화면의 Motion Seq → Common과 동일합니다.

Lane

Part Edit (AWM2) Part Common Edit 화면의 Motion Seq → Lane과 동일합니다.
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Mod/Control

Control Assign

Destination 설정을 제외하면 Part Edit (AWM2) Part Common Edit 화면의 Mod/Control → Control Assign과 동일합니다.

Destination 설정 목록은 Data List의 Control List를 참조하십시오.

Tx/Rx Switch

Part Edit (AWM2) Part Common Edit 화면의 Mod/Control → Tx/Rx Switch와 동일합니다.

Control Settings

Part Edit (AWM2) Part Common Edit 화면의 Mod/Control → Control Settings와 동일합니다.
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Drum Part Edit (AWM2) Key Edit 화면

드럼 파트(AWM2)는 73개의 드럼 키로 구성되어 있습니다.

Drum Part Edit (AWM2)에는 전체 파트에 파라미터를 설정할 때 사용되는 Part Common Edit과 각 드럼 키에 대한 파라미터를 

설정할 때 사용되는 Key Edit이 포함됩니다.

Osc/Tune

Osc/Tune 화면에서 드럼 키 파트에 있는 각 키의 오실레이터를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Key 선택 → Osc/Tune

Drum Key Switch
선택한 드럼 키를 사용하도록 설정합니다.

설정: Off, On

Bank (Waveform Bank)
Number (Waveform Number)
Category (Waveform Category)
Sub Category (Waveform Sub Category)
Waveform Name
드럼 키에 선택된 파형의 이름을 표시합니다.

Bank 요소에 지정된 파형의 형식(내장 설정, 사용자 및 라이브러리)을 나타냅니다.

설정: Data List 참조
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Assign Mode (Key Assign Mode)
내부 톤 제너레이터가 동일한 음향의 노트 온 메시지를 두 번 (이상) 연속으로 수신할 때 음향 생성 방법을 설정합니다. 이 Multi 설정을 

실시하면 특히 크래시 심벌 및 다른 타악기의 감쇄가 긴 상태로 롤이 자연스럽게 들립니다.

설정: 	 Single, Multi

Single: 먼저 음을 멈춘 후에 다시 동일한 음을 연주합니다.

Multi: 첫 번째 음에 겹쳐 두 번째 음을 연주합니다.

Connect (Drum Key Connection)
인서트 이펙트 A(InsA) 또는 인서트 이펙트 B(InsB)로 출력할 키를 설정하거나 인서트 이펙트(Thru)를 건너뜁니다.

이 파라미터는 Drum Part Edit (AWM2) Part Common Edit 화면의 Effect → Routing Connect (Drum Key Connection 

Switch)와 동일합니다.

설정: Thru, InsA, InsB

New Waveform
USB 플래시 드라이브에 저장된 오디오 파일을 파형으로 불러옵니다.

파형을 불러오면 Edit Waveform이 나타납니다.

Edit Waveform
Waveform Edit 화면이 열립니다.

Coarse (Coarse Tune)
드럼 키에 지정된 파형의 피치를 이동시킵니다.

설정: −48–+0–+48

Fine (Fine Tune)
드럼 키에 지정된 음파의 피치를 미세 조정합니다.

설정: −64–+0–+63

Pitch/Vel (Pitch Velocity Sensitivity)
피치 변화가 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

설정: 	 −64–+0–63

양의 값: 세기가 빨라질수록 피치가 높아집니다.

0: 변함없이 유지됩니다.

음의 값: 세기가 빨라질수록 피치가 낮아집니다.

Rcv Note Off (Receive Note Off)
MIDI 노트 오프 메시지를 수신할 드럼 키를 설정합니다. 타악기 음에 켜짐으로 설정한 경우 감쇄 없이 지속될 수 있습니다.

설정: 	 Off, On

On: 건반에서 손을 떼면 음향이 정지됩니다.

Off: 건반에서 손을 떼면 음향이 감쇄됩니다.

Group (Alternate Group)
이 설정을 실시하면 함께 연주할 드럼 키가 부자연스럽거나 잘못 조합되지 않도록 방지할 수 있습니다.

예를 들어, 함께 연주되지 않도록 동일한 그룹에 오픈 및 클로즈드 하이햇을 지정할 수 있습니다.

어떤 조합으로도 자연스럽게 드럼 키를 연주하려면 이 파라미터를 Off로 설정하십시오.

설정: Off, 1–127
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KeyRev (Drum Key Reverb Send Level)
KeyVar (Drum Key Variation Send Level)
인서트 이펙트 A 또는 인서트 이펙트 B를 통해 전송된 드럼 키 신호의 레벨을 리버브 또는 변주 이펙트로 설정합니다. 이 파라미터를 각 

드럼 키로 설정할 수 있습니다.

Connect (Drum Key Connection Switch), Part Output (Part Output Select) 및 Drum Key Out (Drum Key Output Select) 

설정에 따라서는 이 파라미터를 이용할 수 없습니다.

설정: 0–127

Drum Key Out (Drum Key Output Select)
드럼 키의 출력 대상을 설정합니다.

Connect (Drum Key Connection Switch) 및 Part Output (Part Output Select) 설정에 따라서는 이 파라미터를 이용할 수 

없습니다.

설정: 	 MainL&R, (AsgnL&R), USB Stereo, (AsgnL), (AsgnR), USB Mono

MainL&R: OUTPUT [L/MONO] 및 OUTPUT [R] 잭으로 스테레오(2개의 채널)로 출력됩니다.

USB Stereo: [USB TO HOST] 단자로 스테레오(채널 1 및 2~채널 7 및 8)로 출력됩니다.

USB Mono: USB [TO HOST] 단자로 모노(채널 1~8)로 출력됩니다.

주
MONTAGE M과의 데이터 호환 설정은 아래 표시되어 있습니다. 설정 시에는 꺼짐으로 간주됩니다.

•	AsgnL&R

•	USB Stereo: USB9&10 – USB29&30

•	USB mono: USB9 – USB30

•	AsgnL

•	AsgnR

Keyboard Select
건반 선택 설정을 켜짐 또는 꺼짐으로 설정합니다.

이 파라미터를 켜짐으로 설정하면 원하는 드럼 키를 선택할 수 있으므로 건반을 눌러 편집할 수 있습니다.

설정: Off, On
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Filter

드럼 파트의 필터를 설정합니다. 각 드럼 키에 로우 패스 필터 및 하이 패스 필터를 사용하여 음질을 변경할 수 있습니다.

작업

[PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Key 선택 → Filter 

Cutoff (LPF Cutoff Frequency)
로우 패스 필터의 차단 주파수를 설정합니다.

설정: 0–1023

Cutoff/Vel (LPF Cutoff Velocity Sensitivity)
세기 감도를 로우 패스 필터의 차단 주파수로 설정합니다.

이 파라미터가 양의 값으로 설정된 경우, 건반을 강하게(더욱 세게) 연주할수록 차단 주파수가 높아집니다.

이 파라미터가 음의 값으로 설정된 경우, 건반을 강하게 연주할수록 차단 주파수가 낮아집니다.

설정: −64–+0–+63

Resonance (LPF Resonance)
로우 패스 필터에 공명 이펙트 레벨을 설정합니다.

설정: 0–127

HPF Cutoff (HPF Cutoff Frequency)
하이 패스 필터의 차단 주파수를 설정합니다.

설정: 0–1023
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Level/Pan

각 드럼 키에 대한 레벨 및 팬(스테레오 필드에 위치)을 설정합니다.

작업

[PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Key 선택 → Level/Pan

Attack Time (AEG Attack Time)
건반을 누른 순간부터 Level (Drum Key Level)에 설정된 값에 이를 때까지 음량이 변하는 데 소요되는 시간을 설정합니다.

설정: 0–127

Decay 1 Time (AEG Decay 1 Time)
Level (Drum Key Level)에서 Decay 1 Level (AEG Decay 1 Level)로 음량이 변하는 데 소요되는 시간을 설정합니다.

설정: 0–127

Decay 2 Time (AEG Decay 2 Time)
Decay 1 Level (AEG Decay 1 Level)에 설정된 음향에 도달한 후 음량이 감쇄되는 데 소요되는 시간을 설정합니다.

설정: 0–126, Hold

Decay 1 Level (AEG Decay 1 Level)
Level (Drum Key Level)에서 변경할 다음 음량 값을 설정합니다.

설정: 0–127

Level (Drum Key Level)
드럼 키의 출력 레벨을 설정합니다. 이 파라미터를 사용하면 드럼 키 사이의 레벨 밸런스를 조정할 수 있습니다.

설정: 	 0–127

Decay2 Time = 0–126인 경우	 Decay2 Time = hold인 경우

Time

Level Drum Key Level

Attack
Time

Decay 1
Time

Decay 2
Time

Decay 1 Level

Key on

Time

Level Drum Key Level

Attack
Time

Decay 1
Time

Decay 2
Time

Decay 1 Level

Key on
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Level/Vel (Level Velocity Sensitivity)
레벨(음량)이 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

설정: 	 −64– +0–+63

양의 값: 세기가 빨라질수록 음량이 커집니다.

0: 세기 설정과는 상관없이 변하지 않습니다.

음의 값: 음의 값 세기가 느려질수록 음량이 커집니다.

Pan
퍼포먼스의 팬(음장에 위치)을 설정합니다. 드럼 파트에 맞게 스테레오 필드의 위치를 조정할 수 있습니다(드럼 키트).

설정: L63–C(중앙)–R63

Alternate Pan (Alternate Pan Depth)
누르는 각 건반의 음향이 어떻게 좌우 교대로 패닝되는지 설정합니다.

Pan에서 설정된 값은 팬의 좌우 이동에 대한 중앙 위치입니다.

설정: L63–C(중앙)–R63

Random Pan (Random Pan Depth)
누르는 각 건반의 음향이 어떻게 무작위로 좌우 패닝되는지 설정합니다.

Pan에서 설정된 값은 스테레오 필드의 중앙 위치입니다.

설정: 0–127
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Element EQ

Part Edit (AWM2) Element Edit 화면의 Element EQ와 동일합니다.
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Part Edit (FM-X) Part Common Edit 화면

일반 파트(FM-X)는 8개의 오퍼레이터로 구성되어 있습니다.

Part Edit (FM-X)는 전체 파트에 파라미터를 설정할 때 사용되는 Part Common Edit과 각 오퍼레이터에 대한 파라미터를 설정할 때 

사용되는 Operator Edit이 포함됩니다.

General/Pitch

Part Settings

Part Settings 화면에서 파트의 일반 파라미터(예: 파트 이름 및 톤 생성 시스템)를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → General/Pitch → Part Settings

여기에 표시된 화면은 Part Edit (AWM2) Part Common Edit 화면의 General/Pitch → Part Settings에서 연 화면과 동일하지만 

아래 표시된 파라미터가 추가되었습니다.

Random Pan (Random Pan Depth)
누르는 각 건반의 음향이 어떻게 무작위로 좌우 패닝되는지 설정합니다.

Pan에서 설정된 값은 스테레오 필드의 중앙 위치입니다.
설정: 0–127

Alternate Pan (Alternate Pan Depth)
누르는 각 건반의 음향이 어떻게 좌우 교대로 패닝되는지 설정합니다.

Pan에서 설정된 값은 팬의 좌우 이동에 대한 중앙 위치입니다.
설정: L63–C(중앙)–R63

Scaling Pan (Scaling Pan Depth)
누르는 건반의 위치가 팬 설정 위치에 어떻게 영향을 미치는지 설정합니다. 음 번호 C3은 패닝의 기준 지점이고, 이 때의 위치는 Pan에 

설정된 값입니다.

이 파라미터를 양의 값으로 설정하면 낮은 음의 경우 왼쪽에, 높은 음의 경우 오른쪽에 팬이 설정됩니다.

이 파라미터 값을 0으로 설정하면 팬 설정에 아무 변화가 없습니다. 이 파라미터를 음의 값으로 설정하면 낮은 음의 경우 왼쪽에, 높은 

음의 경우 오른쪽에 팬이 설정됩니다.
설정: −64–+0–+63
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KeyOnDly Sync (Key On Delay Tempo Sync)
템포에 맞춰지도록 Key On Delay의 타이밍을 설정합니다.

설정: Off, On

Delay Length (Key On Delay Time Length)
건반을 누른 후 음향이 생성될 때까지 딜레이 타임을 설정합니다.

KeyOnDly Sync를 켜짐으로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 0–127

Delay Length (Key On Delay Note Length)
KeyOnDly Sync (Key On Delay Tempo Sync)를 켜짐으로 설정한 경우 이 파라미터를 이용할 수 있습니다. 악보값을 사용하면 Key 

On Delay에 타이밍을 설정할 수 있습니다.

설정: 	� 1/16(16분 음표), 1/8 Tri. (8분 음표의 셋잇단음표), 1/16 Dot. (점16분 음표), 1/8(8분 음표), 1/4 Tri. (4분 음표의 셋잇단음표), 1/8 Dot. 

(점8분 음표), 1/4(8분 음표), 1/2 Tri. (2분 음표의 셋잇단음표), 1/4 Dot. (점4분 음표), 1/2(2분 음표), Whole Tri. (온음표의 셋잇단음표), 

1/2 Dot. (점2분 음표), 1/4 × 4(4분 음표의 넷잇단음표, 해당 박자에 맞춰 4개의 4분 음표 연주), 1/4 × 5(4분 음표의 다섯잇단음표, 

해당 박자에 맞춰 5개의 4분 음표 연주), 1/4 × 6(4분 음표의 여섯잇단음표, 해당 박자에 맞춰 6개의 4분 음표 연주), 1/4 × 7(4분 음표의 

일곱잇단음표, 해당 박자에 맞춰 7개의 4분 음표 연주), 1/4 × 8(4분 음표의 여덟잇단음표, 해당 박자에 맞춰 8개의 4분 음표 연주)
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Zone Settings

Part Edit (AWM2) Part Common Edit 화면의 General/Pitch → Zone Settings와 동일합니다.

FM-X Settings

FM-X Settings 화면에서 FM-X 음향과 알고리즘(또는 오퍼레이터가 배열되는 방식)에 편리한 편집 도구로 제공되는 FM Color 

파라미터를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → General/Pitch → FM-X Settings

FM Attack
시간 경과에 따라 주파수 모듈레이션의 깊이를 변경하는 EG의 어택 타임을 제어합니다.

설정: −99–+0–+99

FM Decay
시간 경과에 따라 주파수 모듈레이션의 깊이를 변경하는 EG의 감쇄 타임을 제어합니다.

설정: −99–+0–+99

FM Sustain
시간 경과에 따라 주파수 모듈레이션의 깊이를 변경하는 EG의 서스테인 레벨을 제어합니다.

설정: −99–+0–+99

FM Release
시간 경과에 따라 주파수 모듈레이션의 깊이를 변경하는 EG의 릴리스 타임을 제어합니다.

설정: −99–+0–+99

Algorithm (Algorithm Number)
알고리즘을 변경합니다.

설정: Data List 참조

Feedback (Feedback Level)
피드백은 일부 출력 신호를 다시 전송하여 오퍼레이터의 자체 모듈레이션을 유발합니다.

여기에서 이 파라미터를 사용하면 이러한 모듈레이션의 수준을 설정할 수 있습니다.

설정: 0–7
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FM Depth
주파수 모듈레이션의 깊이를 변경합니다.

설정: −99–+0–+99

FM Harmonics
FM 합성의 배음 주파수를 변경합니다.

설정: −99–+0–+99

FM Texture
FM 합성의 텍스처를 변경합니다.

설정: −99–+0–+99

Algorithm Search
Algorithm Search 화면을 엽니다.

•	 Chain

직렬로 연결된 오퍼레이터의 최대 길이를 기준으로 이용할 수 있는 알고리즘을 필터링합니다.

•	 Carrier

캐리어 수를 기준으로 이용할 수 있는 알고리즘을 필터링합니다.

Filter Offset Cutoff (Filter Cutoff Frequency)
필터의 차단 주파수를 설정하여 음향을 변경합니다. 로우 패스 필터를 선택한 경우 값이 커지면 음향이 밝아지고 값이 작아지면 음향이 

어두워집니다.

이 파라미터는 필터 차단 주파수의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

Filter Offset Resonance (Filter Offset Resonance/Width)
차단 주파수 근처의 신호 레벨을 조정하여 음향에 특별한 특성을 더합니다.

이 파라미터는 필터 공명의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

Filter Offset FEG Depth
FEG로 제어되는 차단 주파수 변화의 깊이 범위를 설정합니다.

설정: −64–+0–+63

Filter Type
Filter Type 화면이 열립니다.

Filter EG
Filter EG 화면이 열립니다.
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Pitch

Legato Slope (Portamento Legato Slope)가 비활성화되었다는 점을 제외하고는 Part Edit (AWM2) Part Common Edit 화면의 

General/Pitch → Pitch에서 연 화면과 동일합니다.

PEG/Scale

PEG/Scale 화면에서 파트에 피치 엔벌로프 제너레이터를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → General/Pitch → PEG/Scale

Attack Time (PEG Attack Time)
건반을 누른 순간부터 Attack Level (PEG Attack Level)에서 설정된 값에 이를 때까지 피치가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–99

Decay1 Time (PEG Decay 1 Time)
Attack Level (PEG Attack Level)에서 Decay1 Level (PEG Decay 1 Level)로 피치가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–99

Decay2 Time (PEG Decay 2 Time)
Decay1 Level (PEG Decay 1 Level)에서 Decay2 Level (PEG Decay 2 Level)로 피치가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–99

Release Time (PEG Release Time)
건반에서 손을 뗀 순간부터 Release Level (PEG Release Level)에 이를 때까지 피치가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–99

Center Key (Pitch Key Follow Sensitivity Center Key)
Pitch/Key (Pitch Key Follow Sensitivity)의 기준음을 설정합니다.

설정: C−2–G8
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Pitch/Key (Pitch Key Follow Sensitivity)
인접한 두 건반 사이의 피치 차이를 설정합니다. Center Key (Pitch Key Follow Sensitivity Center Key)에 설정된 음이 기준으로 

사용됩니다.

설정: 		  −200%–+0%–+200%

+100%(기본값): 서로 옆에 위치한 두 건반 사이의 피치 차이가 반음으로 설정됩니다.

0%: 두 건반 사이의 피치 차이가 없으며 모든 건반이 Center Key (Pitch Key Follow Sensitivity Center Key)로 설정된 피치로 

연주됩니다.

음의 값: 음이 낮아지면 피치가 높아지고 음이 높아지면 피치가 낮아지도록 반대 피치 응답을 설정합니다.

Initial Level (PEG Initial Level)
건반을 누를 때 피치를 설정합니다.

설정: −50–+0–+50

Attack Level (PEG Attack Level)
건반을 누른 후 Initial Level (PEG Initial Level)에서 변경할 피치를 설정합니다.

설정: −50–+0–+50

Decay1 Level (PEG Decay 1 Level)
Attack Level (PEG Attack Level)부터 변경할 다음 피치 값을 설정합니다.

설정: −50–+0–+50

Decay2 Level (PEG Decay 2 Level)
Decay1 Level (PEG Decay 1 Level)부터 변경할 다음 피치 값을 설정합니다.

설정: −50–+0–+50

Release Level (PEG Release Level)
건반에서 손을 뗀 후 도달할 최종 피치를 설정합니다.

설정: −50–+0–+50

PEG Depth
PEG로 제어되는 피치 변화의 양을 설정합니다.

설정: 8 oct, 2 oct, 1 oct, 0.5 oct

주
이 파라미터를 8 oct로 설정하면 −4 옥타브의 피치 변화를 생성할 수 있도록 내부 톤 제너레이터에 피치 값 0을 전송하여 피치 EG 레벨에 최소값을 

지정하거나 +4 옥타브의 피치 변화를 생성할 수 있도록 최대값을 지정할 수 있습니다.

Depth/Vel (PEG Depth Velocity Sensitivity)
PEG의 피치 변화가 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

설정: 0–7

Time/Key (PEG Time Key Follow Sensitivity)
PEG의 피치 변화 속도가 건반 위치에 어떻게 반응하는지 설정합니다.

Center Key (Pitch Key Follow Sensitivity Center Key): PEG의 속도 변화는 C3으로 고정된 지정 건반에 사용됩니다.

설정: 		  0–7

양의 값: 연주음이 낮을수록 PEG 변화가 느려지며 연주음이 높을수록 PEG 변화가 빨라집니다.

0: 건반 위치와는 상관없이 PEG가 변하지 않습니다

Random Pitch (Random Pitch Depth)
건반을 누를 때마다 무작위로 요소의 피치를 변경합니다.

설정: 0–127

Pitch/Vel (Pitch Velocity Sensitivity)
피치가 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

설정: 		  −64–+0–+63

	 양의 값: 세기가 빨라질수록 피치가 높아집니다.

	 0: 변함없이 유지됩니다.

	 음의 값: 세기가 빨라질수록 피치가 낮아집니다.
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Filter/Amp

Filter Type

Part Edit (AWM2) Element Edit 화면의 Filter → Type과 동일합니다.

Filter EG

Part Edit (AWM2) Element Edit 화면의 Filter → Filter EG와 동일합니다.

Filter Scale

Part Edit (AWM2) Element Edit 화면의 Filter → Scale과 동일합니다.

Amp EG

Part Edit (AWM2) Part Common Edit 화면의 Filter/Amp → Amp EG와 동일합니다.
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Effect

Routing

여기에 표시된 화면은 아래 표시된 사항을 제외하고는 Part Edit (AWM2) Part Common Edit 화면의 Effect → Routing에서 연 

화면과 거의 동일합니다.

•	 각 Element에 대한 출력 설정 없음

•	 Ins Connect에 대해서는 Parallel을 선택할 수 없음

Ins A, Ins B

Part Edit (AWM2) Part Common Edit 화면의 Effect → InsA 및 InsB와 동일합니다.

3-band EQ

Part Edit (AWM2) Part Common Edit 화면의 Effect → 3-band EQ와 동일합니다.

2-band EQ

Part Edit (AWM2) Part Common Edit 화면의 Effect → 2-band EQ와 동일합니다.

Ins Assign

Part Edit (AWM2) Part Common Edit 화면의 Effect → Ins Assign과 동일합니다.
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Arpeggio

Common

Part Edit (AWM2) Part Common Edit 화면의 Arpeggio → Common과 동일합니다.

Individual

Part Edit (AWM2) Part Common Edit 화면의 Arpeggio → Individual과 동일합니다.

Advanced

Part Edit (AWM2) Part Common Edit 화면의 Arpeggio → Advanced와 동일합니다.
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Motion Seq

Common

Part Edit (AWM2) Part Common Edit 화면의 Motion Seq → Common과 동일합니다.

Lane

Part Edit (AWM2) Part Common Edit 화면의 Motion Seq → Lane과 동일합니다.
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Mod/Control

Control Assign

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Mod/Control → Control Assign

Destination 설정을 제외하면 Part Edit (AWM2) Part Common Edit 화면의 Mod/Control → Control Assign과 동일합니다.

설정 목록은 Data List를 참조하십시오.

ElementSw 및 기타 파라미터 대신 아래 표시된 파라미터를 사용합니다.

Operator Sw 1–8 (Operator Switch)
각 오퍼레이터에 대한 컨트롤러 설정을 켜짐 또는 꺼짐으로 설정할 수 있습니다. 선택한 Destination이 오퍼레이터와 관련된 경우에만 

이 파라미터가 표시됩니다.

설정: Off, On

Sw/Rate
Operator Sw 보기와 Operator Rate 보기를 서로 전환합니다.

Destination을 OP Freq 또는 OP AEG Offset으로 설정한 경우에만 이 파라미터가 표시됩니다.

설정: Off, On

Operator Rate 1–8
Destination에 대해 선택한 컨트롤러의 감도를 설정합니다.

Destination을 OP Freq 또는 OP AEG Offset으로 설정한 경우에만 이 파라미터가 표시됩니다.

설정: −7–+0–+7
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After Touch

Destination 설정을 제외하면 Part Edit (AWM2) Part Common Edit 화면의 Mod/Control → After Touch와 동일합니다.

Tx/Rx Switch

Part Edit (AWM2) Part Common Edit 화면의 Mod/Control → Tx/Rx Switch와 동일합니다.

Control Settings

Part Edit (AWM2) Part Common Edit 화면의 Mod/Control → Control Settings와 동일합니다.

Part LFO

Part LFO 화면에서 파트 LFO를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Mod/Control → Part LFO

LFO Wave
LFO Wave를 선택하고 LFO에 주기적인 변화 유형을 설정합니다.

설정: Triangle, Triangle+, Saw Up, Saw Down, Squ1/4, Squ1/3, Square, Squ2/3, Squ3/4, Trapezoid, S/H1, S/H2, User

Edit User LFO
User LFO Edit 화면이 열립니다.

최대 16단계로 구성된 LFO 파형을 생성할 수 있습니다.
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Tempo Sync (LFO Tempo Sync)
LFO Wave의 변화 속도를 설정하여 아르페지오 또는 곡 재생에 맞춥니다.
설정: Off(동기화되지 않음), On(동기화됨)

•	 Off로 설정한 경우

Speed (LFO Speed)
LFO Wave의 변화 속도를 설정합니다.

Tempo Sync (LFO Tempo Sync)를 켜짐으로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.
설정: 0–63

Random Speed (Part LFO Random Speed Depth)
LFO Speed를 무작위로 변경합니다.

Tempo Sync (LFO Tempo Sync)를 켜짐으로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.
설정: 0–127

•	 On으로 설정한 경우

Tempo Speed (LFO Tempo Speed)
악보값을 사용하여 LFO Wave 변화 속도를 설정합니다.
설정: 	 �1/16(16분 음표), 1/8 Tri. (8분 음표의 셋잇단음표), 1/16 Dot. (점16분 음표), 1/8(8분 음표), 1/4 Tri. (4분 음표의 셋잇단음표), 1/8 Dot. 

(점8분 음표), 1/4(8분 음표), 1/2 Tri. (2분 음표의 셋잇단음표), 1/4 Dot. (점4분 음표), 1/2(2분 음표), Whole Tri. (온음표의 셋잇단음표), 

1/2 Dot. (점2분 음표), 1/4 × 4(4분 음표의 넷잇단음표, 해당 박자에 맞춰 4개의 4분 음표 연주), 1/4 × 5(4분 음표의 다섯잇단음표, 

해당 박자에 맞춰 5개의 4분 음표 연주), 1/4 × 6(4분 음표의 여섯잇단음표, 해당 박자에 맞춰 6개의 4분 음표 연주), 1/4 × 7(4분 음표의 

일곱잇단음표, 해당 박자에 맞춰 7개의 4분 음표 연주), 1/4 × 8(4분 음표의 여덟잇단음표, 해당 박자에 맞춰 8개의 4분 음표 연주), 1/4 × 

16(해당 박자에 맞춰 16개의 4분 음표 연주), 1/4 × 32(해당 박자에 맞춰 32개의 4분 음표 연주), 1/4 × 64(해당 박자에 맞춰 64개의 4분 

음표 연주)

Delay (LFO Delay Time)
건반을 누르는 순간부터 LFO가 적용될 때까지 딜레이 타임을 설정합니다.

값이 커질수록 LFO가 적용될 때까지 소요되는 딜레이가 길어집니다.
설정: 0–127

Fade In (LFO Fade In Time)
건반에서 손을 떼고 Delay (LFO Delay Time)에서 설정된 딜레이 타임이 경과된 후 LFO 이펙트가 페이드 인될 때까지 소요되는 시간을 

설정합니다. 값이 커질수록 이펙트가 최대 레벨에 이를 때까지 소요되는 시간이 길어집니다.
설정: 0–127

0: LFO가 페이드 인 없이 최대값으로 변경됩니다.

값이 작을 경우

Fade In
Maximum

Delay

Key On

Time

값이 클 경우

Fade In
Maximum

Delay

Key On

Time
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Hold (LFO Hold Time)
최대 레벨에 도달한 후 LFO 이펙트를 유지하기 위한 시간을 설정합니다.

설정: 	 0–126, Hold

Hold: 페이드 아웃하지 않음

Hold
Maximum

Key On

Time

Fade Out (LFO Fade Out time)
Hold (LFO Hold Time)에 설정된 홀드 타임이 경과한 후 LFO 이펙트가 페이드 아웃하는 데 소요되는 시간을 설정합니다. 값이 

커질수록 LFO 이펙트가 페이드 아웃할 때까지 소요되는 시간이 길어집니다.

설정: 	 0–127

값이 작을 경우

Fade-Out
Maximum

Hold

Key On

Time

값이 클 경우

Fade-Out
Maximum

Hold

Key On

Time
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Key On Reset (LFO Key On Reset)
건반을 누를 때 LFO의 진동을 재설정합니다.
설정: 	 Off, Each-on, 1st-on

Off로 설정한 경우
LFO의 진동을 재설정하지 않습니다. 해당 시점에서 LFO가 어떤 상태에 있든지 건반을 누르면 LFO 음파가 시작됩니다.

Key On

Time

Each-on으로 설정한 경우
건반을 누를 때마다 LFO 진동을 재설정하고 위상 파라미터로 지정된 위상에서 파형을 시작합니다.

Key On
(first note)

Key On
(second note)

Time

1st-on으로 설정한 경우
건반을 누를 때마다 LFO 진동을 재설정하고 위상 파라미터로 지정된 위상에서 파형을 시작합니다.
첫 번째 음을 유지하면서 두 번째 음을 연주하면 재생이 재설정되지 않습니다.

Key On
(first note)

Key On
(second note)

Time

Loop (LFO Loop Switch)
순환(반복) 재생 또는 단일 재생으로 LFO Wave를 설정합니다.
설정: Off, On

Phase (LFO Phase)
LFO Wave가 재설정되는 시간에 대한 초기 위상을 설정할 수 있습니다.
설정: 0°, 90°, 120°, 180°, 240°, 270°

Phase

Time

Level

0° 90°
120° 240°

180° 270°

Destination (LFO Destination)
LFO Wave로 제어되도록 기능을 설정합니다.
설정: Insertion Effect A Parameter1–24, Insertion Effect B Parameter1–24(인서트 이펙트에 따름)

Depth (LFO Depth)
각 Destination에 대한 LFO Wave 의 컨트롤의 깊이를 설정합니다.
설정: 0–127
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2nd LFO

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Mod/Control → 2nd LFO

LFO Wave (2nd LFO Wave)
2nd LFO를 선택합니다.

설정: Triangle, Saw Down, Saw Up, Square, Sine, S/H

주
Amplitude Modulation 위상은 Sine과 함께 이동합니다.

Extended LFO (2nd LFO Extended LFO)
속도(LFO 속도)의 기존 Speed (2nd LFO Speed) 설정 세트(Off: 0–99)와 높은 해상도의 신규 설정 세트(On: 0–415)를 서로 

전환합니다.

기존 설정으로 생성한 데이터의 호환성을 유지하려면 이 파라미터를 꺼짐으로 설정합니다.

설정: Off, On

Speed (2nd LFO Speed)
LFO Wave (2nd LFO Wave)의 변화 속도를 설정합니다.

설정: 0–99(Extended LFO를 Off로 설정한 경우), 0–415(Extended LFO를 On으로 설정한 경우)

Phase (2nd LFO Phase)
LFO Wave (2nd LFO Wave)가 재설정되는 시간에 대한 초기 위상을 설정할 수 있습니다.

설정: 0°, 90°, 180°, 270°

Delay (2nd LFO Delay Time)
건반에서 손을 떼고 Delay에서 설정된 딜레이 타임이 경과된 후 2nd LFO 이펙트가 페이드 인될 때까지 소요되는 시간을 설정합니다.

설정: 0–99

Key On Reset (2nd LFO Key On Reset)
건반을 누를 때 2nd LFO의 진동을 재설정합니다.

설정: Off, On
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Pitch Modulation Depth (2nd LFO Pitch Modulation Depth)
이 파라미터는 LFO Wave (2nd LFO Wave)를 사용하여 비브라토 이펙트(주기적인 피치 변화)를 생성하며, LFO에 따라 피치 

모듈레이션의 깊이를 지정할 수 있습니다.

설정: 0–99

Pitch Modulation Operator Depth Ratio 1~8 (2nd LFO Pitch Modulation Depth Offset)
Pitch Modulation Depth (2nd LFO Pitch Modulation Depth)에서 설정된 LFO 신호에 따라 모듈레이션 깊이를 설정합니다.

설정: 0–7

Amplitude Modulation Depth (2nd LFO Amplitude Modulation Depth)
이 파라미터는 LFO Wave (2nd LFO Wave)를 사용하여 음량의 주기적인 변화를 생성하며, LFO에 따라 음량 모듈레이션의 깊이를 

지정할 수 있습니다.

설정: 0–99

Amplitude Modulation Operator Depth Ratio 1~8 (2nd LFO Amplitude Modulation Depth Offset)
Amplitude Modulation Depth (2nd LFO Amplitude Modulation Depth)에서 설정된 LFO 신호에 따라 모듈레이션 깊이를 

설정합니다.

설정: 0–7

Filter Modulation Depth (2nd LFO Filter Modulation Depth)
이 파라미터는 LFO Wave (2nd LFO Wave)를 사용하여 주기적으로 필터 차단 주파수를 변화시키며, LFO에 따라 필터 모듈레이션의 

깊이를 지정할 수 있습니다.

설정: 0–99
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Part Edit (FM-X) Operator Edit 화면

일반 파트(FM-X)는 8개의 오퍼레이터로 구성되어 있습니다.

Part Edit (FM-X)는 전체 파트에 파라미터를 설정할 때 사용되는 Part Common Edit과 각 오퍼레이터에 대한 파라미터를 설정할 때 

사용되는 Operator Edit이 포함됩니다.

Form/Freq

Form/Freq 화면에서 오퍼레이터의 파형 및 주파수를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Operator 선택 → Form/Freq

Attack Time (PEG Attack Time)
건반을 누른 순간부터 Attack Level (PEG Attack Level)에서 설정된 값에 이를 때까지 피치가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–99

Decay Time (PEG Decay Time)
Attack Level (PEG Attack Level)에서 설정된 값부터 PEG 값이 0으로 바뀔 때까지 피치가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–99

Initial Level (PEG Initial Level)
건반을 누를 때 피치를 설정합니다.

설정: −50–+0–+50



304MODX M 사용설명서

Attack Level (PEG Attack Level)
건반을 누른 후 Initial Level (PEG Initial Level)에서 변경할 피치를 설정합니다.

설정: −50–+0–+50

Time

Level
+50

−50

Attack
Time

Decay
Time

Attack Level

Initial Level

Spectral (Spectral Form)
선택한 오퍼레이터의 파형을 설정합니다.

설정: 	 Sine, All 1, All 2, Odd 1, Odd 2, Res 1, Res 2

Sine: 배음이 존재하지 않는 사인파

All 1: 광범위한 Spectral 범위에 배음이 존재하는 음파

All 2: 협소한 Spectral 범위에 배음이 존재하는 음파

Odd 1: 광범위한 Spectral 범위에 홀수 하모닉이 포함된 음파

Odd 2: 협소한 Spectral 범위에 홀수 하모닉이 포함된 음파

Res 1: 광범위한 Spectral 범위에 특정 하모닉의 피크가 존재하는 음파

Res 2: 협소한 Spectral 범위에 특정 하모닉의 피크가 존재하는 음파

Skirt (Spectral Skirt)
전환 대역(스커트)의 폭을 설정합니다. 값이 작아지면 특정 하모닉이 증폭시킬 수 있는 스커트 범위가 협소해집니다.

Spectral (Spectral Form)을 Sine으로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.

설정: 0–7



305MODX M 사용설명서

Resonance (Spectral Resonance)
Spectral에 공명 이펙트의 감도를 설정합니다.

중심 주파수가 고차 하모닉으로 이동하므로 공명 이펙트를 생성하거나 음향에 특별한 특성을 더할 수 있습니다.

Spectral (Spectral Form)을 Res 1 또는 Res 2로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 0–99

Sine은 하모닉이 존재하지 않는 기본 음파만 포함된 간단한 파형이며, 배음이 포함되어 있는 파형도 있습니다. 그러므로, Sine 이외의 

다른 음파로 Form을 설정하면 하모닉 및 “피크”값(포먼트) 관련 파라미터를 이용할 수 있습니다.

Spectral에 설명된 각 음파를 제어할 때 사용되는 일부 특정 파라미터가 아래 소개되어 있습니다.

Level

Level

Level

Level

Skirt Skirt

Skirt Skirt

Center Frequency
(F.Coarse & Freq Fine)

Center Frequency
(F.Coarse & Freq Fine)

Center Frequency
(F.Coarse & Freq Fine)

Center Frequency
(F.Coarse & Freq Fine)

Frequency
(Hz)

Frequency
(Hz)

Frequency
(Hz)

Frequency
(Hz)

큰 Skirt 값을 설정하여 스펙트럼 범위를 확장하면 배음 수를 늘릴 수 있습니다.

Level Level

Skirt

Resonance of
Center Frequency

Resonance of
Center Frequency

Skirt

Center Frequency
(F.Coarse & Freq Fine)

Center Frequency
(F.Coarse & Freq Fine)

Frequency (Hz) Frequency (Hz)

큰 Resonance 값을 설정하면 중심 주파수가 고차 하모닉으로 이동합니다.
Resonance를 0으로 설정한 경우: 첫 번째 하모닉으로 이동합니다.
Resonance를 99로 설정한 경우: 100번째 하모닉으로 이동합니다.
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Key On Reset (Oscillator Key On Reset)
건반을 누를 때 오실레이터의 진동을 재설정합니다.

설정: 	 Off, On

Off: 오실레이터의 진동을 재설정하지 않고 건반을 연주하면 그 순간의 위상과는 상관없이 신호 파형이 시작됩니다.

Pitch/Vel (Pitch Velocity Sensitivity)
피치가 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

Freq Mode (Oscillator Frequency Mode)를 Fixed로 설정한 경우에만 이 파라미터를 이용할 수 있습니다.

설정: 	 −7–+0–+7

양의 값: 세기가 빨라질수록 피치가 높아집니다.

0: 변함없이 유지됩니다.

음의 값: 세기가 빨라질수록 피치가 낮아집니다.

Freq Mode (Oscillator Frequency Mode)
오퍼레이터의 출력 피치를 설정합니다.

설정: 	 Ratio, Fixed

Ratio: 건반에 따라 출력 피치를 설정합니다.

Fixed: 누른 건반의 피치와는 상관없이 Coarse 또는 Fine 설정에 피치를 설정합니다.

Coarse (Coarse Tune)
각 오퍼레이터의 출력 피치를 조정합니다.

설정: Freq Mode를 Ratio로 설정한 경우: 0–31, Freq Mode를 Fixed로 설정한 경우: 0–21

Fine (Fine Tune)
각 오퍼레이터의 출력 피치를 미세하게 조정합니다.

설정: Freq Mode를 Ratio로 설정한 경우: 0–99, Freq Mode를 Fixed로 설정한 경우: 0–127

Detune
각 오퍼레이터의 출력 피치를 약간 높거나 낮게 설정합니다.

동일한 값을 Coarse (Coarse Tune) 또는 Fine (Fine Tune)으로 설정한 경우 Detune이 설정된 오퍼레이터에는 경미한 피치 차이가 

존재합니다. 따라서, 더욱 따뜻한 느낌의 음향이나 코러싱 이펙트를 생성할 수 있습니다.

설정: −15–+0–+15

Pitch/Key (Pitch Key Follow Sensitivity)
인접한 두 건반 사이의 피치 차이를 설정합니다. Freq Mode (Oscillator Frequency Mode)를 Fixed로 설정한 경우에만 이 

파라미터를 이용할 수 있습니다.

설정: 	 0–99

0: 인접한 두 건반 사이의 피치 차이가 없으며 모든 건반이 Coarse 또는 Fine에서 설정된 피치로 연주됩니다.

99: 인접한 두 건반 사이의 피치 차이가 반음으로 설정됩니다.
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Level

Level 화면에서 오퍼레이터의 일반 파라미터를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Operator 선택 → Level

Hold Time (AEG Hold Time)
건반을 누른 순간부터 Rel (Hold) Level (AEG Release (Hold) Level)에 이를 때까지 값이 변하는 데 소요되는 시간을 설정합니다.

설정: 0–99

Attack Time (AEG Attack Time)
건반을 누른 순간부터 Attack Level (AEG Attack Level)에 이를 때까지 값이 변하는 데 소요되는 시간을 설정합니다.

설정: 0–99

Decay 1 Time (AEG Decay 1 Time)
Attack Level (AEG Attack Level)에서 Decay 1 Level (AEG Decay 1 Level)로 값이 변하는 데 소요되는 시간을 설정합니다.

설정: 0–99

Decay 2 Time (AEG Decay 2 Time)
Decay 1 Level (AEG Decay 1 Level)에서 Decay 2 Level (AEG Decay 2 Level)로 값이 변하는 데 소요되는 시간을 설정합니다.

설정: 0–99

Release Time (AEG Release Time)
건반에서 손을 뗀 순간부터 Rel (Hold) Level (AEG Release (Hold) Level)에 이를 때까지 값이 변하는 데 소요되는 시간을 

설정합니다.

설정: 0–99

Attack Level (AEG Attack Level)
건반을 누른 후 변경할 값을 설정합니다.

설정: 0–99
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Decay 1 Level (AEG Decay 1 Level)
Attack Level (AEG Attack Level)부터 변경할 다음 값을 설정합니다.

설정: 0–99

Decay 2 Level (AEG Decay 2 Level)
건반을 누르고 있는 동안 유지되는 값을 설정합니다.

설정: 0–99

Rel (Hold) Level (AEG Release (Hold) Level)
건반에서 손을 뗀 후 도달할 최종 값을 설정합니다.

설정: 0–99

Level

Hold
Time

Attack
Time

Decay 1
Time

Decay 2
Time

Release
Time

Time

Rel (Hold)
Level

Rel (Hold)
Level

Decay 1 Level

Decay 2 Level

Key On Key Off

Attack Level

Level (Operator Level)
오퍼레이터의 출력 레벨을 설정합니다.

설정: 0–99

Level/Vel (Level Velocity Sensitivity)
레벨이 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

설정: 	 −7–+0–+7

양의 값: 세기가 빨라질수록 음량이 커집니다.

0: 세기 설정과는 상관없이 변하지 않습니다.

음의 값: 음의 값 세기가 느려질수록 음량이 커집니다.

Time/Key (AEG Time Key Follow Sensitivity)
AEG의 레벨 변화 속도가 건반 위치에 어떻게 반응하는지 설정합니다.

설정: 	 0–7

양의 값: 연주음이 낮을수록 AEG 음량 변화가 느려지며 연주음이 높을수록 AEG 음량 변화가 빨라집니다.

0: 건반 위치와는 상관없이 AEG 음량이 변하지 않습니다.

Break Point (Level Scaling Break Point)
진폭 스케일링의 Break Point에 대한 음 번호를 설정합니다.

설정: A−1–C8

Lvl/Key Lo (Level Scaling Low Depth)
Lvl/Key Hi (Level Scaling High Depth)
변화 곡선의 첨도를 설정합니다.

설정: 0–99



309MODX M 사용설명서

Curve Lo (Level Scaling Low Curve)
Curve Hi (Level Scaling High Curve)
진폭 스케일링의 변화 곡선을 설정합니다.

설정: −Linear, −Exp, +Exp, +Linear

Break Point에서 건반이 두 부분으로 나뉩니다. 좌측에 위치한 곡선 첨도에 Curve Lo, 우측에 위치한 곡선 첨도에 Lvl/Key Lo를 

설정합니다. 마찬가지로 Curve Hi를 설정하여 우측에 곡선을 선택하고, 곡선 첨도에 Lvl/Key Hi를 설정합니다

Low Depth

Break Point Output Level

Low Curve High Curve

Key
High Depth

Output Level

−

+

+exp +exp+linear +linear

−exp −exp−linear −linear

Break Point의 건반은 Level (Operator Level)에서 설정된 출력 레벨과 동일합니다.

Break Point 좌측에 건반이 위치한 경우 출력 레벨은 Curve Lo 및 Lvl/Key Lo에서 설정된 곡선에 맞게 교정됩니다. 우측에 건반이 

위치한 경우에는 출력 레벨이 Curve Hi 및 Lvl/Key Hi에서 설정된 곡선에 맞게 교정됩니다.

Exp 곡선의 출력 레벨은 지수적(기하급수적)으로 변하지만 Linear 곡선의 출력 레벨은 선형적으로 변합니다. 어떤 경우이든,  

Break Point에서 멀어질수록 출력 레벨 변화가 심해집니다.
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Part Edit (AN-X) Part Common Edit 화면

일반 파트(AN-X)는 3개의 오실레이터와 노이즈로 구성되어 있습니다.

Part Edit (AN-X)에는 전체 파트에 파라미터를 설정할 때 사용되는 Part Common Edit, 각 오실레이터에 파라미터를 설정할 때 

사용되는 Oscillator Edit 및 노이즈를 편집할 때 사용되는 Noise Edit이 포함됩니다.

General/Pitch

Part Settings

Part Edit (AWM2) Part Common Edit 화면의 General/Pitch → Part Settings와 동일합니다.

Zone Settings

Part Edit (AWM2) Part Common Edit 화면의 General/Pitch → Zone Settings와 동일합니다.

AN-X Settings

AN-X Settings 화면에서 AN-X 사운드 엔진에 고유한 파라미터를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → General/Pitch → AN-X Settings

Unison
다수의 음향을 레이어링 처리하여 두께를 생성합니다.

설정: Off, 2, 4

Unison Detune
레이어 처리된 음향의 피치가 어떻게 변하는지 설정합니다.

설정: 0–15

Unison Spread
레이어 처리된 음향이 스테레오 필드에서 어떻게 확산되는지 설정합니다.

설정: 0–15
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OSC Reset
오실레이터 재설정 방법을 지정합니다.

설정: 	 Off, Phase, Tune, Full

Off: 재설정하지 않습니다.

Phase: 누를 때 OSC 1~3의 위상을 재설정합니다.

Tune: OSC 1~3의 위상을 균일하게 만듭니다.

Full: Phase와 Tune을 동시에 활성화합니다.

Amplitude

Osc 1

Osc 2

Osc 3

Key On

OSC Reset = Off or Tune

OSC Reset = Off or Phase

Amplitude

Osc 1

Osc 2

Osc 3

Key On

OSC Reset = Phase or Full

OSC Reset = Tune or Full

Osc 1

Osc 3

Osc 2

Pitch

t

Osc 1, 2, 3
Pitch

t

Voltage Drift
오실레이터의 피치와 Filter Cutoff의 변형을 지정합니다. 이 변형은 Ageing의 영향도 받습니다.

설정: 	 0–127

0: 변형 없음

64: 표준

127: 최대 변형

Ageing
악기 모델의 가상 연령에 따라 주파수 응답과 OSC Pitch, Filter Cutoff 및 EG Time을 조정합니다.

설정: −100(기존)–+100(신규)

	� Voltage Drift 및 Ageing

(1)

210 43 64 85 107 128
Voltage Drift

Ageing = −100 (Retro)

Ageing = 0 (Default)

Ageing = 100 (Modern)

(1) Cutoff 또는 Pitch의 변형



312MODX M 사용설명서

Filter Offset Cutoff (Filter Cutoff Frequency)
필터의 차단 주파수를 설정하여 음향을 변경합니다. 로우 패스 필터를 선택한 경우 값이 커지면 음향이 밝아지고 값이 작아지면 음향이 

어두워집니다.

이 파라미터는 필터 차단 주파수의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

Filter Offset Resonance (Filter Offset Resonance/Width)
차단 주파수 근처의 신호 레벨을 조정하여 음향에 특별한 특성을 더합니다.

이 파라미터는 필터 공명의 오프셋 값으로 지정됩니다.

설정: −64–+0–+63

Filter Offset FEG Depth
FEG로 제어되는 차단 주파수 변화의 깊이 범위를 설정합니다.

설정: −64–+0–+63

Filter Type
Filter Type 화면이 열립니다.

Filter EG
Filter EG 화면이 열립니다.

AEG Offset Attack (AEG Attack Time)
건반을 누른 순간부터 최대값에 이를 때까지 음량이 변하는 데 소요되는 시간을 설정합니다.

Attack (Amplitude EG Attack Time)에 오프셋 값을 설정합니다.

설정: −64–+0–+63

AEG Offset Decay (AEG Decay Time)
최대값에 이른 후 음량이 변할 때까지 소요되는 시간을 설정합니다.

Decay (Amplitude EG Decay Time)에 오프셋 값을 설정합니다.

설정: −64–+0–+63

AEG Offset Sustain (AEG Sustain Level)
감쇄 타임 후 유지되는 음량을 설정합니다.

Sustain (Amplitude EG Sustain Level)에 오프셋 값을 설정합니다.

설정: −64–+0–+63

AEG Offset Release (AEG Release Time)
건반에서 손을 뗀 후 음향이 감쇄될 때까지 소요되는 시간을 설정합니다.

Release (Amplitude EG Release Time)에 오프셋 값을 설정합니다.

설정: −64–+0–+63

Amp EG
Amp EG 화면이 열립니다.
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Pitch

Legato Slope(Portamento Legato Slope)가 비활성화되었다는 점을 제외하고는 Part Edit (AWM2) Part Common Edit 화면의 

General/Pitch → Pitch에서 연 화면과 동일합니다.

Pitch EG

Pitch EG 화면에서 필터 엔벌로프 제너레이터를 설정할 수 있습니다.

이 파라미터를 사용해 건반을 누른 순간부터 음향이 감쇄될 때까지 시간 경과에 따라 음향이 어떻게 변하는지 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → General/Pitch → Pitch EG

Attack (Pitch EG Attack Time)
건반을 누른 순간부터 최대값에 이를 때까지 EG가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–255

Decay (Pitch EG Decay Time)
최대값에서 Sustain (Pitch EG Sustain Level) 값에 이를 때까지 EG가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–255

Sustain (Pitch EG Sustain Level)
서스테인 레벨을 설정합니다.

설정: 0–511

Release (Pitch EG Release Time)
건반에서 손을 뗀 후 EG 값이 0에 이를 때까지 소요되는 시간을 설정합니다.

설정: 0–255

Time/Vel (Pitch EG Time Velocity Sensitivity)
시간 경과에 따라 세기가 어떻게 EG를 변화시키는지 설정합니다.

값이 커질수록 빠른 세기로 건반을 연주할 때 시간 경과에 따라 EG 변화 속도가 빨라집니다.

설정: −255–+0–+255
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PEG Depth - Osc 1–3 (Oscillator 1–3 Pitch EG Depth)
EG의 최대 피치 변화량(단위: cent)을 설정합니다. 깊이 값이 0에서 멀어지면 피치 변화가 넓어집니다.

설정: 	 −4800 cent – +0 – +4800 cent

0: 변함없이 유지됩니다.

음의 값: 피치 변화가 반대가 됩니다.

PEG Depth/Vel - Osc 1–3 (Oscillator 1–3 Pitch EG Depth Velocity Sensitivity)
PEG로 제어되는 피치 변화의 깊이 범위가 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

설정: 	 −255–+0–+255

양의 값: 세기 값이 빠를수록 차단 주파수의 깊이 범위가 넓어지고 값이 느릴수록 차단 주파수의 깊이 범위가 좁아집니다.

0: 세기 설정과는 상관없이 PEG가 변하지 않습니다.

음의 값: 세기 값이 빠를수록 차단 주파수의 깊이 범위가 좁아지고 값이 느릴수록 차단 주파수의 깊이 범위가 넓어집니다.

값이 양수일 경우

빠른 세기(피치 변화의 깊이 범위가 넓어짐)	 느린 세기(피치 변화의 깊이 범위가 좁아짐)

Time

(1)

Time

(1)

(1) Pitch Depth
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Pitch LFO

Pitch LFO 화면에서 피치 LFO를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → General/Pitch → Pitch LFO

Wave (Pitch LFO Wave)
LFO Wave를 선택하고 LFO에 주기적인 변화 유형을 설정합니다.

설정: Saw, Square, Triangle, Sine, Random

Key On Reset (Pitch LFO Key On Reset)
건반을 누를 때 LFO의 위상을 재설정합니다.

설정: Off, On

Time

Key on

Time

Key on

OnOff

Speed (Pitch LFO Speed)
LFO 음파 변화 속도를 설정합니다.

설정: 0–415

Delay (Pitch LFO Decay Time)
건반을 누르는 순간부터 LFO가 적용될 때까지 딜레이 타임을 설정합니다.

설정: 0–127
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Fade In (Pitch LFO Fade In Time)
건반에서 손을 떼고 Delay에서 설정된 딜레이 타임이 경과된 후 LFO 이펙트가 페이드 인될 때까지 소요되는 시간을 설정합니다. 값이 

커질수록 이펙트가 최대 레벨에 이를 때까지 소요되는 시간이 길어집니다.

설정: 	 0–214

0: LFO가 페이드 인 없이 최대값으로 변경됩니다.

값이 작을 경우

Fade In
Maximum

Delay

Key On

Time

값이 클 경우

Fade In
Maximum

Delay

Key On

Time

Phase (Pitch LFO Phase)
건반을 누를 때 음파 재설정에 사용되는 위상을 설정합니다.

설정: 	 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330(°)

음파의 위상

Phase

Time

Level

0° 90°
120° 240°

180° 270°

Pitch LFO Depth - Osc 1–3 (Oscillator 1–3 Pitch LFO Depth)
LFO로 제어되는 피치 변화의 깊이 범위를 설정합니다. 깊이 값이 0에서 멀어지면 피치 변화가 넓어집니다.

설정: 	 −4800 cent – +0 – +4800 cent

0: 변함없이 유지됩니다.

음의 값: 피치 변화가 반대가 됩니다.
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Modifier

Modifier는 OSC 블록에서 신호 출력에 디스토션을 추가하거나 음향에 하모닉스를 추가할 때 사용되는 기능 블록입니다.

Amp Effects

Motion Sequencer
Envelope Follower

Pitch EG
Pitch LFO

OSC EG
OSC LFO

Modifier EG
Modifier LFO

Filter EG
Filter LFO

Amp EG
Amp LFO Part LFO

Oscillators Modifier Filters
Output

Wave Folder

Wave Folder 규정값에 따라 파형 폴딩을 실시하여 생성되는 이펙트입니다. 이 이펙트를 사용하면 섬세한 디스토션부터 음향 파괴까지 
매끄러운 변화를 창출할 수 있습니다. AN-X 사운드 엔진을 사용하면 각 음에 개별적으로 이 이펙트를 사용할 수 있습니다.
EG, LFO, 세기 및 다성 음색 애프터터치를 포함한 다양한 컨트롤러를 이용할 수 있어 실시간으로 이 이펙트를 제어할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Modifier → Wave Folder
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Wave Folder (Modifier Wave Folder)
파형 폴딩 정도를 지정합니다.

설정: 0–255

Folder/Vel (Modifier Wave Folder Velocity Sensitivity)
Wave Folder가 세기에 어떻게 반응하는지 설정합니다.

설정: −255–+0–+255

Texture (Modifier Wave Folder Texture)
Wave Folder의 텍스처를 변화시킵니다.

설정: 0–255

Folder Type (Modifier Wave Folder Type)
Wave Folder 형식을 변화시킵니다.

설정: Soft, Hard

Modifier EG Settings
Modifier EG 화면이 열립니다.

Modifier LFO Settings
Modifier LFO 화면이 열립니다.
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Modifier EG

Modifier EG 화면에서 Modifier의 엔벌로프 제너레이터를 설정할 수 있습니다..

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Modifier → Modifier EG

Attack (Modifier EG Attack Time)
건반을 누른 순간부터 최대값에 이를 때까지 EG가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–255

Decay (Modifier EG Decay Time)
최대값에서 Sustain (Modifier EG Sustain Level) 값에 이를 때까지 EG가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–255

Sustain (Modifier EG Sustain Level)
서스테인 레벨을 설정합니다.

설정: 0–511

Release (Modifier EG Release Time)
건반에서 손을 뗀 후 EG 값이 0에 이를 때까지 소요되는 시간을 설정합니다.

설정: 0–255

Time/Vel (Modifier EG Velocity Sensitivity)
시간 경과에 따라 세기가 어떻게 EG를 변화시키는지 설정합니다.

값이 커질수록 빠른 세기로 건반을 연주할 때 시간 경과에 따라 EG 변화 속도가 빨라집니다.

설정: −255–+0–+255

EG Depth (Modifier Wave Folder EG Depth)
Wave Folder가 Modifier EG에 어떻게 반응하는지 설정합니다.

설정: −127–+0–+127
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Modifier LFO

Modifier LFO 화면에서 Modifier LFO를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Modifier → Modifier LFO

Wave (Modifier LFO Wave)
LFO Wave를 선택하고 LFO에 주기적인 변화 유형을 설정합니다.

설정: Saw, Square, Triangle, Sine, Random

Key On Reset (Modifier LFO Key On Reset)
건반을 누를 때 LFO의 위상을 재설정합니다.

설정: Off, On

Time

Key on

Time

Key on

OnOff

Speed (Modifier LFO Speed)
LFO 음파 변화 속도를 설정합니다.

설정: 0–415

Delay (Modifier LFO Decay Time)
건반을 누르는 순간부터 LFO가 적용될 때까지 딜레이 타임을 설정합니다.

설정: 0–127
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Fade In (Modifier LFO Fade In Time)
건반에서 손을 떼고 Delay에서 설정된 딜레이 타임이 경과된 후 LFO 이펙트가 페이드 인될 때까지 소요되는 시간을 설정합니다. 값이 

커질수록 이펙트가 최대 레벨에 이를 때까지 소요되는 시간이 길어집니다.

설정: 	 0–214

0: LFO가 페이드 인 없이 최대값으로 변경됩니다.

값이 작을 경우

Fade In
Maximum

Delay

Key On

Time

값이 클 경우

Fade In
Maximum

Delay

Key On

Time

Phase (Modifier LFO Phase)
건반을 누를 때 음파 재설정에 사용되는 위상을 설정합니다.

설정: 	 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330(°)

음파의 위상

Phase

Time

Level

0° 90°
120° 240°

180° 270°

LFO Depth (Modifier Wave Folder LFO Depth) 
Wave Folder가 Modifier LFO에 어떻게 반응하는지 설정합니다. 깊이 값이 0에서 멀어지면 피치 변화가 넓어집니다.

설정: 	 −127–+0–+127

0: 변함없이 유지됩니다.

음의 값: 피치 변화가 반대가 됩니다.
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Filter/Amp

Mixing

Mixing 화면에서 AN-X 파트의 신호 흐름도를 확인하면서 각 오실레이터의 출력을 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Filter/Amp → Mixing

FM 3 → 1 (Oscillator 1 FM Level)
FM 3 → 2 (Oscillator 2 FM Level)
OSC3이 주파수 모듈레이션(FM)을 사용하여 어떻게 OSC1 및 OSC2를 변조하는지 설정합니다.

설정: 0–255

Osc 1 (Oscillator 1)
Osc 2 (Oscillator 2)
Osc 3 (Oscillator 3)
Oscillator Edit의 OSC/Tune 화면을 엽니다.

Noise
Noise 화면이 나타납니다.

노이즈 신호에 VCF 및 HPF와 같은 필터를 사용하여 다양한 SFX 음향을 생성할 때 유용합니다.

Ring 3 → 1 (Oscillator 1 Ring Level)
Ring 3 → 2 (Oscillator 2 Ring Level)
OSC3이 링 모듈레이션을 사용하여 어떻게 OSC1 및 OSC2를 변조하는지 설정합니다.

설정: 0–255

1 (Oscillator 1 Out Level)
2 (Oscillator 2 Out Level)
3 (Oscillator 3 Out Level)
Noise (Noise Out Level)
1, 2 및 3은 오실레이터 음량을 설정할 때 사용됩니다.

Noise는 노이즈 유닛에서 전송되는 신호 출력 레벨을 조정할 때 사용됩니다. OSC 1, OSC 2 및 링 모듈레이터와 같은 다른 신호들을 

사용하여 레벨 밸런스를 제어할 수 있습니다.

설정: 0–511
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Connect 1 (Oscillator 1 Out Select)
Connect 2 (Oscillator 2 Out Select)
Connect 3 (Oscillator 3 Out Select)
Noise Connect (Noise Out Select)
오실레이터 및 노이즈의 출력 대상을 설정합니다.

설정: Filter, Amp

Modifier
Modifier → Wave Folder가 표시됩니다.

Filter 1
Filter 2
Filter/Amp → Filter Type이 표시됩니다.

Amplifier
Filter/Amp → Amp EG가 표시됩니다.

Filter Type

Filter Type 화면에서 필터 형식을 선택할 수 있습니다.

사용 가능한 파라미터는 여기에서 선택한 필터 형식에 따라 다릅니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Filter/Amp → Filter Type

Filter 1 Type
Filter 2 Type
필터를 설정합니다.

AN-X에 이용할 수 있는 필터는 LPF, HPF 및 BPF의 3개 형식으로 분류됩니다.

설정: Thru, LPF24, LPF18, LPF12, LPF6, HPF24, HPF18, HPF12, HPF6, BPF12, BPF6
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•	 LPF 

차단 주파수에서 설정된 값 위의 신호를 차단합니다. 이 필터 형식은 고전적인 신디사이저 사운드를 만드는 데 많이 사용됩니다.

차단 주파수를 높이면 음향이 밝아지는데, 필터가 더 많은 신호를 통과시키기 때문입니다.

차단 주파수를 낮추면 음향이 어두워지는데, 필터가 신호를 차단하거나 막기 때문입니다.

공명을 높이거나 차단 주파수 근처의 신호 레벨을 증폭시키면 독특한 “피크” 음향을 생성할 수 있습니다.

Frequencies that are
“passed” by the filter

Cutoff Frequency

Resonance

FrequencyCutoff FrequencyFrequency

Gain
Gain

LPF24: −24 dB/oct

LPF18: −18 dB/oc

LPF12: −12 dB/oct

LPF6: −6 dB/oct

•	 HPF 

차단 주파수 위의 신호만 통과시키는 필터 형식입니다.

공명을 높이거나 차단 주파수 근처의 신호 레벨을 증폭시키면 독특한 “피크” 음향을 생성할 수 있습니다.

Resonance

Frequencies that are
“passed” by the filter

Frequency
Cutoff Frequency

Gain

HPF24: −24 dB/oct

HPF18: −18 dB/oct

HPF12: −12 dB/oct

HPF6: −6dB/oct

•	 BPF 

특정 주파수 대역(차단 주파수)에 대한 신호만 통과시키고 다른 모든 신호를 차단하는 필터 형식입니다.

Frequencies that are “passed” by the filter

FrequencyCenter Frequency

Gain

BPF12: −12dB/oct

BPF6: −6dB/oct
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Cutoff (Filter Cutoff)
차단 주파수를 설정합니다. 여기에서 설정된 주파수는 Filter Type에서 설정된 필터를 통해 사용됩니다.

설정: 0–1023

Resonance (Filter Resonance)
공명의 크기를 설정합니다. Filter Type에 따라서는 이 파라미터를 이용하지 못할 수 있습니다.

설정: 0–255

Cutoff/Vel (Filter Cutoff Velocity Sensitivity)
차단 주파수가 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

설정: 	 −255–+0–+255

양의 값: 세기가 빨라질수록 차단 주파수 값이 커집니다.

0: 차단 주파수가 세기에 반응하지 않습니다.

음의 값: 세기가 느려질수록 차단 주파수 값이 커집니다.

Resonance/Vel (Filter Resonance Velocity Sensitivity)
공명 레벨이 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다. Filter Type에 따라서는 이 파라미터를 이용하지 못할 수 

있습니다.

설정: 	 −255–+0–+255

양의 값: 세기가 작아질수록 공명이 커집니다.

음의 값: 세기가 작아질수록 공명이 커집니다.

0: 공명 값이 세기에 따라 변하지 않습니다.

Cutoff/Key (Filter Cutoff Key Follow)
필터의 차단 주파수 레벨이 건반 위치에 어떻게 반응하는지 설정합니다. 값을 1oct로 설정한 경우 피치와 차단 주파수 모두 동일한 

속도에서 변경됩니다.

설정: Off, 1/3oct, 1/2oct, 2/3oct, 1oct, 2oct

Filter 1 Drive (Filter 1 Saturator Drive)
Filter 2 Drive (Filter 2 Saturator Drive)
필터의 Saturator 부분을 통해 제어되는 디스토션의 양을 설정합니다.

설정: 0.0 dB–60.0 dB (단위: 0.75 dB)

Filter 1 Drive/Vel (Filter 1 Saturator Drive Velocity Sensitivity)
Filter 2 Drive/Vel (Filter 2 Saturator Drive Velocity Sensitivity)
Drive가 세기에 어떻게 반응하는지 설정합니다.

설정: −255–+0–+255

F1 Out Level (Filter 1 Out Level)
F2 Out Level (Filter 2 Out Level)
필터의 출력 레벨을 설정합니다.

설정: −12.000 – +0.000 – +12.000 (dB) (단위: 0.375 dB)
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Filter EG

Filter EG 화면에서 필터 엔벌로프 제너레이터(FEG)를 설정할 수 있습니다.

FEG를 사용하면 차단 주파수의 변화도(또는 레벨)와 건반을 누른 순간부터 음향이 감쇄될 때까지 시간 경과에 따라 어떻게 변하는지 

설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Filter/Amp → Filter EG

Attack (Filter Cutoff EG Attack Time)
건반을 누른 순간부터 최대값에 이를 때까지 EG가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–255

Decay (Filter Cutoff EG Decay Time)
최대값에서 Sustain (Filter Cutoff EG Sustain Level) 값에 이를 때까지 EG가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–255

Sustain (Filter Cutoff EG Sustain Level)
서스테인 레벨을 설정합니다.

설정: 0–511

Release (Filter Cutoff EG Release Time)
건반에서 손을 뗀 후 EG 값이 0에 이를 때까지 소요되는 시간을 설정합니다.

설정: 0–255

Time/Vel (Filter Cutoff EG Time Velocity Sensitivity)
차단 주파수가 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

설정: 	 −255–+0–+255

양의 값: 세기가 빨라질수록 FEG 변화가 빨라집니다.

0: 세기 설정과는 상관없이 변하지 않습니다.

음의 값: 세기 값이 빠르면 FEG 변화가 느려지고 세기 값이 느리면 FEG 변화가 빨라집니다.
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FEG Depth - Filter 1–2 (Filter 1–2 Cutoff EG Depth)
FEG로 제어되는 차단 주파수 변화의 깊이 범위를 설정합니다(단위: 50 cent). 설정값이 0에서 멀어질수록 차단 주파수의 깊이 범위가 

넓어집니다.

설정: 	 −9600 – +0 – +9600 (cent)

0: FEG에 따라 차단 주파수가 변화되지 않습니다.

음의 값: 차단 주파수 변화가 반전됩니다.

FEG Depth/Vel - Filter 1–2 (Filter 1–2 Cutoff EG Depth Velocity Sensitivity)
FEG로 제어되는 차단 주파수가 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

설정: 	 −255–+0–+255

양의 값: 세기가 빨라질수록 차단 주파수의 깊이 범위가 넓어집니다. 세기가 느려질수록 차단 주파수의 깊이 범위가 좁아집니다.

0: 차단 주파수가 세기에 반응하지 않습니다.

음의 값: 세기가 빨라질수록 차단 주파수의 깊이 범위가 좁아집니다. 세기가 느려질수록 차단 주파수의 깊이 범위가 넓어집니다.

Filter LFO

Filter LFO 화면에서 필터 LFO를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Filter/Amp → Filter LFO

Wave (Filter Common Cutoff LFO Wave)
LFO 음파를 선택합니다. 여기에서 선택한 음파를 사용하면 다양한 형식의 모듈레이션을 생성할 수 있습니다.

설정: Saw, Square, Triangle, Sine, Random
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Key On Reset (Filter Common Cutoff LFO Key On Reset)
건반을 누를 때 LFO의 진동을 재설정합니다.

설정: Off, On

Time

Key on

Time

Key on

OnOff

Speed (Filter Common Cutoff LFO Speed)
LFO 음파 변화 속도를 설정합니다.

설정: 0–415

Delay (Filter Common Cutoff LFO Decay Time)
건반을 누르는 순간부터 LFO가 적용될 때까지 딜레이 타임을 설정합니다. 값이 커질수록 LFO가 적용될 때까지 소요되는 딜레이가 

길어집니다.

설정: 0–127

Fade In (Filter Common Cutoff LFO Fade In Time)
건반에서 손을 떼고 Delay에서 설정된 딜레이 타임이 경과된 후 LFO 이펙트가 페이드 인될 때까지 소요되는 시간을 설정합니다. 값이 

커질수록 이펙트가 최대 레벨에 이를 때까지 소요되는 시간이 길어집니다.

설정: 	 0–214

0: LFO가 페이드 인 없이 최대값으로 변경됩니다.

값이 작을 경우

Fade In
Maximum

Delay

Key On

Time

값이 클 경우

Fade In
Maximum

Delay

Key On

Time
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Phase (Modifier LFO Phase)
LFO 음파가 재설정되는 시간에 대한 초기 위상을 설정할 수 있습니다.

설정: 	 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330(°)

음파의 위상

Phase

Time

Level

0° 90°
120° 240°

180° 270°

Filter LFO Depth - Filter 1–2 (Filter Cutoff LFO Depth) 
Filter 1 및 Filter 2에 대해 LFO Wave 컨트롤 깊이를 설정합니다(단위: 50 cent).

설정: −9600 – +0 – +9600 (cent)

Amp EG

Amp EG 화면에서 AEG(진폭 엔벌로프 제너레이터)를 설정할 수 있습니다.

Amp EG를 설정하면 건반을 누른 순간부터 음향이 감쇄될 때까지 음량이 어떻게 변하는지 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Filter/Amp → Amp EG

Attack (Amplitude EG Attack Time)
건반을 누른 순간부터 Level (Amplitude Level)에 이를 때까지 소요되는 시간을 설정합니다.

설정: 0–255
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Decay (Amplitude EG Decay Time)
Level (Amplitude Level)에서 Sustain (Amplitude EG Sustain Level)로 음량이 변하는 데 소요되는 시간을 설정합니다.

설정: 0–255

Sustain (Amplitude EG Sustain Level)
건반을 누르고 있는 동안 유지되는 음량을 설정합니다.

설정: 0–511

Release (Amplitude EG Release Time)
건반에서 손을 뗀 후 음향이 감쇄될 때까지 소요되는 시간을 설정합니다.

설정: 0–255

Time/Vel (Amplitude EG Time Velocity Sensitivity)
AEG의 음량 변화가 건반을 누르는 세기 또는 강도에 어떻게 반응하는지 설정합니다.

설정: 	 −255–+0–+255

양의 값: 세기가 빨라질수록 AEG 음량 변화가 빨라집니다.

0: 세기 설정과는 상관없이 변하지 않습니다.

음의 값: 세기 값이 빠르면 AEG 음량 변화가 느려지고 세기 값이 느리면 AEG 음량 변화가 빨라집니다.

Level (Amplitude Level)
진폭의 음량 레벨을 설정합니다.

설정: 0–511

Level/Vel (Amplitude Level Velocity Sensitivity)
진폭 레벨이 어떻게 세기에 반응하는지 설정합니다.

설정: −255–+0–+255

Level/Key (Amplitude Level Key Follow)
Amp Level이 어떻게 피치에 반응하는지 설정합니다.

Amplitude Level Key를 127로 설정하면 피치가 한 옥타브 올라갈 때 Amp Level이 6dB 아래로 떨어집니다.

설정: 0–127

Drive (Amplitude Saturator Drive)
Amplitude 섹션의 Saturator를 통해 제어되는 디스토션의 양을 설정합니다.

설정: 0.0 dB–60.0 dB (단위” 0.75 dB)
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Amp LFO

Amp LFO 화면에서 진폭 LFO를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Filter/Amp → Amp LFO

Wave (Amplitude LFO Wave)
LFO 음파를 선택합니다. 여기에서 선택한 음파를 사용하면 다양한 형식의 모듈레이션을 생성할 수 있습니다.

설정: Saw, Square, Triangle, Sine, Random

Key On Reset (Amplitude LFO Key On Reset)
건반을 누를 때 LFO의 진동을 재설정합니다.

설정: Off, On

Time

Key on

Time

Key on

OnOff

Speed (Amplitude LFO Speed)
LFO 음파 변화 속도를 설정합니다.

설정: 0–415

Delay (Amplitude LFO Decay Time)
건반을 누르는 순간부터 LFO가 적용될 때까지 딜레이 타임을 설정합니다. 값이 커질수록 LFO가 적용될 때까지 소요되는 딜레이가 

길어집니다.

설정: 0–127



332MODX M 사용설명서

Fade In (Amplitude LFO Fade In Time)
건반에서 손을 떼고 Delay에서 설정된 딜레이 타임이 경과된 후 LFO 이펙트가 페이드 인될 때까지 소요되는 시간을 설정합니다. 값이 

커질수록 이펙트가 최대 레벨에 이를 때까지 소요되는 시간이 길어집니다.

설정: 	 0–214

0: LFO가 페이드 인 없이 최대값으로 변경됩니다.

	 값이 작을 경우

Fade In
Maximum

Delay

Key On

Time

	 값이 클 경우

Fade In
Maximum

Delay

Key On

Time

Phase (Amplitude LFO Phase)
LFO 음파가 재설정되는 시간에 대한 초기 위상을 설정할 수 있습니다.

설정: 	 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330(°)

	 음파의 위상

Phase

Time

Level

0° 90°
120° 240°

180° 270°

Depth (Amplitude Level LFO Depth)
LFO로 제어되는 음량 변화의 깊이 범위를 설정합니다.

설정: −127–+0–+127



333MODX M 사용설명서

Effect

Routing

여기에 표시된 화면은 아래 표시된 사항을 제외하고는 Part Edit (AWM2) Part Common Edit 화면의 Effect → Routing에서 연 

화면과 거의 동일합니다.

•	 각 Element에 대한 출력 설정 없음

•	 Ins Connect에 대해서는 Parallel을 선택할 수 없음

Ins A, Ins B

Part Edit (AWM2) Part Common Edit 화면의 Effect → Ins A 및 Ins B와 동일합니다.

3-band EQ

Part Edit (AWM2) Part Common Edit 화면의 Effect → 3-band EQ와 동일합니다.

2-band EQ

2-band EQ 화면에서 파트 EQ를 설정할 수 있습니다. EQ는 인서트 이펙트 후에 설정할 수 있습니다.

Ins Assign

Part Edit (AWM2) Part Common Edit 화면의 Effect → Ins Assign과 동일합니다.
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Arp/MS

Arp Common

Part Edit (AWM2) Part Common Edit 화면의 Arpeggio → Common과 동일합니다.

Individual

Part Edit (AWM2) Part Common Edit 화면의 Arpeggio → Individual과 동일합니다.

Advanced

Part Edit (AWM2) Part Common Edit 화면의 Arpeggio → Advanced와 동일합니다.

MS Common

Part Edit (AWM2) Part Common Edit 화면의 Motion Seq → Common과 동일합니다.

Lane

Part Edit (AWM2) Part Common Edit 화면의 Motion Seq → Lane과 동일합니다.
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Mod/Control

Control Assign

Destination 설정을 제외하면 Part Edit (AWM2) Part Common Edit 화면의 Mod/Control → Control Assign과 동일합니다.

ElementSw 및 기타 파라미터 대신 아래 표시된 파라미터를 사용합니다.

Oscillator Sw (Oscillator Switch)
각 오실레이터에 대한 컨트롤러 설정을 켜짐 또는 꺼짐으로 설정할 수 있습니다. 이 파라미터는 선택한 Destination이 오실레이터와 

관련된 경우에만 표시됩니다.

일반적으로 3개의 스위치가 표시되지만, Destination을 OSC FM 또는 OSC Ring으로 설정한 경우에는 이 중 2개만 표시됩니다.

설정: Off, On

Filter Sw
각 필터에 대한 컨트롤러 설정을 켜짐 또는 꺼짐으로 설정할 수 있습니다.

선택한 Destination이 필터와 관련된 경우에만 이 파라미터가 표시됩니다.

설정: Off, On

After Touch

Destination 설정을 제외하면 Part Edit (AWM2) Part Common Edit 화면의 Mod/Control → After Touch와 동일합니다.

Tx/Rx Switch

Part Edit (AWM2) Part Common Edit 화면의 Mod/Control → Tx/Rx Switch와 동일합니다.

Control Settings

Part Edit (AWM2) Part Common Edit 화면의 Mod/Control → Control Settings와 동일합니다.

Part LFO

여기에 표시된 화면은 유일하게 이용 가능한 Destination 설정이 Ins라는 점을 제외하고는 Part Edit (AWM2) Part Common Edit 

화면의 , Mod/Control → Part LFO에서 연 화면과 동일합니다.
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Part Edit (AN-X) Oscillator Edit 화면

일반 파트(AN-X)는 3개의 오실레이터와 노이즈로 구성되어 있습니다.

Part Edit (AN-X)에는 전체 파트에 파라미터를 설정할 때 사용되는 Part Common Edit, 각 오실레이터에 파라미터를 설정할 때 

사용되는 Oscillator Edit 및 노이즈를 편집할 때 사용되는 Noise Edit이 포함됩니다.

Osc/Tune

Osc/Tune 화면에서 오실레이터의 일반 파라미터를 설정할 수 있습니다.

이 화면에서 이용할 수 있는 모듈레이션 및 음파 형성 기능은 FM(주파수 모듈레이션), 링 모듈레이션, 오실레이터 동기화, Pulse Width 

및 Wave Shaper입니다.

작업 

[PERFORMANCE (HOME)] → Part 선택 → Oscillator 선택 → Osc/Tune

Wave (Oscillator Wave)
오실레이터의 파형을 설정합니다.

설정: Saw1, Saw2(음향이 풍부한 Saw1의 변형), Square, Triangle, Sine

Out Level (Oscillator Out Level)
오실레이터 음량을 설정합니다.

설정: 0–511

Out Level/Vel (Oscillator Out Level Velocity Sensitivity)
오실레이터가 세기에 어떻게 반응하는지 설정합니다.

설정: −255–+0–+255



337MODX M 사용설명서

Invert (Oscillator Out Invert Enable)
오실레이터 출력의 음수/양수 반전을 실시합니다.

설정: Off, On

Connect (Oscillator Out Select)
오실레이터의 출력 대상을 설정합니다.

설정: Filter, Amp

Octave (Oscillator Octave)
오실레이터 피치를 옥타브 단위로 설정합니다.

설정: 64’, 32’, 16’, 8’, 4’, 2’, 1’

Pitch (Oscillator Pitch)
오실레이터의 피치를 미세하게 조정합니다.

설정: −1200 – +0 – +1200(cent)

	� FM(주파수 모듈레이션)
다른 오실레이터를 사용하여 오실레이터 주파수를 변조합니다.

FM Level (Oscillator FM Level)
주파수 모듈레이션의 레벨을 설정합니다.

설정: 0–255

FM Level/Vel (Oscillator FM Level Velocity Sensitivity)
주파수 모듈레이션이 세기에 어떻게 반응하는지 설정합니다.

설정: −255–+0–+255

	� 링 모듈레이션
2개의 오실레이터 신호를 믹싱하면 금속성의 부조화 음향을 생성할 수 있습니다.

Ring Level (Oscillator Ring Level)
링 모듈레이션의 레벨을 설정합니다.

설정: 0–255

Ring Level/Vel (Oscillator Ring Level Velocity Sensitivity)
링 모듈레이션이 세기에 어떻게 반응하는지 설정합니다.

설정: −255–+0–+255

	� 오실레이터 동기화
오실레이터 동기화는 2개의 오실레이터를 강제로 동기화하여 복잡한 음파를 생성하는 체계입니다.

AN-X 사운드 엔진을 사용하면 각 오실레이터가 관련 동기화 타이밍을 설정할 수 있어 오실레이터 하나만으로도 복잡한 파형을 생성할 

수 있게 됩니다.

Sync Pitch (Oscillator Self Sync Pitch)
오실레이터 동기화의 레벨을 설정합니다(단위: 25 cent).

설정: 0–4800 (cent)

Sync Pitch/Vel (Oscillator Self Sync Pitch Velocity Sensitivity)
Sync Pitch가 세기에 어떻게 반응하는지 설정합니다.

설정: −255–+0–+255
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	� Pulse Width
Pulse Width는 Square 음파의 음수/양수 부분에 대한 비율입니다.

Pulse Width를 작은 값으로 설정한 경우 Pulse Width를 50%로 설정한 경우 Pulse Width를 큰 값으로 설정한 경우

AN-X 사운드 엔진을 사용하면 Square 음파는 물론 다른 음파에도 Pulse Width를 사용할 수 있습니다.

Pulse Width를 사용한 LFO 모듈레이션은 Pulse Width Modulation(PWM)이라고 하며, 특징적인 소용돌이 같은 음향을 생성할 수 

있습니다.

AN-X 사운드 엔진을 통해 Osc EG 및 Osc LFO를 사용하여 PWM을 활용할 수 있습니다. Osc EG 화면 및 Osc LFO 화면의 PWM 

레벨을 지정할 수 있습니다.

Pulse Width (Oscillator Pulse Width)
음파의 Pulse Width를 설정합니다.

설정: 1.0%–50.0%–99.0%

PulseWidth/Vel (Oscillator Pulse Width Velocity Sensitivity)
Pulse Width가 세기에 어떻게 반응하는지 설정합니다.

설정: −255–+0–+255

	� Wave Shaper
파형 형태를 변경하여 특징적인 디스토션 및 배음 구조 변화를 생성합니다.

Shaper (Oscillator Wave Shaper)
Wave Shaper의 레벨을 설정합니다. Wave Shaper를 사용하면 음파가 역동적으로 변합니다.

설정: 0–255

Shaper/Vel (Oscillator Wave Shaper Velocity Sensitivity)
Wave Shaper가 세기에 어떻게 반응하는지 설정합니다.

설정: −255–+0–+255

Pitch EG Settings
General/Pitch → Pitch EG가 Part Edit (AN-X) Part Common Edit 화면에 표시됩니다.

Pitch LFO Settings
General/Pitch → Pitch LFO가 Part Edit (AN-X) Part Common Edit 화면에 표시됩니다.

Osc 1–3 EG Settings
Osc EG 화면이 나타납니다.

Osc 1–3 LFO Settings
Osc LFO 화면이 나타납니다.
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Osc EG

Osc EG 화면에서 오실레이터의 엔벌로프 제너레이터를 설정할 수 있습니다.

건반을 누른 순간부터 음향이 감쇄될 때까지 시간 경과에 따라 Sync, Pulse Width 및 Wave Shaper가 어떻게 변하는지 설정할 수 

있습니다.

작업

[PERFORMANCE (HOME)] → Part 선택 → Oscillator 선택 → Osc EG

Attack (Oscillator EG Attack Time)
건반을 누른 순간부터 Attack Level에서 설정된 값에 이를 때까지 EG가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–255

Decay (Oscillator EG Decay Time)
건반을 누른 순간부터 Decay Level에서 설정된 값에 이를 때까지 EG가 변하는 데 소요되는 시간을 설정합니다.

설정: 0–255

Sustain (Oscillator EG Sustain Level)
서스테인 레벨을 설정합니다.

설정: 0–511

Release (Oscillator EG Release Time)
건반에서 손을 뗀 후 EG 값이 0에 이를 때까지 소요되는 시간을 설정합니다.

설정: 0–255

Osc EG Depth Sync (Oscillator Self Sync EG Depth)
Sync가 Osc EG에 어떻게 반응하는지 설정합니다.

설정: −4800 – +0 – +4800 (cent)

Osc EG Depth Pulse Width (Oscillator Pulse Width EG Depth)
Pulse Width가 Osc EG에 어떻게 반응하는지 설정합니다.

설정: −127–+0–+127

Osc EG Depth Shaper (Oscillator Wave Shaper EG Depth)
Shaper가 Osc EG에 어떻게 반응하는지 설정합니다.

설정: −127–+0–+127
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Osc LFO

Osc LFO 화면에서 오실레이터 LFO를 설정할 수 있습니다.

작업

[PERFORMANCE (HOME)] → Part 선택 → Oscillator 선택 → Osc LFO

LFO Wave (Oscillator LFO Wave)
LFO 음파를 선택합니다. 여기에서 선택한 음파를 사용하면 다양한 형식의 모듈레이션을 생성할 수 있습니다.

설정: Saw, Square, Triangle, Sine, Random

Key On Reset (Oscillator LFO Key On Reset)
건반을 누를 때 LFO의 진동을 재설정합니다.

설정: Off, On

Time

Key on

Time

Key on

OnOff

Speed (Oscillator LFO Speed)
LFO 음파 변화 속도를 설정합니다.

설정: 0–415
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Delay (Oscillator LFO Delay Time)
건반을 누르는 순간부터 LFO가 적용될 때까지 딜레이 타임을 설정합니다.

설정: 0–127

Fade In (Oscillator LFO Fade In Time)
건반에서 손을 떼고 Delay에서 설정된 딜레이 타임이 경과된 후 LFO 이펙트가 페이드 인될 때까지 소요되는 시간을 설정합니다.

설정: 0–214

Oscillator LFO Phase
건반을 누를 때 음파 재설정에 사용되는 LFO 위상을 설정합니다.

설정: 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330(°)

Osc LFO Depth Sync (Oscillator Self Sync LFO Depth)
Sync가 Osc LFO에 어떻게 반응하는지 설정합니다.

설정: −4800 – +0 – +4800 (cent)

Osc LFO Depth Pulse Width (Oscillator Pulse Width LFO Depth)
Pulse Width가 Osc LFO에 어떻게 반응하는지 설정합니다.

설정: −127–+0–+127

Osc LFO Depth Shaper (Oscillator Wave Shaper LFO Depth)
Shaper가 Osc LFO에 어떻게 반응하는지 설정합니다.

설정: −127–+0–+127
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Part Edit (AN-X) Noise Edit 화면

일반 파트(AN-X)는 3개의 오실레이터와 노이즈로 구성되어 있습니다.

Part Edit (AN-X)에는 전체 파트에 파라미터를 설정할 때 사용되는 Part Common Edit, 각 오실레이터에 파라미터를 설정할 때 

사용되는 Oscillator Edit 및 노이즈를 편집할 때 사용되는 Noise Edit이 포함됩니다.

Noise

Noise 화면에서 Noise Generator를 설정할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Part 선택 → Oscillator 선택 → Noise

Noise Tone (Noise Generator Tone)
Noise의 주파수 응답을 설정합니다.

설정: 	 0–64–127

0–63: 고음 차단

64: 백색 소음

65–127: 저음 차단

Out Level (Noise Generator Out Level)
Noise의 음량을 설정합니다.

설정: 0–511

Out Level/Vel (Noise Generator Out Level Velocity Sensitivity)
Noise 음량이 Velocity에 어떻게 반응하는지 설정합니다.

설정: −255–+0–+255

Connect (Noise Generator Out Select)
Noise의 출력 대상을 설정합니다.

설정: Filter, Amp
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Category Search 화면

카테고리 검색은 지정된 카테고리에서 사용하려는 특정 퍼포먼스, 파트, 아르페지오 또는 파형을 신속하게 찾을 수 있는 기능입니다.

Performance Category Search

Performance Category Search 화면에서 퍼포먼스를 검색하고 선택할 수 있습니다.

Category Search 화면이 표시되는 동안 상단 패널의 버튼을 사용하여 파트 선택 또는 음소거 설정을 변경할 수 있습니다.

작업

[CATEGORY] 버튼 누르기

퍼포먼스 이름을 탭하고 콘텍스트 메뉴에서 Category Search 선택

Filter
검색에서 사용할 필터를 선택합니다.

설정: Category, Attribute

Main (Main Category)
Sub (Sub Category)
카테고리별로 필터링합니다.

Main 또는 Sub 체크상자에 체크표시를 해제하면 카테고리별로 필터링할 수 있습니다.

설정: Data List 참조

Attribute
속성별로 필터링합니다.

Attribute 체크상자에 체크표시를 해제하면 속성별로 필터링할 수 있습니다.

설정: AWM2, FM-X, AN-X, MC, SSS, Smart Morph, Single, Multi, MOTIF XF, MONTAGE, MODX M OS V1.0
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Bank/Favorite (Bank/Favorite Select)
뱅크 또는 즐겨찾기별로 필터링합니다.

Favorite을 선택한 경우 즐겨찾는 플래그가 있는 퍼포먼스만 목록에 나타납니다.

카테고리 검색 화면이 표시되면 [CATEGORY] 버튼을 눌러 All → Favorite → Preset → User → 라이브러리 이름 순서로 뱅크를 

전환할 수 있습니다(라이브러리 파일을 불러온 경우).

[CATEGORY] 버튼을 누른 상태에서 선택 사항이 All로 재설정됩니다.

설정: All, Favorite, Preset, User, 라이브러리 이름(라이브러리 파일을 불러온 경우)

Name Search
쉽게 검색할 수 있도록 포함된 특정 문자를 입력할 수 있습니다. 최대 20자의 영숫자 문자를 사용할 수 있습니다.

Job
작업 메뉴를 불러옵니다.

•	 Delete

선택한 내용을 삭제합니다.

유저 뱅크의 퍼포먼스를 선택한 경우에만 이 파라미터를 이용할 수 있습니다.

•	 Rename

선택한 내용의 이름을 변경합니다.

유저 뱅크의 퍼포먼스를 선택한 경우에만 이 파라미터를 이용할 수 있습니다.

•	 Favorite All Clear

퍼포먼스에서 모든 즐겨찾는 플래그를 삭제합니다.

즐겨찾는 플래그가 있는 퍼포먼스가 없는 경우에는 이 파라미터를 이용할 수 없습니다.

Sort
퍼포먼스 목록의 정렬 순서를 설정합니다.

설정: 	 Default, Name, Date

Name: 이름별로 정렬합니다. 아래 방향 화살표는 목록이 오름차순(A에서 Z로)으로 배열된다는 의미입니다. 위 방향 화살표는 목록이 

내림차순으로 배열된다는 의미입니다.

Date: 설정 저장일별로 분류합니다. 아래 방향 화살표는 목록이 내림차순(신규에서 기존으로)으로 배열된다는 의미입니다. 위 방향 화살표는 

목록이 오름차순으로 배열된다는 의미입니다.

Audition
오디션 프레이즈 재생을 켜짐 또는 꺼짐으로 설정합니다.

Audition Lock을 [UTILITY] → Settings → Advanced에서 켜짐으로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.

설정: Off, On

퍼포먼스 목록
활성화된 파트, 속성 및 즐겨찾는 플래그와 함께 퍼포먼스 이름을 표시합니다.
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Performance Merge

Performance Merge 화면을 사용하면 선택한 퍼포먼스의 다중 파트를 지정하여 다른 퍼포먼스의 파트를 비울 수 있습니다. 예를 들어, 

4파트 피아노 퍼포먼스 및 2파트 현악기 퍼포먼스를 레이어 처리하여 풍부한 6파트 퍼포먼스를 생성할 수 있습니다.

작업

[PERFORMANCE (HOME)] → 파트 선택(선택한 파트 및 모든 이후 파트가 비어 있을 때) → [+] 탭하기

Source
퍼포먼스를 선택할 때 여기에서 지정한 파트의 음향이 현재 선택한 파트에 지정됩니다.

설정: 	 All, Part 1–16

All: 선택한 퍼포먼스의 모든 파트가 (최대한) 선택된 다른 퍼포먼스의 빈 파트에 지정됩니다.

Part 1–16: 지정한 파트의 음향만 선택된 다른 파트에 지정됩니다.

Mute Org (Original Part Mute)
이 파라미터를 꺼짐으로 설정한 경우 Performance Merge 화면이 열리기 전에 표시된 파트는 음소거됩니다.

설정: Off, On

Mute Add (Additional Part Mute)
이 파라미터를 꺼짐으로 설정한 경우 Performance Merge 화면에 추가된 파트는 음소거됩니다.

설정: Off, On
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Part Category Search

Part Category Search 화면에서 파트를 검색하고 선택할 수 있습니다.

작업

[SHIFT] + [CATEGORY] 

(음향이 이미 지정된 파트를 선택할 때) 퍼포먼스 이름을 탭하고 콘텍스트 메뉴에서 Category Search 선택

(음향이 이미 지정된 빈 파트를 선택할 때) [+] 탭하기

Source (Source Part)
퍼포먼스를 선택할 때 여기에서 지정한 파트의 음향이 현재 선택한 파트에 지정됩니다.

초기 설정은 Part 1입니다.

설정: Part 1–16

Solo
솔로 기능을 켜짐 또는 꺼짐으로 설정합니다.

이 스위치를 켜면 선택한 파트가 솔로로 설정됩니다.

설정: Off, On

Param. with Part (Parameter with Part)
퍼포먼스를 선택한 경우 파라미터 값 그룹을 불러옵니다.

꺼짐으로 설정된 파라미터는 새 퍼포먼스를 선택해도 현재 설정을 유지합니다.

파라미터 그룹: Mixing, Arp/MS, Scene, Zone

설정: Off, On
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Rhythm Pattern

Rhythm Pattern 화면에서 리듬 패턴을 검색하고 선택할 수 있습니다.

리듬 패턴 기능을 사용하면 현재 퍼포먼스에 바로 리듬 파트를 추가할 수 있습니다. 또한, 리듬 패턴을 엔벌로프 팔로워 이펙트와 

결합해도 음향을 추가로 변경할 수 있습니다.

작업 

[SHIFT] + [SONG/PATTERN]

Arp (Arpeggio)
Envelope Follower
Arpeggio 화면 또는 Envelope Follower 화면을 선택합니다.

Bank/Favorite (Bank/Favorite Select)
뱅크 또는 즐겨찾기별로 필터링합니다.

Favorite을 선택한 경우 즐겨찾는 플래그가 있는 리듬 패턴만 목록에 나타납니다.

설정: All, Favorite, Preset, User, 라이브러리 이름(라이브러리 파일을 불러온 경우)

Name Search
쉽게 검색할 수 있도록 포함된 특정 문자를 입력할 수 있습니다. 최대 20자의 영숫자 문자를 사용할 수 있습니다.

Sort
리듬 패턴 목록의 정렬 순서를 설정합니다.

설정: 	 Default, Name, Date

Name: 이름별로 정렬합니다. 아래 방향 화살표는 목록이 오름차순(A에서 Z로)으로 배열된다는 의미입니다. 위 방향 화살표는 목록이 

내림차순으로 배열된다는 의미입니다.

Date: 설정 저장일별로 분류합니다. 아래 방향 화살표는 목록이 내림차순(신규에서 기존으로)으로 배열된다는 의미입니다. 위 방향 화살표는 

목록이 오름차순으로 배열된다는 의미입니다.

Mute Org (Original Part Mute)
이 파라미터를 꺼짐으로 설정한 경우 Rhythm Pattern 화면이 열리기 전에 표시된 파트는 음소거됩니다.

설정: Off, On

Mute Add (Additional Part Mute)
이 파라미터를 꺼짐으로 설정한 경우 Rhythm Pattern 화면에 추가된 파트는 음소거됩니다.

설정: Off, On

리듬 패턴 목록
리듬 패턴 목록을 표시합니다.
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Cancel
작업을 취소합니다.

	� Arp를 켜짐으로 설정한 경우
아르페지오 설정에 자주 사용되는 파라미터가 화면 좌측에 표시됩니다.

Tempo
템포를 설정합니다.

설정: 5–300

Volume
리듬 패턴의 음량을 설정합니다.

설정: 0–127

Category (Arpeggio Main Category)
Sub Category (Arpeggio Sub Category)
Name
현재 선택한 아르페지오 카테고리 , 하위 카테고리 및 이름을 표시합니다.

이름을 탭하면 아르페지오 카테고리 검색 및 숫자 입력에 대한 콘텍스트 메뉴가 표시됩니다.

설정: Data List 참조

Arp Select (Arpeggio Select)
아르페지오를 선택합니다.

설정: 1–8
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	� Envelope Follower를 켜짐으로 설정한 경우
Envelope Follower 설정에 자주 사용되는 파라미터가 화면 좌측에 표시됩니다.

이로써 리듬 패턴에 자주 사용되는 파라미터를 쉽게 입력할 수 있게 됩니다.

기타 파라미터를 변경하려면 Edit을 사용하여 Envelope Follower Edit 화면을 엽니다.

Quick Assign
엔벌로프 팔로워를 활성화합니다.

설정: Off, On

Gain (Envelop Follower Gain)
입력 소스에 대한 입력 게인을 설정합니다.

설정: −24.0dB – 0.0dB – 24.0dB

Destination
엔벌로프 팔로워에 대한 대상을 설정합니다.

설정: 	 Volume, Cutoff, Resonance, Pitch, Pan, Reverb Send, Variation Send, LFO Speed, LFO Depth 1, LFO Depth 2, LFO Depth 3

Curve Type
Polarity (Curve Polarity)
Ratio (Curve Ratio)
Param1 (Curve Parameter 1)
Param2 (Curve Parameter 2)
Control Assign 화면과 동일합니다.

Edit
Envelope Follower Edit 화면이 나타납니다.
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리듬 패턴 기능 사용 방법

여기에서는 예시로 리듬 패턴 8Z Trance Basics 1을 퍼포먼스 Supertrance에 추가한 후 엔벌로프 팔로워로 음향을 변경하는 방식을 

설명합니다.

먼저, 리듬 파트를 추가합니다.

1.	 리듬 파트를 추가하려는 퍼포먼스를 선택합니다.

Supertrance를 선택합니다.

2.	 [SHIFT]와 [SONG/PATTERN]을 눌러 Rhythm Pattern 화면을 엽니다.

파트 1~8 모두 사용 중인 경우 PartFull이 표시되어 리듬 패턴을 추가할 수 없게 됩니다.

3.	 리듬 패턴 목록에서 사용하려는 리듬 패턴 키트를 탭합니다.

8Z Trance Basics 1을 탭합니다.

리듬 파트가 추가되었습니다.

4.	 건반을 눌러서 리듬을 재생합니다.

5.	 [PERFORMANCE (HOME)] 버튼이나 [EXIT] 버튼을 눌러 리듬 패턴을 확인합니다.

Rhythm Pattern 화면이 닫힙니다.

주
HOME 아이콘( )을 눌러도 선택 사항을 확인할 수 있습니다.

6.	 리듬 패턴을 멈추려면 [ARP] 버튼 또는 [] (정지) 버튼을 누릅니다.

그 다음, 엔벌로프 팔로워를 설정합니다. 엔벌로프 팔로워에 관한 정보는 "엔벌로프 팔로워 사용하기"를 참조하십시오.

7.	 [SHIFT]와 [SONG/PATTERN]을 눌러 Rhythm Pattern 화면을 열고 Envelope Follower를 누릅니다.

8.	 Quick Assign을 켜짐으로 설정합니다.

건반을 연주하면 엔벌로프 팔로워가 활성화된 음향을 들어볼 수 있습니다.
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9.	 설정은 필요한 경우 조정할 수 있습니다.

이 예시에서는 Polarity를 Bi로 설정하고 Ratio를 −64, Gain을 −12.0dB로 설정합니다.

미세 조정은 화면의 Edit에서 Envelope Follower Edit을 엽니다.

리듬 패턴 키트나 아르페지오 형식을 변경하려면 [SHIFT]와 [SONG/PATTERN]을 눌러 Rhythm Pattern 화면으로 

돌아갑니다. Envelope Follower 설정은 새 키트나 아르페지오 형식을 선택한 후에도 유지됩니다.
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Arp Category Search (Arpeggio Category Search)

Arp Category Search 화면에서 아르페지오 형식을 검색하고 선택할 수 있습니다.

작업 

[PERFORMANCE (HOME)] → Part Common 선택 → [EDIT/ ] → Arpeggio → Individual → [CATEGORY]

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Arp / MS → Arp Overview → 파트 선택 → [CATEGORY]

Classic (Classic Switch)
Classic 보기를 켜짐 또는 꺼짐으로 설정합니다.

Classic 보기에서는 공통 아르페지오만 표시되며 검색에 대해 어떤 필터도 이용할 수 없습니다.

설정: Off, On

Main (Main Category)
Sub (Sub Category)
카테고리별로 필터링합니다.

Main 또는 Sub 체크상자에 체크표시를 해제하면 카테고리별로 필터링할 수 있습니다.

설정: Data List 참조

Attribute
속성별로 필터링합니다.

Attribute 체크상자에 체크표시를 해제하면 속성별로 필터링할 수 있습니다.

설정: Note, Chord, Other, Intro, Main, Fill, Ending, AF, Accent, Random SFX, Mg, 바의 수, 박자 기호, 템포

Bank/Favorite (Bank/Favorite Select)
뱅크 또는 즐겨찾기별로 필터링합니다.

Favorite을 선택한 경우 즐겨찾는 플래그가 있는 아르페지오 형식만 목록에 나타납니다.

설정: All, Favorite, Preset, User, 라이브러리 이름(라이브러리 파일을 불러온 경우)
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Name Search
쉽게 검색할 수 있도록 포함된 특정 문자를 입력할 수 있습니다. 최대 20자의 영숫자 문자를 사용할 수 있습니다.

Job
작업 메뉴를 불러옵니다.

•	 Delete

선택한 내용을 삭제합니다.

유저 뱅크의 아르페지오를 선택한 경우에만 이 파라미터를 이용할 수 있습니다.

•	 Rename

선택한 내용의 이름을 변경합니다.

유저 뱅크의 아르페지오를 선택한 경우에만 이 파라미터를 이용할 수 있습니다.

•	 Favorite All Clear

아르페지오에서 모든 즐겨찾는 플래그를 삭제합니다.

즐겨찾는 플래그가 있는 아르페지오 형식이 없는 경우에는 이 파라미터를 이용할 수 없습니다.

Sort
아르페지오 형식 목록의 정렬 순서를 설정합니다.

설정: 	 Default, Name, Date

Name: 이름별로 정렬합니다. 아래 방향 화살표는 목록이 오름차순(A에서 Z로)으로 배열된다는 의미입니다. 위 방향 화살표는 목록이 

내림차순으로 배열된다는 의미입니다.

Date: 설정을 불러온 날짜별로 분류합니다. 아래 방향 화살표는 목록이 내림차순(신규에서 기존으로)으로 배열된다는 의미입니다. 위 방향 

화살표는 목록이 오름차순으로 배열된다는 의미입니다.

아르페지오 목록
아르페지오 이름, 소절의 수, 박자 기호, 권장 템포, 속성 및 즐겨찾는 플래그 상태를 표시합니다.
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Waveform Search (Waveform Category Search)

Waveform Search 화면에서 파형을 검색하고 선택할 수 있습니다.

작업 

Waveform 관련 화면 → Part 선택 → Waveform 선택 → [CATEGORY]

Bank/Favorite (Bank/Favorite Select)
뱅크 또는 즐겨찾기별로 필터링합니다.

Favorite을 선택한 경우 즐겨찾는 플래그가 있는 파형만 목록에 나타납니다.

설정: All, Favorite, Preset, User, 라이브러리 이름(라이브러리 파일을 불러온 경우)

Name Search
쉽게 검색할 수 있도록 포함된 특정 문자를 입력할 수 있습니다. 최대 20자의 영숫자 문자를 사용할 수 있습니다.

Main (Main Category)
Sub (Sub Category)
카테고리별로 필터링합니다. Main 또는 Sub 체크상자에 체크표시를 해제하면 카테고리별로 필터링할 수 있습니다.

설정: Data List 참조

Job
작업 메뉴를 불러옵니다.

•	 Delete

선택한 내용을 삭제합니다.

유저 뱅크의 파형을 선택한 경우에만 이 파라미터를 이용할 수 있습니다.

•	 Rename

선택한 내용의 이름을 변경합니다.

유저 뱅크의 파형을 선택한 경우에만 이 파라미터를 이용할 수 있습니다.

•	 Favorite All Clear

파형에서 모든 즐겨찾는 플래그를 삭제합니다.

즐겨찾는 플래그가 있는 파형이 없는 경우에는 이 파라미터를 이용할 수 없습니다.
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Sort
파형 목록의 정렬 순서를 설정합니다.

설정: 	 Default, Name, Date

Name: 이름별로 정렬합니다. 아래 방향 화살표는 목록이 오름차순(A에서 Z로)으로 배열된다는 의미입니다. 위 방향 화살표는 목록이 

내림차순으로 배열된다는 의미입니다.

Date: 설정 저장일별로 분류합니다. 아래 방향 화살표는 목록이 내림차순(신규에서 기존으로)으로 배열된다는 의미입니다. 위 방향 화살표는 

목록이 오름차순으로 배열된다는 의미입니다.

파형 목록
파형 목록을 표시합니다.
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Live Set 화면

Live Set 기능은 예를 들어 설정 목록의 곡을 연주할 때 여러 퍼포먼스 사이에서 즉각적으로 변경할 수 있는 편리한 방법입니다.

Live Set

Live Set 화면에서 퍼포먼스를 불러올 수 있습니다.

User Bank를 선택한 상태에서 [SHIFT] + [EDIT/ ]을 누르면 대화 상자가 표시됩니다. 그러면 페이지 또는 뱅크를 복사하거나 

교환할 수 있습니다.

작업 

[LIVE SET] 버튼 누르기

LIVE SET 아이콘( ) 탭하기

Bank (Bank Name)
Live Set 뱅크를 선택합니다.

설정: Preset, User 1–8 (공장 기본 설정), 라이브러리 이름(라이브러리 파일을 불러온 경우)

Page
Live Set 페이지를 선택합니다.

Edit
Live Set Edit 화면이 나타납니다.

Edit은 User Bank를 선택한 경우에만 나타납니다.

Live Set Slot 1–16
선택한 Live Set 페이지에 등록된 퍼포먼스의 목록을 표시합니다.

Category Search
Performance Category Search 화면이 열립니다.
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Current Performance Name
선택한 슬롯에 등록된 퍼포먼스 이름을 표시합니다.

Current Slot Name
선택한 슬롯의 이름을 표시합니다.

패턴, 곡 또는 오디오를 슬롯에 지정한 경우 해당 패턴, 곡 또는 오디오의 이름이 표시됩니다.

Performance Attribute
선택한 슬롯에 등록된 퍼포먼스 속성을 표시합니다.

Live Set 화면에서 체인이 켜짐으로 설정된 패턴을 슬롯에 지정한 경우 PTN 아이콘이 PTN CHAIN으로 변경됩니다.

PTN: 패턴이 지정된 슬롯에 대해 표시됩니다.

PTN CHAIN: 체인이 켜짐으로 설정된 패턴이 지정된 슬롯에 대해 표시됩니다.

SONG: 곡이 지정된 슬롯에 대해 표시됩니다.

AUDIO: 오디오가 지정된 슬롯에 대해 표시됩니다.
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Live Set Register

Live Set Register 화면에서 퍼포먼스를 Live Set 슬롯에 등록할 수 있습니다.

작업 

[SHIFT] + [LIVE SET]

[SHIFT] 버튼을 누른 상태에서 탐색 바의 LIVE SET 아이콘 탭하기

Store as New Perf. and Register (Store as New Performance and Register)
현재 퍼포먼스를 새 퍼포먼스로 저장한 후 선택한 슬롯에 등록합니다.

Jump to Data Utility
Data Utility 화면이 나타납니다.

Overwrite Current Perf. and Register (Overwrite Current Performance and Register)
기존 퍼포먼스를 새 퍼포먼스로 저장한 후 선택한 슬롯에 등록합니다.

Register
퍼포먼스를 등록합니다.

[SHIFT] 버튼을 누른 상태에서 Register를 눌러 퍼포먼스를 슬롯 사이에 삽입하여 등록합니다.
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Live Set Edit

Live Set Edit 화면에서 Live Set를 편집할 수 있습니다.

유저 뱅크의 Live Set만 편집할 수 있습니다.

작업 

[LIVE SET] → [EDIT/ ]

Bank (Bank Name)
선택한 Live Set 뱅크를 새 이름으로 저장합니다. 최대 20자의 영숫자 문자를 사용할 수 있습니다.

Page (Page Name)
선택한 Live Set 페이지를 새 이름으로 저장합니다. 최대 20자의 영숫자 문자를 사용할 수 있게 됩니다.

Done
탭해 Live Set Edit을 닫고 Live Set 화면을 표시합니다.

Live Set Slot 1–16
선택한 Live Set에 등록된 퍼포먼스의 목록을 표시합니다.

[+] (Add)
탭해 선택한 퍼포먼스를 해당 슬롯에 등록합니다.

Job
작업 메뉴를 불러옵니다.

•	 Copy

복사 기능을 켭니다.

슬롯 복사 소스를 선택하고 Copy를 누른 후 슬롯 복사 대상을 선택하면 설정을 복사할 수 있습니다.

설정: Off, On

•	 Exchange

교환 기능을 켭니다.

첫 번째 슬롯을 선택하고 Exchange를 탭한 후 두 번째 슬롯을 선택하면 설정을 교환할 수 있습니다.

설정: Off, On

•	 Delete

슬롯을 선택한 후 Delete을 탭해 등록한 퍼포먼스 및 다른 설정을 슬롯에서 삭제합니다.

•	 Delete & Move

슬롯을 선택한 후 Delete & Move를 탭해 등록한 퍼포먼스 및 다른 설정을 슬롯에서 삭제하고 이후 슬롯으로 이동합니다.
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Slot Type
슬롯 형식을 선택합니다.

설정: 	 Perform, Song, Audio, Pattern

Perform: 퍼포먼스만을 슬롯에 등록합니다.

Song: 퍼포먼스와 곡을 슬롯에 등록합니다.

Audio: 퍼포먼스와 오디오 파일을 슬롯에 등록합니다.

Pattern: 퍼포먼스와 패턴을 슬롯에 등록합니다.

Slot Name
Song Name
Audio Name
Pattern Name
Slot Type이 Perform일 때 Slot Name을 표시합니다.

이름을 탭하면 화면 건반이 표시되어 현재 슬롯에 대한 이름을 입력할 수 있게 됩니다. 최대 20자의 영숫자 문자를 사용할 수 있습니다.

Slot Type이 Pattern이면 Pattern Name이 표시됩니다. Song인 경우에는 Song Name이 표시되며, Audio이면 Audio Name이 

표시됩니다. 등록한 패턴, 곡 또는 오디오가 표시됩니다. 이름을 탭하면 Utility Load 화면이 표시됩니다. 그러면 등록하려는 패턴, 곡 

또는 오디오를 선택할 수 있습니다.

Performance (Performance Name)
선택한 슬롯에 등록된 퍼포먼스 이름을 표시합니다.

탭하면 Performance Category Search 화면이 나타납니다.

Color
선택한 슬롯의 색상을 설정합니다.

설정: Black, Red, Yellow, Green, Blue, Azure, Pink, Orange, Purple, Sakura, Cream, Lime, Aqua, Beige, Mint, Lilac

Volume
선택한 슬롯에 등록된 퍼포먼스 음량을 설정합니다.

SSS Time
선택한 슬롯의 SSS Time을 조정합니다. SSS Time을 설정한 경우 연주 중에 퍼포먼스를 변경해도 연주되는 음향이 Note Off로 

설정되어 있다면 음향이 설정된 시간 후 페이드 아웃됩니다.

설정: 0.0sec – 30sec, Hold, System

Live Set 화면을 통해 패턴, 곡 또는 오디오 파일 재생

작업 

[LIVE SET] (또는 상단 패널의 LIVE SET 아이콘 탭하기) → User Bank 선택 → Slot 선택 → [] (재생) 버튼

주
•	패턴 또는 곡 재생 중에는 퍼포먼스 및 슬롯을 변경할 수 없습니다. 변경하려고 시도하면 오류 메시지가 나타납니다.

•	패턴, 곡 또는 오디오 파일 재생 중 [] (재생) 버튼을 누르면 패턴, 곡 또는 오디오 파일 재생 화면이 열립니다.
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Utility 화면

Utility 화면은 전체 악기의 공통 항목을 설정할 때 사용됩니다.

Settings

Sound

Sound 화면은 악기에서 출력되는 음향을 설정할 때 사용됩니다.

작업

[UTILITY] → Settings → Sound

Tone Generator Volume
악기에서 출력되는 음향의 전체 음량을 설정합니다.

설정: 0–127

Tone Generator Note Shift
악기의 톤 제너레이터 블록에 의해 생성된 전체 음향의 피치를 반음 단위로 조정합니다.

설정: −24–+0–+24

Tone Generator Tune
악기의 톤 제너레이터 블록에 의해 생성된 전체 음향의 튜닝을 반음 단위로 조정합니다. 피치를 센트 단위로 미세 조정할 수 있습니다.

설정: −102.4–+0.0–+102.3

SSS Time
악기의 톤 제너레이터 블록에 의해 생성된 전체 음향의 SSS Time을 조정합니다. 선택한 경우 Live Set Slot의 SSS Time이 적용됩니다.

설정: 0.0sec – 30sec, Hold, System
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Keyboard Octave Shift
건반 피치를 옥타브 단위로 이동합니다. 이 파라미터는 상단 패널의 [OCTAVE] 버튼과 연결되어 있습니다.

설정: −3–+0–+3

주
Keyboard Octave Shift 설정은 다음 번 프로그램을 시작할 때 0으로 설정됩니다.

Keyboard Transpose
건반 피치를 반음 단위로 이동합니다.

설정: −11semi –+0semi–+11semi

주
•	피치가 음원 섹션이 재생할 수 있는 범위(C-2/G8)를 초과할 경우 한 옥타브 높은 음이 출력됩니다.

•	Keyboard Transpose 설정은 다음 번 프로그램을 시작할 때 +0semi로 설정됩니다.

Keyboard Velocity Curve
건반을 연주하는 강도에 따라 세기가 어떻게 표현되는지를 결정하기 위한 세기 곡선을 설정합니다.

그래프의 수평축은 건반을 연주하는 강도를 의미하고 수직축은 건반의 세기 출력을 의미합니다.

설정: 	 Normal, Soft 1, Soft 2, Hard 1, Hard 2, Wide, Fixed

Normal: 건반을 누르는 강도 및 세기가 비례하는 가장 일반적인 곡선

Soft 1: 증가한 응답을 제공합니다.

Soft 2: Soft 1과 Normal 사이의 곡선

Hard 1: 감소한 응답을 제공합니다.

Hard 2: Hard 1과 Normal 사이의 곡선

Wide: 가벼운 터치로 세기를 억제하고 강한 터치로 세기를 더욱 뚜렷하게 하는 곡선. 넓은 다이나믹 레인지를 제공합니다.

Fixed: 건반을 누르는 강도와 상관없이 고정된 세기를 제공하는 음원을 생성하고 싶을 때 사용합니다. Keyboard Fixed Velocity에 설정된 

값이 세기 값으로 사용됩니다.

Keyboard Fixed Velocity
건반 연주의 강도와 상관없이 톤 제너레이터에 고정된 세기를 전송합니다.

Keyboard Velocity Curve 파라미터를 Fixed로 설정한 경우에만 유효합니다.

설정: 1–127

Sustain Pedal (Sustain Pedal Select)
후면 패널의 FOOT SWITCH [SUSTAIN] 잭에 연결된 풋스위치의 형식을 선택합니다.

•	 FC3, FC3A(하프 댐퍼 기능 활성화)

FC3A (Half On)을 선택합니다. 하프 댐퍼 기능을 사용할 필요가 없다면 FC3A (Half Off)를 선택합니다.

•	 FC4, FC4A, FC5

FC4A 또는 FC5를 선택합니다. 하프 댐퍼 기능은 FC4, FC4A 및 FC5와 함께 사용할 수 없습니다.

•	 극성이 역전된 페달

Reverse Polarity를 선택합니다. 하프 댐퍼 기능을 이용할 수 없습니다.

설정: FC3A (Half On), FC3A (Half Off), FC4A/FC5, Reverse Polarity

주
하프 댐퍼 연주에 외부 MIDI 장치의 컨트롤 변경을 사용할 경우 Sustain Pedal (Sustain Pedal Select) 설정은 필요하지 않습니다.
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Global Tuning (Global Micro Tuning Switch)
이 파라미터가 켜짐인 경우 전체 설정의 미세 튜닝 설정이 퍼포먼스의 각 파트에 대한 미세 튜닝 설정보다 우선합니다. 이 파라미터는 드럼 

파트 이외의 모든 파트에 적용됩니다.

설정: Off, On

주
Global Tuning (Global Micro Tuning Switch) 설정은 다음 번 프로그램을 시작할 때 꺼짐으로 설정됩니다.

Micro Tuning Name (Global Micro Tuning Name)
선택한 미세 튜닝의 이름을 표시합니다. 이름을 탭하면 미세 튜닝 선택 메뉴를 불러올 수 있습니다.

설정: 	 Preset: Equal Temperament, Pure Major, Pure Minor, Werckmeister, Kirnberger, Vallotti & Young, 1/4 shift, 1/4 tone, 1/8 

tone, Indian, Arabic1, Arabic2, Arabic3  

User: Init Tuning1–8  

Library: 라이브러리 이름(라이브러리 파일을 불러온 경우)

Root (Global Micro Tuning Root)
미세 튜닝의 근음을 설정합니다. Micro Tuning Name에서 선택한 형식에 근음이 필요하지 않는 경우에는 이 파라미터가 표시되지 

않습니다.

설정: C–B

Edit User Tuning
User Micro Tuning 설정 창을 엽니다.
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Quick Setup

이 기능을 사용하면 설정 그룹만 선택해도 외부 장치를 최적값에 연결할 때 필요한 모든 항목을 설정할 수 있습니다.

다수의 설정 화면에 걸친 파라미터를 의도한 목적에 맞도록 한 번에 설정할 수 있습니다.

작업

[QUICK SETUP]

[UTILITY] → Settings → Quick Setup

Audio Signal Flow
현재 오디오 신호 흐름도를 표시합니다.

표시된 신호 흐름은 USB [TO HOST] 단자의 연결 상태 및 악기의 기타 설정에 따라 달라집니다.

MIDI Signal Flow
현재 MIDI 신호 흐름도를 표시합니다.

신호 흐름도는 악기의 설정에 따라 달라집니다.

Quick Setup (Quick Setup Select)
Quick Setup을 선택합니다.

설정: 	 Standalone, MIDI Rec on DAW (Setup No.1), Audio Rec on DAW (Setup No.1), With Plugin Host App (Setup No.3)

각 Quick Setup에 저장된 파라미터는 다음과 같습니다.

오디오 설정 Direct Monitor

MIDI 설정 Local Control

퍼포먼스 설정 Part 1–16 Output Select
A/D In Output Select
Digital In Output Select
Part 1–8 Keyboard Control Switch
Part 1–16 Part Mode
Part 1–16 Transmit Channel

오디오 설정 파라미터와 MIDI 설정 파라미터의 MIDI I/O는 Audio I/O를 참조하십시오.
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Quick Setup 초기 설정

•	 Standalone
악기만 사용하거나 악기를 통해 외부 장치를 작동하기 위한 설정입니다.

Direct Monitor Local Control Output Select Keyboard Sw Part Mode Transmit Ch

On On Main L&R Part 1–8: On Part 1–16: Int Part 1–16: Ch 1–16

•	 MIDI Rec on DAW
DAW 소프트웨어의 MIDI에 퍼포먼스를 녹음하기 위한 설정

Direct Monitor Local Control Output Select Keyboard Sw Part Mode Transmit Ch

On Off Main L&R Part 1–8: On Part 1–16: Int Part 1–16: Ch 1–16

•	 Audio Rec on DAW
내부 톤 제너레이터의 각 파트를 개별적인 오디오 트랙으로 DAW에 녹음하기 위한 설정

Direct Monitor Local Control Output Select Keyboard Sw Part Mode Transmit Ch

Off On Different for each 
Part

Part 1–8: On Part 1–16: Int Part 1–16: Ch 1–16

•	 With Plugin Host App
사운드 제너레이터 플러그인이 내장된 내부 톤 제너레이터를 컴퓨터에서 사용하기 위한 설정

Direct Monitor Local Control Output Select Keyboard Sw Part Mode Transmit Ch

On On Main L&R Part 1–5: On
Part 6–8: Off

Part 1–4: Int
Part 5–16: Ext

Part 1–4: Ch 1–4
Part 5–8: Ch 1–4
Part 9–16: Ch 9–16

Store Current Settings
Quick Setup의 Setup No.1–3 중 하나에 현재 설정을 저장할 수 있습니다.
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Audio I/O

Audio I/O 화면에서 오디오 신호 입력 및 출력을 설정할 수 있습니다.

작업

[UTILITY] → Settings → Audio I/O

Audio Signal Flow
현재 오디오 신호 흐름도를 표시합니다.

표시된 신호 흐름은 USB [TO HOST] 단자의 연결 상태 및 악기의 기타 설정에 따라 달라집니다.

A/D Input (A/D Input Gain)
A/D INPUT 잭의 입력 게인을 Mic 또는 Line으로 설정합니다.

설정: 	 Mic, Line

Mic: 마이크와 같이 출력 레벨이 낮은 장치에 사용됩니다.

Line: 신디사이저나 오디오 장치와 같이 출력 레벨이 높은 장치에 사용됩니다.

주
액티브 픽업을 갖춘 기타 또는 베이스를 직접 연결할 수 있습니다. 반면, 패시브 픽업을 사용할 때에는 이펙트 유닛 또는 다이렉트 박스를 통해 악기를 

연결하십시오.

USB Volume (USB Input Volume)
USB [TO HOST] 단자에서 전송되는 오디오 신호 입력의 음량을 조정합니다.

설정: 0–127

주
USB 입력 음량은 각 퍼포먼스 기준이 아닌 시스템 전체 설정에 저장됩니다.

Direct Monitor
Main L&R, USB Main 또는 USB 1–8 채널에서 외부 장치(예: 컴퓨터)로 오디오 신호 출력을 설정해도 본 악기에서 재생할 수 

있습니다(직접 모니터링).

이 파라미터를 켜짐으로 설정하면 Main L&R, USB Main 및 USB 1–8 채널도 본 악기의 OUTPUT [L/MONO] 및 [R] 잭과 

[PHONES] 잭으로 출력됩니다. USB로 연결되지 않은 경우 자동으로 켜집니다.

설정: Off, On
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Main L&R (Analog Output L&R Output Gain)
OUTPUT [L/MONO] 및 [R] 단자 채널의 출력 게인을 설정합니다.

설정: −6dB, +0dB, +6dB, +12dB

USB Main (USB Main L&R Output Gain)
USB [TO HOST] 단자 메인 L&R 채널의 출력 게인을 설정합니다.

설정: −6dB, +0dB, +6dB, +12dB

USB 1-8 (USB Individual Output Gain)
USB [TO HOST] 단자 채널 1~8의 출력 게인을 설정합니다.

설정: −6dB, +0dB, +6dB, +12dB

Monitor Volume
Monitor Volume 화면이 나타납니다.
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MIDI I/O

MIDI 입력 및 출력은 MIDI I/O 화면에서 설정됩니다.

작업 

[UTILITY] → Settings → MIDI I/O

Quick Setup 아이콘 탭하기

MIDI Signal Flow
현재 MIDI 신호 흐름도를 표시합니다. 이 흐름도는 악기의 설정에 따라 달라집니다.

MIDI Signal Flow의 Local Control 스위치 근처를 누르면 Local Control을 켜거나 끌 수 있습니다.

MIDI IN/OUT
MIDI 메시지를 전송/수신할 때 사용되는 단자를 선택합니다.

설정: MIDI, USB

MIDI Thru
MIDI [OUT] 단자가 MIDI Thru 단자로 사용되는지 여부를 지정합니다. 

설정: Off, On

Local Control
로컬 컨트롤을 켜거나 끕니다.

로컬 컨트롤을 꺼짐으로 설정한 경우 악기의 컨트롤러 블록 및 톤 제너레이터 블록이 분리되며 건반을 연주해도 음향이 들리지 않습니다.

그러나 이 설정과는 상관없이 본 악기의 건반 퍼포먼스는 MIDI 메시지로 전송됩니다. 또한, MIDI 입력 메시지는 톤 제너레이터 블록에 

의해 처리됩니다.

설정: Off, On

MIDI I/O Channel
Common 및 Keyboard Control Switch가 켜짐으로 설정될 파트의 입력 및 출력에 대한 MIDI 채널을 설정합니다.

설정: Ch1–Ch16
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MIDI Sync
연결된 외부 장치와의 동기화와 관련된 파라미터를 설정합니다.

아르페지오, 모션 시퀀서, 곡 및 패턴을 재생하려면 본 악기의 내장 클록이나 컴퓨터에 설치된 DAW 소프트웨어의 외부 MIDI 클록 또는 

A/D INPUT 잭에서 전송되는 오디오 신호 입력을 선택합니다.

설정: 	 Internal, MIDI, A/D In (ABS)

Internal: 내장 클록에 동기화됩니다. 자체적으로 사용하거나 다른 장치의 마스터 클록 소스로 본 악기를 사용할 때 적용됩니다.

MIDI: 외부 MIDI 장치에서 수신된 MIDI 클록에 동기화됩니다. 마스터 클록 소스로 외부 장치를 사용할 때 적용됩니다.

A/D In (ABS): Audio Beat Sync 기능을 사용해 템포를 A/D INPUT 단자에서 전송되는 오디오 신호 입력에서 추출하여 작동합니다.

Clock Out (MIDI Clock Out)
전송할 MIDI 클록 메시지를 설정합니다.

설정: Off, On

Receive (Receive Sequencer Control)
곡 시작/정지를 위해 MIDI 메시지를 수신합니다.

설정: Off, On

Transmit (Transmit Sequencer Control)
곡 시작/정지를 위해 MIDI 메시지를 전송합니다.

설정: Off, On

Controller Hold/Reset
퍼포먼스를 서로 전환할 때 모듈레이션 휠, 애프터터치, 풋 컨트롤러 및 브레스 컨트롤러와 같은 컨트롤러의 현재 설정(Hold)을 사용할지 

초기 설정(Reset)으로 재설정할지 설정합니다.

설정: 	 Hold, Reset

Reset으로 설정한 경우 아래와 같이 퍼포먼스를 서로 전환하면 컨트롤러가 재설정됩니다.

피치 벤드 중앙

모듈레이션 휠 최소

애프터터치 최소

풋 컨트롤러 최대

풋스위치 꺼짐

리본 컨트롤러 중앙

브레스 컨트롤러 최대

표현 최대

지정 가능 스위치 1 및 2 꺼짐

[KEYBOARD HOLD] 버튼 꺼짐

모션 시퀀서의 각 레인 레인의 Motion Seq Polarity를 켜짐으로 설정한 경우 Unipolar: 값은 0(최소값)
레인의 Motion Seq Polarity를 켜짐으로 설정한 경우 Bipolar: 값은 64(중앙)

FS Assign (FootSwitch Assign Control Number)
FOOT SWITCH [ASSIGNABLE] 잭에 연결된 풋스위치를 작동하여 생성되는 컨트롤 변경 번호를 설정합니다. 본 악기가 여기에서 

지정했던 동일한 컨트롤 변경 번호를 갖춘 MIDI 메시지를 외부 MIDI 장치에서 수신하면 풋스위치를 조작한 것처럼 악기가 작동합니다.

설정: Off, 1–95, Arp Sw, MS Sw, Play/Stop, Live Set+, Live Set−, Oct Reset, Tap Tempo
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Super Knob CC (Super Knob Control Change Number)
수퍼 노브를 작동하여 생성되는 컨트롤 변경 번호를 설정합니다.

본 악기가 여기에서 지정했던 동일한 컨트롤 변경 번호를 갖춘 MIDI 메시지를 외부 MIDI 장치에서 수신하면 수퍼 노브를 조작한 것처럼 

악기가 작동합니다.

설정: Off, 1–95

주

이 파라미터를 꺼짐으로 설정한 경우 MIDI 메시지를 취급할 때 시스템 전용(SysEx)이 사용됩니다.

Scene CC (Scene Control Change Number)
Scene을 서로 전환할 때 생성되는 컨트롤 변경 번호를 설정합니다.

또한, 여기에서 설정했던 동일한 컨트롤 변경 번호를 갖춘 MIDI 메시지가 외부 MIDI 장치에서 수신되어도 Scene이 변경됩니다.

설정: Off, 1–95

주
•	컨트롤 변경 번호에 따라 Scene 1~8 중 하나가 선택됩니다.  

0–15: Scene 1, 16–31: Scene 2, 32–47: Scene 3, 48–63: Scene 4, 64–79: Scene 5, 80–95: Scene 6, 96–111: Scene 7, 112–127: 

Scene 8

•	Super Knob CC 번호와 Scene CC 번호를 동일한 값으로 설정하면 해당 번호 앞에 느낌표가 나타납니다. 이 경우, Scene 컨트롤 변경이 우선하며 

수퍼 노브 컨트롤 변경은 비활성화됩니다.

Control Number
Common Edit 화면의 Control → Control Number를 엽니다.
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Advanced

Advanced 화면에서 자세한 악기 설정을 실시할 수 있습니다.

작업 

[UTILITY] → Settings → Advanced

Audition Lock
오디션 잠금을 켜거나 끕니다. 켜짐으로 설정한 경우 오디션 기능이 비활성화됩니다.

설정: Off, On

Audition Loop
이 파라미터를 켜짐으로 설정한 경우 오디션 프레이즈가 순환 재생됩니다.

이 파라미터를 꺼짐으로 설정한 경우 곡이 끝까지 연주되면 오디션 프레이즈가 자동으로 정지됩니다.

설정: Off, On

Kbd Hold Lock (Keyboard Hold Lock)
건반 고정 기능을 켜짐 또는 꺼짐으로 전환합니다. 켜짐으로 설정한 경우 건반 고정 기능이 비활성화됩니다.

이 파라미터는 [KEYBOARD HOLD] 버튼과 연계하여 작동합니다.

설정: Off, On

Auto Power Off (Auto Power Off Time)
자동 꺼짐은 실수로 장치를 켜놓아서 불필요한 전력 소모가 되지 않도록 장치가 일정 기간 동안 작동되지 않을 때 전원을 자동으로 끄는 

기능입니다.

여기에서 악기의 전원이 자동으로 꺼질 때까지의 시간을 설정할 수 있습니다.

설정: Off (Auto Power Off 비활성화), 5min, 10min, 15min, 30min, 60min, 120min

Device Number
MIDI 장치 번호를 설정합니다. 외부 MIDI 장치와의 시스템 전용 메시지(예: 벌크 덤프 및 파라미터 변경)를 전송/수신하는 경우, 이 

번호를 설정하여 다른 장치의 번호에 맞춰야 합니다.

설정: 1–16, All, Off
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Bank Select (Receive/Transmit Bank Select)
악기와 외부 MIDI 장치 간 뱅크 선택 메시지의 수신/전송 여부를 설정합니다.

켜짐으로 설정한 경우 악기가 외부 MIDI 장치에서 전송되는 뱅크 선택 메시지를 수신하거나 인식합니다.

설정: Off, On

Pgm Change (Receive/Transmit Program Change)
악기와 외부 MIDI 장치 간 프로그램 변경 메시지의 수신/전송 여부를 설정합니다.

켜짐으로 설정한 경우 악기가 외부 MIDI 장치에서 전송되는 프로그램 변경 메시지를 수신하거나 인식합니다.

설정: Off, On

Receive Bulk
벌크 덤프 메시지의 수신 여부를 설정합니다.

설정: Protect(수신하지 않음), On(수신함)

Bulk Interval
본 악기가 외부 장치에서 벌크 요청 메시지를 수신할 때 벌크 데이터 전송 간격 시간을 설정합니다.

설정: 0–900ms

Sequencer Event Chase (Song Event Chase)
이 파라미터는 예를 들어, 중간부터 곡을 재생하거나 앞으로(빨리 감기) 및 뒤로(되감기) 작동 시 지정된 이벤트가 올바르게 인식되도록 

보장합니다.

그러면 MIDI Event Chase로 설정된 이벤트가 앞으로/뒤로 작동을 통해 올바르게 기능합니다.

설정: Off, PC (Program Change), PC+PB+Ctrl (Program Change+Pitch Bend+Control Change)

Init On Boot (Initialize User Data on Boot-up)
시작할 때 데이터를 초기화 할지(On) 또는 하지 않을지(Off) 여부를 설정합니다.

설정: Off, On

Audio I/O Mode
USB [TO HOST] 단자에서 전송되는 오디오 신호 출력의 모드를 전환합니다.

악기를 재부팅해야 이 설정이 적용됩니다.

설정: 	 5 Stereo/44.1kHz, 1 Stereo/44.1–96kHz

5 Stereo/44.1kHz: 샘플링 주파수 44.1kHz에서 최대 10개의 채널(5개의 스테레오 채널)

1 Stereo/44.1-96kHz: 샘플링 주파수 44.1kHz-96kHz에서 최대 2개의 채널(1개의 스테레오 채널)

주
1 Stereo/44.1-96kHz로 설정할 경우 이용할 수 있는 주파수: 44.1/48/96kHz

Legacy Mode
MIDI 2.0 대신 MIDI 1.0을 사용하려면 이 파라미터를 켜짐으로 설정하십시오.

악기를 재부팅해야 이 설정이 적용됩니다.

설정: Off, On

Initialize Advanced Settings
Advanced 화면에서 설정을 초기화합니다.
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System

System 화면에서 전체 악기와 관련된 파라미터를 설정할 수 있습니다.

작업 

[UTILITY] → Settings → System

[UTILITY] + [DAW REMOTE] (→ Calibrate Touch Panel 설정)

Power on Mode
악기의 전원을 켤 때 표시되도록 화면을 설정합니다.

설정: Perform, Live Set

Calibrate Touch Panel
터치스크린 보정 화면을 엽니다. 터치스크린이 올바르게 응답하지 않을 때 사용합니다.

Initial Live Set Bank (Initial Live Set Bank)
Initial Live Set Page (Initial Live Set Page)
Initial Live Set Slot (Initial Live Set Slot)
Power on Mode를 Live Set으로 설정하면 Live Set 슬롯이 시작 즉시 선택됩니다.

주
Live Set 화면에서 퍼포먼스를 선택하고 이 화면을 연 후 Set Current Slot 버튼을 눌러도 슬롯을 설정할 수 있습니다.

Set Current Slot (Set Current Slot to Initial Live Set)
시작 후 선택한 Live Set 슬롯에 현재 퍼포먼스를 설정합니다.

Initialize All Settings
모든 Utility 화면 설정을 초기화합니다.

Animation
화면이 전환될 때 애니메이션을 켜거나 끌지 여부를 설정합니다.

설정: Off, On



374MODX M 사용설명서

Beep
터치스크린 작동음을 켜거나 끕니다.

설정: Off, On

Part Display
Part Name을 설정하여 카테고리 또는 파트 형식을 표시하거나 파트 이름만 표시합니다.

설정: Type, Name

Live Set Font
Live Set 화면과 Category Search 화면에서 내용 이름과 카테고리 이름의 글씨 크기를 결정합니다.

설정: Normal, Large

Initialize User Data
사용자 메모리의 사용자 데이터(퍼포먼스, 모션 시퀀스, 라이브 세트 등)와 Utility 화면의 설정을 모두 초기화합니다.

Knob Flash (Super Knob LED Blink)
수퍼 노브의 점멸 기능을 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

KnobBrightness
수퍼 노브 조명 밝기를 제어합니다.

설정: 0–128

Half Glow (LED Half Glow Brightness)
버튼 램프의 감광을 제어합니다.

설정: Off, 1/4, 1/2

Perf Inc/Dec
Home 화면에서 퍼포먼스를 켜는 방법을 설정합니다.

설정: 	 Default, Live Set

Default: Performance Category Search 화면의 퍼포먼스 목록의 순서를 전환합니다.

Live Set: Live Set 슬롯의 순서를 전환합니다.

Initialize All Data
사용자 메모리의 모든 데이터와 Utility 화면 설정을 초기화합니다.

Product Info
악기의 펌웨어 버전을 표시합니다.

주의사항

초기화는 대상 데이터 및 시스템을 공장 설정으로 덮어쓰기합니다.

중요한 데이터가 사라지지 않도록 주의하십시오. USB 플래시 드라이브에 미리 필요한 설정을 저장하는 것도 좋습니다.
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Contents

Load

파일 및 내부 데이터를 Load 화면을 사용해 불러옵니다.

작업

[UTILITY] → Contents → Load

[SHIFT] + [STORE]

Content Type
모든 데이터나 특정 데이터 세트를 USB 플래시 드라이브에 저장된 단일 파일이나 악기에 저장된 설정에서 불러올 수 있습니다. 

여기에서는 파일의 어떤 데이터 세트를 불러올지 선택할 수 있습니다.

이용 가능한 설정은 화면을 열기 위해 취하는 경로에 따라 달라집니다.

설정: 불러올 수 있는 파일 형식은 다음과 같습니다.

내용 형식 장치 형식 파일 확장자 설명

User File 파일 .Y2U
(.Y2W)
.X7U
.X8U

•	USB 드라이브에 저장된 사용자 파일을 사용자 메모리의 사용자 영역으로 
불러올 수 있습니다.

•	사용자 파일이 분할된 경우 .Y2U와 .Y2W 모두 USB 드라이브에 저장해야 
합니다.

•	다음 설정이 사용자 파일에 포함됩니다.  
Performance, Arpeggio, Motion Sequence, Curve, Live Set, 
Microtuning, Waveform, Audition, Utility Settings(.Y2U만 해당), 
Quick Setup(.Y2U만 해당)

Library File 파일 .Y2L
(.Y2M)
.X7L
.X8L

•	USB 드라이브에 저장된 라이브러리 파일을 사용자 메모리의 라이브러리 
영역으로 불러올 수 있습니다.

•	라이브러리 파일이 분할된 경우 .Y2L과 .Y2M 모두 USB 드라이브에 
저장해야 합니다.

•	다음 설정이 사용자 파일에 포함됩니다.  
Performance, Arpeggio, Motion Sequence, Curve, Live Set (1 bank 
only), Microtuning, Waveform, Audition

Backup File 파일 .Y2A
(.Y2B)
.X7A
.X8A

•	USB 드라이브에 저장된 백업 파일을 사용자 메모리로 불러올 수 있습니다.

•	백업 파일에는 사용자 및 라이브러리 영역의 모든 데이터와 곡 및 패턴이 
포함되어 있습니다.

•	백업 파일이 분할된 경우 .Y2A와 .Y2B 모두 USB 드라이브에 저장해야 
합니다.
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내용 형식 장치 형식 파일 확장자 설명

Song&Perf
(Song & Performance)

내부 데이터 •	지정한 곡만 사용자 메모리의 사용자 영역에 저장된 곡에서 불러올 수 
있습니다.

•	MIDI 시퀀스와 퍼포먼스 모두 불러올 수 있습니다.

Song 내부 데이터 •	지정한 곡만 사용자 메모리의 사용자 영역에 저장된 곡에서 불러올 수 
있습니다.

•	MIDI 시퀀스 데이터만 불러올 수 있습니다.

.mid File 파일 .MID USB 드라이브에 저장된 (형식 0 또는 1의) 표준 MIDI 파일(SMF)을 불러올 수 
있습니다

.wav File 파일 .WAV USB 드라이브에 저장된 오디오 파일을 불러올 수 있습니다.

Pattern&Perf
(Pattern & Performance)

내부 데이터 •	지정한 패턴만 사용자 메모리의 사용자 영역에 저장된 패턴에서 불러올 수 
있습니다.

•	MIDI 시퀀스와 퍼포먼스 모두 불러올 수 있습니다.

Pattern 내부 데이터 •	지정한 패턴만 사용자 메모리의 사용자 영역에 저장된 패턴에서 불러올 수 
있습니다.

•	MIDI 시퀀스 데이터만 불러올 수 있습니다.

Audio File* 파일 .WAV
.AIF

USB 드라이브에 저장된 오디오 파일을 파형으로 불러올 수 있습니다.
예: [PERFORMANCE (HOME)] → [EDIT/ ] → Part 선택 → Element 
선택 → Osc/Tune

Motion Seq
(Motion Sequence)*

내부 데이터 지정한 시퀀스만 사용자 메모리의 사용자 영역에 저장된 모션 시퀀스에서 
불러올 수 있습니다.

Smart Morph* 내부 데이터 Smart Morph 데이터만 사용자 메모리의 사용자 영역에 저장된 퍼포먼스에서 
불러올 수 있습니다.

주
Utility 화면에서 이 화면을 여는 경우 별표(*)가 있는 내용 형식은 표시되지 않습니다.

Parent Folder Name
Current Folder Name
상위 폴더 이름 및 현재 폴더 이름을 표시합니다.

상위 폴더 이름을 탭하면 현재 폴더가 됩니다.

Job
Job 기능이 활성화되었는지(켜짐) 아닌지(꺼짐) 여부를 설정합니다.

이 파라미터를 켠 경우 현재 파일, 폴더 또는 내용을 누르면 Rename 또는 Delete 콘텍스트 메뉴가 표시됩니다.

연결된 USB 플래시 드라이브를 누르면 Format 콘텍스트 메뉴가 표시됩니다.

설정: Off, On
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Free Storage
선택한 저장 공간의 사용한 용량 및 전체 용량을 표시합니다.

표시는 내용 형식에 따라 달라집니다.

Folder file select
현재 폴더 안의 폴더 및 파일을 표시합니다.

Sort
File select의 파일에 대한 정렬 순서를 설정합니다.

설정: 	 Name, Size, Date, Default (내용 형식에 따라 달라짐)

Name: 이름별로 정렬합니다. 아래 방향 화살표는 목록이 오름차순(A에서 Z로)으로 배열된다는 의미입니다. 위 방향 화살표는 목록이 

내림차순으로 배열된다는 의미입니다.

Size: 데이터 크기 순서대로 정렬합니다. 아래 방향 화살표는 목록이 오름차순(작은 크기에서 큰 크기로)으로 배열된다는 의미입니다.  

위 방향 화살표는 목록이 내림차순으로 배열된다는 의미입니다. 내용 형식 Motion Seq, Song, Song&Perf, Pattern, Pattern&Perf, 

Performance, Smart Morph에 대해서는 무효합니다.

Date: 설정 저장일별로 분류합니다. 아래 방향 화살표는 목록이 내림차순(신규에서 기존으로)으로 배열된다는 의미입니다. 위 방향 화살표는 

목록이 오름차순으로 배열된다는 의미입니다. 내용 형식이 Motion Seq, Song, Song&Perf, Pattern, Pattern&Perf, Performance, 

Smart Morph인 경우에만 이용할 수 있습니다.

Default: 내용 번호 오름차순으로 정렬합니다. 내용 형식이 Song, Song&Perf, Pattern, Pattern&Perf, Performance, Motion Seq,  

Smart Morph인 경우에만 이용할 수 있습니다

Mode
불러올 모드를 선택합니다.

User File 또는 Library File에 대해서만 표시됩니다.

설정: 	 Default, 1 Perf

Default: 모든 퍼포먼스를 불러옵니다.

1 Perf: 지정한 퍼포먼스만 불러옵니다.

Key (Center Key)
불러온 WAV 또는 AIFF가 지정될 건반을 선택합니다.

오디오 파일에만 표시됩니다.

설정: Keyboard Select (C−2 −G8), All

Keyboard Select
건반 작동으로 Center Key가 업데이트되는지 설정합니다.

오디오 파일에만 표시됩니다.

Page
File select에 표시된 파일이 단일 페이지에 적합하지 않으면 스크롤 버튼이 나타나므로 페이지를 선택할 수 있습니다. 또는 디스플레이 

노브를 사용하여 페이지를 선택할 수도 있습니다.
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Save

Save 화면에서 파일 및 데이터를 불러올 수 있습니다.

기본적으로 Load 화면과 동일합니다.

작업

[UTILITY] → Contents → Save

Content Type
USB 드라이브나 본체에 저장된 파일의 모든 데이터 또는 데이터의 지정된 부분을 검색하여 악기로 불러올 수 있습니다.

여기에서 어떤 데이터를 저장할지 설정할 수 있습니다.

이용 가능한 설정은 화면을 열기 위해 취하는 경로에 따라 달라집니다.

설정: 다음 표에는 저장할 수 있는 내용 형식이 수록되어 있습니다.

내용 형식 장치 형식 파일 확장자 설명

Performance 내부 데이터 사용자 메모리의 사용자 영역에 퍼포먼스를 저장합니다.

User File 파일 .Y2U
(.Y2W)

•	사용자 메모리의 사용자 영역에 저장된 설정은 USB 드라이브에 사용자 
파일로 저장됩니다.

•	다음 설정이 사용자 파일에 포함됩니다.  
Performance, Arpeggio, Motion Sequence, Curve, Live Set, 
Microtuning, Waveform, Audition, Utility Settings, Quick Setup

•	파일 크기가 2GB가 넘는 파일이 분할된 상태이면 .Y2U와 .Y2W 모두 통째로 
처리해야 합니다.

Library File 파일 .Y2L
(.Y2M)

•	사용자 메모리의 사용자 영역에 저장된 설정은 USB 드라이브에 라이브러리 
파일로 저장됩니다.

•	라이브러리 파일에 포함되는 설정은 다음과 같습니다(유틸리티 설정을 
제외하고 사용자 파일과 동일).  
Performance, Arpeggio, Motion Sequence, Curve, Live Set (1 bank 
only), Microtuning, Waveform, Audition

•	파일 크기가 2GB가 넘는 파일이 분할된 상태이면 .Y2L과 .Y2M 모두 통째로 
처리해야 합니다.

Backup File 파일 .Y2A
(.Y2B)

•	사용자 메모리에 저장된 설정은 USB 드라이브에 백업 파일로 저장됩니다.

•	백업 파일에는 사용자 및 라이브러리 영역의 모든 데이터와 곡 및 패턴이 
포함되어 있습니다.

•	파일 크기가 2GB가 넘는 파일이 분할된 상태이면 .Y2A와 .Y2B 모두 통째로 
처리해야 합니다.
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내용 형식 장치 형식 파일 확장자 설명

.mid File 파일 .MID 사용자 메모리의 곡 및 패턴 영역에 저장된 MIDI 데이터는 USB 드라이브에 
표준 MIDI 파일(SMF: 형식 1만 해당)로 저장됩니다.

Motion Seq
(Motion Sequence)*

내부 데이터 편집 중인 모션 시퀀스를 사용자 영역에 저장합니다.

주
Utility 화면에서 이 화면을 여는 경우 별표(*)가 있는 내용 형식은 표시되지 않습니다.
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Data Utility

Data Utility 화면에서 사용자 메모리의 파일 및 데이터를 관리할 수 있습니다.

기본적으로 Load 화면과 동일합니다.

작업 

[UTILITY] → Contents → Data Utility

Folder select
사용자 메모리의 내용 형식을 폴더로 표시합니다. 폴더를 탭하면 열립니다.

내용 형식: Arp, Audition, Curve, Library, Live Set, Micro Tuning, Motion Seq, Pattern, Performance, Song, Waveform

Content Select
내용을 누르면 Rename, Delete 컨텍스트 메뉴가 표시됩니다.

Job을 켜짐으로 설정하면 다음 세 항목이 표시됩니다.

Select All
폴더의 모든 내용을 선택합니다.

선택한 내용이 없는 경우 표시됩니다.

Unselect All
폴더의 모든 내용을 선택 해제합니다.

선택한 내용이 있는 경우 표시됩니다.

Delete
선택한 모든 내용을 삭제합니다.

선택한 내용이 있는 경우 표시됩니다.
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Library Import

이 기능은 라이브러리에서 특정 퍼포먼스를 선택해 이 퍼포먼스를 사용자 뱅크로 복사합니다.

기본적으로 Load 화면과 동일합니다.

작업

[UTILITY] → Contents → Library Import

Select All
현재 라이브러리 폴더의 모든 퍼포먼스를 선택합니다.

선택한 퍼포먼스가 없는 경우에만 표시됩니다.

Unselect All
현재 라이브러리 폴더의 모든 퍼포먼스를 선택 해제합니다.

선택한 퍼포먼스가 있는 경우에만 표시됩니다.

Import to User Bank
선택한 퍼포먼스를 유저 뱅크에 복사합니다.

이 작업을 실시한 경우 선택한 퍼포먼스에 사용된 사용자 파형 및 사용자 아르페지오, 사용자 곡선, 사용자 미세 튜닝 및 사용자 오디션도 

유저 뱅크에 복사됩니다.

선택한 퍼포먼스가 있는 경우에만 표시됩니다.
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Tempo Settings

Tempo Settings 화면에서 템포 및 동기화 관련 파라미터를 설정할 수 있습니다.

작업

[TEMPO/TAP]

[UTILITY] + Tempo Settings

TEMPO SETTINGS 아이콘 탭하기

Tempo
퍼포먼스 템포를 설정합니다.

MIDI Sync가 MIDI 또는 A/D In (ABS)로 설정되고 외부 장치와 동기화될 경우 설정값 대신 Ex.Tempo가 표시됩니다.

설정: 5–300

Knob Flash (Super Knob LED Blink)
수퍼 노브의 점멸 기능을 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Global Tempo
이 파라미터를 꺼짐으로 설정한 경우 각 퍼포먼스의 템포 설정이 사용됩니다.

켜짐으로 설정한 경우에는 퍼포먼스를 변경해도 현재 템포가 유지됩니다.

설정: Off, On

Tap Tempo
커서가 표시될 때 영역을 탭하거나 [ENTER] 버튼을 누르면(탭하면) 속도를 탭하거나 눌러 템포를 설정할 수 있습니다.

[TEMPO/TAP] 버튼을 사용하여 동일한 방법으로 템포를 설정해도 됩니다.

그러나 MIDI Sync를 MIDI로 설정하고 악기를 외부 장치와 동기화로 설정한 경우에는 이 파라미터를 이용할 수 없습니다.

주
MIDI Sync를 “A/D In (ABS)”로 설정할 경우 탭하기가 박자의 시작 역할을 하여 템포가 변경됩니다.
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MIDI Sync
연결된 외부 장치와의 동기화와 관련된 파라미터를 설정합니다.

악기의 내장 클록, DAW 소프트웨어 또는 본 장치와 연결된 MIDI 장치의 클록(외부 클록) 또는 A/D INPUT 잭에서 전송되는 오디오 신호 

입력을 사용하여 아르페지오, 모션 시퀀서 및 곡을 재생할지 선택할 수 있습니다.
설정: 	 Internal, MIDI, A/D In (ABS)

Internal: 내장 클록에 동기화됩니다. 자체적으로 사용하거나 다른 장치의 마스터 클록 소스로 본 악기를 사용할 때 적용됩니다.
MIDI: 외부 MIDI 장치에서 수신된 MIDI 클록에 동기화됩니다. 마스터 클록 소스로 외부 장치를 사용할 때 적용됩니다.
A/D In (ABS): Audio Beat Sync 기능을 사용해 템포를 A/D INPUT 단자에서 전송되는 오디오 신호 입력에서 추출하여 작동합니다.

Clock Out (MIDI Clock Out)
전송할 MIDI 클록 메시지를 설정합니다.
설정: Off, On

Sync Quantize (Arpeggio Synchro Quantize Value)
다중 파트에 대해 아르페지오를 재생할 경우 다음 아르페지오 시작 타이밍을 조정합니다. 꺼짐으로 설정된 경우 건반에서 파트를 연주할 

때 아르페지오가 재생됩니다.
설정: “Off, 60(32분 음표), 80(16분 음표의 셋잇단음표), 120(16분 음표), 160(8분 음표의 셋잇단음표), 240(8분 음표), 320(4분 음표의 

셋잇단음표), 480(4분 음표)”

Mode (Click Mode)
클릭음(메트로놈음)의 재생 타이밍을 설정합니다.
설정: 	 Off, Rec, Rec/Play, Always

Off: 클릭음이 재생되지 않습니다.
Rec: 곡 또는 패턴 녹음 중 클릭음이 재생됩니다.
Rec/Play: 곡 또는 패턴 녹음이나 재생 중 클릭음이 재생됩니다.
Always: 클릭음이 항상 재생됩니다.

주
클릭음은 내부 톤 제너레이터를 사용해 재생하므로 일부 동시 음향 출력이 사용됩니다.

Precount (Click Precount)
곡 또는 패턴을 녹음할 때 [] (재생) 버튼을 누른 순간부터 실제로 녹음이 시작될 때까지 카운트인 소절의 수를 설정합니다.
설정: Off ([] (재생) 버튼을 누른 순간부터 녹음이 시작됨), 1meas–8meas

Volume (Click Volume)
클릭음의 음량을 설정합니다.
설정: 0–127

Beat (Click Beat)
클릭음이 연주되는 비트를 설정합니다.
설정: 1/16(16분 음표), 1/8(8분 음표), 1/4(4분 음표), 1/2(2분 음표), Whole(온음표)

Type (Click Type)
클릭음의 형식을 선택합니다.
설정: 1–10

Click Out (Click Output Select)
클릭음의 출력 대상을 설정합니다.
설정: 	 MainL&R, (AsgnL&R), USB Stereo, (AsgnL), (AsgnR), USB mono

MainL&R: OUTPUT [L/MONO] 및 OUTPUT [R] 잭으로 스테레오(2개의 채널)로 출력됩니다.
USB Stereo: USB [TO HOST] 단자로 스테레오(채널 1 및 2~채널 7 및 8)로 출력됩니다.
USB mono: USB [TO HOST] 단자로 모노(채널 1~8)로 출력됩니다.

주
MONTAGE M과의 데이터 호환 설정은 아래 표시되어 있습니다. 설정 시에는 꺼짐으로 간주됩니다.
•	AsgnL&R
•	USB Stereo: USB9&10 – USB29&30
•	USB mono: USB9 – USB30
•	AsgnL
•	AsgnR
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Effect Switch

Effect Switch 화면에서 이펙트 바이패스 관련 파라미터를 설정할 수 있습니다.

이 화면의 설정은 저장되지 않으므로 악기를 재시작하면 기본값으로 재설정됩니다.

작업 

[UTILITY] → Effect Switch

EFFECT 아이콘( FX ) 탭하기

[SHIFT] + [QUICK SETUP]

Insertion FX (Insertion Effect)
인서트 이펙트를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

System FX (System Effect)
시스템 이펙트를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Master FX (Master Effect)
마스터 이펙트를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Master EQ
마스터 EQ를 켜짐 또는 꺼짐으로 설정합니다.

설정: Off, On

Arp Bypass (Arpeggio Bypass)
아르페지오 건너뛰기를 켜짐 또는 꺼짐으로 설정합니다. 이 파라미터를 켜짐으로 설정한 경우 모든 아르페지오 작업이 비활성화됩니다.

설정: Off, On

주
•	Arp Bypass가 켜져 있으면 [ARP] 버튼이 깜박입니다.

•	Arp Bypass가 켜짐으로 설정된 경우 각 파트에 대해 Arpeggio Switch를 전환하면 Arp Bypass가 꺼짐으로 설정됩니다.

•	아르페지오 기능을 사용하여 녹음한 곡의 경우 데이터에 아르페지오 시퀀스가 포함됩니다. DAW 소프트웨어에서 곡 데이터를 계속 편집할 경우 Arp 

Bypass를 켜짐으로 설정하면 아르페지에이터의 이중 이펙트를 방지할 수 있습니다.
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Kbd Ctrl Lock (Keyboard Control Lock)
컨반 컨트롤 잠금을 켜짐 또는 꺼짐으로 설정합니다.

켜짐으로 설정할 경우, 잠금이 활성화되어 모든 파트의 Keyboard Control이 비활성화됩니다. 끄면 건반 컨트롤이 잠금해제됩니다.

각 MIDI 트랙을 개별적으로 생성하거나 편집할 때, 특히 DAW 소프트웨어와 함께 16파트 다중 음색 사운드 모듈로 악기를 사용할 때 

유용합니다.

설정: Off, On

주
Kbd Ctrl Lock이 켜져 있으면 각 파트의 Keyboard Control SW를 변경할 경우 Kbd Ctrl Lock이 꺼짐으로 설정됩니다.

Global A/D
이 파라미터를 켜짐으로 설정한 경우, 퍼포먼스를 서로 전환할 때 A/D 파트는 변하지 않으며 A/D 파트와 관련된 다른 파라미터도 변하지 

않습니다. 이 파라미터를 꺼짐으로 설정한 경우, 퍼포먼스를 서로 전환할 때 음량은 퍼포먼스에 특정한 설정으로 변경되며 A/D 파트와 

관련된 다른 파라미터가 변경됩니다.

Master FX와 Master EQ가 동시에 켜지고 꺼집니다.

설정: Off, On
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Other Info

기타 정보는 Other Info 화면에 표시됩니다.

Shift Function

[SHIFT] 버튼과 다른 버튼을 동시에 누를 때 사용되는 단축키 작업 목록을 표시합니다.

Legal Notices

저작권과 같은 내용을 표시합니다.
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특정 버튼을 눌러 표시되는 화면

Panel Lock

패널 잠금 기능을 사용하면 라이브 연주 중 우발적인 작동을 방지할 수 있습니다.

작업 

Home 화면 또는 Live Set 화면이 표시될 때 [SHIFT] + [TEMPO/TAP] 누르기

	� 유효한 작업
건반, 페달, 마스터 볼륨, 슈퍼 노브, 피치 벤드 휠, 모듈레이션 휠, 리본 컨트롤러 및 패널 잠금 해제

	� 무효한 작업
터치스크린 작업을 포함한 모든 다른 작업

패널 잠금 해제 방법

패널을 잠금 해제하려면 [TEMPO/TAP] 버튼을 누른 상태에서 [SHIFT] 버튼을 눌러 패널을 잠금 해제합니다.
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Split Job

스플릿을 설정합니다.

작업 

[SPLIT] 버튼을 누릅니다.

Split Points
분리점 수를 지정합니다.

설정: Off, 1–3

Split Point 1–3
분리점에 대한 건반을 지정합니다.

Keyboard를 켜짐으로 설정한 경우 건반을 사용해 분할 지점 위치도 지정할 수 있습니다.

설정: C#−2 – G8

Part Name
파트 이름을 탭하면 Category Search 및 Delete의 콘텍스트 메뉴가 표시됩니다.

[+](Add)
탭하면 Part Category Search 화면 또는 Performance Merge 화면이 나타나 파트를 추가할 수 있게 됩니다.

Group A–D
Group 버튼을 눌러 파트를 그룹에 지정합니다.

[SHIFT] 버튼을 누른 상태에서 Group 버튼을 눌러 단일 파트를 다수 그룹에 지정합니다.

× (Cancel)
그룹 지정을 취소합니다.

Done
설정을 확인하고 화면을 닫습니다.

주
좌측 상단의 ×(닫기)를 누르면 파트 추가, 삭제 또는 변경을 제외한 설정을 확인하지 않고 화면을 닫습니다.
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Note Range

작업

[SHIFT] + [SPLIT]

Home 화면에 Part - Note 보기가 표시됩니다.

커서가 선택한 파트의 TG Note Limit Low로 이동하며, 건반에서 음 범위의 하한을 입력할 수 있습니다.

Navigation

작업 

[NAVIGATION] 버튼 누르기

(Home 화면 View Mode가 Default로 설정된 경우) 화면에 표시된 Navigation 탭하기 

아이콘을 누르면 해당 설정 화면이 표시됩니다.

편집 중 [NAVIGATION] 버튼을 눌러도 현재 위치 아이콘( )을 불러올 수 있습니다.

Navigation 화면에서 요소 및 Part Common의 Filter 및 Amp EG로 점프할 수 있습니다.



390MODX M 사용설명서

FX Overview

FX OVERVIEW 화면에서 이펙트 설정 상태를 확인하고 고급 설정 화면에 쉽게 접근할 수 있습니다.

작업 

[SHIFT] + [NAVIGATION]

(Home 화면 View Mode가 Default로 설정된 경우) 화면에 표시된 Fx Overview 탭하기

Switching Parts for display
표시할 파트를 전환합니다.

설정: 1–4, 5–8, 9–12, 13–16, A/D In

All Ins
모든 인서트 이펙트(A와 B)를 켜거나 끕니다.

설정: Off, On

Var + Rev
변주 또는 비브라토 이펙트를 켜거나 끕니다.

설정: Off, On

Ins A, Ins B, Var, Rev, MFX, MEQ
세부 설정에 해당되는 화면을 표시합니다.

Effect switch
각 이펙트를 켜거나 끕니다.

설정: Off, On

Type
각 이펙트의 유형을 설정합니다.

설정: 이펙트 형식을 참조합니다.

Preset
각 이펙트의 내장 설정을 설정합니다.

설정: Data List 참조
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Store

사용자 영역에 현재 퍼포먼스를 저장할 때 사용되는 확인 화면입니다.

Store As New Performance
새 퍼포먼스로 등록합니다.

Update Current Live Set Slot
사용자 Live Set 뱅크의 슬롯을 선택한 경우 Live Set 슬롯 업데이트 확인 메시지가 나타납니다. 업데이트를 진행할 때 상자에 

체크표시를 한 후 Store As New Performance를 선택합니다.

Overwrite Current Perf.
화면에 표시된 기존 설정(뱅크, MSB, LSB 및 프로그램 변경 번호)에 편집 중인 퍼포먼스를 저장합니다.

Jump to Data Utility
Performance full 등의 오류에 의해 저장이 불가능할 경우 표시됩니다.

[UTILITY] → Contents → Data Utility를 사용해 화면을 표시합니다.
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DAW Remote

[DAW REMOTE] 버튼을 누르면 DAW Remote 기능을 사용할 수 있어 악기의 컨트롤러로 선호하는 DAW를 편리하게 제어할 수 

있습니다.

작업

[DAW REMOTE]

Mode (Remote Control Mode)
3가지 작동 모드 중에서 DAW Remote 기능을 선택합니다.

설정: 	 Track, Plugin, Transport

Track: DAW에서 다수의 트랙을 한 번에 제어할 때 사용되는 모드입니다. 노브 및 컨트롤러 슬라이더 작동은 포트 2에서 Mackie Control 

호환 프로토콜로 전송됩니다.

Plugin: DAW에서 특정 플러그인을 제어할 때 사용되는 모드입니다. 노브 및 컨트롤러 슬라이더 작동은 포트 1에서 Remote 기능에 대한 CC 

Number의 형식으로 전송됩니다.

Transport: DAW에 녹음된 데이터를 재생하면서 건반을 연주하거나 DAW에 건반 연주를 녹음할 때 사용되는 모드입니다. 시퀀서 전송 

버튼을 사용하면 DAW에서 재생을 시작하고 중지시킬 수 있습니다. 시퀀서 전송 버튼을 제외한 모든 컨트롤러는 평소와 같이 작동합니다.

화면 전환
각 컨트롤러 및 Remote 기능의 설정 화면을 엽니다.

설정: Knob/Slider, Scene Sw, Display Knob, AS, Pedal, Settings

Local Control
로컬 컨트롤을 켜짐 또는 꺼짐으로 설정합니다.

[UTILITY] → Settings → MIDI I/O에서의 설정과 동일합니다.

Use for Remote Cursor / Dial
DAW를 제어할 수 있도록 상단 패널의 데이터 다이얼 및 커서 버튼을 사용할지 여부를 설정합니다.

켜짐: DAW를 제어합니다.

꺼짐: 상단 패널의 메인 화면을 제어합니다.

Track (Track Select)
트랙 그룹 선택 사항(한 번에 8개의 트랙)을 출력합니다.
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컨트롤러 사용 시

	� Track 모드

컨트롤러

(1) (2)

(3) (4) (5)

(6)

(7)

(4)

컨트롤러 DAW 작동

(1) [ASSIGN] 버튼 팬 선택(1~4 / 5~8)

(2) 노브 1~4(5~8) 트랙 팬은 포트 2에서 출력됩니다.

(3) 컨트롤 슬라이더 1~8 트랙 음량은 포트 2에서 출력됩니다.

(4) PART 버튼, [PART SELECT] 버튼 트랙을 선택하며, 선택한 트랙의 음소거 및 솔로 기능을 켜짐 또는 

꺼짐으로 설정합니다.

(5) SCENE 버튼 기능 1~8은 포트 2에서 출력됩니다.

(6) 데이터 다이얼, 커서 버튼 커서 위치 또는 곡 위치를 옮깁니다.

(7) 시퀀서 전송 버튼.  

[SONG/PATTERN] 버튼

전송 작동(녹음 및 재생)을 제어합니다.

다른 컨트롤러는 Remote 모드에서 설정한 컨트롤 변경 메시지를 전송하도록 설정됩니다.
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	� Plugin 모드

컨트롤러

(1) (2)

컨트롤러 DAW 작동

(1) [ASSIGN] 버튼 노브 선택(1~4 / 5~8)

(2) 노브(1~4 / 5~8), 컨트롤러 슬라이더 1~8, 

SCENE 버튼, 화면 노브

선택한 컨트롤 변경

(DAW Remote 화면의 Edit에 설정된 CC 번호가 출력됩니다.)

PART 버튼, [PART SELECT] 버튼, [KEYBOARD CONTROL] 버튼, 데이터 다이얼, 커서 버튼, 시퀀서 전송 버튼, BANK 버튼 및 

PAGE 버튼은 Track 모드에서와 동일하게 작동합니다.
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	� Transport 모드

컨트롤러

(1)

(2)

컨트롤러 DAW 작동

(1) 데이터 다이얼, 커서 버튼 커서 위치 또는 곡 위치를 옮깁니다.

(2) 시퀀서 전송 버튼.  

[SONG/PATTERN] 버튼

전송 작동(녹음 및 재생)을 제어합니다.

다른 컨트롤러는 평소대로 작동합니다.
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Edit 중

Edit
포트 1에서 출력된 컨트롤 변경 메시지(예: 컨트롤 번호 및 채널 번호)를 설정합니다.

각 탭의 설정은 다음과 같습니다.

	� 공통

Local (Local Control)
로컬 컨트롤을 켜짐 또는 꺼짐으로 설정합니다.

[UTILITY] → Settings → MIDI I/O에서의 설정과 동일합니다.

Use for Remote Cursor / Dial
DAW를 제어할 수 있도록 상단 패널의 데이터 다이얼 및 커서 버튼을 사용할지 여부를 설정합니다.

On: DAW를 제어합니다.

Off: 상단 패널의 메인 화면을 제어합니다.

	� Knob / Slider

CC Num. (Control Change Number)
노브 및 컨트롤 슬라이더의 컨트롤 번호를 설정합니다.

설정: 1–95

	� Scene SW

Scene1–8CC# (Scene 1–8 Control Number)
SCENE 버튼의 컨트롤 번호를 설정합니다.

설정: 1–95

Latch/Momentary (Scene 1–8 Switch Mode)
SCENE 버튼의 작동 모드를 전환합니다.

설정: Momentary, Latch

	� Display Knob

DispKnob 1–6CC# (Display Knob 1–6 Control Number)
화면 노브의 컨트롤 번호를 설정합니다.

설정: 1–95

AS 
Porta Sw CC# (Portamento Switch Control Number)
[PORTAMENTO] 버튼의 컨트롤 번호를 설정합니다.

설정: 1–95

Latch/Momentary (Portamento Switch Mode)
[PORTAMENTO] 버튼의 작동 모드를 전환합니다.

설정: Momentary, Latch

Porta Knob CC# (Portamento Knob Control Number)
PORTAMENTO [TIME] 노브의 컨트롤 번호를 설정합니다.

설정: 1–95
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AssignSw 1 CC# (Assignable Switch 1 Control Number)
AssignSw 2 CC# (Assignable Switch 2 Control Number)
MS Trigger CC# (Motion Seq Trigger Switch Control Number)
[ASSIGN 1] 버튼, [ASSIGN 2] 버튼 및 [MSEQ TRIGGER] 버튼의 컨트롤 번호를 설정합니다.

설정: 1–95

Assign SW 1 Latch/Momentary (Assignable Switch 1 Mode)
Assign SW 2 Latch/Momentary (Assignable Switch 2 Mode)
MS Trigger Latch/Momentary (Motion Seq Trigger Switch Mode)
[ASSIGN 1] 버튼, [ASSIGN 2] 버튼 및 [MSEQ TRIGGER] 버튼의 작동 모드를 전환합니다.

설정: Momentary, Latch

	� Pedal

FC 1 CC# (Foot Controller 1 Control Number)
FC 2 CC# (Foot Controller 2 Control Number)
풋 컨트롤러 1 및 풋 컨트롤러 2의 컨트롤 번호를 설정합니다.

설정: 1–95

FS CC# (Foot Switch Control Number)
풋스위치의 컨트롤 번호를 표시합니다.

설정: 1–95

Latch/Momentary (Foot Switch Mode)
풋스위치의 작동 모드를 전환합니다.

설정: Momentary, Latch

	� Settings

DAW
본 악기와 함께 사용할 특정 DAW를 선택합니다.

설정: Cubase, Logic Pro, Pro Tools, Live

MIDI I/O Ch.
Common 및 Keyboard Control Switch가 켜짐으로 설정될 파트의 입력 및 출력에 대한 MIDI 채널을 설정합니다.

여기에서 설정된 MIDI 채널은 DAW Remote에서 컨트롤 변경 메시지를 전송할 때에도 사용됩니다.

[UTILITY] → Settings → MIDI I/O에서의 설정과 동일합니다.

설정: Ch1–Ch16



398MODX M 사용설명서

Control Assign

Controller Set의 Source와 Destination의 조합을 등록합니다.

작업 

화면에서 컨트롤러에 지정할 수 있는 파라미터를 선택하면서 [CONTROL ASSIGN]을 누릅니다.

대상 파라미터 조정에 사용하는 컨트롤러를 작동하거나 화면에서 Motion Sequencer Lane, Envelope Follower 또는 Ribbon을 

선택합니다.

주
•	수퍼 노브를 움직이고 있으나 설정을 진행할 미사용 지정 노브가 없는 경우 오류 메시지가 나타납니다.

•	Part 파라미터를 선택한 경우 지정 가능 노브를 작동하면서 [COMMON] 버튼을 눌러 Common의 지정 가능한 노브를 선택합니다.
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Control View

작동 중인 컨트롤러의 설정을 확인할 수 있습니다.

작업 

[SHIFT] + [CONTROL ASSIGN]

(Home 화면이 View Mode Default로 설정된 경우) 화면에 표시된 Control View 탭하기)

확인하려는 컨트롤러를 작동하거나 화면에서 Motion Sequencer Lane, Envelope Follower 또는 Ribbon을 선택합니다. 설정 정보를 

볼 수 있는 Control Assign 화면이 열립니다.
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7.	 기타 정보

이펙트 형식

No Effect 이펙트를 비활성화합니다. 음향을 출력하지 않습니다.

Thru 이펙트를 Thru로 설정합니다. 입력된 음향은 이펙트가 적용되지 않은 상태로 출력됩니다.

Reverb

HD Hall 콘서트 홀의 자연스러운 음향을 재현합니다.

REV-X Hall REV-X 리버브 알고리즘을 사용한 홀 리버브입니다.

R3 Hall ProR3 디지털 리버브 프로세서의 리버브 알고리즘을 사용한 홀 리버브입니다.

SPX Hall 클래식 SPX1000의 홀 리버브입니다.

HD Room 실내의 자연스러운 음향을 재현합니다.

REV-X Room REV-X 리버브 알고리즘을 사용한 룸 리버브입니다.

R3 Room ProR3 디지털 리버브 프로세서의 리버브 알고리즘을 사용한 룸 리버브입니다.

SPX Room 클래식 SPX1000의 룸 리버브입니다.

HD Plate 플레이트 리버브를 재현합니다.

R3 Plate ProR3 디지털 리버브 프로세서의 리버브 알고리즘을 사용한 플레이트 리버브입니다.

SPX Stage 클래식 SPX1000의 스테이지 리버브입니다.

Space Simulator 실내 규모의 폭, 높이 및 깊이를 지정할 수 있습니다.

Gated Reverb 게이티드 리버브를 생성합니다.

Reverse Reverb 게이티드 리버브를 역재생합니다.

Shimmer Reverb 피치가 변경된 리버브 음향을 추가하여 신비롭게 일렁거리는 이펙트를 창출합니다.

Delay

Cross Delay 두 채널 각각의 딜레이 음향 피드백이 반대쪽 채널에 배치됩니다.
좌측 및 우측에서 대체 딜레이 음향을 생성합니다.

Tempo Cross Delay 템포 동기화 크로스 딜레이입니다.

Tempo Delay Mono 템포 동기화 모노 딜레이입니다.

Tempo Delay Stereo 템포 동기화 스테레오 딜레이입니다.

Control Delay 딜레이 길이를 실시간으로 변경하여 스크래치 음향을 생성할 때 사용되는 딜레이입니다.

Delay LR 2개의 피드백 딜레이로 좌측 및 우측에서 2개의 딜레이 음향을 생성합니다.

Delay LCR 좌측, 중앙 및 우측에서 3개의 딜레이 음향을 생성합니다.

Analog Delay Retro 짧은 딜레이로 설정된 버킷 브리게이드 아날로그 딜레이를 재현합니다.

Analog Delay Modern 긴 딜레이로 설정된 버킷 브리게이드 아날로그 딜레이를 재현합니다.
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Chorus

G Chorus 모듈레이션이 복잡한 깊은 음향을 생성합니다.

2 Modulator 피치 모듈레이션 및 진폭 모듈레이션을 설정할 수 있습니다. 음향을 자연스럽게 확산시킵니다.

SPX Chorus 3상 LFO를 사용하여 음향에 모듈레이션과 공간감을 가미하는 코러스 이펙트입니다.

Symphonic 공간감이 더욱 더 느껴지도록 모듈레이션을 다중화합니다.

Ensemble Detune 피치가 약간 변조된 음향을 추가하여 생성된 모듈레이션 없는 코러스 이펙트입니다.

Flanger

VCM Flanger VCM 기술을 사용한 플랜저입니다.

Classic Flanger 일반적인 소용돌이 같은 음향이 포함된 플랜저입니다.

Tempo Flanger 템포 동기화된 LFO가 포함된 플랜저입니다.

Dynamic Flanger 입력 음향의 레벨에 따라 딜레이 모듈레이션을 실시간으로 제어하는 플랜저입니다.

Control Flanger LFO 대신 수동 작동을 허용합니다.

Phaser

VCM Phaser Mono VCM 기술을 사용한 모노 페이저입니다.

VCM Phaser Stereo VCM 기술을 사용한 스테레오 페이저입니다.

Tempo Phaser 템포 동기화된 LFO가 포함된 페이저입니다.

Dynamic Phaser 입력 음향의 레벨에 따라 위상을 실시간으로 제어하는 플랜저입니다.

Control Phaser LFO 대신 수동 작동을 허용합니다.

Trem/Rtr (Tremolo & Rotary)

Auto Pan 팬을 좌우로 움직입니다.

Tremolo 주기적으로 음량을 변경합니다.

Rotary Speaker 1 로터리 스피커를 재현합니다.

Rotary Speaker 2 앰프를 포함한 로터리 스피커를 재현합니다.

VCM Rotary Speaker 
Classic

VCM 기술을 사용한 표준 로터리 스피커 이펙트입니다. 오르간에 적합합니다.

VCM Rotary Speaker 
Overdrive

VCM 기술을 사용한 로터리 스피커 이펙트입니다. 트랜지스터 프리앰프가 연결된 로터리 스피커의 왜곡된 음향을 
재현합니다.

VCM Rotary Speaker 
Studio

3차원 회전과 함께 VCM 기술을 사용한 로터리 스피커 이펙트입니다.

Dist (Distortion)

Amp Simulator 1 기타 앰프를 재현합니다.

Amp Simulator 2 기타 앰프를 재현합니다.

Comp Distortion 컴프레션과 디스토션을 결합합니다.

Comp Distortion Delay 컴프레션, 디스토션, 딜레이를 결합합니다.

U.S. Combo 아메리칸 콤보 앰프 시뮬레이터입니다.

Jazz Combo 재즈 콤보 앰프 시뮬레이터입니다.

U.S. High Gain 아메리칸 하이 게인 앰프 시뮬레이터입니다.

British Lead 브리티시 스택 앰프 시뮬레이터입니다.

Multi FX 기타에 사용되는 멀티 이펙트 프로세서입니다.

Small Stereo 기타 음향의 스테레오 디스토션입니다.

British Combo 브리티시 콤보 앰프 시뮬레이터입니다.

British Legend 브리티시 스택 앰프 시뮬레이터입니다.
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Comp (Compressor)

VCM Compressor 376 VCM 기술을 사용한 컴프레서입니다.

Classic Compressor 간편하고 사용하기 쉬운 컴프레서입니다. 독주 악기에 적합합니다.

Multi-band Comp 3개의 대역으로 음향을 분리하고 이러한 대역에 개별적으로 컴프레서를 적용합니다.

Uni Comp Down 큰 음향을 억제하는 하향 알고리즘이 내장된 컴프레서입니다.

Uni Comp Up 부드러운 음향을 증폭시키는 상향 알고리즘이 내장된 컴프레서입니다.

Parallel Comp 압축된 음향 및 dry 음향의 병렬 처리를 적용하는 컴프레서입니다.

Wah

VCM Auto Wah VCM 기술을 사용한 Auto Wah입니다. 주기적으로 필터의 중심 주파수를 변경합니다.

VCM Touch Wah VCM 기술을 사용한 Touch Wah입니다. 입력 음향의 레벨에 따라 필터의 중심 주파수를 변경합니다.

VCM Pedal Wah VCM 기술을 사용한 Pedal Wah입니다. 페달과 같은 컨트롤러를 조작하여 필터의 중심 주파수를 변경합니다.

Lo-Fi

Lo-Fi Lo-Fi 음향의 오디오 입력 품질을 저하시킵니다.

Noisy 음향에 노이즈를 추가합니다.

Digital Turntable 음향에 턴테이블 노이즈를 추가합니다.

Bit Crusher 디지털 음향의 분해능 또는 대역폭을 감소시켜 디스토션을 생성합니다.

Tech

Ring Modulator 입력을 금속성 음향으로 변화시킵니다.

Dynamic Ring Modulator 입력 음향의 레벨에 따라 링 모듈레이터의 OSC Freq 파라미터가 실시간으로 제어됩니다.

Dynamic Filter 입력 음향의 레벨에 따라 필터 차단 주파수가 실시간으로 제어됩니다.

Auto Synth 딜레이 및 모듈레이션을 사용하여 입력 신호를 재합성합니다.

Spiralizer P 상하 피치 변화가 무한해 보이는 특수 페이저 기반 필터입니다.

Tempo Spiralizer P 템포 동기화된 LFO가 포함된 스파이럴라이저입니다.

Spiralizer F 상하 피치 변화가 무한해 보이는 특수 플랜저 기반 필터입니다.

Tempo Spiralizer F 템포 동기화된 LFO가 포함된 스파이럴라이저입니다.

Isolator 강력한 필터를 사용하여 각 대역의 음량을 제어합니다.

Slice 입력 음향의 진폭 EG를 슬라이스 처리합니다.

Tech Modulation 특수 모듈레이션을 적용합니다.

Control Filter 수동으로 차단 주파수를 작동할 수 있는 필터입니다.

Vinyl Break 서서히 피치를 떨어뜨려 손을 사용하거나 장치의 전원을 꺼 정지시킨 턴테이블의 음향 이펙트를 생성합니다.

Beat Repeat (even) 샘플링된 음향을 반복적으로 연주하여 기계적인 비트를 추가합니다. 반복 길이는 분모가 짝수 번호인 박자(예: 1/2, 
1/4, 1/8, 1/16 등)의 일부분으로 지정됩니다.

Beat Repeat (triplet) 샘플링된 음향을 반복적으로 연주하여 기계적인 비트를 추가합니다. 반복 길이는 분모가 3배수인 박자(예: 1/3, 1/6, 
1/12 등)의 일부분으로 지정됩니다.

Beat Repeat (even+tri.) 샘플링된 음향을 반복적으로 연주하여 기계적인 비트를 추가합니다.
짝수 및 3분 음표 설정 모두 포함합니다.

Beat Repeat (free) 샘플링된 음향을 반복적으로 연주하여 기계적인 비트를 추가합니다. 반복 길이가 소수로 지정됩니다.
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Misc

VCM EQ 501 VCM 기술을 사용한 5대역 EQ입니다.

Presence 입력 음향의 음향 프레즌스를 향상시킵니다.

Harmonic Enhancer 입력 음향이 두드러지도록 배음을 추가합니다.

Stereophonic Optimizer 음장의 스테레오 필드를 조정합니다.

Talking Modulator 입력 음향을 재합성하여 바우얼 포먼트를 생성합니다.

Wave Folder 배음을 제어하여 시간 경과에 따라 변하는 풍부한 음향을 생성합니다.

VCM Mini Filter 음향에 두께와 깊이를 더해주는 필터입니다. 아날로그 신디사이저 회로를 재현합니다.

VCM Mini Booster 뚜렷한 특성을 갖춘 부스터입니다. 아날로그 신디사이저 회로를 재현합니다.

Damper Resonance 어쿠스틱 피아노의 개방 현 음 공명을 재현합니다.

Pitch Change 입력 신호의 피치를 변경합니다.

Early Reflection 리버브의 초기 반향을 격리시켜 생성되는 이펙트입니다.

Vocoder 마이크 음향에서 특징을 추출하여 건반에서 연주되는 파트에 적용합니다. 악기의 음향이 로봇 음색과 같은 음향으로 
변합니다.

NoiseGate+Comp+Eq 노이즈 게이트, 컴프레서 및 3대역 EQ를 포함합니다.
주로 음성에 적합합니다.
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이펙트 파라미터

A

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

AEG Phase AEG Phase Slice 진폭 EG의 위상을 이동시킵니다.

AM Depth AM Depth 2 Modulator, Tremolo, Noisy, 
Auto Synth, Shimmer Reverb

진폭 모듈레이션의 깊이를 설정합니다.

AM Freq AM Frequency Shimmer Reverb 진폭 모듈레이션 속도를 설정합니다.

AM Inverse R AM Inverse R Auto Synth 우측 채널에 대한 진폭 모듈레이션의 위상을 
설정합니다.

AM LR Phase AM LR Phase Shimmer Reverb L 및 R 채널에 대한 진폭 모듈레이션의 위상을 
설정합니다.

AM Speed AM Speed Noisy, Auto Synth 진폭 모듈레이션 속도를 설정합니다.

AM Wave AM Wave Auto Synth 진폭을 변조할 때 사용되는 음파를 선택합니다.

AM Waveform AM Waveforms Shimmer Reverb 진폭을 변조할 때 사용되는 음파를 선택합니다.

Amp Type Amp Type Amp Simulator 2 재현할 앰프 형식을 선택합니다.

Analog Feel Analog Feel Classic Flanger 음향에 아날로그 플랜저의 특성을 더합니다.

Attack Attack Comp Distortion, VCM 
Compressor 376, Classic 
Compressor, Downward 
Compressor, Upward 
Compressor

컴프레서가 최대값에 이를 때까지 소요되는 시간을 
설정합니다.

Attack Offset Attack Offset VCM Touch Wah 와와 이펙트가 최대값에 이를 때까지 소요되는 시간을 
설정합니다.

Attack Time Attack Time Dynamic Flanger, Dynamic 
Phaser, Dynamic Ring 
Modulator, Dynamic Filter

엔벌로프 팔로워의 어택 타임을 설정합니다.

Beat Repeat 전체 음향에 적용되는 Gate의 Attack 타임을 
설정합니다.

B

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Balance Balance U.S. Combo 저음과 고음 간 밸런스를 조정합니다.

Bass Bass British Combo, British Lead, 
British Legend, Jazz Combo, U.S. 
High Gain

저음의 음질을 조정합니다.

Bit Bit Bit Crusher 비트 해상도를 감소시킵니다.

Bit Assign Bit Assign Lo-Fi Word Length가 어떻게 음향에 적용되는지 
설정합니다.

Bit Link Bit Link Bit Crusher M/S가 켜짐일 때 Mid 값을 따르는 Side 레벨을 
설정합니다.

BPF 1–10 Gain BPF1–10 Gain Vocoder 보코더 이펙트 BPF 1~10의 Gain을 설정합니다.

Break Break Vinyl Break Break를 켜짐으로 설정합니다.

Brilliant Brilliant British Combo 저음이 차단되는 음향의 음량을 조정합니다.
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화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Chorus Chorus Jazz Combo 코러스 형식을 선택합니다.

Click Density Click Density Digital Turntable 반복할 클릭음의 주파수를 설정합니다.

Click Level Click Level Digital Turntable 클릭 레벨을 설정합니다.

Clipper Clipper Upward Compressor, Downward 
Compressor

음파를 제한하기 위한 최대 레벨을 결정하는 클리퍼의 
디스토션 레벨을 설정합니다.

Clipper Source Clipper Source Upward Compressor, Downward 
Compressor

클리퍼 이펙트가 적용되는 신호를 선택합니다.

Color Color Control Phaser, VCM Phaser 
Mono, VCM Phaser Stereo

고정된 위상 모듈레이션을 설정합니다.

Com Release Common Release Multi Band Comp 3개의 대역에 공통적으로 사용되는 릴리스 
타임(컴프레서 이펙트가 사라질 때까지 소요되는 
시간)을 설정합니다.

Comp Attack Comp Attack NoiseGate+Comp+Eq 컴프레서가 적용될 시간을 설정합니다.

Comp Level Comp Level Small Stereo 컴프레서의 출력 레벨을 조정합니다.

Comp Out Lvl Comp Output Level NoiseGate+Comp+Eq 컴프레서의 출력 레벨을 설정합니다.

Comp Ratio Comp Ratio NoiseGate+Comp+Eq 컴프레서의 비율을 설정합니다.

Comp Release Comp Release NoiseGate+Comp+Eq 컴프레서 이펙트가 사라질 때까지 소요되는 시간을 
설정합니다.

Comp Sustain Comp Sustain Multi FX, Small Stereo 컴프레서가 유지될 시간을 설정합니다.

Comp Sw Comp SW Small Stereo 컴프레서를 켜거나 끕니다.

Comp Threshold Comp Threshold NoiseGate+Comp+Eq 이펙트가 적용될 입력 레벨을 설정합니다.

Compress Compress Comp Distortion Delay 컴프레서가 적용될 한계값(또는 최소 입력 레벨)을 
설정합니다.

Compression Compression Parallel Compressor 컴프레서가 적용되는 정도를 설정합니다.

Control Type Control Type Control Delay Normal로 설정한 경우, 딜레이 이펙트가 항상 음향에 
적용됩니다. Scratch로 설정한 경우, 컨트롤러 값 
0을 Delay Time에 설정하더라도 딜레이 이펙트가 
적용되지 않습니다. 딜레이가 다른 경우에 적용됩니다.

Cross-Feedback Cross-Feedback Shimmer Reverb 피치 변조 음향 피드백의 반대 경로에 전송되도록 첫 
번째 경로의 피치 변조 음향 밸런스를 설정하고 두 번째 
경로의 피치 음향을 설정합니다.

Crush Type Crush Type Bit Crusher 비트 해상도가 어떻게 감소되는지 설정합니다.

Cut Cut British Combo 음향 끝부분에 세기 곡선을 설정합니다.

Cutoff Cutoff Frequency Beat Repeat 고주파수를 차단합니다

VCM Mini Filter 이펙트 음향의 필터 차단 주파수를 설정합니다.

Cutoff Frequency 
Control

Control Filter 필터 차단 주파수를 설정합니다.
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화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Damper Control Damper Control Damper Resonance 피아노 댐퍼의 공명량을 설정합니다.

Decay Decay REV-X Hall, REV-X Room 리버브 음향 감쇄 방식을 제어합니다.

Delay Control Delay Control Multi FX Delay Sw에 설정된 이펙트의 깊이 또는 양을 
설정합니다.

Delay Input Lvl Delay Input Level Analog Delay Retro, Analog 
Delay Modern

딜레이의 입력 레벨을 설정합니다.

Delay Level Delay Level Auto Synth 딜레이된 음향 레벨을 설정합니다.

Delay Level C Delay Level C Delay LCR 중앙 채널의 딜레이된 음향 레벨을 설정합니다.

Delay Mix Delay Mix Comp Distortion Delay 딜레이된 음향의 믹싱 레벨을 설정합니다.

Delay Offset Delay Offset G Chorus, 2 Modulator, SPX 
Chorus, Symphonic, Classic 
Flanger, Tempo Flanger, 
Dynamic Flanger

딜레이 모듈레이션의 오프셋 값을 설정합니다.

Delay Sw Delay SW Multi FX 딜레이 형식 또는 모듈레이션 형식을 설정합니다.

Delay Time Delay Time Tempo Delay Mono, Tempo 
Delay Stereo

음표 길이에 딜레이 길이를 지정합니다.

Comp Ratio Comp Ratio Control Delay, Auto Synth, Tech 
Modulation, Multi FX, Analog 
Delay Retro, Analog Delay 
Modern

딜레이 길이를 설정합니다.

Delay Time C Delay Time C Delay LCR 중앙 채널에 대한 딜레이 길이를 설정합니다.

Delay Time L Delay Time L Delay LR, Delay LCR, Comp 
Distortion Delay

좌측 채널에 대한 딜레이 길이를 설정합니다.

Delay Time L>R Delay Time L>R Cross Delay, Tempo Cross Delay 좌측에서 입력된 음향이 우측에서 출력될 딜레이 
타임을 설정합니다.

Delay Time R Delay Time R Delay LR, Delay LCR, Comp 
Distortion Delay

우측 채널에 대한 딜레이 길이를 설정합니다.

Delay Time R>L Delay Time R>L Cross Delay, Tempo Cross Delay 우측에서 입력된 음향이 좌측에서 출력될 딜레이 
타임을 설정합니다.

Delay Tm Ofs R Delay Time Offset R Auto Synth, Tech Modulation 우측 채널에 대한 딜레이 길이에 오프셋을 설정합니다.

Density Density R3 Hall, R3 Room, R3 Plate, SPX 
Hall, SPX Room, SPX Stage, 
Space Simulator

리버브의 밀도를 설정합니다.

Early Reflection, Gated Reverb, 
Reverse Reverb

반향의 밀도를 설정합니다.

Depth Depth Space Simulator 재현된 실내의 깊이를 설정합니다.

VCM Flanger 딜레이 모듈레이션의 주기적인 변화를 제어하는 LFO 
음파의 진폭을 설정합니다.

VCM Phaser Mono, VCM Phaser 
Stereo

위상 모듈레이션의 주기적인 변화를 제어하는 LFO 
음파의 진폭 값을 설정합니다.

Jazz Combo 코러스/비브라토의 깊이를 설정합니다.

Device Device Amp Simulator 1, Comp 
Distortion Delay

디스토션 음향을 생성하는 장치를 설정합니다.
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Diffusion Diffusion REV-X Hall, REV-X Room, R3 
Hall, R3 Room, R3 Plate, SPX 
Hall, SPX Room, SPX Stage, 
Space Simulator, Gated Reverb, 
Reverse Reverb, Shimmer 
Reverb

리버브의 스프레드를 설정합니다.

Tempo Phaser, Early Reflection 선택한 이펙트의 스프레드를 설정합니다.

Direction Direction Dynamic Flanger, Dynamic 
Phaser, VCM Touch Wah, VCN 
Pedal Wah, Dynamic Ring 
Modulator, Dynamic Filter

엔벨로프 팔로워로 제어되는 모듈레이션의 방향을 
설정합니다.

Tempo Spiralizer P, Tempo 
Spiralizer F

피치 이동 방향을 설정합니다.

Dist Drive Dist Drive Multi FX, Small Stereo 디스토션의 양을 제어합니다.

Dist EQ Dist EQ Multi FX, Small Stereo 디스토션 음질을 조정하기 위해 EQ 형식을 전환합니다.

Dist Presence Dist Presence Multi FX, Small Stereo 각 디스토션 형식의 음질을 조정합니다.

Dist Sw Dist SW Multi FX 디스토션 형식을 설정합니다.

Dist Tone Dist Tone Multi FX, Small Stereo 디스토션의 음질을 조정합니다.

Dist Type Dist Type Small Stereo 디스토션 형식을 설정합니다.

Distortion Distortion Jazz Combo 디스토션 레벨을 설정합니다.

Divide Freq Hi Divide Freq High Multi Band Comp Mid/High 주파수를 설정하여 3개의 대역으로 
나눕니다.

Divide Freq Low Divide Freq Low Multi Band Comp Low/Mid 주파수를 설정하여 3개의 대역으로 
나눕니다.

Divide Min Lvl Divide Min Level Slice 슬라이스 처리된 섹션의 최소 레벨을 설정합니다.

Divide Type Divide Type Slice 음표 길이에 따른 슬라이스 타이밍을 지정합니다.

Drive Drive Noisy, Slice, Rotary Speaker 2, 
VCM Rotary Speaker Classic, 
VCM Rotary Speaker Overdrive, 
VCM Rotary Speaker Studio

디스토션 레벨을 설정합니다.

Harmonic Enhancer, Talking 
Modulator

이펙트의 레벨을 설정합니다.

Drive Horn Drive Horn Rotary Speaker 1 혼(고음)의 회전을 통해 생성되는 모듈레이션의 깊이를 
설정합니다.

Drive Rotor Drive Rotor Rotary Speaker 1 로터(우퍼)의 회전을 통해 생성되는 모듈레이션의 
깊이를 설정합니다.

Dry Level Dry Level Digital Turntable dry 음향 레벨을 설정합니다.

Dry LPF Cutoff Dry LPF Cutoff 
Frequency

Digital Turntable dry 음향에 적용된 로우 패스 필터를 사용하여 차단할 
주파수를 설정합니다.

Dry Mix Level Dry Mix Level Auto Synth dry 음향 레벨을 설정합니다.

Dry/Wet Dry/Wet Balance All dry 음향과 이펙트 음향 간 밸런스를 설정합니다.
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화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Edge Edge Comp Distortion 음향이 왜곡되는 방식을 결정하는 곡선을 
설정합니다.

Emphasis Emphasis Lo-Fi 고주파수 특성의 변화를 설정합니다.

EQ 1 Freq EQ1(LSH) Frequency VCM EQ 501 EQ1 (Low Shelving)의 차단 주파수를 
설정합니다.

EQ 1 Gain EQ1(LSH) Gain VCM EQ 501 EQ1 (Low Shelving)의 게인을 설정합니다.

EQ 2 Freq EQ2 Frequency VCM EQ 501 EQ2의 중심 주파수를 설정합니다.

EQ 2 Gain EQ2 Gain VCM EQ 501 EQ2의 게인을 설정합니다.

EQ 2 Q EQ2 Q VCM EQ 501 EQ2의 Q를 설정합니다.

EQ 3 Freq EQ3 Frequency VCM EQ 501 EQ3의 중심 주파수를 설정합니다.

EQ 3 Gain EQ3 Gain VCM EQ 501 EQ3의 게인을 설정합니다.

EQ 3 Q EQ3 Q VCM EQ 501 EQ3의 Q를 설정합니다.

EQ 4 Freq EQ4 Frequency VCM EQ 501 EQ4의 중심 주파수를 설정합니다.

EQ 4 Gain EQ4 Gain VCM EQ 501 EQ4의 게인을 설정합니다.

EQ 4 Q EQ4 Q VCM EQ 501 EQ4의 Q를 설정합니다.

EQ 5 Freq EQ5(HSH) Frequency VCM EQ 501 EQ5 (High Shelving)의 차단 주파수를 
설정합니다.

EQ 5 Gain EQ5(HSH) Gain VCM EQ 501 EQ5 (High Shelving)의 게인을 설정합니다.

EQ Frequency EQ Frequency Noisy EQ를 사용하여 증폭 또는 감쇄시킬 주파수를 
설정합니다.

VCM Mini Booster Type으로 설정된 EQ의 주파수를 설정합니다.

EQ Gain EQ Gain Noisy EQ를 사용하여 증폭 또는 감쇄시킬 게인을 
설정합니다.

EQ High Freq EQ High Frequency Cross Delay, Tempo Cross Delay, 
Tempo Delay Mono, Tempo 
Delay Stereo, Control Delay, 
Delay LR, Delay LCR, G Chorus, 
2 Modulator, SPX Chorus, 
Symphonic, Ensemble Detune, 
Classic Flanger, Tempo Flanger, 
Dynamic Flanger, Tempo 
Phaser, Dynamic Phaser, Auto 
Pan, Tremolo, Rotary Speaker 1, 
Ring Modulator, Dynamic Ring 
Modulator, Dynamic Filter, Slice, 
HD Hall, HD Room, HD Plate, 
NoiseGate+Comp+Eq

EQ를 사용하여 증폭 또는 감쇄시킬 고대역 
주파수를 설정합니다.

EQ High Gain EQ High Gain Cross Delay, Tempo Cross Delay, 
Tempo Delay Mono, Tempo 
Delay Stereo, Control Delay, 
Delay LR, Delay LCR, G Chorus, 
2 Modulator, SPX, Chorus, 
Symphonic, Ensemble Detune, 
Classic Flanger, Tempo Flanger, 
Dynamic Flanger, Tempo 
Phaser, Dynamic Phaser, Auto 
Pan, Tremolo, Rotary Speaker 1, 
Ring Modulator, Dynamic Ring 
Modulator, Dynamic Filter, Slice, 
HD Hall, HD Room, HD Plate, 
NoiseGate+Comp+Eq

EQ를 사용하여 증폭 또는 감쇄시킬 고대역 게인을 
설정합니다.
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EQ Low Freq EQ Low Frequency Cross Delay, Tempo Cross Delay, 
Tempo Delay Mono, Tempo 
Delay Stereo, Control Delay, 
Delay LR, Delay LCR, G Chorus, 
2 Modulator, SPX Chorus, 
Symphonic, Ensemble Detune, 
Classic Flanger, Tempo Flanger, 
Dynamic Flanger, Tempo 
Phaser, Dynamic Phaser, Auto 
Pan, Tremolo, Rotary Speaker 1, 
Ring Modulator, Dynamic Ring 
Modulator, Dynamic Filter, Slice, 
Comp Distortion, HD Hall, HD 
Room, HD Plate

EQ를 사용하여 증폭 또는 감쇄시킬 저대역 
주파수를 설정합니다.

EQ Low Gain EQ Low Gain Cross Delay, Tempo Cross Delay, 
Tempo Delay Mono, Tempo 
Delay Stereo, Control Delay, 
Delay LR, Delay LCR, G Chorus, 
2 Modulator, SPX Chorus, 
Symphonic, Ensemble Detune, 
Classic Flanger, Tempo Flanger, 
Dynamic Flanger, Tempo 
Phaser, Dynamic Phaser, Auto 
Pan, Tremolo, Rotary Speaker 1, 
Ring Modulator, Dynamic Ring 
Modulator, Dynamic Filter, Slice, 
Comp Distortion, HD Hall, HD 
Room, HD Plate

EQ를 사용하여 증폭 또는 감쇄시킬 저대역 게인을 
설정합니다.

EQ Mid Freq EQ Mid Frequency G Chorus, 2 Modulator, SPX 
Chorus, Symphonic, Classic 
Flanger, Tempo Flanger, Auto 
Pan, Tremolo, Comp Distortion, 
NoiseGate+Comp+EQ

EQ를 사용하여 증폭 또는 감쇄시킬 중대역 
주파수를 설정합니다.

EQ Mid Gain EQ Mid Gain G Chorus, 2 Modulator, SPX 
Chorus, Symphonic, Classic 
Flanger, Tempo Flanger, Auto 
Pan, Tremolo, Comp Distortion, 
NoiseGate+Comp+EQ

EQ를 사용하여 증폭 또는 감쇄시킬 중대역 게인을 
설정합니다.

EQ Mid Width EQ Mid Width G Chorus, 2 Modulator, SPX 
Chorus, Symphonic, Classic 
Flanger, Tempo Flanger, Auto 
Pan, Tremolo, Comp Distortion, 
NoiseGate+Comp+EQ

EQ를 사용하여 증폭 또는 감쇄시킬 중대역 폭을 
설정합니다.

EQ Width EQ Width Noisy EQ를 사용하여 증폭 또는 감쇄시킬 폭을 
설정합니다.

ER/Rev Balance ER/Rev Balance R3 Hall, R3 Room, R3 Plate, SPX 
Hall, SPX Room, SPX Stage, 
Space Simulator

초기 반향 및 리버브 음향의 레벨 밸런스를 
설정합니다.
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F/R Depth F/R Depth Auto Pan 전면 및 후면의 팬 깊이를 설정합니다(PAN 
Direction을 L Turn 또는 R Turn으로 설정한 경우 
이용 가능)

FB Hi Dmp Ofs R FB Hi Damp Offset R Tech Modulation 우측 채널에 대한 고음 감쇄를 설정합니다.

FB High Damp Feedback High Damp R3 Hall, R3 Room, R3 Plate, 
SPX Hall, SPX Room, SPX 
Stage, Space Simulator, Cross 
Delay, Tempo Cross Delay, 
Tempo Delay Mono, Tempo 
Delay Stereo, Control Delay, 
Delay LR, Delay LCR, Classic 
Flanger, Early Reflection, 
Gated Reverb, Reverse Reverb, 
Comp Distortion Delay, Tech 
Modulation

피드백 음향을 사용하여 고대역 음향의 감쇄를 
조정합니다. 값이 작아질수록 고주파수 음향 
감쇄가 빨라집니다.

FB Level Ofs R FB Level Offset R Auto Synth, Tech Modulation 우측 채널 피 드백 양의 오프셋을 설정합니다.

FB Time L Feedback Time L Delay LR 좌측 딜레이에 대한 피드백 길이를 설정합니다.

FB Time R Feedback Time R Delay LR 우측 딜레이에 대한 피드백 길이를 설정합니다.

Feedback Feedback VCM Flanger, VCM Phaser Mono, 
VCM Phaser Stereo, Control 
Flanger, Control Phaser
Spiralizer P, Spiralizer F, Tempo 
Spiralizer P, Tempo Spiralizer F

이펙트 블록으로 반송되는 출력 신호의 레벨을 
설정합니다.

Feedback Feedback Level R3 Hall, R3 Room, R3 Plate, 
SPX Hall, SPX Room, SPX 
Stage, Space Simulator, Early 
Reflection, Gated Reverb, 
Reverse Reverb

초기 딜레이의 피드백 레벨을 설정합니다.

Cross Delay, Tempo Cross 
Delay, Tempo Delay Mono, 
Tempo Delay Stereo, Control 
Delay, Delay LR, Delay LCR, 
G Chorus, 2 Modulator, SPX 
Chorus, Classic Flanger, Tempo 
Flanger, Dynamic Flanger, Comp 
Distortion Delay, Auto Synth, 
Teck Modulation

입력으로 다시 전송할 딜레이 음향의 레벨을 
설정합니다. (음의 값에서는 위상이 역전됨)

Analog Delay Retro, Analog 
Delay Modern

딜레이된 음향의 피드백 레벨을 설정합니다.

Tempo Phaser, Dynamic Phaser 페이저에서 출력되어 입력으로 반송되는 신호의 
레벨을 설정합니다. (음의 값에서는 위상이 역전됨)

Feedback Lvl 1 Feedback Level 1 Pitch Change 첫 번째 경로에 위치한 딜레이 음향의 피드백 
레벨을 설정합니다.

Feedback Lvl 2 Feedback Level 2 Pitch Change 두 번째 경로에 위치한 딜레이 음향의 피드백 
레벨을 설정합니다.

Feedback Time Feedback Time Delay LCR, Comp Distortion 
Delay

피드백의 딜레이 길이를 설정합니다.

Filter Type Filter Type Lo-Fi 이펙트 형식을 선택합니다.

Dynamic Filter, Control Filter 필터 형식을 설정합니다.

Beat Repeat 이펙트 음향의 필터 형식을 설정합니다.

Fine 1 Fine 1 Pitch Change, Shimmer Reverb 첫 번째 경로의 피치를 미세 튜닝합니다.

Fine 2 Fine 2 Pitch Change, Shimmer Reverb 두 번째 경로의 피치를 미세 튜닝합니다.
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화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Flanger Control Flanger Control Control Flanger 딜레이 값을 설정합니다. (딜레이 모듈레이션의 
Comb Filter 값)

Fold Fold Wave Folder 음향을 왜곡시킵니다.

Fold Type Fold Type Wave Folder 디스토션 레벨을 선택합니다.

Formant Offset Formant Offset Vocoder 악기 음향 입력을 위해 BPF의 차단 주파수에 
오프셋 값을 추가합니다.

Formant Shift Formant Shift Vocoder 악기 음향 입력을 위해 각 BPF의 차단 주파수를 
이동시킵니다.

Freeze Freeze Beat Repeat 이 파라미터를 켜짐으로 설정한 경우 박자가 
반복됩니다.

G

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Gain Gain U.S. High Gain 프리앰프의 게인을 설정합니다.

VCM Mini Booster ShelfEQ의 Gain을 조정합니다.

Gain Boost Gain Boost U.S. Combo 파워 앰프의 게인을 전환합니다.

Gain Limit Gain Limit Upward Compressor 최대 Gain 레벨을 설정합니다.

Gate Time Gate Time Slice 슬라이스의 게이트 시간을 설정합니다.

Beat Repeat 전체 음향의 Gate 시간을 설정합니다.

H

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Height Height Space Simulator 재현된 실내의 높이를 설정합니다.

Hi Damp Freq High Damp Frequency HD Hall, HD Room, HD Plate 고대역의 감쇄를 조정합니다.

High Attack High Attack Multi Band Comp 컴프레서가 고대역에 적용될 시간을 설정합니다.

High Cut High Cut U.S. Combo 고대역을 차단합니다

High Gain High Gain Multi Band Comp 고대역의 출력 레벨을 설정합니다.

High Gain L High Subband Gain Lch Stereophonic Optimizer 스테레오 음향(L 채널) 조정 후 High 대역의 
결과적인 게인을 설정합니다.

High Gain R High Subband Gain Rch Stereophonic Optimizer 스테레오 음향(R 채널) 조정 후 High 대역의 
결과적인 게인을 설정합니다.

High Level High Level Isolator 고대역의 레벨을 설정합니다.

High Mute High Mute Isolator 고대역의 음소거를 전환합니다.

High Ratio High Ratio REV-X Hall, REV-X Room, HD 
Hall, HD Room, HD Plate

고주파수의 비율을 조정합니다.

Multi Band Comp 고대역의 압축 비율을 설정합니다.

High Threshold High Threshold Multi Band Comp 이펙트가 고대역에 적용될 최소 입력 레벨을 
설정합니다.

High Treble High Treble Jazz Combo Treble 설정보다 높은 주파수의 톤 퀄리티를 
조정합니다.

Horn Accel Horn Acceleration Rotary Speaker 2, VCM Rotary 
Speaker Classic, VCM Rotary 
Speaker Overdrive, VCM Rotary 
Speaker Studio

혼(고음)의 회전이 어떻게 Slow에서 Fast로 
변하는지 설정합니다.
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화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Horn Decel Horn Deceleration Rotary Speaker 2, VCM Rotary 
Speaker Classic, VCM Rotary 
Speaker Overdrive, VCM Rotary 
Speaker Studio

혼(고음)의 회전이 어떻게 Fast에서 Slow로 
변하는지 설정합니다.

Horn Fast Horn Speed Fast Rotary Speaker 1, Rotary 
Speaker 2, VCM Rotary Speaker 
Classic, VCM Rotary Speaker 
Overdrive, VCM Rotary Speaker 
Studio

Fast 설정에 맞게 혼(고음)의 회전 속도를 
설정합니다.

Horn Level Horn Level VCM Rotary Speaker Classic, 
VCM Rotary Speaker Overdrive, 
VCM Rotary Speaker Studio

혼(고음)의 음량을 설정합니다.

Horn Slow Horn Speed Slow Rotary Speaker 1, Rotary 
Speaker 2, VCM Rotary Speaker 
Classic, VCM Rotary Speaker 
Overdrive, VCM Rotary Speaker 
Studio

Slow 설정에 맞게 혼(고음)의 회전 속도를 
설정합니다.

Horn Slow/Fast Horn Slow/Fast Time Rotary Speaker 1 혼(고음) 회전 속도의 전환 시간을 설정하여 
Slow에서 Fast로 변경합니다.

HPF Cutoff HPF Cutoff Frequency REV-X Hall, REV-X Room, 
R3 Hall, R3 Room, R3 Plate, 
SPX Hall, SPX Room, SPX 
Stage, Space Simulator, 
Ring Modulator, Dynamic 
Ring Modulator, Auto Synth, 
Harmonic Enhancer, Early 
Reflection, Gated Reverb, 
Reverse Reverb

HPF를 사용하여 차단할 저주파를 설정합니다.

Vocoder 마이크에서 입력된 음향에 적용되는 하이 패스 필터 
차단 주파수를 설정합니다.

HPF Output Lvl HPF Output Level Vocoder 하이 패스 필터 출력과 보코더 출력의 믹싱 정도를 
설정합니다.
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I

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Initial Delay Initial Delay REV-X Hall, REV-X Room, 
R3 Hall, R3 Room, R3 Plate, 
SPX Hall, SPX Room, SPX 
Stage, Space Simulator, Early 
Reflection, HD Hall, HD Room, 
HD Plate, Gated Reverb, Reverse 
Reverb

초기 반향에 대한 딜레이 타임을 설정합니다.

Initial Delay 1 Initial Delay 1 Pitch Change 1차 이펙트의 딜레이 길이를 설정합니다.

Initial Delay 2 Initial Delay 2 Pitch Change 2차 이펙트의 딜레이 길이를 설정합니다.

Initial Delay L Initial Delay Lch Ensemble Detune 좌측 채널 딜레이의 길이를 설정합니다.

Initial Delay R Initial Delay Rch Ensemble Detune 우측 채널 딜레이의 길이를 설정합니다.

Input Level Input Level Bit Crusher, VCM Compressor 
376, Rotary Speaker 2, Parallel 
Compressor, Wave Folder, VCM 
Mini Filter, VCM Mini Booster

입력 레벨을 설정합니다.

Input Mode Input Mode G Chorus, 2 Modulator, SPX 
Chorus, Auto Pan, Tremolo, Lo-Fi

입력 음향이 모노인지 스테레오인지 선택합니다.

Input Select Input Select Cross Delay, Tempo Cross Delay 입력을 선택합니다.

Inst Level Inst Level Vocoder 악기 음향의 레벨을 설정합니다.

K

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Knee Knee Upward Compressor, Downward 
Compressor

Threshold 근처에서 곡선을 설정합니다. 값이 
높아질수록 곡선이 얕아집니다.

L

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

L/R Depth L/R Depth Auto Pan 좌측 및 우측 팬의 깊이를 설정합니다.

L/R Diffusion L/R Diffusion Tempo Delay Mono, Tempo 
Delay Stereo

공간감을 생성할 수 있도록 우측과 좌측의 딜레이 
차이를 설정합니다.

Lag Lag Tempo Cross Delay, Tempo 
Delay Mono, Tempo Delay 
Stereo

음표 길이에 의해 지정된 딜레이 음향에 적용되는 
추가 딜레이 길이를 설정합니다.

Length Length Beat Repeat 반복할 길이를 설정합니다.

Level Offset Dyna Level Offset Dynamic Flanger, Dynamic 
Phaser, Dynamic Ring 
Modulator, Dynamic Filter

엔벨로프 팔로워의 출력에 추가된 오프셋 값을 
설정합니다.

LFO Depth LFO Depth SPX Chorus, Symphonic, Classic 
Flanger, Tempo Flanger, Ring 
Modulator

모듈레이션의 깊이를 설정합니다.

Tempo Phaser 위상 모듈레이션의 깊이를 설정합니다.

Wave Folder LFO 이펙트의 깊이를 조정합니다.

LFO Shape LFO Shape Wave Folder LFO의 형태를 조정합니다.
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LFO Speed LFO Speed G Chorus, 2 Modulator, SPX 
Chorus, Symphonic, Classic 
Flanger, Tremolo, Ring 
Modulator, Multi FX

모듈레이션의 주파수를 설정합니다.

Tempo Flanger, Tempo Phaser 음표 길이에 따른 모듈레이션 속도를 지정합니다.

Auto Pan Auto Pan의 주파수를 설정합니다.

Wave Folder LFO 속도를 조정합니다.

LFO Wave LFO Wave Classic Flanger, Ring Modulator 모듈레이션의 음파를 선택합니다.

Auto Pan 패닝 곡선을 설정합니다.

VCM Auto Wah 사인파 또는 사각형파 중 음파를 선택합니다.

Liveness Liveness Gated Reverb, Reverse Reverb, 
Early Reflection

초기 반향의 감쇄를 설정합니다.

Ln Chg Quantz Length Change Quantize Beat Repeat Length 파라미터 변경 타이밍을 퀀타이즈 
처리합니다.

Low Attack Low Attack Multi Band Comp 컴프레서가 저대역에 적용될 시간을 설정합니다.

Low Cut Low Cut U.S. Combo 저대역을 차단합니다

Low Gain Low Gain Multi Band Comp 저대역의 출력 레벨을 설정합니다.

Low Gain L Low Subband Gain Lch Stereophonic Optimizer 스테레오 음향(L 채널) 조정 후 Low 대역의 
결과적인 게인을 설정합니다.

Low Gain R Low Subband Gain Rch Stereophonic Optimizer 스테레오 음향(R 채널) 조정 후 Low 대역의 
결과적인 게인을 설정합니다.

Low Level Low Level Isolator 저대역의 레벨을 설정합니다.

Low Mute Low Mute Isolator 저대역의 음소거를 전환합니다.

Low Ratio Low Ratio REV-X Hall, REV-X Room 저주파수의 레벨을 설정합니다.

Multi Band Comp 저대역의 압축 비율을 설정합니다.

Low Threshold Low Threshold Multi Band Comp 이펙트가 저대역에 적용될 최소 입력 레벨을 
설정합니다.

Lower Range Lower Range VCM Auto Wah, VCM Touch 
Wah, VCM Pedal Wah

가변 와와 필터 범위에 최대값을 설정합니다.

Control Flanger Flanger Control 가변 범위의 최대값을 
설정합니다.

Control Phaser Phase Control 가변 범위의 최대값을 설정합니다.

LPF Cutoff LPF Cutoff Frequency REV-X Hall, REV-X Room, R3 
Hall, R3 Room, R3 Plate, SPX 
Hall, SPX Room, SPX Stage, 
Space Simulator, Amp Simulator 
2, Comp Distortion, Noisy, 
Ring Modulator, Dynamic Ring 
Modulator, Auto Synth, Early 
Reflection, Gated Reverb, 
Reverse Reverb, Auto Synth, 
Noisy

로우 패스 필터에 의해 차단되는 고주파수 범위를 
설정합니다.

LPF Resonance LPF Resonance Noisy 로우 패스 필터로 전송되는 입력에 특성을 
더합니다.
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M

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

M/S M/S Bit Crusher 이 파라미터가 켜짐일 때 중앙, 좌측 및 우측에 
위치한 각 음향이 개별적으로 변경됩니다. 

Make Up Gain Make Up Gain Upward Compressor, Downward 
Compressor

컴프레서에서 전송된 신호 출력의 레벨을 
조정합니다.

Manual Manual VCM Flanger 딜레이 모듈레이션의 오프셋 값을 설정합니다.

VCM Phaser Mono, VCM Phaser 
Stereo

위상 모듈레이션의 오프셋 값을 설정합니다.

Master Volume Master Volume U.S. High Gain, British Lead, 
British Legend

파워 앰프의 게인을 조정합니다.

Mic Input Level Mic Input Level Vocoder 마이크의 입력 레벨을 설정합니다.

Mic L-R Angle Mic L-R Angle Rotary Speaker 1, Rotary 
Speaker 2, VCM Rotary Speaker 
Classic, VCM Rotary Speaker 
Overdrive, VCM Rotary Speaker 
Studio

출력에서 음향을 추출할 수 있도록 마이크의 L/R 
각도를 설정합니다.

Mic Out Gate Mic Output Gate Switch Vocoder Off: HPF 출력 및 Noise Generator 출력을 항상 
전달합니다.
On: 악기 음향의 오디오 입력이 있을 때 HPF 출력 
및 Noise Generator 출력을 전달합니다.

Mic Position Mic Position U.S. Combo, Jazz Combo, U.S. 
High Gain, British Lead, British 
Combo, British Legend, Rotary 
Speaker 2

스피커에 대한 마이크의 상대 위치를 설정합니다.

Mid Middle British Lead, British Legend, Jazz 
Combo, U.S. High Gain

중대역의 음질을 설정합니다.

Mid 1 Gain L Mid1 Subband Gain Lch Stereophonic Optimizer 스테레오 음향(L 채널) 조정 후 Mid1 대역의 
결과적인 게인을 설정합니다.

Mid 1 Gain R Mid1 Subband Gain Rch Stereophonic Optimizer 스테레오 음향(R 채널) 조정 후 Mid1 대역의 
결과적인 게인을 설정합니다.

Mid 2 Gain L Mid2 Subband Gain Lch Stereophonic Optimizer 스테레오 음향(L 채널) 조정 후 Mid2 대역의 
결과적인 게인을 설정합니다.

Mid 2 Gain R Mid2 Subband Gain Rch Stereophonic Optimizer 스테레오 음향(R 채널) 조정 후 Mid2 대역의 
결과적인 게인을 설정합니다.

Mid 3 Gain L Mid3 Subband Gain Lch Stereophonic Optimizer 스테레오 음향(L 채널) 조정 후 Mid3 대역의 
결과적인 게인을 설정합니다.

Mid 3 Gain R Mid3 Subband Gain Rch Stereophonic Optimizer 스테레오 음향(R 채널) 조정 후 Mid3 대역의 
결과적인 게인을 설정합니다.

Mid Attack Mid Attack Multi Band Comp 컴프레서가 중대역에 적용될 시간을 설정합니다.

Mid Cut Mid Cut U.S. Combo 중주파수를 차단합니다

Mid Gain Mid Gain Multi Band Comp 중대역의 출력 레벨을 설정합니다.

Mid Level Mid Level Isolator 중주파수의 레벨을 설정합니다.

Mid Mute Mid Mute Isolator 중주파수의 음소거를 전환합니다.

Mid Ratio Mid Ratio Multi Band Comp 중대역의 압축 비율을 설정합니다.
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Mid Sweep Mid Sweep U.S. Combo 중주파수가 차단되는 주파수 범위를 조정합니다.

Mid Threshold Mid Threshold Multi Band Comp 이펙트가 중대역에 적용될 최소 입력 레벨을 
설정합니다.

Mid Width Mid Width U.S. Combo 중주파수를 차단할 대역폭을 설정합니다.

Mix Mix VCM Flanger, Control Flanger 이펙트 음향의 음량을 설정합니다.

Mix Level Mix Level Harmonic Enhancer dry 음향으로 믹싱된 이펙트 음향의 레벨을 
설정합니다.

Mod Depth Mod Depth Noisy, Auto Synth, Tech 
Modulation, Shimmer Reverb

모듈레이션의 깊이를 설정합니다.

Modulation Depth Rotary Speaker 2 음량의 주기적인 변화 깊이를 설정합니다.

Mod Dpt Ofs R Mod Depth Offset R Auto Synth R 채널에 대한 모듈레이션 깊이에 오프셋을 
설정합니다.

Mod Feedback Mod Feedback Noisy 모듈레이션에 피드백 레벨을 설정합니다.

Mod Gain Mod Gain Tech Modulation 모듈레이션 게인 레벨을 설정합니다.

Mod LPF Cutoff Mod LPF Cutoff 
Frequency

Tech Modulation 변조음에 적용되는 로우 패스 필터의 차단 
주파수를 설정합니다.

Mod LPF Res Mod LPF Resonance Tech Modulation 로우 패스 필터를 사용하여 변조음에 특성을 
더합니다.

Mod Mix Mod Mix Balance Noisy, Tech Modulation 변조음의 믹스 밸런스를 설정합니다.

Mod Phase Modulation Phase Classic Flanger 변조파의 L/R 위상 차이를 설정합니다.

Mod Speed Mod Speed Noisy, Auto Synth, Tech 
Modulation, Shimmer Reverb

모듈레이션 속도를 설정합니다.

Mod Wave Type Mod Wave Type Auto Synth 모듈레이션에 대한 음파 형식을 선택합니다.

Mode Mode VCM Phaser Mono, VCM Phaser 
Stereo, Control Phaser

페이저 형식 변경 요소, 더욱 구체적으로 말하면 
페이저 이펙트를 형성하기 위한 계수를 설정합니다.

British Combo 프리앰프를 전환합니다.

Modulator Lvl Modulator Input Level Ring Modulator 모듈레이션 레벨을 설정합니다.

Move Speed Move Speed Talking Modulator Vowel 파라미터에 의해 지정된 음향이 변할 
때까지 소요되는 시간을 설정합니다.

N

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Noise Level Background Noise Level VCM Rotary Speaker Classic, 
VCM Rotary Speaker Overdrive, 
VCM Rotary Speaker Studio

배경 노이즈의 양을 설정합니다.

Noise Level Vocoder 노이즈 입력의 레벨을 설정합니다.

Digital Turntable 노이즈 레벨을 설정합니다.

Noise LPF Q Noise LPF Q Digital Turntable 노이즈에 적용되는 로우 패스 필터의 공명을 
설정합니다.

Noise Switch Background Noise 
Off/On

VCM Rotary Speaker Classic, 
VCM Rotary Speaker Overdrive, 
VCM Rotary Speaker Studio

배경 노이즈를 켜거나 끕니다.

Noise Tone Noise Tone Digital Turntable 노이즈의 음질을 설정합니다.
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화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Normal Normal British Combo EQ 응답이 평탄한 음향의 음량을 조정합니다.

Ns Gate Atk Noise Gate Attack NoiseGate+Comp+Eq 노이즈 게이트가 적용될 시간을 설정합니다.

Ns Gate Rls Noise Gate Release NoiseGate+Comp+Eq 노이즈 게이트가 비활성화될 시간을 설정합니다.

Ns Gate Thrs Noise Gate Threshold NoiseGate+Comp+Eq 노이즈 게이트가 적용될 최소 입력 레벨을 
설정합니다.

Ns LPF Cutoff Noise LPF Cutoff 
Frequency

Digital Turntable 노이즈에 적용된 로우 패스 필터를 사용하여 
차단할 주파수를 설정합니다.

Ns Mod Depth Noise Mod Depth Digital Turntable 노이즈 모듈레이션의 깊이를 설정합니다.

Ns Mod Speed Noise Mod Speed Digital Turntable 노이즈 모듈레이션의 속도를 설정합니다.

O

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Offset Filter Offset Spiralizer P, Spiralizer F, Tempo 
Spiralizer P, Tempo Spiralizer F

초기 피치 값을 반음 단위로 설정합니다.

Ofs Transition Offset Transition Rate Spiralizer P, Spiralizer F, Tempo 
Spiralizer P, Tempo Spiralizer F

오프셋 값이 새 값으로 변경될 전환 시간을 
설정합니다.

On/Off Switch On/Off Switch Isolator 아이솔레이터를 켜거나 끕니다.

Stereophonic Optimizer 이펙트를 켜거나 끕니다.

Osc Freq OSC Frequency Coarse Ring Modulator 입력 음파를 변조할 때 사용되는 주파수를 
설정합니다.

Osc Freq Fine OSC Frequency Fine Ring Modulator 입력 음파를 변조할 때 사용되는 주파수를 미세 
조정합니다.

Output Output VCM Auto Wah, VCM Touch 
Wah, VCM Pedal Wah

출력 레벨을 설정합니다.

Output Level Filter Output Level Control Filter 필터의 출력 레벨을 설정합니다.

Output Level Amp Simulator 1, Amp Simulator 
2, Comp Distortion, Comp 
Distortion Delay, U.S. Combo, 
Jazz Combo, U.S. High Gain, 
British Combo, British Lead, 
British Legend, Multi FX, Small 
Stereo, VCM Compressor 376, 
Classic Compressor, VCM EQ 
501, Talking Modulator, Lo-
Fi, Bit Crusher, Vinyl Break, 
Beat Repeat, Rotary Speaker 
2, Downward Compressor, 
Upward Compressor, Parallel 
Compressor, Presence, Wave 
Folder, VCM Mini Filter, VCM 
Mini Booster

출력 레벨을 설정합니다.

Vocoder 보코더의 출력 레벨을 설정합니다.

Output Level 1 Output Level1 Pitch Change 첫 번째 경로의 출력 레벨을 설정합니다.

Output Level 2 Output Level2 Pitch Change 두 번째 경로의 출력 레벨을 설정합니다.

Overdrive Overdrive Amp Simulator 1, Amp Simulator 
2, Comp Distortion, Comp 
Distortion Delay, VCM Auto 
Wah, VCM Touch Wah, VCN 
Pedal Wah

디스토션 레벨을 설정합니다.
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P

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Pan 1 Pan 1 Pitch Change 첫 번째 경로의 팬을 설정합니다.

Pan 2 Pan 2 Pitch Change 두 번째 경로의 팬을 설정합니다.

Pan AEG Min Lvl Pan AEG Min Level Slice 패닝된 음향에 적용되는 진폭 EG의 최소 레벨을 
설정합니다.

Pan AEG Type Pan AEG Type Slice 패닝된 음향에 적용되는 진폭 EG의 형식을 
설정합니다.

Pan Depth Pan Depth Slice 팬의 깊이를 설정합니다.

Pan Direction Pan Direction Auto Pan 자동 팬 형식을 설정합니다.

Pan Type Pan Type Slice 팬 형식을 설정합니다.

Panning Panning Jazz Combo 코러스/비브라토의 스프레드를 설정합니다.

Pedal Control Pedal Control VCM Pedal Wah 와와 필터의 차단 주파수를 제어합니다.

Phase Control Phase Control Control Phaser 위상 모듈레이션의 깊이를 설정합니다.

Phase Differ LFO Phase Difference Tempo Flanger, Tremolo 변조파의 L/R 위상 차이를 설정합니다. (각도가 
0도이거나 값이 64인 경우 위상 차가 존재하지 
않음)

Phase Reset LFO Phase Reset Tempo Flanger, Tempo Phaser, 
Slice

LFO의 초기 위상 재설정 방식을 설정합니다.

Phase Shift Ofs Phase Shift Offset Tempo Phaser 위상 모듈레이션의 오프셋 값을 설정합니다.

Phaser Sw Phaser SW Multi FX 페이저 형식을 설정합니다.

Pitch 1 Pitch 1 Pitch Change, Shimmer Reverb 첫 번째 경로의 피치를 반음 단위로 설정합니다.

Pitch 2 Pitch 2 Pitch Change, Shimmer Reverb 두 번째 경로의 피치를 반음 단위로 설정합니다.

P1/P2 Balance Pitch 1/Pitch 2 Balance Shimmer Reverb 첫 번째 경로 및 두 번째 경로의 피치 변조 음향에 
대한 음량 밸런스를 설정합니다.

P1&P2 Dly Ofs Pitch 1 & Pitch 2 Delay 
Offset

Shimmer Reverb 첫 번째 경로 및 두 번째 경로의 피치 변조 음향에 
대한 딜레이 오프셋값을 설정합니다.

P1&P2 Panning Pitch 1/Pitch 2 Panning Shimmer Reverb 첫 번째 경로 및 두 번째 경로의 피치 변조 음향에 
대한 팬을 설정합니다.

Pitch Sweep Pitch Sweep Beat Repeat 매번 반복할 때마다 서서히 변하도록 피치를 
설정합니다. 

Plate Type Plate Type HD Plate 음향 공명 방식을 설정합니다.

Play Speed Play Speed Beat Repeat 재생 속도를 설정합니다.

PM Depth PM Depth G Chorus, 2 Modulator, Tremolo 피치 모듈레이션의 깊이를 설정합니다.

Post-comp HPF Post-comp HPF Upward Compressor, Downward 
Compressor

컴프레서를 따르는 하이 패스 필터의 차단 
주파수를 설정합니다.

Pre Mod HPF F Pre Mod HPF Cutoff 
Frequency

Tech Modulation 모듈레이션이 적용되기 전 하이 패스 필터의 차단 
주파수를 설정합니다.

Preamp Preamp British Lead 프리앰프의 게인을 설정합니다.

Pre-Delay Pre-Delay Shimmer Reverb 초기 반향에 대한 딜레이 타임을 설정합니다.

Pre-LPF Cutoff Pre-LPF Cutoff 
Frequency

Lo-Fi 고주파수를 차단할 수 있도록 하이 패스 필터의 
차단 주파수를 설정합니다.

Pre-LPF Res Pre-LPF Resonance Lo-Fi 로우 패스 필터로 전송되는 입력에 특성을 
더합니다.

Presence Presence Presence 이펙트의 레벨을 설정합니다.

Amp Simulator 1, Comp 
Distortion Delay U.S. Combo, 
U.S. Hi Gain, British Lead, British 
Legend

고주파수를 증폭시킵니다.
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R

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

R/H Balance Rotor/Horn Balance Rotary Speaker 1, Rotary 
Speaker 2

혼(고음) 및 로터(우퍼)의 음량 밸런스를 
결정합니다.

Random Random Beat Repeat 무작위 반복을 생성합니다.

Ratio Ratio Comp Distortion, VCM 
Compressor 376, Classic 
Compressor, Downward 
Compressor, Upward 
Compressor

컴프레서의 비율을 설정합니다.

Release Release Comp Distortion, VCM 
Compressor 376, Classic 
Compressor, Downward 
Compressor, Upward 
Compressor

컴프레서 이펙트가 사라질 때까지 소요되는 시간을 
설정합니다.

Release Curve Release Curve Dynamic Flanger, Dynamic 
Phaser, Dynamic Ring 
Modulator, Dynamic Filter

엔벌로프 팔로워의 릴리스 곡선을 설정합니다.

Release Time Release Time Dynamic Flanger, Dynamic 
Phaser, Dynamic Ring 
Modulator, Dynamic Filter

엔벌로프 팔로워의 릴리스 타임을 설정합니다.

Beat Repeat 전체 음향에 적용되는 Gate의 Release 타임을 
설정합니다.

Repeat Repeat Beat Repeat 반복을 켜짐 또는 꺼짐으로 설정합니다.

Resonance Resonance Dynamic Filter, Control Filter, 
VCM Mini Filter, VCM Mini 
Booster

필터에 특성을 가미합니다.

Beat Repeat 이펙트 음향에 필터 공명을 설정합니다.

Resonance Ofs Resonance Offset VCM Auto Wah, VCM Touch 
Wah, VCN Pedal Wah

공명에 오프셋 값을 설정합니다.

Retrigger Cycle Retrigger Cycle Beat Repeat Repeat을 다시 트리거하기 위한 사이클을 
설정합니다.

Reverb Delay Reverb Delay R3 Hall, R3 Room, R3 Plate, SPX 
Hall, SPX Room, SPX Stage, 
Space Simulator

초기 반향부터 리버브까지의 딜레이 타임을 
설정합니다.

Reverb Time Reverb Time REV-X Hall, REV-X Room, R3 
Hall, R3 Room, R3 Plate, SPX 
Hall, SPX Room, SPX Stage, 
Space Simulator, HD Hall, HD 
Room, HD Plate

리버브 길이를 설정합니다.

Room Size Room Size REV-X Hall, REV-X Room, Early 
Reflection, HD Hall, HD Room, 
Gated Reverb, Reverse Reverb

실내의 크기를 설정합니다.

Rotor Accel Rotor Acceleration Rotary Speaker 2, VCM Rotary 
Speaker Classic, VCM Rotary 
Speaker Overdrive, VCM Rotary 
Speaker Studio

로터(우퍼) 회전 속도를 Slow에서 Fast로 
변경합니다.

Rotor Decel Rotor Deceleration Rotary Speaker 2, VCM Rotary 
Speaker Classic, VCM Rotary 
Speaker Overdrive, VCM Rotary 
Speaker Studio

로터(우퍼) 회전 속도를 Fast에서 Slow로 
변경합니다.

Rotor Fast Rotor Speed Fast Rotary Speaker 1, Rotary 
Speaker 2, VCM Rotary Speaker 
Classic, VCM Rotary Speaker 
Overdrive, VCM Rotary Speaker 
Studio

Fast 설정에 맞게 로터(우퍼)의 회전 속도를 
설정합니다.
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화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Rotor Level Rotor Level VCM Rotary Speaker Classic, 
VCM Rotary Speaker Overdrive, 
VCM Rotary Speaker Studio

로터(우퍼)의 음량을 설정합니다.

Rotor Slow Rotor Speed Slow Rotary Speaker 1, Rotary 
Speaker 2, VCM Rotary Speaker 
Classic, VCM Rotary Speaker 
Overdrive, VCM Rotary Speaker 
Studio

Slow 설정에 맞게 로터(우퍼)의 회전 속도를 
설정합니다.

Rotor Slow/Fast Rotor Slow/Fast Time Rotary Speaker 1 로터(우퍼) 회전 속도의 전환 시간을 Slow에서 
Fast로 변경합니다.

Rtg Attack T Retrigger Attack Time Beat Repeat 전체 음향에 적용되는 Gate의 Attack 타임을 
설정합니다.

Rtg Gate Time Retrigger Gate Time Beat Repeat 전체 음향의 Gate 시간을 설정합니다.

Rtg Quantize Retrigger Quantize Beat Repeat 이 파라미터를 켜짐으로 설정한 경우 내장 시퀀서에 
설정된 소절의 시작 부분에서 음향이 반복됩니다.

Rtg Release T Retrigger Release Time Beat Repeat 전체 음향에 적용되는 Gate의 Release 타임을 
설정합니다.

S

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Sample Rate Sample Rate Bit Crusher Sample Rate를 낮춥니다.

Sampling Freq Sampling Frequency 
Control

Lo-Fi 샘플링 주파수를 제어합니다.

SC EQ Freq Side Chain EQ 
Frequency

Downward Compressor, Upward 
Compressor

컴프레서 레벨을 감지할 때 사용되는 EQ의 
주파수를 설정합니다.

SC EQ Gain Side Chain EQ Gain Downward Compressor, Upward 
Compressor

컴프레서 레벨을 감지할 때 사용되는 EQ의 게인을 
설정합니다.

SC EQ Q Side Chain EQ Q Downward Compressor, Upward 
Compressor

컴프레서 레벨을 감지할 때 사용되는 EQ의 Q를 
설정합니다.

Scale Type Spiral Step Scale Type Spiralizer P, Spiralizer F, Tempo 
Spiralizer P, Tempo Spiralizer F

Step Mode를 Scale로 설정한 경우 어떻게 
변화하는지 설정합니다.

Semitones Spiral Step Semitones Spiralizer P, Spiralizer F, Tempo 
Spiralizer P, Tempo Spiralizer F

Step Mode를 Semitone으로 설정한 경우 
변경폭을 지정합니다.

Send to Noise Dry Send to Noise Digital Turntable 노이즈 이펙트로 전송된 dry 신호의 레벨을 
설정합니다.

Sensitivity Sensitivity Dynamic Flanger, Dynamic 
Phaser, Dynamic Ring 
Modulator, Dynamic Filter

입력 변화에 적용되는 모듈레이션의 감도를 
설정합니다.

VCM Touch Wah 입력 변화에 적용되는 와와 필터의 감도를 
설정합니다.

SEQ Clock SEQ Clock Wave Folder 내장 시퀀서의 속도를 조정합니다.

SEQ Depth SEQ Depth Wave Folder 내장 시퀀서의 이펙트 깊이를 조정합니다.

SEQ Pattern SEQ Pattern Wave Folder 내장 시퀀서의 패턴을 조정합니다.

SEQ Ph Reset SEQ Phase Reset Wave Folder 내장 시퀀서 재설정 모드를 설정합니다.

SEQ Variation SEQ Variation Wave Folder 내장 시퀀서의 거동을 조정합니다.

Shimmer Fdbk Shimmer Feedback Shimmer Reverb 피치 변조 음향의 피드백 레벨을 조정합니다.
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화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Shimmer Gain Shimmer Gain Shimmer Reverb 피치 변조 음향의 레벨을 조정합니다.

Shimmer HPF Shimmer HPF Frequency Shimmer Reverb 피치 변조 음향의 저주파수를 차단할 수 있도록 
하이 패스 필터의 차단 주파수를 설정합니다.

Shimmer LPF Shimmer LPF Frequency Shimmer Reverb 피치 변조 음향의 고주파수를 차단할 수 있도록 
로우 패스 필터의 차단 주파수를 설정합니다.

Side Bit Side Bit Bit Crusher 사이드 체인의 비트 해상도를 감소시킵니다.

Side Chain EQ Side Chain EQ Switch Downward Compressor, Upward 
Compressor

컴프레서 레벨을 감지할 때 사용되는 EQ를 켜거나 
끕니다.

Side Chain Lvl Side Chain Input Level VCM Compressor 376, Classic 
Compressor, Dyna Flanger, 
Dyna Phaser, Dyna Ring Mod, 
Dyna Filter, Multi Band Comp

사이드 체인의 컨트롤 회로에 입력 레벨을 
설정합니다.

Side Smpl Rate Side Sample Rate Bit Crusher 사이드의 Sample Rate를 감소시킵니다.

Size Size Shimmer Reverb 분명한 리버브 공간 크기를 설정합니다.

Smpl Rate Link Sample Rate Link Bit Crusher M/S가 켜짐일 때 Mid 값을 따르는 Side 설정의 
레벨을 설정합니다.

Space Type Space Type Space Simulator 공간 시뮬레이션 형식을 선택합니다.

Speaker Air Speaker Air U.S. Combo, Jazz Combo, U.S. 
High Gain, British Lead, British 
Combo, British Legend

스피커 회로의 특성을 강조합니다.

Speaker Type Speaker Type Amp Simulator 1, Comp 
Distortion Delay

스피커 시뮬레이션 형식을 선택합니다.

U.S. Combo, Jazz Combo, U.S. 
High Gain, British Lead, Small 
Stereo, British Combo, British 
Legend, Multi FX

스피커 형식을 설정합니다.

Speed Speed VCM Flanger 주기적인 딜레이 모듈레이션 변화를 제어하는 LFO 
음파의 주파수를 설정합니다.

VCM Phaser Mono, VCM Phaser 
Stereo

주기적인 위상 모듈레이션 변화를 제어하는 LFO 
음파의 주파수를 설정합니다.

VCM Auto Wah LFO의 속도를 설정합니다.

Vinyl Break 음향이 멈출 시간을 설정합니다.

Speed Adjust Speed Adjust Vinyl Break 속도를 미세하게 조정합니다.

Speed Control Speed Control Rotary Speaker 1, Rotary 
Speaker 2

회전 속도를 전환합니다.(Slow/Fast)

VCM Rotary Speaker Classic, 
VCM Rotary Speaker Overdrive, 
VCM Rotary Speaker Studio

회전 속도를 전환합니다.(Slow/Stop/Fast)

Spiral Spiral Switch Spiralizer P, Spiralizer F, Tempo 
Spiralizer P, Tempo Spiralizer F

LFO를 켜거나 끕니다.

Spiral Speed Spiral Speed Spiralizer P, Spiralizer F, Tempo 
Spiralizer P, Tempo Spiralizer F

피치 변화의 속도를 설정합니다.

Spiral Sync Spiral Sync Spiralizer P, Spiralizer F, Tempo 
Spiralizer P, Tempo Spiralizer F

표준 피치 변경 사이클을 단계별로 설정합니다.

Spread Spread Ensemble Detune, VCM Flanger, 
VCM Phaser Stereo, Control 
Phaser

음향 확산 방식을 설정합니다.
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화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Stage Stage VCM Phaser Mono, VCM Phaser 
Stereo, Tempo Phaser, Dynamic 
Phaser, Control Phaser

위상 전환기의 단계 수를 설정합니다.

Step Mode Spiral Step Mode Spiralizer P, Spiralizer F, Tempo 
Spiralizer P, Tempo Spiralizer F

지속적으로(매끄럽게) 또는 단계별로 변하도록 
피치를 설정합니다.

Step Transition Spiral Step Transition 
Rate

Spiralizer P, Spiralizer F, Tempo 
Spiralizer P, Tempo Spiralizer F

피치가 단계별로 변하도록 전환 시간을 설정합니다.

Sample Rate Sample Rate Bit Crusher Sample Rate를 낮춥니다.

Sampling Freq Sampling Frequency 
Control

Lo-Fi 샘플링 주파수를 제어합니다.

T

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Texture Texture Parallel Compressor, Presence, 
VCM Mini Filter, VCM Mini 
Booster

이펙트 텍스처를 다양하게 변경합니다.

Threshold Threshold Comp Distortion, Classic 
Compressor, Downward 
Compressor, Upward 
Compressor

이펙트가 적용될 입력 레벨을 설정합니다.

Threshold Level Dyna Threshold Level Dynamic Flanger, Dynamic 
Phaser, Dynamic Ring 
Modulator, Dynamic Filter

엔벨로프 팔로워가 시작되는 최소 레벨을 
설정합니다.

Time Sweep Time Sweep Beat Repeat 매번 반복할 때마다 시간을 서서히 변경합니다.

Tone Tone Rotary Speaker 2, VCM Rotary 
Speaker Classic, VCM Rotary 
Speaker Overdrive, VCM Rotary 
Speaker Studio

톤 컨트롤을 설정합니다.

Tone Shift Tone Shift British Lead 톤 컨트롤의 특성을 전환합니다.

Transition Rate Delay Transition Rate Control Delay 현재 Delay Time을 새 값 Delay Time으로 
변경할 수 있도록 전환 속도를 설정합니다.

Treble Treble British Combo, British Lead, 
British Legend, Jazz Combo, U.S. 
High Gain

고음의 음질을 조정합니다.

Type Type VCM Flanger, Control Flanger 플랜저 형식을 선택합니다.

VCM Auto Wah, VCM Touch 
Wah, VCN Pedal Wah

와와 형식을 선택합니다.

Early Reflection, Gated Reverb, 
Reverse Reverb

반향 형식을 선택합니다.

US High Gain, British Lead 앰프 형식을 선택합니다.

Analog Delay Retro, Analog 
Delay Modern

딜레이의 특성을 설정합니다.

Parallel Compressor 컴프레서 형식을 설정합니다.

Mini Filter, Mini Boost 필터 형식을 설정합니다.



423   MODX M 사용설명서

U

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Upper Range Upper Range VCM Auto Wah, VCM Touch 
Wah, VCN Pedal Wah

가변 와와 필터 범위에 최대값을 설정합니다.

Control Flanger Flanger Control 가변 범위의 최대값을 
설정합니다.

Control Phaser Phase Control 가변 범위의 최대값을 설정합니다.

V

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Vib Speed Vib Speed Jazz Combo 비브라토의 속도를 설정합니다. Chorus를 Vib로 
설정한 경우 이용할 수 있습니다.

Vocoder Attack Vocoder Attack Vocoder 보코더 출력의 어택 값을 설정합니다.

Vocoder Rls Vocoder Release Vocoder 보코더 출력의 릴리스 값을 설정합니다.

Volume Volume U.S. Combo, Jazz Combo 프리앰프의 레벨을 설정합니다.

Vowel Vowel Talking Modulator 바우얼 형식을 선택합니다.

W

화면 이름 파라미터 이름 파라미터를 사용하는 이펙트 형식 설명

Wah Pedal Wah Pedal Multi FX 와와 페달의 위치를 설정합니다.

Wah Sw Wah SW Multi FX 와와 형식을 설정합니다.

Wall Vary Wall Vary Space Simulator 재현된 실내의 벽 형식을 설정합니다.  
값이 커질수록 반향이 더 많이 확산됩니다.

Width Width Space Simulator 재현된 실내의 폭을 설정합니다.

Width High Width High Stereophonic Optimizer High 대역의 스테레오 밸런스를 조정합니다.

Width Low Width Low Stereophonic Optimizer Low 대역의 스테레오 밸런스를 조정합니다.

Width Mid 1 Width Mid1 Stereophonic Optimizer Mid1 대역의 스테레오 밸런스를 조정합니다.

Width Mid 2 Width Mid2 Stereophonic Optimizer Mid2 대역의 스테레오 밸런스를 조정합니다.

Width Mid 3 Width Mid3 Stereophonic Optimizer Mid3 대역의 스테레오 밸런스를 조정합니다.

Word Length Word Length Lo-Fi 음향의 분해능 또는 거친 정도를 설정합니다.
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단축키 및 특수 작업

[SHIFT] 버튼 등을 사용한 단축키 작업에 더해 특수 작업은 버튼을 2번 누르거나 길게 누르는 것으로 실행할 수 있습니다.

단축키

작업 기능

[SHIFT] + 노브 1~4 (5~8) 노브를 고정밀 모드(느린 값 변화)로 전환합니다.
값을 미세조정하고자 할 때 유용합니다.

[SHIFT] + [EDIT/ ] Copy/Exchange 화면을 불러옵니다.

[SHIFT] + KNOB POSITION [LEFT] 노브에 지정된 Assign 1–8 값을 KNOB POSITION [LEFT] 버튼에 등록합니다.

[SHIFT] + KNOB POSITION [MID] 노브에 지정된 Assign 1–8 값을 KNOB POSITION [MID] 버튼에 등록합니다.

[SHIFT] + KNOB POSITION [RIGHT] 노브에 지정된 Assign 1–8 값을 KNOB POSITION [RIGHT] 버튼에 등록합니다.

[SHIFT] + [PAGE JUMP] [QUICK EDIT] 버튼으로 전환할 수 있는 파라미터를 변경하여 현재 화면에 표시된 파라미터와 
일치시킵니다.

[SHIFT] + [PART SELECT] 음소거 설정을 켜거나 끌 수 있도록 PART 버튼을 활성화합니다.

[SHIFT] + 파트 그룹 [1–8/9–16] 파트 9~16 사이를 전환할 수 있도록 PART 버튼 및 슬라이더를 활성화합니다.

[SHIFT] + [COMMON] 요소, 오퍼레이터 및 오실레이터에 Common을 선택합니다.

[SHIFT] + PART [1]–[8] 요소 1~8, 오퍼레이터 1~8 및 오실레이터 1~3 및 노이즈 중에서 하나를 선택합니다.

[SHIFT] + OCTAVE [−] 조옮김 값을 −1(감소)로 설정합니다.

[SHIFT] + OCTAVE [+] 조옮김 값을 +1(증가)로 설정합니다.

[SHIFT] + OCTAVE [−] + OCTAVE [+] 조옮김 값을 0(재설정)으로 설정합니다.

[SHIFT] + SCENE [1]–[8] 생성한 Scene을 SCENE [1]~[8] 버튼 중 하나에 등록합니다.

[SHIFT] + [DEC/NO] 선택한 파라미터 값을 −10(감소)으로 설정합니다.
Live Set 화면의 이전 페이지로 돌아갑니다.

[SHIFT] + [INC/YES] 선택한 파라미터 값을 +10(증가)으로 설정합니다.
Live Set 화면의 다음 페이지로 이동합니다.

[SHIFT] + [ARP] Arp Edit 화면을 불러옵니다.

[SHIFT] + [MSEQ] Motion Seq Edit 화면을 불러옵니다.

[SHIFT] + [CONTROL ASSIGN] Control View 화면을 불러옵니다.

[SHIFT] + [PERFORMANCE (HOME)] info 화면(property 화면) (Home 화면에만 해당)을 불러옵니다.

[SHIFT] + [LIVE SET] Live Set Register 화면으로 이동합니다.

[SHIFT] + [CATEGORY] 선택한 파트의 Part Category Search 화면을 엽니다.

[SHIFT] + [UTILITY] 파라미터 값을 조정합니다.

[SHIFT] + [NAVIGATION] FX Overview 화면을 불러옵니다.

[SHIFT] + [QUICK SETUP] Effect Switch 화면을 불러옵니다.

[SHIFT] + [STORE] Load 화면을 불러옵니다.

[SHIFT] + [SPLIT] Part-Note 보기가 선택된 Home 화면을 불러옵니다.

[SHIFT] + [SONG/PATTERN] Rhythm Pattern 화면을 불러옵니다.

[SHIFT] + [TEMPO/TAP] 패널 잠금 기능을 켜거나 끕니다.(Home 화면 또는 Live Set 화면에만 해당)

[SHIFT] + [A/D INPUT] Audio In Mixing 화면을 불러옵니다.

[SHIFT] + [PORTAMENTO] Pitch Edit 화면을 불러옵니다.

[SHIFT] + [ASSIGN 1]/[ASSIGN 2] Control Settings 화면을 불러옵니다.

[UTILITY] + [DAW REMOTE] Calibration Touch Panel을 선택합니다. 

OCTAVE [−] + OCTAVE [+] 옥타브 이동을 재설정합니다.
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기타 작업

작업 기능

PART 버튼을 빠르게 2번 누르기 Internal과 External 사이를 전환합니다.l
External로 전환할 경우, 파트 이름이 파란색으로 표시됩니다.

[CATEGORY] 버튼을 길게 누르기 Bank/Favorite (Bank/Favorite Select)을 All로 재설정합니다.
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메시지 목록

메시지 설명 필요한 작업

** library will be overwritten. 라이브러리를 불러오려고 할 때 이름이 동일한 
라이브러리 파일을 이미 불러온 상태입니다. 
새 데이터를 불러온 경우 기존 데이터가 
덮어쓰기됩니다.
불러오려는 라이브러리 파일의 이름이 ** 대신 
표시됩니다.

** Control Assign full. 이용 가능한 컨트롤 세트가 없어 작업을 실시할 
수 없습니다.
컨트롤러 세트에 추가하려는 파트 이름이 ** 
대신 표시됩니다.

불필요한 컨트롤러 세트를 삭제한 후 작업을 
다시 실시하십시오.

** will be deleted. 이 작업의 결과로 데이터가 삭제됩니다.

** will be loaded to Pattern. .mid 파일이 패턴에 불러오기됩니다.

** will be loaded to Song. .mid 파일이 곡에 불러오기됩니다.

** will be loaded. 파일이 불러오기됩니다.

** will be overwritten. 저장할 때 이름이 동일한 퍼포먼스, 파일, 폴더 
또는 빠른 설정이 이미 존재합니다. 저장하는 
데이터를 덮어쓰기합니다.
저장하려는 퍼포먼스, 파일, 폴더 또는 빠른 
설정의 이름이 ** 대신 표시됩니다.

Activate the source controller to 
assign.

작동하려는 컨트롤러에 파라미터를 지정할 수 
있습니다.

지정하려는 컨트롤러를 작동하십시오.

Advanced settings will be initialized. [UTILITY] → Settings → Advanced 탭의 
설정을 초기화합니다.

All data and libraries will be 
initialized. Unsaved user data will be 
lost.

출고 시 기본 설정으로 복원합니다. USB 플래시 드라이브에 유지하려는 필요한 
설정을 미리 저장하는 것도 좋습니다.

All data is initialized upon power-on. 악기의 전원을 켤 때 출고 시 기본 설정으로 
복원되도록 악기가 설정되었습니다.

All data will be overwritten by ** 불러올 때 모든 데이터가 덮어쓰기됩니다.
불러오려는 백업 파일의 이름이 ** 대신 
표시됩니다.

All Favorite Marks will be cleared. 모든 즐겨찾기 표시가 삭제됩니다.

All settings will be initialized. User 
data is kept.

악기의 설정이 초기화됩니다. 사용자 데이터가 
삭제되지 않습니다.

All sound will be stopped during 
optimization.

내부 메모리가 복원됩니다.

All user data will be initialized. 
Unsaved user data will be lost.

사용자 메모리의 사용자 영역에 초기화됩니다. USB 플래시 드라이브에 유지하려는 필요한 
설정을 미리 저장하는 것도 좋습니다.

Arpeggio bypass disabled. Arpeggio Bypass 가 비활성화됩니다.

Arpeggio full. Arpeggio가 가득 차 작업을 실시하지 
못했습니다.

불필요한 User Arpeggio 데이터를  
[UTILITY] → Contents → Data Utility 
화면에서 삭제하십시오.
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메시지 설명 필요한 작업

Assignable knob full. 컨트롤러 세트에 모든 지정 가능 노브가 
사용되어 작업을 실시하지 못했습니다.

지정 가능 노브가 소스로 설정된 불필요한 
컨트롤러 세트를 삭제하고 작업을 다시 
실시하십시오.

Audio file is not found. 지정된 오디오 파일을 찾을 수 없습니다.

Audio Rec stopped due to lack of 
memory space.

USB 플래시 드라이브가 가득 차 오디오 녹음이 
자동으로 멈췄습니다.

새 USB 플래시 드라이브를 사용하거나 
불필요한 파일을 삭제한 후 이 작업을 다시 
시도하십시오.

Audition full. User Audition 데이터가 가득 차 작업을 
실시하지 못했습니다.

불필요한 User Audition 데이터를  
[UTILITY] → Contents → Data Utility 
화면에서 삭제하십시오.

Auto power off disabled. Auto Power Off 기능이 비활성화되었습니다.

Bulk data protected. 설정으로 인해 벌크 데이터를 수신할 수 
없습니다.

Can’t process. 요청된 작업을 처리할 수 없습니다.

Can’t register unstored 
performance.

편집 중인 뱅크 또는 프로그램 번호가 아직 
설정되지 않아 Live Set에 퍼포먼스를 등록할 수 
없습니다.

Completed. 지정된 불러오기, 저장, 포맷 또는 다른 작업이 
완료되었습니다.

Connecting to USB device... 악기에 USB 플래시 드라이브를 연결하는 
중입니다.

Converting Pattern to Song. 패턴이 변환 중입니다.

CPU Fan Error 내장 냉각 팬이 정지되었습니다. 이 상태로 인해 내부 온도가 상승하여 악기가 
작동을 멈출 수 있습니다.
바로 필요한 모든 데이터를 백업하고 악기의 
전원을 끈 후 Yamaha 구입처에 문의하십시오.

Current user data will be overwritten 
by **.

파일을 불러올 대상에 사용자 데이터가 
이미 존재합니다. 진행하면 기존 데이터가 
덮어쓰기됩니다.
불러오려는 사용자 파일의 이름이 ** 대신 
표시됩니다.

Curve full User Curve 데이터가 가득 차 작업을 실시하지 
못했습니다.

불필요한 사용자 곡선 데이터를  
[UTILITY] → Contents → Data Utility 
화면에서 삭제하십시오.

Data memory full. (라이브러리 파일을 불러올 때) 악기 메모리가 
가득 차 라이브러리의 내용 데이터를 저장하지 
못했습니다.

Device number is off. 장치 번호가 꺼져 있어 벌크 데이터를 
전송하거나 수신할 수 없습니다.

Device number mismatch. 장치 번호가 일치하지 않아 벌크 데이터를 
전송하거나 수신할 수 없습니다.

Dividing the drum track makes new 
performance data. Performance full.

Divide Drum Track을 사용하여 생성한 
퍼포먼스에 공간이 없어 실행할 수 없습니다.

Dividing the drum track makes new 
performance data. You can’t undo 
this operation.

Divide Drum Track을 사용하여 새 퍼포먼스를 
생성합니다. 이 작업은 취소할 수 없습니다.

File is not found. 선택한 형식에 대한 파일이 없습니다.

File or folder already exists. 동일한 파일 또는 폴더가 이미 존재합니다.
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메시지 설명 필요한 작업

File or folder path is too long. 경로 이름이 너무 길어 지정된 파일 또는 폴더를 
열 수 없습니다.

Folder is not empty. 데이터를 포함한 폴더를 삭제하려고 합니다.

Folder is too deep. 폴더 계층이 너무 깊어 폴더를 열 수 없습니다.

Illegal bulk data. 벌크 데이터나 벌크 요청을 수신하는 동안 
오류가 발생했습니다.

Illegal file name. 파일 이름이 무효합니다.

Illegal file. 지정된 파일을 본 악기에서 처리하거나 불러올 
수 없습니다.

Illegal parameters. 잘못된 파라미터가 지정되었습니다.

Illegal sample data. 지정된 샘플 데이터가 지원되지 않습니다.

Illegal smart morph data. 지정된 Smart Morph 데이터가 지원되지 
않습니다.

Keybank full. 불러올 때 키 뱅크의 총 수가 최대 수를 
초과합니다.

Keyboard control lock disabled. Keyboard Lock이 비활성화됩니다.

Knob value stored. Knob Value가 저장되었습니다.

Library full. 라이브러리의 총 수가 최대 수를 초과합니다.

Micro Tuning full. User Micro Tuning 데이터가 가득 차 실행할 
수 없습니다.

불필요한 User Micro Tuning 데이터를 
[UTILITY] → Contents → Data Utility 
화면에서 삭제하십시오.

MIDI buffer full. 너무 많은 양의 MIDI 데이터가 한 번에 수신되어 
처리할 수 없습니다.

MIDI checksum error. 수신된 시스템 전용 메시지의 체크섬이 
부정확합니다.

No data. 선택한 트랙이나 지정한 범위에 데이터가 
존재하지 않습니다.
범위를 다시 선택하십시오.

No read/write authority to the file. 이 파일에 대한 읽기 또는 쓰기 권한이 없습니다.

Note ranges will be initialized. 음 범위가 초기화됩니다.

Now initializing all data... 출고 시 설정을 복원 중입니다.

Now initializing... 일부 데이터가 초기화되는 중입니다.

Now loading... 파일을 불러오는 중입니다.

Now receiving MIDI bulk data... 악기가 MIDI 벌크 데이터를 수신하는 중입니다.

Now saving... 파일을 저장하는 중입니다.

Now transmitting MIDI bulk data... 악기가 MIDI 벌크 데이터를 전송하는 중입니다.

Panel unlocked. 패널 잠금이 비활성화되었습니다.

Part *** will be overwritten. 복사 대상에 파트가 이미 존재합니다. 작업을 
계속 진행하는 경우 복사 대상의 기존 파트가 
덮어쓰기됩니다.

Part full. 이용할 수 있는 파트가 없어 Rhythm Pattern 
화면을 열지 못했습니다.

불필요한 파트를 삭제한 후 작업을 다시 
실시하십시오.

Pattern full. 패턴이 가득 차 작업을 실시하지 못했습니다.

Pattern will be converted to Song. 패턴이 곡으로 변환됩니다.
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메시지 설명 필요한 작업

Performance data in *** will be 
loaded.

파일 내 기존 모델의 Performance Data가 
불러오기됩니다.

Performance full. Performance가 가득 차 작업을 실시하지 
못했습니다.

Please connect USB device. USB 플래시 드라이브를 연결합니다.

Please keep power on. 플래시 ROM에 데이터를 기록합니다. 이 메시지가 표시되는 동안 악기의 전원을 끄지 
마십시오.
이 메시지가 표시되는 동안 악기의 전원을 끄면 
사용자 데이터가 손실되거나 시스템이 손상되어 
다음 번에 악기의 전원을 켤 때 시스템이 
올바르게 시작되지 않을 수 있습니다.

Please reboot to enable the new 
Audio I/O Mode.

악기를 재시작하여 오디오 입력 및 출력 설정을 
변경하십시오.

Please reboot to enable the new USB 
Driver Mode.

악기를 재시작하여 USB 드라이버 모드 설정을 
변경하십시오.

Please reboot to maintain internal 
memory.

악기를 재시작하여 악기 메모리를 수리합니다.

Please stop audio play/rec. 오디오 녹음 또는 재생을 멈춘 후 다시 
시도하십시오.

Please stop sequencer. 시퀀서(패턴 또는 곡)를 멈춘 후 다시 
시도하십시오.

Please store the pattern to change 
the chain play mode.

체인 재생 모드를 변경하기 전에 패턴을 
저장하십시오.

Please wait... 처리 중입니다. 기다려 주십시오.

Press [SHIFT]+[TEMPO/TAP] to 
unlock panel.

패널 잠금이 활성화되었습니다.
[SHIFT] + [TEMPO/TAP]을 눌러 패널을 
잠금해제합니다.

Quick Setup ** is loaded. Quick Setup이 불러오기되었습니다.

Recall latest edits. 마지막으로 편집한 퍼포먼스 데이터를 불러와 
편집 버퍼에 배치합니다.

Redo **. 취소했던 작업을 다시 실시합니다(Redo).
작업 이름이 “**” 대신 표시됩니다.

Sample is protected. 샘플이 보호된 상태여서 변경할 수 없습니다.

Sample is too long. 샘플 크기가 너무 커서 불러올 수 없습니다.

Turn on Memory Switch to memorize 
** into this scene.

Scene에 기능을 등록하려면 해당 기능의 
Memory(Memory Switch)를 미리 켜야 
합니다.

[PERFORMANCE (HOME)] → Scene에서 
화면을 열고 스위치를 켜십시오.

Undo **. 직전에 수행한 작업을 취소합니다(Undo).
작업 이름이 “**” 대신 표시됩니다.

Unsupported USB device. 이 USB 장치는 본 악기에서 지원되지 않습니다.

USB connection terminated. 비정상적인 전류 흐름으로 인해 USB 플래시 
드라이브가 차단되었습니다.

USB 플래시 드라이브를 분리한 후 상단 패널의 
버튼을 누르십시오.

USB device is full. USB 플래시 드라이브가 가득 차 파일을 저장할 
수 없습니다.

새 USB 플래시 드라이브를 사용하거나 
불필요한 파일을 삭제한 후 이 작업을 다시 
시도하십시오.
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메시지 설명 필요한 작업

USB device is write-protected. 사용 중인 USB 플래시 드라이브가 쓰기 
보호되고 있습니다.

USB device read/write error. USB 플래시 드라이브를 읽거나 쓰는 동안 
오류가 발생했습니다.

USB device will be formatted. USB 플래시 드라이브가 포맷됩니다.

User auditions will be overwritten 
with stored songs.

기존 User Audition이 현재 저장된 곡으로 
덮어쓰기됩니다.

VCM Rotary is disabled except in Part 
1.

VCM Rotary는 파트 1에서만 사용할 수 
있습니다. 다른 파트에서는 사용할 수 없습니다.

Voice data in *** will be loaded. 파일 내 기존 모델의 Voice Data가 
불러오기됩니다.

Waveform full. 파형의 총 수가 최대 수를 초과합니다.
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문제가 발생한 경우

음향이 전혀 들리지 않습니까? 잘못된 음향이 들립니까? 이와 같은 문제가 발생하면 제품이 이상이 있다고 판단하기 전에 다음 문제 해결 

부분을 확인하십시오.

USB 플래시 드라이브에 데이터를 백업한 후 Initialize All Data를 실시하면 수많은 문제를 해결할 수 있습니다.

그래도 문제가 해결되지 않으면 Yamaha 구입처에 문의하십시오.

터치스크린 응답이 불량합니다.

•	커서가 터치스크린을 누른 정확한 위치를 향하고 있습니까?

그렇지 않은 경우 터치스크린을 보정하십시오.

[UTILITY] + [DAW REMOTE] → Calibrate Touch Panel

[UTILITY] → Settings → System → Calibrate Touch Panel

음향이 전혀 들리지 않습니다.

•	컨트롤 슬라이더 1~8이 최저값으로 설정되었습니까?

컨트롤 스라이더 1~8의 위치를 변경하십시오.

•	악기에 앰프, 스피커 또는 헤드폰이 연결되어 있습니까?

본 악기에는 내장 스피커가 없어 음향을 들으려면 앰프, 스피커 또는 헤드폰을 연결해야 합니다.

•	본 악기 및 연결된 장치의 전원이 켜져 있습니까?

•	본 악기의 마스터 음량 및 연결된 장치의 음량 설정을 포함한 적절한 레벨 설정을 모두 했습니까?

풋 컨트롤러가 [FOOT CONTROLLER] 잭에 연결된 경우 풋 컨트롤러를 움직여 보십시오.

•	로컬 컨트롤이 꺼짐으로 설정되어 있습니까?

Local Control이 꺼짐으로 설정된 경우 건반을 연주해도 음향이 들리지 않습니다.

[UTILITY] → Settings → MIDI I/O → Local Control

•	비어 있는 파트가 선택되었습니까?

그런 경우 파트에 음향을 지정하거나 다른 파트를 선택하십시오.

•	각 파트의 음소거 스위치가 켜집니까?

음소거 스위치를 켜면 건반을 연주해도 음향이 생성되지 않습니다.

[PERFORMANCE (HOME)] → Part 선택 → Mute

•	각 파트의 Keyboard Control Switch가 꺼진 상태입니까?
[PERFORMANCE (HOME)] → Part 선택 → Keyboard Control Switch

•	선택한 파트의 Arp Play Only가 켜진 상태입니까?

Arp Play Only가 켜지면, 해당 파트가 아르페지오 재생을 통해서만 음향을 생성합니다.

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → General / Pitch → Part Settings → Arp Play Only

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Arpeggio → Common → Arp Play Only
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•	외부 컨트롤러를 사용할 때 MIDI 음량이나 MIDI 표현 설정이 너무 낮습니까?

•	이펙트 및 필터 설정이 적절합니까?

필터를 사용하는 경우 차단 주파수를 변경해 보십시오. 일부 차단 설정으로 모든 음향이 필터링될 수 있습니다.

[SHIFT] + [NAVIGATION]

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Effect

일반 파트(AWM2) 및 드럼 파트의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Element 또는 Drum Key → Filter

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Effect

일반 파트(FM-X) 및 일반 파트(AN-X)의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Filter / Amp

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Effect

•	보코더가 파트의 인서트 이펙트 형식으로 선택됩니까?

그런 경우 A/D INPUT 잭 관련 파라미터를 적절한 값으로 설정한 후 본 악기에 연결된 마이크에 대고 말하거나 노래를 부르면서 건반을 

연주하십시오. 상단 패널의 A/D INPUT [GAIN] 노브가 0 이외의 다른 값으로 설정되어 있는지 확인하십시오.

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Effect → Routing

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Audio In

•	음량 또는 레벨 설정이 너무 낮습니까?
[UTILITY] → Settings → Sound → Tone Generator Volume

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → General/Pitch → Perf Settings → Volume

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → General/Pitch → Part Settings → Volume

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Part Settings → Dry Level

일반 파트(AWM2) 및 드럼 파트의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Element 또는 Drum Key 선택 → Amplitude → Level/Pan → 
Level

일반 파트(FM-X)의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Operator 선택 → Level → Level

일반 파트(AN-X)의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Oscillator 선택 → OSC/Tune → Out Level

•	Element Switch, Note Limit, Velocity Limit 및 Velocity Offset이 적절합니까?

일반 파트(AWM2) 및 드럼 파트의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → General/Pitch → Part Settings

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Element 또는 Drum Key 선택 → Osc/Tune

일반 파트(FM-X) 및 일반 파트(AN-X)의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → General/Pitch → Part Settings
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•	파트의 각 요소/오퍼레이터마다 음소거 스위치가 켜집니까?
[PERFORMANCE (HOME)] → Part Common 선택 → 탐색바의 Element, Operator 또는 Oscillator 상태

•	일반 파트(FM-X)의 경우 캐리어 레벨이 “0”으로 설정되어 있습니까?
[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Operator 선택 → Level → Level

•	각 파트의 출력 설정이 꺼집니까?
[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → General/Pitch → Part Settings → Part Output

•	컨트롤러 설정이 적절합니까?

Destination이 Volume 또는 Cutoff으로 설정된 경우, 설정 및 컨트롤러 상태에 따라 음향이 생성되지 않습니다.

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Mod/Control → Control Assign

A/D INPUT 잭에서 음향이 생성되지 않습니다.

•	연결된 마이크가 켜집니까?

•	다이나믹 마이크가 악기에 연결되어 있습니까?

•	마이크 또는 오디오 장비와 본 악기 사이에 케이블이 제대로 연결되었습니까?

•	A/D INPUT [GAIN] 노브가 최소 위치로 돌아갑니까?

•	A/D INPUT 버튼이 켜진 상태입니까?

•	A/D INPUT 잭에 연결된 케이블이 잭의 Mono/Stereo 설정과 일치하는지 확인하십시오.
[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Audio In → Mixing → A/D In Input Mode

•	마이크 또는 라인 설정이 적절합니까?

출력 레벨이 낮은 마이크 또는 장치가 연결된 경우, Mic로 설정하십시오. 오디오 장치, 전자 악기 또는 입력 레벨이 높은 장치가 연결된 

경우, Line으로 설정하십시오.

[UTILITY] → Settings → Audio I/O → A/D Input

•	A/D 입력 파트의 음량 설정이 너무 낮습니까?
[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Audio In → Mixing → A/D In Volume

•	A/D 입력 파트의 이펙트 설정이 적절합니까?
[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Audio In → Routing

•	A/D 입력 파트의 출력 설정이 적절합니까?
[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Audio In → Mixing → A/D In Output Select

•	보코더 이펙트가 선택되어 있는지 확인하십시오.

인서트 이펙트가 보코더 사용으로 설정된 경우, A/D INPUT 커넥터의 입력 음향은 건반이 연주되기 전까지 음향을 생성하지 않을 수 

있습니다.

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Effect → Routing
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멈추지 않고 재생이 계속됩니다.

•	 [KEYBOARD HOLD] 버튼이 켜져 있으면 꺼 보십시오.

•	 [ARP] 버튼이 켜진 경우, 버튼을 꺼 보십시오.

•	Pattern/Song/Audio 화면의 경우, [] (정지) 버튼을 누르십시오.

•	이펙트 음향(예: 딜레이)이 지속되어 멈추지 않으면 이펙트 설정을 변경하거나 다른 퍼포먼스를 선택하십시오.

•	클릭음이 지속되면 다음 설정을 확인하십시오.

Always로 설정된 경우, 클릭음이 항상 생성됩니다. 이 파라미터를 Always 이외의 값으로 설정하십시오.

[UTILITY] → Tempo Settings → Click Mode

음향이 왜곡됩니다.

•	음량이 너무 높게 설정되어 있습니까?
[UTILITY] → Settings → Sound → Tone Generator Volume

[UTILITY] → Settings → Audio I/O

[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → General/Pitch → Perf Settings → Volume

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → General/Pitch → Part Settings → Volume

일반 파트(AWM2)의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Element 선택 → Amplitude → Level/Pan → Level

드럼 파트의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Key 선택 → Level/Pan → Level

일반 파트(FM-X)의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Operator 선택 → Level → Level

일반 파트(AN-X)의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Oscillator 선택 → OSC/Tune → Out Level

음향이 차단됩니다.

•	전체 음향이 최대 동시발음수를 초과합니까?
•	 AWM2(사전 설정 파형): 128개 음향(스테레오와 모노 파형 모두)

•	 AWM2(사용자 또는 라이브러리 파형): 128개 음향(스테레오와 모노 파형 모두)

•	 FM-X: 128

•	 AN-X: 12
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한 번에 한 음만 울립니다.

•	톤 생성 모드가 Mono로 설정되었는지 확인하십시오.

코드 연주를 원하면 이 파라미터를 Poly로 설정하십시오.

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → General/Pitch → Part Settings → Mono/Poly

잘못된 피치입니다.

•	튠이 0에서 너무 멀리 설정되어 있습니까?
[UTILITY] → Settings → Sound → Tone Generator Tune

•	각 파트의 음 이동 또는 디튠이 0 이외의 값으로 설정되었습니까?
[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → General/Pitch → Pitch → Note Shift

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → General/Pitch → Pitch → Detune

•	파트의 피치가 잘못된 경우, 마이크로 튜닝 설정에서 특수한 평균율이 선택되었습니까?
[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → General/Pitch → Pitch → Micro Tuning Name

•	Global Tuning에 특수한 평균율을 설정했습니까?
[UTILITY] → Settings → Sound → Global Settings

•	파트에서 잘못된 피치가 생성된 경우 LFO Pitch Modulation Depth가 너무 높게 설정되어 있습니까?

일반 파트(AWM2)의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Element 선택 → Element LFO → Pitch Mod

일반 파트(FM-X)의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Mod/Control → 2nd LFO → Pitch Modulation Depth

일반 파트(AN-X)의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → General/Pitch → Pitch LFO → Pitch LFO Depth

•	파트의 피치가 잘못된 경우, 굵은 튜닝과 미세 튜닝이 정렬되지 않았습니까?

일반 파트(AWM2) 및 드럼 파트의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Element 또는 Drum Key 선택 → Osc/Tune → Coarse

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Element 또는 Drum Key 선택 → Osc/Tune → Fine

일반 파트(FM-X)의 경우

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Operator 선택 → Form/Freq → Coarse

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Operator 선택 → Form/Freq → Fine

•	파트의 피치가 잘못된 경우, 컨트롤러 대상이 피치에 맞게 설정되어 있습니까?
[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Mod/Control → Control Assign → Destination

•	AN-X 파트의 경우, Voltage Drift가 너무 큰 값으로 설정되어 있습니까?
[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → General/Pitch → AN-X Settings → Voltage Drift
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이펙트가 적용되지 않습니다.

[SHIFT] + [NAVIGATION]을 사용하여 이펙트를 설정을 확인하십시오.

•	이펙트 스위치가 꺼져 있습니까?
[UTILITY] → Effect Switch

•	변형 전송 및 리버브 전송 값이 최저 레벨로 설정되어 있습니까?
[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Effect → Routing → Var Send

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Effect → Routing → Rev Send

•	변형 리턴 및 리버브 리턴 값이 최저 레벨로 설정되어 있습니까?
[PERFORMANCE (HOME)] → Common 선택 → [EDIT/ ] → Effect → Routing → Var Return

[PERFORMANCE (HOME) → Common 선택 → [EDIT/ ] → Effect → Routing → Rev Return

•	파트 인서트 이펙트 또는 모든 요소나 모든 키가 Thru로 설정되어 있습니까?
[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Effect → Routing → Connect 또는 Element 1~8

•	 (시스템 이펙트의 경우) 각 이펙트에 선택한 이펙트 형식이 No Effect로 설정되어 있습니까?

•	 (인서트 이펙트의 경우) 각 이펙트에 선택한 이펙트 형식이 Thru로 설정되어 있습니까?

•	인서트 스위치 설정이 적절합니까?
[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Effect → Ins A 또는 Ins B

아르페지오를 시작할 수 없습니다.

•	 [ARP] 버튼이 켜져 있습니까?

아르페지오 스위치가 켜진 파트의 수를 확인하십시오. 아르페지오를 최대 8개의 파트까지 동시에 재생할 수 있습니다.

•	아르페지오 음 제한 및 속도 제한 설정이 적절합니까?
[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Arpeggio → Common

•	아르페지오 형식이 Off로 설정되어 있습니까?
[PERFORMANCE (HOME) → Part 선택 → [EDIT/ ] → Arpeggio → Individual → Name

•	각 파트의 아르페지오 스위치 설정을 확인하십시오.

아르페지오 스위치를 꺼짐으로 설정한 경우 상단 패널의 [ARP] 버튼을 켜도 아르페지오가 재생되지 않습니다.

[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Arpeggio → Common, Individual 또는 Advanced → Arp 

Part
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아르페지오를 중지할 수 없습니다.

•	건반에서 손가락을 떼도 아르페지오 재생이 중지되지 않는 경우 아르페지오 홀드 스위치를 Off로 변경합니다.
[PERFORMANCE (HOME)] → Part 선택 → [EDIT/ ] → Arpeggio → Common → Hold

•	상단 패널의 [KEYBOARD HOLD] 버튼을 끄십시오.

[] (재생) 버튼을 누르면 패턴 또는 곡이 재생되지 않습니다.

•	선택한 패턴 또는 곡에 데이터가 존재합니까?

패턴 또는 곡을 녹음할 수 없습니다.

•	패턴 또는 곡을 녹음할 때 이용할 수 있는 메모리 공간이 존재합니까?

악기의 메모리 공간에는 최대 128개의 패턴 및 128개의 곡을 저장할 수 있습니다. 128개가 넘는 곡이나 패턴을 녹음하려는 경우 

Song full 메시지가 표시되며 더 이상의 녹음이 불가능합니다.

연결된 컴퓨터와 악기 사이의 데이터 통신이 제대로 되지 않습니다.

•	컴퓨터의 포트 설정이 적절합니까?

•	Utility 화면에서 올바른 단자(MIDI 또는 USB)를 선택했습니까?
[UTILITY] → Settings → MIDI I/O → MIDI IN/OUT

MIDI 벌크 데이터가 올바르게 전송되거나 수신되지 않습니다.

•	Receive Bulk가 보호되고 있습니까?

MIDI Receive Bulk를 켜짐으로 설정하십시오.

[UTILITY] → Settings → Advanced → MIDI Receive Bulk

•	본 악기의 벌크 덤프 기능을 사용하여 녹음된 데이터를 수신하려면 전송 및 수신에 동일한 장치 번호를 
설정해야 합니다.
[UTILITY] → Settings → Advanced → MIDI Device Number

•	연결된 MIDI 장치에 동일한 장치 번호가 설정되어 있습니까?
[UTILITY] → Settings → Advanced → MIDI Device Number
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USB 플래시 드라이브에 저장할 수 없습니다.

•	USB 플래시 드라이브가 쓰기 보호되어 있습니까?

•	USB 플래시 드라이브의 이용 가능한 공간이 충분합니까?

내용 화면을 열고 USB 플래시 드라이브에 장치를 설정하십시오. 화면 우측 상단 모서리의 사용 가능한 저장 공간이 0.0KB인지 

확인하십시오.

[UTILITY] → Contents → Save

•	본 악기와 호환되는 것으로 확인된 USB 플래시 드라이브를 사용하고 있습니까?

본 악기와 호환되는 것으로 확인된 USB 장치 목록은 다음 URL을 확인하십시오.

https://download.yamaha.com/

화면에는 일부 검은 점(어두움) 또는 흰색 점(항상 밝음)이 있습니다.

이러한 현상은 컬러 LCD의 특성이며 오작동이 아닙니다. 

https://download.yamaha.com/
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출고 시 기본 설정으로 복원(Initialize All Data)

주의사항

모든 데이터 초기화 기능을 실행한 경우, 사용자 메모리에 저장된 모든 퍼포먼스와 곡과 Utility 화면의 모든 악기 설정이 공장 초기 설정으로 복원됩니다. 

USB 플래시 드라이브에 유지하려는 모든 중요 설정을 미리 저장하는 것이 권장됩니다.

1.	 [UTILITY] → Settings → System에서 설정 화면을 엽니다.

그러면 전체 악기 설정 화면이 나타납니다.

2.	 Initialize All Data를 탭합니다.

확인 화면이 나타납니다.

작업을 취소하려면 화면의 Cancel(NO) 버튼을 탭하거나 상단 패널의 [DEC/NO] 버튼을 누릅니다.

3.	 화면의 Initialize(YES) 버튼을 탭하거나 상단 패널의 [INC/YES] 버튼을 누릅니다.

Initialize All Data 작업이 실행됩니다.
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